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M. Sc. In Botany

Paper - II (First Half) @ Module No. - 13
1. Introduction’ Definition of terms: Systematics, Taxonomy, Classification, Nomenclature. Idcntiﬁcalior\)l

SYSTEMATICS AND TAXONOMY

The terms systematics and taxonomy are synonymous although to a purist these two terms have certain
distinctions While taxonomy is considered 1o be basically concerned with the study of classification
including the principles, rules and procedures, systematics is recognized as a much wider field offstudy
covering diversity of organisms, their relationship, classification and evolution. Simpson (1961) defined
systematics as a scnentlﬁc study of kinds and dxvnrsnt) of organisms, and of any and all relationships
bctween them.

Taxonomy, although the oldest discipiine of biologica) science, was introduced into the field of botanical
studics for the first time by AP de Candolle in 1813 as a combination of taxis (arrangement) and nomes
(rules or laws). Taxonomy, once considered to be theories of classification, h_as widened its aspects and
prospects considerably through ages. Definition of taxonomy coincides with systematics and is concerned
with identification, nomenclature, classification, intericlationship and evolution of organisms. Stace (1989)
defined taxonomy as the study and description of variations in living organisms, the investigation of the
causes and consequence of this variation and the manipulation of the date obtained to produce a system of
classification.

CLASSIFICATION A
Classification is an arrangément of plants into groups oun the basis of certain principles. It is a process in one
hand and product on the other. As a process it involves certain methods and criteria and as a product it
serves as an information storage and retrieval system about the concerned groups or taxa (species, genus,
family, order, class, division etc.) Taxonomic entities are classified in different fashions.-

I. Artificial system of classification: This is utilitarian, based on arbitrary, easily observable characters,
usually one or a few at a time, so that the resulting groups consist of unrelated members. The sexual
system of classification given to us by Linnaeus fits into this category. ‘

2. Natural system of classification are those which are based on evaluation of as man> characters as
possible so that the resulting groups consist of related members. Thus, these . systems use overall
similarity in grouping taxa. This concept was initiated by M. Addnson (1763) and culminated by
Bentham and Hooker (1862-1883). ‘

3. Phylogenetic systems are based on the evolutionary decent of the organisms and their various groups
or categories or taxa. However, these systems are natural in construction and evolutionary in

- expression. The phylogenetic interpretation incorporates information about origin, interrelationship,
development and fate of different taxa. System of Engler and Prant! (1887-1915), John Hutchinson
(1926, 1930, 1959 and 1973), Arrmoi. Takhtajan (1980, 1987, 1997), Arthur Croncum(!%l‘l‘“@?
Robert thorne (1983, 1992, 2000), Rolf Dahlgren (1983, updated in 1989 by his wife Gertura *
Dabhlgren) are phylogenetic w1th great reputation.




NOMENCLATURE ' .
Nomenclature is the procedure of determination of the correct name for a taxon on the basis of rules and
recommendations of the International Code of Botanical Nomenclature (ICBN). Updated every Six years or
so, the code maintains the system of picking up a single correct name out of numerous scxentx_ﬁc names
available for a taxon, with particular circumsctiption, position and rank. To avoid inconvenicnt name
changes for certain taxa, a list of conserved names is provided in the code.

The code (ICBN) aims at provxslon of a stablc method of naming taxonomic groups, avoiding and rejecting
the use of ambiguous and erroneous names. The code consists of 3 components:
1 Principles
1l Rules and recommendations
[11. Provision for modification of the code.

In addition, the code includes the following appendices:
I Names of hybrids :
. Nomina familiarum conservanda et rejicienda
[1. A Nomina generica conservanda et rejicienda
[l1 B Nomina specifica conservanda et rejicienda
IV. Nomina utique rejicienda
V. Opera utique appressa

The last three useful appendices were included for the first time in the Tokyo Code. The first (IIB) includes
the specific narnes conserved and rejected the sécond i.e. IV the name and all combinations based on these
names, which are ruled 4s rejected under Art. 56, and none is to be used; and the last (V) one deals with the
hist of publications (and the category of taxa therein) which are not validly published in accordance with the
code.

IDENTIFICATION

Determination of the name of a species and its systematic position is basic to all taxonomic methods and
pre- requisite to all scientific researches concerning plants and their economic use. Identification of all
catregories in taxonomic hxerarchy needs appropriate characterization and standard authentic keys and for a
spuecies pamcularly comparison with authentic specimens preserved in herbaria (a direct method) is
necessary in addition to dichotomous keys, polyclaves or computer-aided ‘devices (an indirect method) In
most cases, the characters derived from the gross morphology are adequate for provisional identification of a
taxon. Confirmation of such identification may be obtained from other data sources. If the specimen does
not agree either with the predetermined specimen or with the literature, then it is to be treated as so far .
unknown to science. A new name may be given to it following all rules laid by ICBN.

HISTORY OF DEVELOPMENT OF TAXONOMY .

The dependence of man on plants for every aspect of life since the dawn of civilization has always fnduc’ed
in him the urge to know more about the plants. Establishment of identity of plants their description and
classification led to the development of taxonomy. Medicinal plants were recognized as early as Vedic age
The reputed Atharva Veda, written around 2000 B.C. ¢ontains a wealth of information about medicinal
plants and their uses. Texts on medicinal plants in ancient times were plentiful being prepared by Chinese,
Egyptians, Assyrians, Aztecs and others. Vrikshayurveda (science of plant life) is one of the carliest books
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written by Parasara (250 B.C to 120 B.C). This treatise was the basis of botanical studies preparatory 1o
medical science in those days

The ancient Greek philosophers like Plato, Aristotle, Theophrastus and others, who compiled the principles
of plant classification in Greek and Latin (around 400 to 285 B.C) are considered to be founders of
taxonomy. Theophrastus is credited with more than 200 works, but most of these survive only as fragments
or quotations in the work of other writers The most famous ones among his writings include Engquiry into
Plants and The Causes of Plants. The plants were classified by him into trees, shrubs, undershrubs and herbs
and about 480 plants were listed in his Historia Plantarum. Distinctions between centripetal (racemose) and
centrifugal (cymose) types of inflorescence, superior and inferior ovaries and the polvpetalous and
gamopetalous corolla were also made.

One of the most authentic books to have served Europeans for 1500 years from I A D was dgM__ag_e_r,la
Medica authored by Pedanios Dioscorides. This book made a substantial contribution primarily to the then
practice of medicine and secondarily to the developmznt of taxonomy by including description and use of
about 600 species of piants It was de Vegetabilis of Albert Magnus (1193-1280) which was very widely
. used for the next two hundred years The credit goes to him to distinguish the monocotyledons from the
dicotyledous for the first time. ‘

During the fifteenth and sixteenth century many famous books on medicinal plants (Herbals) were pubhshed
which also contributed to the development of taxonomy through plant descriptions and illustrations. These
two hundred years are also branded as the Age of Herbals during which invention of movable type printing
and improvement in the science of navigation augmented the growth of knowledge about plants. Otto
Brunfels (1489-1534), Jerome Bock (1498-1554), [.eonhart Fucks (1526-1609). Methius de I"obel (1515-
1568), John Gerard (1545-1612) and few othcrs are among the herbalists of this age who woild be ever
remembered for their work on medicinal plants-their use and characterization.

It is from the sixteenth and seventeenth century onwards that the science of botany started dev eloptng as an
independent discipline. Since taxonomy is basic to all other branches of botany, in the initial stages botany
started developing through contributions in the area of taxonomy. There were attempts to study more and
more plants and more number of characters in order to arrive at a satisfactory classification

It was A. Caesalpino (1519-1603). an Italian botanist, to give a classification of plants based on deﬁmte
morphological features in his famous work de Plantis (1583). He had realized that the flowers and fruits arc
more reliable in classification than the habit. Further advancement in taxonomy emanated from the
endeavours of Jean Bauhin, Gaspar (Caspar) Bauhin. Jhon Ray, J.P de Tournefort and others Jhon Ray’s
Methodus Plantarum (1682) and Historia Plantarum (1686-1704) deserve special mention since he adopted
the principle that all the parts of the plants should be considered in classification, a principle now recognized
as the cornerstone of a natural system. Tournefort is credited for organization of 698 genera in his Elements
de Botanique (1694) many of which were validated by Linnaeus (eg. Betula, Castanea, Iagus Querces,
Alnus, Abutilon) , )

SEXUAL SYSTEM-A NEW APPROACH

" In 1694 Rudolf Jacob Camerarius experimentally proved sexuality in plants and set a tuining point in the
trend of plant classification It inspired Linnaeus to formulate a comprehensive artificial system based on
sexual characters, viz. androecial and gynoecial characters. Finding the inadequacy of Tournefort’s system.
(1694) he applied his own system in the second edition of Hortus Uplandicus (1732). This also served the
basis of his later publications such as Systenia Namrae (1735), Critica Botanica (1737a), Flora Lappotica
(1737b), Hortus Cliffortianus (1737¢) and Genera Plantarum (1737d), Species Plantarum (1753). tis
sexual system of.classification was very simple and convenient since only one or two characters had served
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* the basis for the same. Although it failed to show natural affinities of plants, the effort provided the idca for
preparation of artificial keys in modern Floras and Monographs. The most significant contribution of
Linnaeus to Botany was introduction of binomial system of plant nomenclature. The date 1¥ May 1753 has
been fixed up as the starting point of plant nomenclature. '

APPROACHES BASED ON NATURAL RELATIONSHIP

It was Michel Adans on (1727-1806), a French explorer to Africa, who rejected all artificial systems
including that of Linnaeus in favour of a natural system. He developed his own system in his book Families
des Plantes (1763). His system was a natural system of classification wherein he had given two postulates:
(i) in classification all characters should be of equal weight and (ii) taxa are to be based on correlation
between these attributes. Through these postulates he had sown the seeds of numerical taxonomy, whitch
took about 200 years to get translated into reality due to the efforts of Sokal and Sneath (1963).

The subsequent systems of classification were based on form-relationship. Genera Plantarum (1789) of A L
de Jussieu marked the beginning of a well-planned natural system and its date of publication is officially
recognized as the starting point for nomenclature of plant families. Jussieu’s system was further developed
by Augustin P. de Candolle (1778-1841) in his Theorie Elementaire de la Botanique (1813). It was this book
through which be introduced the term taxonomy as the theory of plant classification. His monumental work
entitled “Prodriumus Systematis Naturalis Regni Vegetabilis” was initiated in 1824 and he could live to see
its seven volumes getting published. Ten more volumes were published by others after his death. The lucky
choice of Ranalian group as the starting point in the linear sequence of the families had done much to
popularize the system (Davis and Haywood, 1963). '

In the immediate post-Linnacan. period classification of cryptogams remained almost unattended. In 1813 de
Candolle for the first time assembled all pteridophytes in a separate group prior to which Lycopodium was
classed as moss, Salvinia as a liverwort, cycads were kept with Ferns and Equisetum among conifers. The
first distinction between phanerogams and cryptogams was made by Brogniart (1825) and between
angiosperms and gymnosperms by Brown (1827) in his work entitled ‘Prodrumus Florae Novae
Hollandiae . Endlicher ( 1836-1850) divided the plant kingdom into thallophytes (algae, fungi and lichens)
and cromophytes (mosses, ferns and seed plants). The bryophytes were recognized by Braun (1859) and the
most scientific demarcation among different plant groups was schemed by Eichler (1883).

By the middle years of the 19" century, the philosophy of a natural system of plant classification was
thoroughly entrenched in the mind of botanists. The system of de candolle provided the basis to Bentham
and Hooker to prepare their Genera Plantarum (1862-1883) which is a very useful compendium of generic
descriptions arranged in a natural scheme. The generic descriptions therein were models of completeness
and precision. Their system achieved a lot of appreciation since the work was mostly based on the plant
specimens in the British and continental Herbaria and least on literature. Although the publication of Genera
Plantarum was later to that of Darwin’s Origin of Species it did not implement the doctrine of evolution and
remained pre-evolutionary in concept. Like all other pre-Darwinian systems reliance was laid on the dogma
that the species are special creations and therefore constant and immutable. ’

PHYLOGENETIC APPROACHES

Post-Darwinian systems were evolutionary in approach and can be arranged into two main groups according
to the. concept of the primitive angiospermous flower. The first view was proposed by Alexander Braun in
1859 in l?ss Flora der Provinz Bradenburg. This influenced his successor A W .Eicher (1883) in Berlin and
was modified by Adolf Engler in his Guide to Breslau Botanic Garden (1886) and fully elaborated in his
Syllabus der Pflaneznfamilien, the first edition of which appeared in 1892 and the latest i.e. the 12" edition




in 1964 after having been modified by Melchior. Engler in collaboration with karl Prantl, expanded tht?
system in die Naturlichen Pflanzenfamilien (1887-1915). This system covers the whole plant kingdom‘ancl
surpasses all other systems in its quantum of information. It has utilized information emanating fr_orn
embryology, morphology, = anatomy, geographical distribution and presented adequate illustration,
bibliography of pertinent literation and keys to identification. ' ,

The Englerian concept considers unisexual and naked flowers bornein separate aments or catkins as thg most
primitive state which have progressively becn elaborated into bisexual diplochlamydous flowers Bisexual
flowers were derived from a single cluster of male and female flowers held in the same inflorescence that
simulated a flower (pseudanthium), while the subtending perianth evolved later. .

The most primitive flowers were wind-pollinated like the cones of gymnosperms and were derived frgm a .
gymnospermous ancestor with unisexual strobilus bearing either micro-or mega-sporophylls. Melch}or’s .
tevision of Engler’s Syllabus (1964) involved profound changes and rearrangements Dicots were treated as
more primitive than monocots, various orders were splitted and families there in were rearranged
Nevertheless, the essence of the Englerian concept of primitive flowers is maintained in original form.

Englers concept received support from Wettstein (1901), Hayata (1921), Pulle (1938, 1950) Rendle (]9Q4.
1925, 1930, 1938) Skottsberg (1940) and others who had also framed their own systems keeping the axial
theme more or less similar. :

The non-Englerian concept is familiar as the Ranalian concept. The pioneer architect of this concept was
charles E. Bessey (1883) of the University of Nebraska whose final system of classification (191_5) fecexve’d
admiration from a number of taxonomists including Cronquist for strobilus bearing. in its axis
megasporophylls above and microsporophylls below. The lower sporophylls were transformed into sepals
and petals through sterilization. The primitive angiospermous flowers have many frec perjanth members;
numerous, free stamens and carpels arranged spirally on the long conspious thalamus. The nearest approach
to this type of floral organization is made by the extant Magnolia Arber and Parkin (1907) provided the
theoretical basis for this view. The angiosperms owe their origin ta sofar unknown gymnosperm relatefi to
the rare fossil Cycadeoidea dacotenisis, a Mesozoic plant of Bennettitales that had borne ‘anthostrobili’ in
the axis of cycad like leaves. '
A somewhat similar type phylogenetic system was received from Hans Hallier (1905, 1908, 1912) whose
independent  endeavour concerned an exhaustive survey of literature, herbarium specimens and
palacobotanical evidences. This system of classification, according to Takhtajan, was more synthetic and
had a deeper insight into the morphological evolution and phylogeny of angiosperms, arose .frory: an
unknown and extinct tribe of cycads that was related to Bennettitales and had affinities with Maratiales.
Monocots were thought to be evolved from an extinct dicot ancestral to Lardizabalaceae. o
Jhon Hutchinson (1926, 1934, 1959, 1964-67, 1973), a British botanist, proposed a system of cla;snﬁcatlon
resembling Bessey’s but differing in certain fundamental aspects. Hutchinson derived the flowing plants
from a hypothetical proangiosperm and divided them into three lines: the Monocotyleadons, Herbaceae
Dicoty-leadones and Lignosae Dicoty leadones. Monacots. were belived to arise from herbaceous Ran-ales.
The woody line (lignosae) was derived from the woody Magnoliales and Herbaceal from Ran-ales.

Although Hutchinson’s treatment of individual families and genera and especially th_at of the
monocotyleadons is excellent, creation of woody and herbaceous lines has resulted into alignment of
unrelated taxa and done much to detract from overall value of his work.

MODERN APPROACHES .
A number of taxonomists henceforth got involved in improving schemes of classification based on new
information from various sources. Date from palaeo botany, phytochemistry, ultra structure, numerical




taxonomy, serology etc. have helped in enriching taxonomy, solving many problems related 10
circumscription, phylogeny and evaluation of utilitarian aspects of plants. Some of the noteworthy
taxonomists and their contributions are discussed in the following. '

The philosophical tradition of Bessey and Halliers phylogenetic systems of classification had M‘?jlmpacl on
Armen Takhtajan (1954, 1958, 1966, 1969, 1980, 1987 and 1997) and Arthur Crongquist (1957, 1968, 1981
and 1988), R. Dahlgren (1975, 1980, 1983) and R.L.Thorne (1976, 1981, 1983, 1992, 2000). The system of
Takhtajan has similarity in fundamental aspects with that of Cronquist and so is the system of Dahlgren with
that of Thorne. An updated revision of classification of Dahlgren was published by his wife Gertrud
Dahlgren (1989). Takhtajan’s recent system of classification (1997) recognizes 11 subclasses of dicots and 6
of monocots. These are further subdivided into superorders, orders and families; 56 super orders, 175 orders
and 459 families have been put under dicots and 16 supcrorders, 58 orders and 133 families under monocots,
Arthun Cronguist on the other hand had recognized 6 and 5 subclasses of dicots and monocots respectively
Unlike Takhtajan, Conquest did not recognize superorders. The Dicots were directly divided into 64 orders
and 318 families, and monocots were divided into 19 orders and 65 families. Whereas Takhtajan attaches
more importance to cladistics Cronquist gives more importance to phenetic relationship in the placement of
varioys groups. ' _

The realignments in Dahlgren’s system (1987) are based on a large number of characteristics mainly
phytochemistry, ultra structure and embryology. It includes 25 super orders in dicots and 8 in monocots. The
diagram, which is a cross section of the phylogenetic tree passed across the top, is very useful for mappmg
character distribution in various groups which may go a long way in developing an ideal system of
classification. -

"R. F. Thorne’s system of classification (1992) was revised by him in 2000 after having realized that much
new information has become available about the classification of Angiospermae, especially in the currently
popular fields of cladistics, micro-morphological and molecular taxonomy. His recent efforts were aimed
towards bringing into light the up-to-date knowledge about monocots (2000a) and dicots (2000b). keeping
his philosophy essentially the same. Thorne retained Angiospermae as a class and had modified
considerably the subclasses of Cronquist and Takhtajan because of their polyphyletic nature. Thorne divided
angiosperms into ten, hopefully monophyletic subclasses, viz Mognoliidae, Ranunculidae, Caryophilidae,
Dilleniidae, Rosidae, Asteridae, Lamiidae under dicots and Liliidae, Alismatidae, and Commelinidae under
mMonocots.

PHENETIC APPROACHES :

New approaches started developing over the last few decades in search of greater objectivity for better
under-standing of taxonomy. One of such efforts is numerical taxonomy or phenetics, which has evolved
from availability and development of electronic computers in the late 1950s and in the 1960s (Sneath, 1957
a and b, Michener and Sokal, 1957; Sokal and Sneath, 1963). It involves numerical evaluation of the affinity
between taxonomic units and the: ordering of these units into taxa on the basis of their affinity. A number of
standard publications (Sokal and Sneath, 1963; Rohlf and Sokal 1965; Sucath and Sokal, 1973, Neff and
_ Marcus, 1980; Duncan and Baum, 1981; Gordon, 1981; Dunn and Everitt, 1982; Felsenstein, 1981, 1983,
Legendre and Legendre, 1983; McNeil, 1983) came out in succession till the early eightys, which have
provided useful taximetric techniques and shown their applications. The numerical methods in general are
not specifically sensitive to convergent evolution, sibling species or to isolating mechanisms




CLADISTIC APPROACHES

Another objective approach emanated in form of phylogenetic systematics due to the endeavors of
W Hennig (1966) which was termed cladistics by Mayr (1969) and developed by Nelson and Patnick (1981)
and Bremer and Wanntorp (1981). Since mid 1970s many botanists particularly those of USA started
working in this direction. An American botanist, W.H Wagner, working independently on Hawaian ferns
developed a cladistic method familiar as ground-plan divergence method. In principle cladistics attempts to
analyse phylogenetic data objectively very much like numerical taxonomy which analyses phenetic Qala
Cladistic methods are largely based on the principle of parsimony according to which the most likely
evolutionary route is the shortest hypothetical pathway of changes that explains the pattern under
observation Journals like Cladistics (since 1985), Advances in Cladistics (since 1981) are being published
and society called “Willi Hennig Society’ has been established. Though there is a claim of superiority of
principle and practices of cladistics, it needs much improvisation in the future.

BIOSYSTEMATIC APPROACHES

A new discipline of biology concemmg development of taxonomy in relation to population sampling and
experimental procedures emerged in form of Biosystematics, which was introduced, by Camp and Gilly in
1943. Biosystematics has been providing a rich source of understanding of taxa and reassessment of their
circumscription, interrelationship and classification on the basis of analysis of variation pattern and genetic
relationship

HISTORY OF BOTANICAL NOMENCLATURE

Although - Casper Bauhin (1923) introduced the concept of binomical nomenclature the credit for .
cstabhshmg, this system of naming a species goes to Corolus Linnacus. This system has been totally

followed in his book’ entitled “Species Plantarum” for which its date of publication ie. 1® May 1753 has

been officially recognized as the starting point of plant nomenclature. The early rules of this system were set

forth by Linnaeus in his Critica Botanica (1737). It was A.P. de Candolle (1813) who had given exp.hcn

instructions on nomenclatural procedures through his book Theorie Ililemeniaire de la_Botanigue. Th'c:

pioneer taxonomist to have prepared an Index of latin names of the then known plants was Steudel Hns

creation “Nomenclator Botanique” (1821) is still re:nembered today with gratitude and honour for having

taught us the importance of an Index for standardization of nomenclature and also for having given Ihe raw

materials for present day Indices.

The first organized effort for standardization of plant nomenclature was made by Alphonse de Candolle who

had given the leadcrshlp for holding the first International Botanical Congress at Paris in 1867. The rules

adopted therein is familiar as Paris Code. For not having been satisfied with the Paris code, Axverncan ~
Botanists adopted a separate Rochester Code (1892) which introduced the concept of types. The Paris code
was replaced by Vienna code (1905) which declared “Species Plantarum” of Lannaeus (1753) as ;he
starting point, rejected tautonyms and made Latin diagnosis essentia! for new species. Moreover, a list of
cconserved generic names (Nomina Generica Conservanda) was approved. Being dissatisfied with the
Vienna Code also, adherents to the Rochester code adopted the American code (1907) which rejected the list
of conserved names as well as the need for Latin diagnosis.

It was not until the 5* International Botanical Congress held at Cambridge (1930) that differences in
opinions were femoved and a truly International Code eyolved, accepting the type concept, rejecting the

tautonyms, making Latin diagnosis compulsory for concerned taxon in nomenclatural proposais and
approving conservation of fenenc names. The code is being reviewed periodically and amended m the
Botanical Congress. The 15" International Botanical Congress was held at Tokyo in 1993 and the 16 in St




Louis in 1999 Revision of the code is based on the realization that the system of nomenclature should be
simple. comprehensive and precise so that it proves useful to all in all theoretical as well as applied aspects

PHASES OF TAXONOMIC STUDIES
Taxonomic studies concerned with characterization and classification of living entities is accomplished
through the following phases. ' | _

I The pioneer or exploratory phase: This is the most important pre-requisite for taxonomic studies
since it is a natural science and is based on field survey or exploration. During field work the species
are identified at least provisionally.

Il The consolidation phase: The specimens procured from the field are brought to the Herbarium not

only for preservation but also for preparing their descriptions and confirming identification of cach

species in consultation with authentic herbarium specimens and literature. _
The first two phase are very much associated with preparation of Flora, Distributional Records,
Monographs, Reviews etc.

[Il The Biosystematic phase: This phase is concerned with indepth study of taxa based not only on the
above two phases but also on geographical variations and correlative ecological features, genetic

experiments, cytological observations, physiological features of samples representing populations of

a species. . ‘
1V. The Encyclopaedic phase: This is compilation and co-ordination of the above-mentioned phases.

The first two phases are mainly descriptive and based on gross morphological features as a result of

which these correspond to the “alpha” taxonomy and the last two phases dealing \fvith greater number
of data sources correspond to “omega” taxonomy of Turrill (1938). Thus, the distinction lies in the
depth ot knowledge (Davis and Heywood, 1963) v :

AIMS OF TAXONOMY
Taxonomy, which is mainly concerned with identification, nomenclature and classification, can be said to
have the following aims:
I to provide a standard procedure of identification,
to provide the basis for scientific communications about various aspects of plants and animals,
to classify on the basis of nature affinities of organisms as far as possible, '
to assemble the knowledge of plant recourses so as to implicate the same to our well-being,
to prepare an inventory of living organisms for use in flora, fauna or stock-taking of biodiversity and
to have provisions for imparting training to biology students and scholars so that they can develop
complementarity with the synthetic approaches of modern taxonomy.

o QLU I >N VLI §]

PROCEDURES OF TAXONOMY _ B
These -are three aspects of taxonomic procedure, viz. identification, nomenclature and classification This 18
basic to all disciplines of biological science and is concerned with study and description of variatons n
living organisms for which it necessitates through field observations and perfect morphological description

The thorough morphological description and the voucher specimen collected from field are used in
identification of the species for reference to the keys available in literature and matching with the auhentic

specimens preserved in Herbaria respectively. These conventional procedures are associated with cassical

taxonomy. _
Since taxonomy has undergone modernization through its synthetic approach, procedures 1o re'veal the
embryological, palynological features etc. of the species get concerned with charactenzation and
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classlﬁcation of plants and interpretation of their evolution.

BIOSYS’I‘EMATICS
Definition; - The systematics of llvmg orgamsms concerned with developmem of taxonomy through
establishment of variation pattem on the basis of populatlon sampling is knowh as. biosystematics,
Biosystematics has also been termed in various other ways, ‘viz. experimental taxonomy, modern taxonomy,
neosystematics; genenomy, genecology and soon. - : T
Variation - phenotypic plasticity . '
Biosystematics is concerned with the study and description of variations in the populatlons of lwmg
organisms. The variation is considered as the outcome of interaction of genes to a specific ecological
- conditions and & pnpulatlon is certain' to show certairi characters' that -can be correlated thh its habitat
characteristics. ~
-In biosystematics it is very essentlal to determme whether the variation is permanent or temporary ln the
“former case the variation results from genetic changes induced by the environment.
On the other hand if the variation in populations growing in dxﬂ'erent ecological conditions dlsappear when
grown together in the same habitat and environment the case is treated as phenotypic plasticity. In cases of
phenotypic plasticity the ecological isolation is so meager that these hardly lead to- genetic drift dnd
speciation. Such populations are termed ecads or cophene s and may be considered forerunrer of genetic
variations.
Principles-of biosystematics '
1. Biosystematics is largely concerned with cytogenetic and ecological aspects of taxonomy an ]
“involves studies in the field as well ‘as experimental gardens and laboratories. In broad terms it -
appears that bxosystematxcs covers in one hand the.neo- systematics taking into account’ genetlc and
evolutlonary nature of groups and the micro evolutlonary phenomena on the other hand.
2. Tt is based on' the concept of reproductlve isolation and genetic structure. of populatlons or blO{lC
units, :
3. It. relies upon- the descnptlve phase of” taxonomy and for delimitation of different categories it
incorporates evidences.from morphology and various- other sources as genetxcs ecology, physiology,
bxochemlstxy, embryology, palynology etc. "

Procedurés
' Biosystematic studies are performed in these steps e

1. Thorough sampling of the taxon and its populations: It involves field studies to identify populations

showing variation in correlation with their environment.. Voucher specimens ‘are collected for

. preservation and their propagules (seeds, rhizomes, tubers etc.) for cultivation in experimental
garden for further cytogenetic anatomxcal Palynological, chemical studies etc. The field observations
are very carefully recorded.

2. Herbatiom study: A preliminary knowledge about the range variations within a species can be
obtained from the study of the specxmens of each species preserved in herbaria. This would also
enable detection of discontinuities in population samples. The information drawn from herbarium
study cdn be correlated with other kinds of studies. The discontinuities are used to identify genetic

~ isolation and eventually delmntatxon of taxa. The observatxons have to be confirmed by expenmental
studies.

3. Hybridization: The ability of the different population systems to hybridize is studied by growing
(cultivating) their representatives in experimental garden under umform conditions. The next step




involves the study of vigour and fertility of the hybrids. This enables identification of genetic barrier
(reproductive isolation) developed between population systems. o -
4. Cytological study: The homology of chromosomes in the hybrids is determined on the basis of
observation on their behaviour during meiosis. _ g _ .
5. Compilation and categorization: The informatipn or data obtained from the above steps is compiled
*with data from comparative morphology and geographical distribution. After compilation, the data is
" used in assigning the population systems the respective biosystematic category. . :
6. Modern methods: Since genetic experiments in the experimental ‘garden. are time consuming and
* inconvenient, method for study of genetic relationship have started concerning semantides, i.e.
information containing molecules such as DNA-DNA hybridization,- DNA-RNA hybridization,
nucleotide sequencing, comparative protein sequencing, allozyme comparison, serology etc.

RELATION WITH TAXONOMY o _
Biosystematics, although a very young discipline, is essentially an expansion of classical taxonomy (Davis
“and Heywood, 1963). It still employs comparative morphology as a primary means of describing and -
defining taxa. For delimitation and discrimination .of taxa it uses genetic experiments and pays much
emphasis on responses of genetic structure of populations to different ecological conditions. Thus,
biosystematics has the potential to improvise, revise and enrich classical taxonomy and transform it into a
synthetic science. Biosystematics in general, has been of tremeridous help in (i) delimiting the natural biotic
units and (i) application of nomenclature to these units in such a way so that it conveys precise information
regarding their defined limits, relationships, variability and dynamic structure (Camp and Gilly, 1943).
However one should very carefully welcome biosystematics in the’ existing system of nomenclature.
Biosystematics can certainly prove: helpful in the understanding of interrelationship and interpreting
microevolution, - L : :

BIOSYSTEMATIC CATEGORIES : . o _

Biosystematics have developed certain categories for experimentally investigated biotic units. The most

widely accepted categories, in order of ascending phyletic value are ecotype, ecospecies, cenospecies and

comparium. R o T o :

" Ecotype: It is the unit in biosystematics adapted to a particular environment but capable of producing fully .

 fertile hybrids with other related ecotypes. Such ecotypes are inseparable by genetic barriers, although they
develop certain variations in correlation with their environments. L :

* Ecospecies: A group formed by association of one or more ecotypes, which are able to exchange their genes
without ¢xtending detriment to the offsprings. Related ecospecies, ‘on hybridization usually. produce sterile
F, hybrids. Thus such ecospecies are separated by ecological barrier in one hand and partial genetic barrier
‘precluding free exchange of genes on the other. _ ‘ '
Cenospecies: A group formed by uniting one or more ecospecies of common evolutionary .origin. Related
cenospecieses rarely produce sterile hybrids. Thus genetic barrier between related .cenospecies is complete.
Comparium: A group formed by similar cenospecies that do not cross or hybridize. :

BOTANIC GARDENS AND HERBARIA .

Gardens which are specifically designed and sustained to sponsor acadeémic as well as beneficial aspects of
plants are categorized as botanical gardens. The first garden for the purpose of science and educationt was
maintained by Theophrastus in Lyceum, Athens, probably bequeathed to him by his teacher, Aristotle.
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Credit for establishing a full-fledged botanical garden goes to Luca Ghini (1490-1556) who developed ut at
Pisa in Italy in 1544 This was followed by establishment of such gardens at Padua and Florence of.haly in
1545 At present there are thousands of botanic gardens allover the world and are looked aﬁer_ by qxfferenx
institutions. Of these about 800 gardens are documented in the International Directery of. Botanical Gardens
A botanical garden today is a green area maintained by an organization for growing various types of plants
so as to fulfill aesthetic, conservational, educational, recreational, utilitarian and various scientific purposes.
Although botanical gardens house plant species which the climate of the area can support, there are many
gardens which have controiled systems to sustain species collected from different phytoggographxcal gnd
eco-climatic regions. Glasshouses in temperate regions provide adequate warmth to sub-tropical and tropncal'
species through what is known as manipulated green house effects. Similarly in tropical gardens, specxa”y
cooled indoor growing houses are maintained for sustaining cold loving plants. .

Botanical gardens have always been the major source of inspiration as well as informagon to many
taxonomists to develop systems of classification almost since the time of Theophrastus, Linnacus while
working at Uppsala and Bernard de Jussieu at Versailles created the then the most rational artificial and
natural systems of classification respectively.

Botanical gardens play the following important roles: .

I Aesthetic value- The plants of a botanical garden always induce aesthetic pleasure, e.g. the Great
Banyan Tree in the Indian Botanical Garden, Sibpur. .

2. Supply of material/specimens for botanical research. _

3. Imparts training and teaching to general people, students and scholars about taxonomy, economic
botany and ecology. :

4. ‘Supports research projects . o

5. Conservation of threatened species: Botanical gardens are important in conserving genetic diversity
in general and endangered species ‘in particular (ex situ conservation). The proceedings of tbc
Symposium on Threatened and Endangered species, sponsored by New York Botanical Garden in
1976 (“Extinction is forever”) and the conference on the practical role of botanical gardens in
conservation of rare and threatened species sponsored by the Royal Botanical Gardens, Kc'w
(“Survival and Extinction”) have brought to our knowledge the role of botanical gardens in
conservation. )

6. Seed Bank: Most of the botanical gardens act as Seed Banks and more then 500 botanical gardens of
the world operate seed exchange programmes, offer annual lists of available species and freely
exchangeable seed:s.

7. Academic Institution and Documentation centres: Most of the botanical gardens have a linkage with
a herbarium and library and collectively play very important academic role. . S ]

8. Public Services: Botanical gardens provide information to the general public on identification of -
rative and exotic species, methods of propagation and also planting material through sale or
exchange. ’ .

9 Ecological role: Botanical gardens optimize the environmental state even of the nearby cities or
townships and act very much as the human lungs to refresh the air. ) _

10. Introduction of Germ-plasm: Germplasm of many economic plants are introduced from oth.er
countries and the spécies are initially acclimatized prior to their spread within the country for
cultivation,
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Some of the world famous botanical gardens are enumerated in the following
Botanic Garden of Padua, Padua, Italy (1545)

Botanic Garden of Heidelberg, University of Heidelberg, Germany (1593)
National Museum of Natural History, Paris, France (1635)

Botanical Garden and Museum, Berlin, Germany (1646)

Royal Botanic Garden, Edinburgh, Scotland (1670)

Botanic Garden of the Academy of science, Leningrad, Russia (1712)
University Botanic Gardens, Cambridge, England (1762)

Indian Botanic Garden, Howrah, India (1787)

. Botanic Garden of Harvard University, Cambridge, Mass., USA (1807)
10 Botanic Gardens, Munich, Germany. (1809) '

11. Royal Botanic Garden, Kew, England (1841) .

12. Missouri Botanical Garden, St. Louis, Mo., USA (1859)

13. Amold Arboretum of Harvard University, Jamaica Plains, Mass., USA (1872)
14. The New York Botanical Garden, New York, USA (1890)

15 Montreal Botanic Garden, Montreal, Canada (1936)

R e

HERBARIUM . )

The herbarium is a repository of plant specimens arranged in the sequence of a standard natural system of
classification. According to Fosberg (1946) herbarium is a great filing system for information about plants,
both primarily in form of actual specimens of the plants and secondarily in form of published information,
pictures and recorded notes. , o
Herbaria are integrated with academic institutions, Botanical gardens, Research institutions. scientific
societies etc. .

The Index Herbariorum Part I includes the names of all Herbaria of distinction and Part If of the same
publication includes the name of reputed plant collectors and present location of their specimens. Some of
the world famous herbaria are listed below with the respective acronyms within brackets

Royal Botanic Garden, Kew (K) A

V. L. Komarov Botanical Institute, Leningrad (LE)

Museum National d'Histoire Naturelle, Paris (P)

British Museum (Natural History), London (BM)

Central National Herbarium, Sibpur, Howrah, India (CAL)

Harvard University, Cambridge, USA (A+FH+GH)

Some of the famous herbaria in India besides CAL are mentioned in the following.
Herbarium of the Industrial Section at the Indian Museum, Calcutta
National Botanical Garden, Lucknow

Blatter Herbarium, Bombay

Eastern Circle Herbarium, BSI, Shillong

Western Circle Herbarium, BSI, Pune

Southern Circle Herbarium, BSI, Coimbatore

Herbarium of the Forest Research Institute Dehra Dun

Northern Circle Herbarium, BSI, Dehra Dun

Central Circle Herbarium, BSI, Allahabad

Nl N RV RS S
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Impontance of Herbarium in taxonomic studies

!
2

Model

st

Herbaria present pictures of local, regional and world flora through preserved plant specimens. '

It serves as the chief basis for taxonomic researches aiming towards preparation of Reviews,
Monographs, Flora, Manual etc.

Since herbaria are repository of type specimens critical nomenclatural reassignment can be made.

[t is concerned with time-based documentation of local flora ' .

The students section of Herbarium as well as the entire Herbarium is useful in imparting training to
students of plant sciences, forest officers, conservators and others interested in plaqt sciences, _
Herbaria not only serves taxonomists but also the economic botanists, ethnobotanists, morphologists,
geneticists etc. , ‘ ’
Herbaria are concerned with the identification of specimens submitted to them in one hand and by
giving authentic specimens on loan, , ' o
Herbaria are always associated with Libraries enriched with different types of taxonomic literature
including pictorial atlas, albums, field notes and records, icons, encyclopaedia, documentary
microfilms etc. As such Herbaria are research institutions which are well organized to augment
different types of botanical research and academic accomplishment.

uestions;

Answer the following (of one mark each)

SOENS LA —

B oo bt et et bt oo e e
O O I h D W N —

What is Flora?

What is ICBN?

Who was the author of the book “de Materia Medica”?

Who proved sexuality in plants and when?

Who introduced the term taxonomy to plant sciences?

Define phenetics.

Define cladistics. :

What was the name of the book written by Bentham and Hooker?
Name any book of Englar & Prantl.

- What is a Herbal?
. Define ecotype. : . .
- Mention the name of any internationally famous botanical garden of India with its locations,

Which date is officially declared as the starting point of plant nomenclature?

- Name one famous-botanical garden outside [ndia and mention its l'ocation.
- Name one internationally famous Herbarium and mention its location.

- What is alpha taxonomy?

- What is omega taxonomy?

. What is Paris Code?

- What is meant by ‘ex-situ’ conservation?

What 1s meant by ‘age of herbals’?
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Questions of 2 marks each
Distinguish between systematics and taxonomy
What were the postulates given by Michel Adanson? ,
Mention the characters of the most primitive angiosperm flower according to Engler.
What is Biosystematics? Why is it often termed genecology?
_ Which International Botanical Congress was for the first time truly international? Where was it held’
Distinguish between the terms phenetics and cladistics.
Why is numerical taxonomy called neo-Adansonian classification?
What are the contents of ICBN?
How. many subclasses of dicots and monocots were recognized by Takhtajan (1997) and Thorne
(2000) '
10. Name two journals on cladistics.

R R R

Questions of 5 marks each
1. Write notes on:
a) Nomenclature
b) Classification
c) Principles of biosystematics
d) Biosystematic categories
e) Taxonomic procedure
What is taxonomy? State its aims.
. Explain phenotypic plasticity.
Elucidate the relationship of biosystematics with taxonomy.
Explaih the Ranalian concept of primitive flowers.

wnoA W

Questions of 10 mark cach:
1. What is biosystematics? Discuss different steps to such studies.
What is Herbarium? Discuss its importance in taxonomic studies.
What is Botanical Garden? Discuss its importance / functions.
Discuss in brief history of botanical nomenclature.
Prepare a concise account on phylogenetic, phenetic, cladistic and biosystematic approaches

SRR
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‘M.Sc. Botany
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 NUMERICAL TAXONOMY

* Organisms are classified on the evidence obtained from their characters, therefore, it becomes
necessary to employ all the characters for the ideal or a natural classification. But since each individual
may possess thousands of characters, it becomes impracticable to use all characters and as Mayr bhas remarked,
the nurhber is limited by the patience of the investigator. This naturally leads to the problem of selection of
suitable characters. ‘ |

Taxonomists such as Bentham and Hooker, Engler and Prantl, Tippo, Hutchinson and othgrs have
employed mo‘rphdlogical and dnatomical characters their major source of evidence while- more recent
‘workers including Takhtajan, Cronquist, Thorne, Dahlgren and others have based their classiﬁca’tio‘ns on
relatively largé' number of attributes. I is for this reason that most of these later classifications have gained
a wider acceptance. They are more natural.

The uée of as any characters as possible, or i‘d_éally, ail the characters for classification Wa_s._pfopos‘cd _

by Adanson (1963) and such classifications are called Adansonian classifications. The two important

postulates are: (i) in constructing the classification each attribute selected is of equal weight and (i{) tax are
based on correlations betweeh tﬁeg.e.‘ attributes. ' : :  4

The Adansonian principies have received great support since the 1960s and have developed new
methods in taxonomy included under a general term uumerical taxonomy. It involves the: 9umeri¢81
evaluation of the affinity or sitmlarity Hetween taxonomic units and the ordering of these units into taxﬁ on
. the bases of affinities. This is essentially an extension of the Adansonian classification using mathematical
procedure with the primary aims of repeatability and objectivity (Davis and Heywood, 1963). There are
two aspects of such procedures — thé construction of taxonomic groups and discrifination.
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Construction of Taxonomic Groups

In the past, tax(momtc groups were constructed using characters by some form of wcxghtmg -
_physiological importance of character in the pre-Adansonian taxonomy and phylogenetic importance in
the post— Darwinian period or intuitive corre!atxon wcxghtmg In angiospers, due to the absence of reliable
fossil evidence, phylogenetic weighting becomes largely negative. Phenetic classification, on the other
hand, is based on overall affinity as judged by using as inany characters or as much evidence as is available.
In practice it employes correlation weighting by mechanical methods of comparison. Various tcchmques '
are involved and newer ones are being incorporated (Sokal and Sneath, 1963; Estabrok and Rogers, 1965;
Rohlf, 1965; Rohif and Sokal 1965; Bonner, 1964; Crawitrd and Wishart, 1967 and many othcrs) The

successive steps iecogmsed by Sneath (1 962) are :- -

1. Openmonal Taxonomic Units (OTUs)

The fundamental unit that can logically.- be classified by numerical methods is the individual
- orgamsm But generally it is not possible to use numerous individuals of the samc species of each of
~ several taxonomic groups to compute a ..lassxﬁcatxon Furthcr such a study would reveal resemblance’s at
the intraspecific ievel and usually would not offer much scope: for higher levels. It is, therefore, customary
to employ species as a unit for this purpose. Smcc the taxonomic units employed in numerical methods are
not always comp&rﬁ'clc to formal taxonomic units, they are termed as operatmnal taxonomic units (OTUs)

lf a numerical taxonomlc study of higher categones is to be undertaken, a hngher taxon whiclr
represemts a cluster of various polymorphxc tax should be employed as the OTU. Another solution is to use
only a single represcntatnve of the polymorphic group.

2. Unit Characters

A .unit character has been deﬁned as a taxonomic character of two or more states, which within
the study at hand cznnot be subdivided logically, except for subdivision brought about by changes in
- the method of coding (Sokal and Sneath, 1963). Further, only the phenotyplc characters are used for this
~ basic mformatlon Thus, the presence or absence of an awn in a-grass spikelet may be a unit character. The
: 'Orgamsaﬁonanevel for unit characters may differ from character to character. But as a rule, each character
state should ccnmbute one new item of information.

- The proper sefection of charactas is a critical peint in the apphcatxon of numencal taxonomy, as it’
is in other disciplines of taxonomy. Certain characters are clearly disqualified for numerical taxonomy and
these are listed by Sokal and Sneath (1963) as inadmissble characters. According to these authors,, it %
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undesirable to use : (i) attributes which are not a reflection of the grenotypes of the organisms themselves;
(i1) any property which is a logical consequence of another, exther partly or wholly; and (m) characters

which do not vary within the entire sample of orgamsms

A large number of characters at least more than 50, must be selected. Several hundreds will be more:
. significant but too few characters are not reliable. These characters have then to be coded or given some
symbol or mark. '

(a)  Two —state coding : This is the sitnplest form of coding where characters are divided into + and ~
or as | and 0. The positive characters are recorded as + or as 1 and negative characters as — oras 0.
In case the organ possessing a given characters is missing in an organism. the character must be
scored NC. In other words, the symbol NC means “no comparison”. :

(b)  Multi-state coding: The multi-state characters may be either quantitative or qualitative. Quantitative
characters can each be expressed by a single numerical value, e.g. amount of pubescence on a leaf. -
Such characters can be coded into number of states (1,2,3 ...) comrespanding to their range of
variation. Quantitative multi-state characters cannot be arranged in some order, and no reliable
sequence can be established. In such cases, qualitative characters are conveniently converted into
seme new characters. Many a times, it is convenient to convert multi-state okaracters into two-state
characters. In additive coding, for example, multiple characters with four states could be coded as

Two state characters

1 2 3
Maultiple states | 0- . - |
1+ - ’ -
2+ + +
3+ + | +

In this way, a multistate character of n states is tumed into n-1 two-state characters. The obtained by
scoring the characters in OTUs are then arranged in a table in a matrix form as above and cempared.

3. Measuvement of Resemblance

There have been three methods devised so far for estimating phenetic resemblance between the
taxonomic groups, namely (i) co-sfficients of association; (ii) co-efficients of correlation: and (i m) measures
of taxonomic distarce using the convcrmon of multidimenstional spate with the dimension for each
characters.
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4, Cluster Analysis

a taxonomic system can be constructed from the resemblances among the OTUs. To form taxa

different OTUs are grouped together on the basis of affinities found by measurcment of resemblances.

These group of OTUs are termed clusters.

Clustering is achieved in two ways : (i) by employing the attributes one at a time- monothetic
systems or (i) according to all their attributes considered similtancously. The monothetic method obviously
leads to artificial clustering while the second method gives a natural grouping. One cluster or a group is
separated from the other by the dividing line which indicates a distinct gap between the two. It is often easy
to separate categories of higher rank, i.e. above the genus level, clearly. In case of intraspecific clusters.

there are ofter: few discontinuties.

There are several techniques to describe structure'in matrices of similarity co-efficient. One of the
comumon techniques is the differential shading of the similarity matrix. In this method, similarity co-
efficients ar: grouped into five to ten evenly spaced classes. Each of thesc classes are represented by
different degrees of shading in the squares of half matrix. The hxghest value is generally shown darkest and
the lowest value lightest, as in the following Figure. Then the half matrix can be seen as a pattern 10
different shades, limited by a diagona! of squares with the darkest shade. Thus, on rearrangement of the
sequence of OTUs, clusters can be more sharply defined. as in the Figure below.

Percenl OTUs A B € D -E Otlus A D C E B

Similarity
100 A A
9 9% B D
80 80 C C
70, 7014 D E
psnsy
60 - 60 E it B
a b c

FIG. :- Shaded similarity matrices : (a) percentage similarity, (b) with the OTU!
arranged haphazardly. (c) after rearrangement of OTU s.

The groups of related OTUs based on high similarity coefficients can be analysed by a large numb:
of numerical techniques such as elementary cluster analysxs, clustering by single, complete or average

linkage, central or nodal clustering and so on.

The groups of similar organisms recognised in this manner are termed phenons. The clusters ol
phenons are then rearranged in a dendrogram which summarises the main features of the cluster analysis.
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5. Phenons and Rank =~

* The groups or ciusters established by numerical methods may be equivalent with those of classical -
taxonomic methods, i.e. usual rank categories such as.genus, tnbe or. family. But these terms have
evolutionary and nomenclatural background, If this is to be avoided, Sokal and Sneath(l 962) have provided
a new expression — phenons. Their jevel of affinity i is indicated by prefacmg them with a number. A group
affiliated at 80 and above in the similarity scale may Lhus be tcrmed 80-phenon. In ﬁgm'es, clusters with

different shade indicate 60 to 90 phenons. These terms are intended to cover the | groups produced by any
| form of clustet: anaiysxs or from any form of similarity co-efficients. Although phenons may be equnvalent
to various taxonomic groups the term “phenon” is not synonymous with “taxon”.

" The delimitation of: phenons is done by drawing a hro'_:wntal line across the dendrogram at a sumlanty _
value. A line at 75%, for example, creates five 75-phenonss 11, 7, 3,5, 6, 4 9,10 and 2, 8; while that a
80% creates six 80-pehnons. Such a denodogram will have a reference to a given taxon and cannot be '
. transferred to any other study. In the following dendogram ifOTUs ! to'10 had been specxes an ‘80-phenon
line could indicate 6 subgenera and 65~pehnon lme two generd. It should however be remembercd that-
-phenons are arbxtrary and relatnve groups

a7 ,3_5 6_,_‘4"910 28
e l' L l e ,
—g 80 : - _80% Phenon line
70}~ '
f e o we e amm e e —'—— —— - """"“‘" 65% " "
60 -

#16. Dendrogram (o show formation of phenons.

. Discrimination

If taxonomic groups chosen for the study show: overlapping of characters, discrimination should be
used to select them, Vanous te»hmques such as discriminant analysis, have been devised for such purposes.
The best methods for delum’(mg tax are based on the utilisation of maximum number of charactérs with-
similar weightage giv'eh to them. |

Nowenclature and Numerical Taxonomy

Modern nomenclature does not concern itself with the problems of delimitation of taxa. Jt serves
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onlyasa reference pomt toﬂleuxmomlc nisthves. The limits are debatable, subjective and forever chan geable.
Numerical taxonomy, on the other hand, is very useful in delimitation of taxa by exact estimation of
affinities (although phenetic). Thus, there is-no scope for.“personal opinion™. ’.or “declslon of taxonormsts
The limits may be: oqectxve, utxhtanan, permanent and fixed by common conscnt

Applxcatlons of Numencal Taxonomy ‘

The taxonomists who are mterested in the study. of sxmzlarmes and differences are now using
numerical methods on an mcreasmg scale. There has. been consxderable work on bactena, other micro-
| organisms and several animal groups, using numerical methods. However, it apphcatxon in plant taxonomy
has not been comparable to that in other groups: From angiosperms, genera such as Oryza (Morishima and
Oka, 1961), Solanum (Soria and Helser, 1961), Sarcostemma (Johnson and Holm, 1968) and other groups
mcludmg Farinosae of Engler (Hamann 1961) and a few others have been tried by numencal taxonomy
‘for their delimitation. The results, in general have been in conformity with the earlier works based on
- classical methods. It is only in certain taxa (Fannosae~Hamann, 1961) that the earlier assemblages have
been shown to be unnatural. Numerical taxonomic studies on the genus Onoms (Papilionaceae) by Cook -
(1969) are in conﬁrmatxon with the system proposed eatlier by Sujaev (1932).

In genetal the results achieved so far by numetical taxonomy, have not been appreciably different
fromi those achwved by others methods. It is probably because the methods employed need much
improvement. A colloqumm held at andrew’s University, Scotland in 1968 brough out several modifications
in methods, and since then many have attempted to rcclass1fy a number of plant tax abut w1thout any
apprecxable deviation from the formal taxonomic classification. '

, Ments and Demerm of Apphcatlon of Numencal Methods

. ' According to Davis and Heywood (1963), it would be better to wclcome these proccdurcs with
caution, since these methods are only an extension of the orthodox procedures. Thc) have raxacd some
doubts. First, the methods will clearly be useful in phenetic.— classifications, not ph) lepenetic. Sxmllaﬂ) '
the pmponents of “bnologxcal” species concetp, may nnto accept the specific limits bound by thése methods.
Even the practxcmg taxonomist might use his brain more eﬁicxently than the machine which is fed with
non~relevant selection of characters. Character selection is the weak link in this approach. The statistical
methods are likely to give ess satisfactory. solution of characters chosen for comparison are inadequate.

_ Stearn (1968) indicated that different taxonometr{o procedures may ,)'iold'diﬁ'erent results. A zﬁajor
difficulty for the beginner is to choose a procedure for his pi;rpose. Another difficulty concerns the number

- 20



of characters (from 40-100) needed in order to obtain satisfactory results by these mechanical sids.
Taxonomsts usually manage with far less characters. Further, so far it has not been seen that the results
achieved by mechanxcal means are in any way more acceptable than those visualised by practicing
taxonomists. It is desriable to ascertain whether a large number of characters wouldtreally give satisfactory
results than those using a smaller number. Steam (1964), after applying taxonometric procedures to the
Jamaican species of Columnea and 4 Iloplestus (Gesneriaceae), came to realise that it seemed a pity not to
make further use of these. This survey, as Stearn (1968) has concluded, demonstrated the capacity of
computer-aided taxonometric methods to build from an asscmblagc of characters a grouping of spocies
comparable in validity to one made by conscious taxonomic effort. It also indicated that the number of
characters used is less important than their range.’

Johnson and Holin (1968), after analysmg their data on the genus Saccostemma (Asclepisdaceac)
by various taxenometric methods, have concluded that the numerical classification based on corrc!ahon
coefliciont bears closer resemblance to the classical taxonomic classification. However; they cxpressed
 their view that tharough analysis of character sets will lead to a better understanding a process of evolution
and the role of envirofiment in determining jmttems of variation.

Date (1968), while presenting the basic procedures which underline numerical t.axonomiclmcthods,
concluded that any taxonomist proposing to use such methods must be careful in his choice and be wary of
what raay seem to be unimportant details.

Cullen (1968), while reviewing the botanical p;'oblems of numerical taxonomy, extended his welcome
to the advance of numerical techniques which, according to him, may well provide means of checkmg and
improving classifications by orthodox taxonomists. He has aiso realised that the numerical classifications
are not likely to supplant orthodox ones — they may either conforms them or, if very different, exists side by
side with then.

Clifford (1970) seems tc have used numerisal methods for a bctter‘c}assiﬁcatiion of the grasses and
ov:d \led trat there is a greater probability of their evoiution from the palms. This conclusion was also
drawn by Meeuse ( 1966) on the basis of the ovatian structure and origin. In both palms and grasses, the
ovay has an ecarpellate vrigin, with greater reduction in the grasses than the palms. Comer (1966) also has
inds. sted that the embryos of A=haitcphoenix possesses a coleorrhiza as in grasses, a feature otherwise

unknown in palms.
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QUESTIONS
' Define Nﬁmerical Taxonomy. D,escri.bed} brioﬂy,‘thegoucc'essive steps as~recognised by Sneath (1962)

for undertaking such studies. Cotﬁxﬁeot on the merits and demerits of Numiérical Toxonomy.
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~ STUDY OF CLASSIFICATION

Taxonomy is the study and description of the variation of organsms. the Investigation of the causes and the
maniipulation of the data obtained to produce a system classxﬁcatxon Thus classxﬁcatxon is the most nmportam
integer of T: axodemy and itg history dates back to the dawn of plant science. '
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Classxhcatron is a process in one hand and object or end product on the other. As a process it is the
production of a logical system of categories each containing a certain number of organisms which allows
easier reference to the components i.e. kinds of organisms. As an object classification is that system itself
of which there are many sorts (Stace, 1989;. in simpler terms classifi cation can be defined as the ordering
of organisms into groups and- arranging these groups in a system of hierarchy so that it can serve as a
mformatron storage as well asa retrreval system.

~ There has been an mherent tendency in man to 1dent1fy and study plants almost since the dawn of
civilisation since plants have been meeting various necessities of his life. The rich botanical literature
authored by Chinese, Assyrians, Aztecs, Egyptians and Indians long before the Christian era have been
discovered. One of the earliest of these is attributed to the legendary emperor aof China-Shen nong who is
' reputed to have Jived about 3600 years before the Christian era. Another botanical literature entitled Cheng
lei pen tsao presented by Tang Shen Wexg earned a lot of popularity. The well- known Atharva Veda, written -
in the Vedic age i.e, around 2000B.C.isa treasure house of infoymation on medicinal plants and their uses,
Vnkshayurveda’ is another book of ancient India in which the author Parashara propounded 4 system of
classrﬁcatlon based on comparative morphology of plants besides giving an account of external morphology.
nature and properties of soil, 14 forest types in India, intemal structute of leaves etc. A large number of
families (Ganas) were so clearly defined that they are even recognisable today (Majumdar. 1927. 1946).
These gems. of botanical literature are poorly known in the West and the work in Greek and Latin are
‘considered to have laid the foundation of botany.

Classlﬁcatlons Based on Hablt '

’Iheophrastus (ca. 370~285 B .) was the greatest botanical writer of classical antrquxty and he is
regarded as the intellectual grandfather of moder botany (Greene, 1909). The wrtitings of Theophrastus on
which a large quantum of his reputation rests include ‘Enquiry into plants’ and ‘Historia Plantarum’. He
classified plants on the basis of their habit intc t-ees, shrubs, undershrubs, herbs; dmtmgurshed between
centrxpe(al (racemose) and centrifugal (cymose) mﬂorescence superior and inferior ovary and polypetalous
‘and gamopetalous corolla. :

A some what srmrlar classxﬁcatron was givén by ley, the Elder (Caius Plinius Secundus) in ¢ Hrstorm
Naturalis* (77 A.D.). Pedanios Dioscorides, a contemporary of Pliny gave information about 600 species
of plants together with their medicinal use in a took entitled ‘dre Materia Medlca inl A. D that served the
need for the next 1500 years. o

The tleusand‘ years or 80 from the decline of Rome or.the Rensissance ws a period when fittle
academic accomplxshment was there i in Europe. In such an era of general ignorance Albert Magnus was the
‘best naturalist who became popular as the ‘Aristotle of the Middle Ages’. His classification (1193-1280)
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recognised moocot and dlcot plants as Comcatae and Tunicatae respecnvely His’de Vegetabilis’ was widely
used for the next 200 years.

Age of herbals

With the advent of Renaissance the cultural and intellectual fabrxc of the West altered. There wasa
great quest for knowledge as a.consequence of which fifteenth and sixteenth century botany experienced a
general awakening in the field of medicine and plant characterisation in form of illustration and description.
Many world famous ‘Herbals’ appeared during these two centuries which earned fame as the ‘Age of
Herbals'. Invention of movable type printing in 1940in Europe afforded compilation of books on medicinal
plants (Herbals). The then devclopment in navigation technology facilitated exploration 4nd concomitant
expansion of botanical knowledge. Note worthy contributions, though indirect, were received from herbalists
like Jerome Bock, Otto Brunfels, Leonhust Fuchs, P. Mathiola, Carolus Clusius. Methias de 1’obel, John
Gerared and many others whose intentions were to prove the novelty and superiority of their respective
Herbals over others, However, the classxﬁcanous des:gned by them had very little systematlc basis.

_ Pilrely Botanicil Approaches
From the sixteenth and seventeenth century onwards the botanists switched over from the utilitarian
approach to that of a scientific one It wag Andraea Caesalpino ( 1512-1603), an Italian botanist, to give a -

classification of pla.nts based on definite morphological features in his famous work de Plantis (1583). He
had realised that the flowers and fruits are more reliable in classification than the habit. Further advancement
in taxonomy emanated from the endeavours of Jean Bauhin, Gaspard (Caspar) Bauhin, John Ray, J.P. de
* Tournefort and others. John Ray’s Methodw Planmrum (1682) and Historia Pflantarum (1686-1704) deserve
5pecp\l mention since he adopted a pnncxple that all parts of the plants should be considered in classification
-4 pnncxple now recegnised as the comet-stone ofa natural system. Tourefort is credited for orgmnsatxon _
of 698 genera in his Elaments de Botamque (1694) many of which were vahdated by Linnaeus (e.g. Betula,
Castanea, Fagus Quercus, Ulniis, Abutilon).

Use of Sei:nal Characters in Classif_i;:é.tion

The systems of classification framed since Theophrastus till the end of the seventeenth céntury
were artificial based mainly on-hébit of plants. In 1694 Rudolf Jacob Camerarius experimentally proved
sexuality in'plants and set a turning point in the trend of plant classification. It inspired Linnaeus to formulate’
a comprehensive artificial 'éystém based on sexual characters viz. androecial and gynoecial characters.
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Finding the inadequacy of Toumefort s system (1694) he appled his own system in the second edition of
Hortus Uplandicus (1732). This also served the basis of his later publications such as Systema Naturae
(1735), Critica Botanica (1737a), Flora Lapponica (1737b), Bortus Cly‘fortzanus (1737c) and Genera
Plantarum(l737d), Spec:es 'Plantarum(1753). His sexual system of classrﬁcatron was very simple and
~ convenient since only one or two characters had served the basis for the same. Although it failed to show
natural affinities of plants, the effort provided the idea for preparation of artificial keys in modern Floras
and Monographs ‘The most significant contrxbutton of innaeus to Botany was mtroductron of binomial
system of plant nomenclature The dta 1* May 1753 has been fixed up as the startmg point of plant

nomenclature.

Natural System of Classrficatxon

The madequacy of Linnaean svstem was realised as soon as botanists started accumulating plant

wealth from d;ﬁ'emnt parts of the world. Michel Adanson (1727-1806), a French explorer to Africa, rejected
-aMl artificial systems meludmg that of Linnaeus infavour of a natural system. He developed his own system
" in Familles des Plantes (1763) whrch is remembered for the use of as many characters as possible and two
postulates : (I) in constructing classification each attribute selected is of equal werght and (u) taxa are based

on correlation between these attributes. Through his'-work he had sown the seeds of phenetrc system which

after spendms dormaney period of 200 years germinated i into numencal taxonomy mainly due to the efforts

of Sokal and Sneath (1963) Hxstonans or Scrence note that Adanson foreshadowed ‘what is now called

phenetlc taxonomy P _

The subsequent systems of classification were based on form-relatxonshrp and attempted to express
natural relationship among taxa. Genera Plantarum (1989) of A L., de Jussiue marked the beginning ofa
well planned natural system and is still honoured for perfection in organisation of may orders (=modem
- families) and ifs year of publication i.e. 1789 is marked out as the starting point for nomenclature of plant

families. Jussieu’s system was further developed by augustin pyrame de Candolle. 1778-1841) in his Theorie
Elementaire de la Botanique (1813). He is remembered for introducing the term ‘Taxoniomy’ as the theory
-of plant classrﬁcatron He was the pioneer in organising pteriodophytes as a separate group, although
erroneously as a co-ordinate group with monocles. His monumental work entitled ¢ Predrumus Systemnatis
Naturalis Regni Vegetabilis was initiated in 1824 and he could live to see only its seven volumes getting
. pubhshed Ten more volumes were published by others after his death. The lucky choice of Ranalian group

as the starting por'ht in the linear sequence of the families had done much to populanse the system (Davis
and Heywood, 1963) ' s

: . In the immediate post-Linnean period classrﬁea(ron of Cryptogams remained almost. unattepded
1n 1813 de Candolle for the first time assembled all pteriodophytes in a separate group pnor to whrch



Lycopodium was classed as a moss, Salvinia as a liverwort, cycaos were kept with Ferns and Equisetum
among conifers. The first distinction between phanerogams and cryptoganus was made by Brongniart. (1825)
and between angiosperms and gymnosperms by Brown 1827) in his work egtitled ‘Prodrumus Fiorae
* Novae Hollandiae’. Endlicher (1836-1850) divided the plant kingdom into Thallophytes (algae, fungiand
licherns) and Cormophytes (mosses, lfe_ms and seed .plants).‘ The bryophytes were recogxliéed by Braun
(1859) and the most scientific demarcation among diﬂ'erent’plant groups was -sehemmed' by Eichler(1 883).

By the middle years of the 19 century, philosophy of natural system of plant classxﬁcatxon was
thoroughly entrenched in the mind of botanists. The system of de Candolle provided the basis to bentham
‘and Hooker to prepare their Genera Rlantarum (1862-1883) which is a very useful compendxum of generic
_ desmpnons arranged in-a natural scheme. The generic description therein were models of completeness
and precision. Their system achieved a lot of apprecia ion since the work was mostly based on the plant
specimens in the British and Continental Herbaria and least on literature. Although the publication of
Genera Plantarum was latet to that of Darwin’s Origin f Species if did not implemeént the doctrine of
evolution and remained pre-evolutxonary in concept. Like all other pre-Dar-winian systems reliance was
laid on the dogma that the species are speclal creations and therefore constant and immutable.

Phylogenet:c Systems of Classlﬁcatxon

Post Darwxman systems were evohmonary in approach and can be arranged into two main groups
accordmg to the concept of the pnmmve angioupermous flower. The first familiar as Englerian concept,
. was proposed by Alexander Braun in 1859 in his Flora der Provinz. Bradenburg. This influenced-his

successor A.W. Eichler (1813) in Berlin and was modified by Adolf Engler in his Guide to Breslau Botanic
Garden (1886).and fully elaborated in his Syllabus der Pflanzenfamilion, the first edition of which appeared
in 1892 and the latest i.c. the 12* edition in 1964 after having been madified by Melchior. Engler in
colfaboration w1th Karl Prantle, expanded the system in Die Naturlichen Pilanzenfamilien (1887-1915).
T{ns system covers the whole plant kingdom and surpasses all other systems in its quantum of information.
It has itilised information emanating from embryology, morphology, anatomy, geographical distribution
-and presented adequate ﬂlustratnons, bibliography of pertinent literature and keys to xdentxﬁcatnon

The Englerian concept considers unisexual and naked fiowers borne in separate aments or catkins
as the most primitive state which have progresswely been elaborated into bisexual, diplochlamydous flowers.
Bisexual flowers were derived from a single cluster of male and female flowers held in the same inflorescence
that. smmlate& a ﬁower (pseudanthxum), while the subtending perianth evolved later

The most prxmmve ﬂowers were wind pollmated like the cones of gymnospersms and were derived
ffom a symnOSPctmous ancestor with unisexual strobilus bearing either micro-or mega-sporophylls,
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‘Melchior’s revision of Engler’s Syilabus (1964) involved profound changes and rearmgcmem» Dicots
 were treated as more primitive than monocots, various- orders were splitted and families there in were
rearranged Nevertheless, the essence of the Englenan conccpt of pnmmvc flowers is mamtamed in original

~ form.

Engler s concept received support from Wettstem(1901) Hayata (1921), Pulle ( 1938, 1950). Rendle
(1904 1945, 1930, 1938). Skottsberg (1940) and- others who had also framed their own systems keeping
the axial theme more or less similar. Among these systems that of Richard von Wettstein (1 901)is apprecxated
“most since it is pylogenetxcally more rational. He considered dicot to be more primitive than monocots the
latter having been derived from Ranalian stocks. Woody plants werc-regarded by him as more primitive
than herbs, many flowered mﬂorescence 1o be more ancient than solitary ﬂowers and Splrﬂl flowers than
cyclxc ones. :

. The non—Englenan concept is familiar as the Ranalian concept. The ploneer archntcct of thxs concept -
was Charles E. Bessey (1883) of the University. of Nebraska whose final system of clpssnﬁcatnon (1915)
received admxratxon from a number of taxononists mcludmg Cronqmst for having considered. Ranales as
. the most primitive order derived from a gymriosperm with a bisexual strobilus bearing in its axis
megasporophyhs above and microsporophylls below. The lower sporophylls were transformed into sepals
-and petals through sterilisation. The primitive angiospermous flowers bad many free perianth members;
- numerous, free stamens and carpéls arranged spirally on the long conspxcuous thalamus. The nearest approach
to this type of floral orgamsatlon is made by the extent Magnolia. Arber and Parkin (1907) provided the
theoretical basis for this view. The angiosperm owe their origin to a sofar unknown gymnosperm relatéd to
the rare fossil Cyca Jeoidea dacotensis. A Mesozoxc plant of Bennetntales that had borne ‘anthostrobil’ in
the axial of its cycad like leaves :

A somewhat sumlar type phylogenatxc system was recexved from Hans Hallier (I 905, 1908, 1912)
whose independent éndevour concerned an exhaustive survey of literature, herbarium specimens and
palaegbotanical ewdences Thxs system of classxﬁcatxon, accordmg to 'I'akhtajan, was more synthetic and
had the deeper insight into the. morphologxcal evolution and phylogeny of flowering plants than other
contemporary systems mcludmg that of Bessey. Hallier believed that angisperms arose from an unknown
and extinct tribe of Cycaos that was related to Bennettitales and had affinities with Marattiales. Monocots
were thought to be evolved from an extinct dicot ancestral to Lardizabalaceae. '

Jolm Hutchinoson (1926, 1934, 1959 1964- 67, 197 3), a British botamst proposed a system of
classification resembling Bessey’s but dxﬁ'ermg in certain fundamental aspects. Hutchinson derived the
flowering plants from a hypothencal proangiosperms and dxvxded them into three lines: the Monocotylcdcns
Herbaceae Dicotyledones and Lignosae Dicotyledones. Monocots were believed to arise from herbaceous‘
Haxaales The woody line (Ltgnosae) derived from the woody Magnolxales and the Herbacese from Ranales
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Although 'Hut'chinson's tréatmcm of individual families and géncra and especially that of t the
monocotyledons is excellent, creation 6f woody and herbaceous lines has resulted into ahgmnent of unrelated
taxa and done much to detract from -overall value of his work.

The philosophical tradmon of Bessey and Halliers’ phylogenetic systems of classification had an
impact on Armen Takhtajan (1954, 1958, 1966, 1969 1980, 1987). A Cronqum (1957. 1968. 1981), R.
Dahigren (1975, 1980, 1983), R.L. Thome ( 1968 1976, 1983). G.L. stebbins (1974).and others who ha\ e
used data from anatomy, palaoobotany, biochemical systematics, serology, embryology, cytogenetics. -
Scaxming and Transmission Flectron Microsoopy etc. in conjunction with information from the traditional .
- source i.e. ‘morphology so as to give us a phylogenencaly fertile and substantial systems of classification. . '
It was Oswald Tippo ( 1942) and Karl Mez (1926, 1936) to have developed systems of classification based
on anatomy and serology respectively. K.R. Spome (1976, 1980) has sought for an objective methodology
for phylogenetic interpretation. He prepared a list of characters significantly correlated among dicot families
and performed simple statistical tests to determine Advancement Index for each family. On the basis of 30
N palrs of such characters Spotne(1 980) ascribed lowest and highest. Advancement ‘Indices to Magnoliaceag
(25 and Dipsacaceae (87) respectively. Although the catalogue of increasing advancement index is in to
way linear sequence of evolution it can .improve existing classification and settle arguments in respect of
taxonomic and phylogenentic relationship. Spome presented a bird’s eye view of evolution in form of a
phylogram drawn in a circle. the radius representing Advancement Index and position on circumference
- the likely degree of divergence. The Danish botanist Rolf Dahlgmu (1975) originally prepared a phytogram
with living orders placed at the topmost plane of the dxagram on the ancestral branches (absent in spomne’s
dxagr am) many of which are extinct. In Kis later scliemes (1977, 1983).he dropped the branching portion of
the phylogram and used only the topmost plane. Dahlgren follows the view that none of the extant groups
of ﬂowenngs plants is ancestral to any other present day group. The Magnoliaceae-Ranunculaceae group
is not ancestral to others but it has simply retained many primitive characters. Similar representatxon is also
noticed in Thome’s work (1983). Dahlgren et al. (1985) divided dicots into 25 super orders and monocots
.;‘{nto 10 superorders. Robert F. Thorne (1983) created 19 and 9 superorders for dicots and mornocots
respectively. Although claimed to have been original the novelty of the systems published during the iast
decade or so is mootable Smce they are deeply rooted in the substrate of Takhtajan and Cronquxst s sys tems
of classxﬁcatxon : . .

~ The system pubhshed by Ta.khta_;an in 1954 has undergone modxﬁcatxons and eleborations in his
later pubhcatxons but the framework and essence remained the same. He divided Magnoliophyta
(Anglo=pen’ks) into two classes viz. Maguolxopsxda (Dicots) and Liliposida (Monocots). The former was
subdivided int6 7 subclasses and 20 superorders and the Liliopsida was subdivided into 3 subclasses and 8
superorders. Monocots have been shown to have undergone parallel evolution with Nymphaeales from a
common Magnoliale having monosulcate pollen and wood without vessels, His system is based on clear
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evolixtiibnaxy principles and rational putative relationship. The excellency of Takhtajan’s system lies in his
attempts to solve s,at'isfxctorily' many problémé related to polyphyly or monophyly primitiveness of
Magnoliaies, s'ccondax‘y nature of anemophilous families with reduced flowers in aments etc. Keepingt
Magmoliales at the base the evolution of dicots and menocots along with their putative relationships have
been shown very efficiently. Although it can not claim to have made the final arrangement of the orders and
famiilies particularly in subclasses-Rosidae and Lilidae thé system has many positive points to its credit.
Takhtajan’s system seems to be very complicated mainly due to creation of the s_‘upero‘rdersabetween
subclasses and orders and recognition of small families and orders in pursuit of sharp definition of groups.
He (1980) recognised 419 families out of which 342 were.dicots and 77 monocots representing 71and21
orders respectively. Moreover derivation of monocots from stocks ancestral to Nymphaeales receives

objection from many corners Stebi:ins,- (1974) was of the opinion that the similarities between Nymphaeal;s '
and Monacots is probably a consequence of convergent évqlution and the ancestore of them are completely
~ obscured in the geological history. There is on obj_eciiox.l.to Takhtajan’s idea of South —east As.ia"as the

cradle or argiosperms’. It is now belicved that the places of North Gondwana particul'arly,be_twé\en South
Africa and South America where gradually appeared the Atlantic Ocean were the centre Ao'f origin of
angiosperms. : o ~ ' :

The system of classification of flowering plants as designed by Arthur Cronquist (1 981) is in similar
. philosophical dogma and is a refinement over Takhtajan’s system. In full justification of the title “An
. Integrated System of Classification of Flowering Plants™ he (1981) integrated all available data from different
sources avoiding undue optimism about &e'pm‘s'eni itnpoﬁance of data that reflect a very sparse sampling.
'He as used classical data with continuing expansion of data-base for chemical and miromorphological
features. The system is compatible with the fossil record and is most comparable with that of Arman '
Takhtajan. Although both Takhtajan and Cronquist agree on main outlines of angiosperm evolution, there
are certain differences in close decisions at micro-level. Takhtajan placed more reliance on serology and
less. On/,bther'chemicﬂ characters ‘th‘an ‘Cronquist. Unlike Takhtajan Cronquist (1981) was reluctant to
assign the status of family or orders to small groups which could be moderately and comfortably
"accommodated in larger groups. As‘a conégquencc the number of families were reduced by Cronquits to
318 and 65 in case of classes ma@oliopsida and Liliopsida respectively. The former class was subdivided
into 6 subclasses and 64 orders and the latter class into 5 subclasses and'19 orders. The basic difference
with Takhtajan's system lies in its simplicity and natural assemblage, the submergence of Ranunculidac
into, Magnoliidae; rejection of superorders, cleavage of Liliidae sensu Takhtajan into Liliidae, Commelinidae
and Zingiberidae. owever, at some levels too much reliance on certain single character like centrifugal
 stamens, free central placentation etc. hampers the otherwise natural classification. The arrangeaent of
families in Liliales, particularly with reference to submérgence of Amarylidaceae into Liliaccae, aithough
tentative, has been a subject of criticism (Treub, 1974, 1975). ’
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Biosystematic apbroaches

. A new dlSClplme of biology conceming development of taxonomy in relation to population sampling
and experimental procedures emerged in form of Btosytematncs which was introdiiced by Camp and Gilly -
in 1943 as ‘Biosystematy’. This type of study provides a rich source of understanding- of a taxa and
reassessment of their circumscription,. interrelationship and classification. Several eategortes of
) expenmcntally investigated' ‘biotic units are in vogue, the most popular among which is Turesgon’s (1922) .
terms used by Clausen ét al. (1940), viz. ecotype, ecospecies, ceilospecies, companum in order of ascending
phyletic value. Biosystematics aims to prepare itself to acquire such dimenstions so as to prove its superiority '
over the conventional ones and to set up a system of classxﬁcanon provxdmg all types of data thh equal
fidelity. :

In conclusxon it may be said that systems of plant classification have been undergoing evolution
‘due to a progressive increase in the rcsolvmg power of taxonomy through ages. The : synthetic approachin
taxonomy has set up new windows with the help of cytogenetics, embryology, ecology, mathematics,
chemistry, palynology, serology etc. to let in more light on our conception about the taxonomic entities and
more fresh air so as to activate as to activate us in understanding their phylogeny. No system of classification
till date can claim to have made the final arrangement of taxa. However, if collaboration among, various
' discxplmes persists the endeavour is sure to offer. uneqmvocal way out to the quandarms faced by traditional |
taxonomy and yield a perfect system of classification.
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Advent of Numerical Taxonomy

New approaches have developed over the last few decades in search of greater objectivity for bettey
understanding of taxonomic entities and their relationship. One of such. efforts 45 numerical taxonom
which (Sneath, 1957 a & b; Michenet and Sokal ad Sneath, 1 9635 It involves the numer ical ev atuation of
the affinity between taxonomrc units and the ordenng of these units into taxa on the basis ot their aftinie.,
This is often viewed as an extension of Adansoman classification using mathemancal procedure with the
primary aims of repeatability and,obj_ecthty (Davis and Heywood, 1963). Numerical taxonomy covers al},
aspects of quantitative studies in systematics, that utilise multivariate techniques. It had its origin in the
phenetic approach to classification (Sokal and Sneath, 1963) which from the description by Jardine and
Sibson (1971) and the discussion in relation to alternative approaches by Mc Neill (1980) appears to be a
natural or general purpose classification in which a large number of gcneral statements can be madc about
the taxa recognised. Although numerlcal taxonomy has developed in the context of phenetic phllosophy it
. is not restricted to the constructxon of phenetic classification. It has integrated itself with biosystematics. A
number of standard pubhcatxons (Sokal and Sneath, 1963; Rolf and Sokal, 1265; Sneath and Sokal, 1973:
Neff and Marcus, 1980; Duncan and Baum, 1981 Gordon 1981; Dunn and Everut 1982; Felsenstein,
1982, 1983: Legendre and Legendre, 1983 Mc Neil 1983) are at our disposal that provide useful intoroduction
to taximetric techniques and- their applxcatxons 'I'hc numencal methods, in general, are not specifically

sensitive to-convergent evolution, sibling species or to 1solatmg mechanisms. -

Cladistic Approaches :

The other objective apprdach emanated in he field of phylogenetxc systematics dueto the cndea\ ours
of W. Henning (1966) which was termed cladistics by later workers (Nelson and Patnick, 198 {: Bremer and
Wanntorop, 1991). Since mid 1970’s many botanists particularly those of USA started walking in this
direction. ,A separate but similar approach came in form of Wagner’s (1980) Gxoundéplasm Divergence’
method based on his work on Hawaiian terns. This method attempts to analyse phylogenetic data’objectively
in a manner parallel to that in taximetrics which seeks to introduce objectivity to natural system. The
re'atmmhlp among plants is assessed on the basis of their evolutionary behaviour and principle of parsimony
. Le. the shortest hypothetical pathway of changes that explains the present phenenc pattern. In the mean
time journals like Cladistics (since 1985), Advances in Cladistics (since 1981) are being published and a
society called Willi Hennig Society has been established. Though there is a claom of its superiority of
principles and practiogs of classification, no subject can rival cladistics i m the degree of argument and
controversy.
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Computer application in biology and bioinformatics

1.0 INTRODUCTION
Pcoplc tried to use computing devices for a long time ago. Modern computer has become
a successtul c.omputmg machine as a result of continuous efforts of the scientists. In
1950s modern computers came into the market and they were used only in limited areas.
Now. computers become part and parcel of the human life.
A computer may be described as an “information processor’. There are several
advantages of using computers.

i) Perform complex and rcpctitive calculation rapidly and accurately.

ii) Storage of large amounts of information for subsequent manipulation.

iii) Make decisions. |

iv) Provide intormation to the user.

v) Draw and print graphs

vi) Converse with users through terminals.
Computers are now affccting every sphere of human activity and bringing about many
changes in industry. government, education. medicine. scientific research. law. social
sciences and even in arts like music and painting. These are presently uscd, among other

applications, to

* Design buildings. bridges and machines.

* Assist in railway reservation.

* - Control inventories to minimize material cost.

* Grade examination and process results.

* - Ald in tcaching.

*  Control space vehicles.

* ~ Play games like chess and vidco games. \

Nowadays computer are being applied in all the branches of sciences including biologigal

sciences.



2.0 AIM OF THE MODULE:

The dreas of abp!icaticns of computer are confined only by limitations of human
creauvity and imagination. In fact any task that can be carried out systeinatically. using a
precise step-by step method. can be performed by a coniputer. Therefore. it is essential

for every educated person today to know about a computer, its strength, its weakness and

its witernal structure.

Earlier. computers were used in the fields of engineering and technology. However. for
the last few years computers are béing used in biology and medicine. There is enough
scope to utilize the computer in various fields of biology and medicine. Therefore. the
biologists. medical practitioners and medical oriented staffs should be computer literate.
Like other branches of biology, the benefits of the computer are utilized in Botany. It can .
“used to solve various problems in different fields of botany, like, taxonomy. plant
physiology, forestry, plant biochemistry. genetics etc. Creation 6f botanical database is -
one of the important field applfcations of computer.

The objective of this module is to delineate important characteristics of computer
hardware. software and the way of using computer in biological science. We shall deal
with the basic architecture of the computer. different software, operating  system,
components of desklop, internet, web based information and an idea of bioinformatics.
3.0 BASIC STRUCTURE OF COMPUTER:

A computer can be broadly divided into two parts:
a) Hardware

b) Software

3.1. Hardware: Hardware refers to the physical structure ofa computer, that is, all of the
clectronic and electro-mechanical devices associated with a computer. The physical
companents of the compyter are included in the following two-divisions:

1) Ccmrél Processing Unit (CPU).

ii) Peripheral devices.

The architecture of a computer is in Fig. 1.
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3.1.1 Central Processing Unit (CPU): It is the central part of the computer. It can be
compared to the brain of a human body. The CPU is connected to all other parts of the
computer. It controls input, output. memory and other electronic ciscuits of the €omputer.
The computational works which are done through the computer are executed by the CPU.
The Central Processing Unit has the following subunits: (i) control Unit (i1) Arithmetic

Logic Unit (ili) Memory.

3.1.1.1 Control Unit (CU): It is the supervisor of the CPU. This unit coordinates the
activities of all other units within the system. The important functions.of this unit are as
follows: (a) It controls the transfer of data and other information among different,subunits
af CPU. (b) It helps to initiate and supervise the functions of arithmetic-logic unit. A user
gives the instruction thrdugh computer program which is stored in the memory. The
. control unit takes those instructions from the mem.ory. decodes them and direc&s the
different units to execute the specific instructions. For example, in a user’s program there
is an instruction to multiply A with B. The contro! unit will fetch the vatues stored in the
memory locations A and B and send them to arithmetic-logic unit. The CU will direct the
~arithmetic-logic unit to perform-the multiplication with the values of A and- B and to send
the result to the memory. It will also send the result to the output unit if there is-
nstruction in the user’s program.-Thus the control unit performs supervisory functions of

the CPU.

3.1.1.2 Arithmetic-Logic Unit (ALU): This subunit is an electromic circuit of CPU. It
performs ail arithmetic as well as logical funcdons of the computer progrum. The
arithmetic function includes addition, subtraction. mﬁltiplication. division. and
exponentiation. Various logical operations, e.g.. greater than. lesser than, equals to. not
equals 1o, greater than cqﬁals to. lesser than equals to etc are also executed by the logic

circuits of ALLL



CPU
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Fig. I: Architecture of a computer.

3.1.1.3 Memory Umt This is another important subumt of CPU The memory unit can
store or hold all data. mstruulons results etc. The memory consists of numerous cells
called storage locations each capable of storing one character or bit. The cells may be
organized as a set of words. each word storing a sequence of bits. The memory unit is
variously known as stordge internal storage. primary storage. memory primary memory.

main memory ete.

The size of the memory is usually expressed in terms ‘bytes’. A byte consists of 10 bits
(binary digits). It is roughly s'ynonyms with one character of data storage, that is. cach

character stored in memory wiH take up one byte of storage. However, in practice

‘computer memories are exprc.ssed m terms kilobytes (KB) where kilo (K) stands for

1024 (2"). Further hlghcr order units are also used as measure of. memory capauty-
megabyte. glgdbyte etc. A megabyte (MB) is 1048576 (22%) bytes where as a bxgabyzc
(GB) is 1024 megabyte.
The primary memory is divided into two pa}ts: "

Random Access Memory (RAM)

Read Only Memory (ROM)



3.1.1.3.1 Random Access Memory (RAM): In this part of the memory all information
or data coming from input unit are stored. Storing the data in the memo.ry is known as
writing the memory and retrieving the data from the memory is known as reading the
memory. In RAM both reading and writing the memory are usually done. That’s why
RAM i’s‘also called Read/ Write memory (R/W). At any time we can store the data in

RAM and data can be erased from the RAM, if desired.
The RAM is usually volatile in nature. All information stored in the RAM is lost when

power is disconnected. The internal electroniic memories of the computer are made by
using large scale integration (LSI) and very large scale integration (VLSI) techniques.

"Different kinds of technologies are used in differcnt RAM, which is dutlined below.

T.T.L. RAM: T.T.L: stands for transistor logic. In T.T.L. RAM transistor is used as -
activeecomponent. The informaiion is stored in the circuit of IC which is made by the
‘ t’r_ansiétdh The writing and reading of data in such RAM is very speedy. It requircs' a large
amount of clectric energy fdf its activation; therefore, the use of baitery is

disadvantageous for it.

COMS RAM: COMS stands for éonip_lcmentary metal oxide semiconductor. This kind
of RAM is made by the semiconductors. The data transfer raté is lower in ‘t}'aan that in
T.T.L. RAM. However. the requirement of electric energy is lesscr than thét of T.T.L.
RAM. The nickel-cadmium rechargeable battery, which is fixed within the computer, is
able to acti_\}ate for a long timg even if the main power supply is furned off. Now-a-days

COMS RAM has become very much popular for personal computer.

DRAM: DRAM stands for dynamic RAM It consists of memory cell$ that are madé by
'MOS (metal oxide semiconductor) transistor and capacitor. When the capacitor of the
memory cell holds the charge, it represents binary 1 and when there is no charge in the
capacitor it indicates 0.Such kinds of memory cell are lesser in size than T.T.L. RAM. A
common s.ized [.Ce. paéi( may contain a large number of DRAM ccll.v ‘The price of the

DRAM 1= also lesser than that of T.T.L.RAM.
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The T.T..RAM'is static in nature. wherecas DRAM is dynamic in nature. In‘static RAM
during retrieval of data. the stored information is not crased. On tife other hand, in
dynamic RAM the stored information are erased during data reading because the
capacitor of the memory cells lose their charge during data retrieval. Such problem is
solved by using DRAM controller circuit. DRAM controller circuit h_élps to rewrite the

information in all memory locations with interval of a few milliseconds. This process is

called memory refresh.

3.1.1.3.2 Read Only Memory (ROM):

The information stored in this part of the memory is only readable: writing is not
possible. Once some information are stored here cannot be erased. They remain in the

memory permanently. The information are not changed even if they are kept unused for a

long ume.

12

Actually, R()M is a type of integrated circuit (IC), usually mounted on a mother board.
The IC pack has some input and output lines. Different memory locations of thc ROM are

addressed by the input lines and the information stored in those locations is found in the

output lines.

ROM provides the basic start-up routines and BIOS (basic Input Output System) of a
computer. It is also used as character generators in printer and monitors. ROM chips store

software which are given by the manufacturers. They insert binary information in’the

memory cell of the ROM during manufacturing.

Basically. ROMs are used for running the computer with the instructions stored in it.

However. the ordinary ROM has some limitations. To overcome these limitations some

advanced type of ROMs have been developed which are pointed out below:
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PROM: PROM stands for “Programmable Read Only Memory™. It has gotJ some
advantages over ROM. The main disadvantages of the ROM are that the user cannot
change the program stored in it, if required. All functions are not performed by the
istructions given in the ROM. PROM offers this facility. One can store the program in
the PROM according to the need of the user. A special instrument, known as PROM
programmer, is used to program a new PROM chip. Programming is usually done by

binary code (1. 0). After completion of programming the chip becomes a new ROM.

EPROM: The full form of EPROM is Frasable Programmable Read Only Memory™. It
is technically better than PROM. One of the problems of using PROM is that once a
program is done on a PROM it cannot be changed. If there is any mistake in single
memory location of PROM., the PROM chip is required to be discarded. Programming a -
PROM is error prone because it is required to handle binary code, i.c., 0 and 1 only.

The above problems are solved by introducing erasing facility in EPROM. The stored
information can be erased by placing the EPROM under the ultraviolet ray for twenty to
thirty minutes.

After the ultraviolet treatment the chip becomes a new PROM and new information may
be stored again by binary programming. In EPROM chip there is a small transparent
quartz window which is the speciality of this chip. When the chip is exposed under the
ultraviolet lamp, the ultraviolet rays cnter intov the inside of the EPROM chip through the
quartz window. All information of the chip are lost due to the action of ultraviolet rays on
the components of ICs. For this advantage EPROM is popularly. used in modern

computer.

. EEPROM: Electrically Erasable Programmable Read Only Memory (EEPROM) is an
advanced version of EPROM. The ultraviolet treatment  cannot .bc done when the
EPROM: chip remains within the computer cii‘cuit.,\}t should be removed from the
_computer for placing under the ultraviolet rays. The pfocéss is difficult for a common
compulcf user. To overcome such difficulties EEPROM is used. The old information

stored in EEPROM can be créseq;ps?',,@nding electric pulse when the EEPROM chip
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remains mntact within the computer. In this case it is not required to remove the chip from

the computer. New program may be donc under this condition.

EAPROM: It stands for Electrically Alterable Programmable Read Only Memory. It is
more or less similar to the EEPROM. The program stored in the’ EPROM can be altered

by sending electric pulse according to the desire of the user.

3.1.2 PERIPHERAL DEVICES:
Any hardware that is external to the CPU and its associated hardware are known as

peripheral device. It includes input devices, output devices and secondary storage.

Input device: The device that provides data or information to the computer is.called

mput device. It is the hardware that generates computer compatible ’inpm. Examples:
- Keyboard. scanner. digitizer, mouse etc.

Output device: The hardwarc system that accepts data from the computer is called

output device. This is a unit of the computer which is used to print or display computed

results. Examples: Printer. Monitor, Plotter etc.

Secondary storage: It is a massAstoragc medium of the computer in addition to the

primary memory. It is nonvolatile in nature, that is, data is not lost when power is turned
off. It does not require a power source once the write operation is complete. Secondary
memory may not be located close to the C PU; it may be present sevéral meters away
from the CPU. Secondary memory is often used for storing off- Ime data. anmples'
floppy disk. hard disk. magnctic tape, ( D-ROM etc.
Some of the above described pcnpheral devices act solely as input device (keyboard) or
output device (printer). However, many of the devices have combined functions (both
input and output). For example. monitor, punched card etc. have both the functions. Some
other devices like floppy disks. magnetic tape etc. act as input unit, output Hnit and
secondary storage.

Some of the important peripheral devices are described below:
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3.1 2 1 PAPER TAPE:

This is also known as punched tape. Paper tape is one of the oldest medxa for input or
output. The tape is usually made with paper having width of half to three inches
(normally one inch). The tape is divided into 5 to 8 tracks or channels (some times 16
channels). Data are represemcd in the tape by making round holes in those channels. Data

are represented by using some mtematmnan) accepted codes.

The holes are made with the help of machine like ordinary typewriier. The punched tape
is sent to a punched tape reader machine which is connected to the computer. The reader
machine decodes the data in terms of binary 0 and ! and sends them to the'C.P.U.

The paper tape is inexpensive. It has unlimited storage medium.

The paper tape is slow medium. It is difficult to read data from it and data correction

cannot be done easily.

PlJNCHFD CARDS

Herman Hollerith, a German Scientist. introduced this input device. The card is 20 cm in
length and 8 cm in width. The card contains 80 columns and 12 rows. The rows from 1-9
are known as digit punches and 0" 11™ & 12" rows are called zone punches. Eleventh
~ and twelfth rows remain aque the O"‘ row. The data is rcpresehtcd in the card by making
some small rectangular holes. The holes are made by card punch machine. A single
character. which may be a digit. alphabet or special character, can be represented in each
- column of the card. Digit is represented by a single punch in a column. Alphabets are
represented by double punch in a column whereas special characters are rcpréscnted by
triple punch in a column. Different alphanumeric characters are represented by means of
a coding syétem. which is known as Hollerith code.
The Hollerith codes for presenting different alphabets (A /) are shown in Fig.2. From the
table it may be noted that different alphabets are represcited as a combination of zone
punches and digil punches. For example, the alphabet P is represented as a combination

h
of a punch in 11" row and 7" row and T is punched as a combination of 0™ and 3" rows.
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Digit punches
1 2 3 4 S 6 7 8 9
Zone 12 A B C D E F G- H [
Punches | 11 J K L M N o) P Q R
0 S T U \% w X Y Z

Fig.2: Hollerith code for alphabetic characters.

The data is feed to the computer by a device called punched card reader from the card.
The cards are given in the input hopper of the card reader and they are passed over a
roller. A photoelectric light beam is directed towards the roller. The light beams are
passed ihrough the punc_ﬁed holes .and electric pulses are gcneraied. T‘llt_: pulses are coded
as ;0‘ and ‘1’ and transmitted to compute'r memory. The card reader éan read 12 to 34
cards per second. v

This inp;xt device is also a slow media. Huge numbers of cards are required for a large

computer program. Data can not be corrected easily in a card.

3.1.2.3 KEY BOARD: v
The computer key board looks like a type writer key board. It contafns several keys to
feed information to the computer. Generally two models-of key boards are used. |

i) ' The standard key board having 84 keys.

ii) The enhanced key board having 104 keys.

Different keys of the standard key board are outlined below.

Typewriter Keys: These are the usual keys ‘as found in the typewriter keyboard.

Different characters. e.g.. letter. numbers and punctuation symbols are present.

Functions Keys: At the top end of the key board some keys are located which are
designated as F| to F12. These keys are called function keys. The functions of these keys

are different in different software.




Cursor Keys: These keys are marked with arrows in four directions (¢, —. 1. ]). One

15 enable to move the cursor towards left. right, up or down in the screen. By pressing
these keys it is possible to move one character at a time.

Beside these other keys are also found in the keyboard for moving cursor for different

purpose as mentioned below:

Home key moves the cursor to the first line of the document. End key moves the cursor

10 the end of the documem (last line).
Page up key is used to move the cursor to the precedmg page of the document in the

screen.

Page down key is used to take the cursor to the next page of the document.

- Delete Key (Del): This key helps to erase a character Wthh remains nght side to the

.. blinking cursor. '

Back Space Key: When this key is pressed a character to the left side of the blinking
curser is erased. ‘

Tab Key: It takes the cursor along a line to a present point.

Escape Key (Esc): The Esc. key is used to cancel or to ignore the emry or command that
has just been emered -

Caps lock key: When this kev is pressed once, any letter which is typed will appear in
upper case (capital letter). A small indicator light will be lit when caps lock key is
pressed. ['he effect will be reverséd when the key is pressed once _again.

Shift key: When the shift key is pressed and the same time pressing any.key creates an
upper case letter. If the caps lock key remains open. the effect will be reversed. Some of
the keys of the key board contain two symbols or characters. Holding the shift key down
it any of these key is pressed, the upper symbol will appear in the screen. 7

Numeric key (NUM): Some of the keys in the right-hand side of the key board are used
tor entering numbers. These are known as numeric key pad. These keys become
functional as numeric keys only when another key, "NUM LOCK". is made on (on is

indicated by light). When *NUM LOCK" is-made off, they perform other functions.
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Control Key (Ctrl): The "Cul® key is used in combination with other key to perform
some special functions. For example, when *Ctrl™and ‘C" are pressed simultaneously. the
current task is aborted and returns DOS prompt. '

Alternate Key (Alt): The "All" key also performs some special functions in combination
with other keys. By pressing Ctrl, Alt and Decl keys simultancously, the computer
automatically restarts. ‘

Enter (or Return) key: After giving instraction to the computer when Enter key is
pressed. the instruction is processed or exccuted. The Enter key is also used for

beginning a new line in Microsoft word program.

3.1.2.4 MOUSE: The mouse is a hand-held input device. It is rectangular in shape. It has
a rubber ball which is embedded at the lower side. There are two buttons or the top of the
mouse. The device is uscd to control or execute several commands of the computer
without using key board. A mouse cursor appears in the screens and the cursor can be
moved by moving the mouse on a rubber pad. Nowadays, mouse are available. without
having rubber ball, which “are operated by the laser rays. The mouse cursor moves
according to the dircction of the movement (up. down. left, right etc) of the mouse. The
eursor may be {ixed on a specitic command in the screen and when the left button of
mouse is pressed the command is executed. Controlling a computer by the rnouﬁe s

casier and faster than that of a key board.

3.1.2.5 MAGNETIC INK CHARACTER RECOGNIZER (MICR):

The mput device is able 1o read characters which are printed by special magnctié ink. It
reads those characters, converts them into computer code and stores in the computer. For
instance. in a cheque the branch code. cheque numbcr, account nuhlber‘ etc. are preprinted
with magnetic ink. When the cheque is entered in the device. all information are stored in

the computer and it climinates the need to manually enter data from the cheque into a

tloppy.
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I'he OCK can rcad any character written on a paper with ordinary ink. This device 1s used
1o read an image which may be a handwritten document. a typed or a printed document or
a picture. The device has a bright light source. lensc and a rectangular matrix of photo
diodes. A reflected image of the document is made 6n the diode by the light and electric
pulses arc created which is converted into binary code (Os and 1s) and are stored in the
computer memory.

The svstem is known as scanner. Scanners arc used in a wide varicty of jobs. They are
" used for storing photographs and impo»rtant documents in their original forms. They may
be used to take cnormous text material in to the computer instead of typing them
manually. Two types of scanner are usually found. (a) Flat bed scanner - it scans single
sheet of paper or pages of a book. The system is expensive and fess compact. (b) Hand
held scanner - one can move the scanner manually over the image which is intended to

scan. The system is inexpensive and portable.

3.1.2.7 VISUAL DISPLAY UNIT (VDU):
Visual Displas Unit (VDU) is thc most popular input/output device. It consists of a
cathode ray tube (CRT) to‘dispfaj} the input data and 6Utput (proccssed ihformation) from
the computer. VDUs are generally available for alphanumeric (alphabets. digits. special
characters) display. Normally, a VDU can display 80 characters in each linc and the
screen can have 24 lines. VDU with graphic capabilitics are also available. This is called
video system. The vidco system consists of a monitdr and a little circuit board called- the
video card. The video card is positioned inside the main unit. The monitor itself can
display one color (monochrome) or many colors (multichrome). For full utilization of the
| computer. a VGA (Video .Graphic Array) or SVGA (Super Video Graphic Array)
monitor is hclpful. The color monitor allows one to run morc sofMarc and games. A
monochrome monitor is safer than the color monitor. Monitors are available in differeﬁt
Shapes and sizes. A monitor should be comfortable for eyes. A large screen does not
necessarily mean better. Although one can see things bigger and cleaner, it is like sitting
right in front of a big screen TV that is harmful to your eyes. On the other hand, a small

black and white monitor will be quite limiting, designing and other such activities cannot
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he done. The resolution of the monitor is an important featurc. A monitor should provide
at least 128 X 1024 resolutions for good display’ The resolution is measured in pixels

(short form of “picture elements’).

3.1.2.8 PRINTERS:
The printer is an output device. The outpui is produced from a computer in a readable

form. I'he documents produced by a printer are pc;manem. Hence, they are called "hari
copy’ |

Computer printers fall into two main categories, namely, line printers and serial character
printers. A line printer prints a complete {inc at a time. Printing speed vary from 150 lines
10 2500 lines per minute with 96 te 160 characters on a 15 inch line. Six to eight lines per
vertical inch are printed: One may buy printers wit‘h a variety of character sets. Usually
64 and 96 character sets are used with English letters. Printers are available in almost all
scripts: e.g.. English, Japanese, Arabic. Russian. Hindi, Bengali etc. There are two types

of line printers. These are drum printers and chain printers.

Drum Printer: A drum printer consists of a cylindrical drum. The characters to be
printed are embossed on its surface. One complete set of characters is embossed for each
and every print position on a line. '

The codes of all characters to be printed on one line are transmitted from the memory of
the computer to a storage unit in the printer. The storage unit called a printer buffer
register can normally store 132 character codes. The printer drum is rotated at a high
speed. A set of printer hammers. one for each character in a line are mounted in front.of
drum. The position of each character on i. band of drum surface is coded using its~angular
displacement from the origin. A character is printed by striking a hammer against the
cmbossed character on the surface. A carbon ribbon and paper are interposed between the
hammer and the drem: As the drum rotates. the hammer waits. and is activated when the
character to be printed at this position (as given in the print buffer register) appears in the
front of the hammer. Thus the drum would have to complete one full revolution for a line
to be printed. This is called “on the flv” printing as the drum continues 1o rotate at a high

speed when the hammer strikes it. Thus the hammer must strike very quickly and must be
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accurately synchronized with the drum movement. If the hammer striking is nistimed.
then the printed line looks wavy and slightly blurred. Printer drums are expensive and

cannot be changed often. Thus drum printers have a fixed front.

Chain Printer: A chain printer has a steel band on which the character sets are
embossed. For a 64 character sct printer. 4 sets of 64 characters each would be embossed
on the band. For printing a linc. all the characters in the linc are sent from the memory 10
the printer'buffer rcgister. The band is rotated at a high spéed. As the band rotates. a
hammer is activated when the desired character as specified in the buffer register comes
in front of it. For a printer with 132 characters per line, 132 hammers will be positioned
to strike the carbon ribbon which is placed between the chain, paper and the hammer. In
this printer also the hammer movement and chain movement should be accurately

synchronized. Bad synchronization leads to blurred lines.

Scrial Printers: Serial printers print one character at a time, with the print head moving
across a line. 1"hcy are similar to typewriters. Serial pripters are normally slow (30 to 300
characters per second). The most popular.serial print is called a ‘dot matrix” printer. In
such a printer the print head consists of an array of pins. Characters to be printcd are sent
one character at a time from thc memory to the printer. The character code is decoded by
the printer electronics and activates the appropriate pins in the pin head.

An advantage of dot matrix printers is the possibility of converting them to print
alphabets other than English. It is possible 10 adopt them to print Debnagari script, Tamil
script, Arabic script etc.

Currently, dot matrix printers which have a print head with 24 pins in a vertical line are
available. In such printers the head is moved horizontally in small increments to print

characters. These printers give very high quality printed output.

Inkjet printer: As a character produced by a dot matrix printer is made up of a finite
number of dots. the appearance of the printed output is not very good. For better looking
output where characters are represented by sharp ¢ontinuous lines, a character printer

known as inkjet printer is used. An inkjet printer consists of a print ‘head which has g
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number of s.mall.holes or nozzles. Individual holes can be heated very rapidly (in a few
microseconds) by an integrated circuit resistor. When the resistor heats up the ink near it
vaporizcs and is ejected through the nozzle and makes a dot on the paper placed near the
head. A high resolution of 300 dots has around 50 nozzles within a height of 7 mm and
print with a resolution of 300 dots per inch. A fairly complex electronic system selects
the holes to ‘be heated based on the character to be printed. The head is also moved
rapidly across the paper. The' printer has enough memory to print an entire page

accommodating different fronts. Color inject printers are now commonly available.

Laser Printers: The basic limitation of line and serial printer is the need fbr a head to

move and impinge on a- nbbon to print characters This mechanical movemem is

rclatively slow due to the high inertia of mechamcal elements.. Intensive research and

development with the goal to eliminate mechanical motion in printer has been conducted
by computer manufacturers. One such effort has lead to the development of laser printers.
~In these printers, an electronically control laser bedm traces out the desired character to

be printed on a photoconductive drum. The drum attracts on ink toner on to the exposed

areas. This image is transferred to the paper which comes in contact with the drum. Low
' speed laser printers which print 4 to 8 pages per minute are very popular., Very fast
printers are also available which print over 10,000 lines per minute. These printers give

excellent output and can print a variety of fronts.

3.1.2.9 Magnetic Tape Drive: '
Magnctic. tape drive is used as secondary storage unit. It may also be utilized as input as
well as output device. Data or information can bs stored on the tape made of plastic
- substances coated wnth ferromagnetic materials (1ron oxide). ‘
A typical-tape is half inch wide and divided irto 7 or 9 tracks. ‘The characters are
represcnted as combinations magnetized dots in tracts using some special codes. The
length of magnetic tape varies from 600 to 2400 feet. The magnetic tape is high speed
input/output medium. To read/write information on tape, the tape is mounted on magn‘ét’ié
tape drive. Reading and writing are done through a read/write head. It unwinds from a

reel and gets wounds on another reel known -as take-up-reel. On magnetic tapes.
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information can be recorded and accessed sequentially (serially). The density varies from
800 bytes to 625Q bytes per inch. Typical speed of tape is about 200 inch per second. The
magncxizéd bits gencrate current pulse in the coils during reading which arc transmitted
to CPU. While writing on tape. electric pulses flow from the CPU, generating magnetized
patterns on the tape.

There are’ some advantages and disadvantages of the magnetic tape. Some of them are
listed below:

Advantages: (a) High data density. (b) Record length is limited by the size of memory.
(c) low cost. (d) Reusability. (e) Off-line storage. (f) Easy handling. (g) Faster transfer
rate. '
Disadvantages: (a) No direct access to the récord,s. (b) Lack of human ,readanbility. ()

Maintenance problem.

3.1.2.10 Magnetic Disk Drive:
Magnetic disk is also a high speed input/output as well as secondary storage medium.
' Tms is plastic or metal patter like a phonograph record. It has an iron oxide coating and
information can be recorded and stored on the surface of the disk in form of magnetu
spots. Magnetic dxsks can be used both for direct or sequential processing.
Magnetic disk drive is a device that is used to record information on the surface of a disk -
and reads information from it. The processing of records on a disk is similar to thc_ |
accessing of a phonograph records from a juke box. A magnetic disk consists of several
- disks (a sct of disk is also called disk pack or cartridge) fixed on a central spindle. The
‘ heromeli’cally sealed unit in which read/write heads can move to reach disk surface is
known as Winchester disk drive. The aceess times for data on.a disk is determined in B
terms of seek and search time. The seek time is the time requlred to position head over a
proper track and thc search time is the time required to reach the required data.
Magneuc disks are used on microcomputers and large main frame computer system. A
typical storage capacity of the disk is 60 MB but it may vary from 40 to. 100 MB. The
transfer.rate in a typical disk is 312,000 characters per second. ‘
The foll,GW'ings are the advantages of the disk: (a) disk offer better file organization than

the other system (b) very large storage capacity (c) fast data transfer speed.

1~
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Floppy disks are made of magnetic oxide-coated mylar éomputer tape material. The
Hlexible tape material 1s cut into circular pieces 3.5 inches in diameter. As thc material
used 15 not a hard plate but a flexible tape. it is called a “floppy disk.” The floppy disk is
-packaged in a 3.5 inch square hard plastic envelop with a long slit for read—wr‘ite head
access. and a whole in the center for mounting the disk drive hub. The floppy disk, along ‘
with the envelope. is slipped’ into the drive mechanism. The mechanism holds the
envelope and the flexible disk is rotated inside the envelope by the drive mechanism. The
inner side of the envelope is smooth and permits free rotation. The read-write head is held
in physical contact with the floppy disk. The stit for read/Avrite remains closed until the
disk is inserted into the drive The slit epens when the disk starts spinning. The hpaﬁ s
moved radially along the slit. Track to track movement and‘positioning of the head is
controlled by a servomechanism. A floppy disk has 198 tracks, 9 sectors per track, and -‘
512 bytes on one side of the disk. The gross capacity on both sides is 1.75 MB and the
net capactity is 1.2 MB. The rotation spée‘d of a floppy is of the order of 366 rpm with a
transfer rate of 40 kilobytes/seconds. For reading and writing on the disk, the head has to
be in contact with the disk surface. Thus disk and head'wear take place.
The advantages of the floppy disk are pointed out as follows: (a) Easy error correction (b)
can be used for storage és well as ‘outﬁut. (c) Direct access (d) reusability () inexpen:.. ¢

media.

3.1.2.12 Hard Disk:

Magnetic hard disks are smooth metal plates coated on both sides with a thin film of
magnetic material. A set of such magnetic platé are fixed to a spindle one below the other
10 make up a disk pack. The disk pack is sealed ard mounted on a disk drive. Such a disk
drive is known as a Win‘chester disk drive. The disk drive consists of a motor to rotate the
disk pack about its axis at a speed of about 5400 revolutions per minute. Thxs drive also
“has a set of magnetic heads mounted on arms. Fhe arm asscmbly 1s capab!c of moving in
and out in radial direction. Information is recorded on the surface of a disk as it rotates

about its axis. Thus it is on circular tracks on each disk surface. A sct of concentric tracks
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are recorded on each surface. A set of corresponding tracks is all surfaces of a disk pack
are called a c&linder. A track is divided into sectors. Read and write operations on a disk
start at sector boundaries. -

Storage capacity of hard disk varies from computer to computer. With advancement of
storage technology thé storage sizc of the hard disk is gradually increasing.

Hard disks possess a number of advantages compared 1o the floppy disks: (a) They can
hold much larger data than floppies (b) They arev fast in reading and writing (¢) They are

not susceptible to dust and statical electricity.”

3.1.2.13 Compact Disk Read Only Memory (CDROM):

The latest and the most promising technology for high capacity secondary storage is
known as Laser Disk technology. This t‘cchnol'ogy h-as evolved out of the entertainment
elcctroni.cs market where cassette tapes and log playing records are being rcplag:cd by
CDs. The terminology of CD used fof audio records stands for Compact Disks. For usc; in
digital computers‘simi'lar technology is used. The disks are used for data storage and
known as Compact Disk Read Only Memory (CDROM). The CDROM disk. also known
as a laser disk. is a shiny metal likc disk whose diameter is 5.25 inches (12 cm). It can
store around 650 megabytes (equivalent to 2. 50,000 pages of printed text).

Information in CDRO\A is written by creating pits on the d:sk surface by shining a laser
beam. As the dnsk rotates the laser beam traces out a contmuous spiral. The sharply
focused beam creates a circular pit of around 0.8 unt diameter wherever a | is to be
~ written and no pit (also called a land) if zero is to be written. From a master disk many
| copies can be reproduce by a process called stamping a disk. | |

Thé CDROM with pre-recorded information is read by CDROM reader which causes a
laserv Bcam for readings. As in a magnetic floppy disk the CDROM disk is inserted in a
slot. It is rotated by a motor at a speed of 360 rpm. A laser head moves in and out 1o the
specified positions. As the disk rotates the head senses pxts and lands. This is converted to

Isand Os hy the electronic interface and sent to the computer

All large software such as operating system and software updates are supplied on

CDROM It has become essential to have a CDROM drive on a PC te install software.
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. Another major apblicalion*qf CDROM is in distributing large texts. For example, the
cotire Encyclopedia Britanni¢a can be stored and distributed in one CbROM. Articles
appearing in scientific joumalé are also distributéed in CDROM. The current booming
market is multimedia CDROMs in which text, audio and video are stored. Aldng with

appropriate softwarc these CDROMs can be used tor education and entertainment.

3.2 Software:
Software is defined as a set of instructions that direct the computer to perform a particular

sct of tasks in a particular order, using Speciﬁed hardware devices, memory locations etc.
Coumputer need clear cut instructions to tell them what to do, how to do and when to-do.
A sel of instructions to carry out these functions is called program. A group of such
programs that are but into a computer to operate and control is activities is called
Software.
Computer software may be classified into two broad categories: application software and
system software. Application sofiware is a set of programs necessary to carry out
operations for a specified application. For example, program to solve a set of equations.
process, examination results etc., constitute application software. System software, on the
other hand. are general programs written for the systems which provide the environment
to facilitate the writing of application software.
Software may further be divided into some categories. There are four major kinds of
software that are implemented (shown in fig 2). The following are different kinds of
soflwares. '

1. Monitor program

2. Operating system

3. Language processor

4. Utility processor

5. Application program
Software includes all layers of program. Different kinds of software are discussed below;



it

3.2.1 Monitor program: _

Monitor program is the minimum software which is required to make the computer
usable. Without monitor program a computer becomes a useléss machine. The monitor
‘program makes a connccfion between the user and the CPU. This program is stored in the
ROM by the manufacturer of the computer. It remains invisible to the users but it serves

the purpose of the users. After the computer is turned on, it directs the functioning of

. CPU and controls the CPU.

Application

Language processors

Monitor program

Hardware

Operating system -

Utility program

Fig 3: Different layers of software

3.2.2. Operating systems:
To make the computer programming easier additional software is given along with
monitor software is given along with monitor software. This is known as operating

“* .
system* It manages the resources of a compiter system and schedules its operation. It acts
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an interface between the hardware and the user programs and facilitates the execution of
programs. In other words operating systcm or OS make the computer more lively or users
friendly. User fnend!y means that it reduces rhe labour of computer user and makes
conversation with users through monitor screen. With the help of monitor software
programming can bc made by machine language (with binary or Hex number) only. But
high level language programming can be made using OS. The principal funcnons of a
operating systcm include:

I. To control and coordinate peripheral devices such as. printers, display screen and
disk drives.
To monitor the use of the machine’s resources.

To help the application programs execute its instructions.

2w N

To help the user for developing programs.

To deal with any faults that may occur in the computer and inform the operator. | -
c

N

On modern computers. the operating system is a master program that manages all
peripheral hardware (e.g. monitor. keyboard. disk drives) and allows other softwarc
applications to run. There is a low-level operating system. sometimes called the BIOS
(Basic Input-Output System). which is largely or entirely in firmware (i.e. software storcd -
in read-only memory). The BIOS handles activities such as deciding what to do when the
computer is switched on after a cold start. reading and writing to disks. responding to .
input. displaying readable characters on the monitor and producmg diagnostics. The
higher- level operating system then takes over. and the computer acquires a typical
graphical user interface (GUI) such as Windows. Files that contain instructions for the
opcrating system are called batch files in Windows and shell scripts in UNIX systems.
For example. the Windows batch file AUTOEXEC.BAT is reqmred to initialize the disk
operanng, system when you switch on your PC. v
In 8-bit microprocessor CP/M (Control Program for Microprocessor) is the operating
system. However. in 16/32 bit processor. opérating systems such as. MSDOS, MS.

Windows. UNIX etc are used and they are becoming very much nepalar,

27



Windows:
windows is the most familiar operating system on home and effice PCs, and is wholly

owned by Microsoft Corporation. Most stand-alone PCs currently run on Windows 95 or
Windows 98 (often grouped as Windows 9x) or Windows Me. Thesc operating systems
are derived from the carlier Microsoft Disk operating System (MS-DOS) and a GUI
simply called Windows. From the launch of Windows 95. the GUI was integrated into the
operating system and opens automatically whep the opcrating system is loaded. Plain text
files can be viewed without the henefit of the GUI using the DOS shell (a shell is an
interactive interface between the user and an:operating system, i.e. the part of the
program that interprets and executes user commands). The DOS shell can be accessed
from Windows by selecting Start, Programs, and MS-DOS Prompt. MS-DOS and early
versions of Windows were designed to run on stand — alone PCs. Now networks of
computers are commonplace, windows have been developed as a multi-user opergg'i"ﬂg
system. In Windows N'I'.and Windows 2000, ditferent users can have access 10 bmfw
personal and common files. which may all be located on a central server. The latest
version of Windows, W}ndows XP, is available tailored for either home (stand-alonc) or
business (network compatible) use.

UNIX:

Although Windows is the most popular operating system on PCs, most commercial
workstations and servers run under variations of an operating system called UNIX.
Unlike Windows, UNIX‘ is not owned by any of the large computer companics, and since
it is written.in the standard programming language C, it has been modified and improved
by many individuals, academic instructions and commercial companies for specific
applications. There have been several public domain releases of operating systems that
conform 1o the UNIX standard, such as GNU and LINUX. In particular, LINUX has
become very popular in the scientific community. LINUX can be downloaded from the
Internet or purchased at a nominal charge from one of several distributors. There are
numerous GUIs for UNIX-like systems, which can be made to look like the familiar
WindowsRor MacOS desktops. These include GNOME (GNU network object model .

environment), KDE (K deskiop environment) and CDE (common desktop environment).
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Other operating systems: |
Some older scrvers use the VMS operating system from the Digital Equipment

Corporation (DEC). Apple Macintosh computers have their own o;’)érating system called
MacOS. which has its own GUI. Therc is no éimple way to view files on an apple
Macintosh without using the GUI. Other operating system includes 0S/390, 0S/400 and

z/OS. which are uscd on some [BM computers.

Utility Program: -
There are many tasks commo‘ﬁ; to a variety of applications. Examples of such tasks:
I Storing a list in a desired sequence.
[I. Merging of two programs.
III. Copying a program from one place to another.
V. Report writing.
One need not write program for these tasks. They are standard and normally handled by
utility programs.
Like the operating system, utility programs are pre-written by the’ manufactures and
supplied with the hardware. They may also be obtained from standard softw_afe vendors.

A good range of utility programs can make life easier for the user.

3.2.3 Language Processor:
Computer can understand instructions only when they are written in their own language
~ called machine language. Therefore, a program written in any other language should be
translated into machine language. Special programs called ‘languaée proéessors’ are
“available to do this job. Tliese special programs accept the user programs and check each
staterent and if it is grammatically correct produce a corresponding set of machine code
instructions. Language processors are also known as translators. There are two forms
translators: ' '
1) Compligrs.

2) Interpreters.
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Compilers:
A compiler is @ complex program which translates the program written in the high level

language to a program in machine language. A complier stores the high level language
program, scans it and then translates the whole program into an equivalent machine

language program. The act to translation is called compilation.

Interpreter:
The second type of translator program, namely interpreter. is gencrally used in personal

computers. An interpreter is also a program which converts the high level language
program statements into the machine level language instructions which are immediately
executed. In this program no object code is saved for feature usc.

An interpreter translates and executes the first instruction before it goes to the second
while a compiler translates the whole program before execution. The major ditferences
between them are:

1. Error correction (called debugging) is much simpler in case of interpreter because
it is done in stages. The complier produces an error list for the entire program at
the end.

2. Compilers and interpreters arc usually written and. supplied by the vendor. Since a
compiler (or interpreter) can translate only a particular language for which it is

designed. one will ::ced to usc a separate translator for each language.

3.2.4 Application Program:

While an operating systcm makes the hardware run properly, application programs make
the hardware do useful work. Application programs are specially prepared to do certain
specific tasks. They can be classified into two categories:

Standard application program

Some applications are common for many organizations. Read-to-use software packages
for such applications are available from hardware and / or software vendors. Standard

packages include among others-

a) Sales ledger



b) Purchase ledger
¢) Statistical analysis
d) Pay roli

e) Linear’brogramming

1) Inventory management

Unique application program
There are situations where one may have to develop one’s own programs to suit one's

unique requirements. Once developed. those programs come into the category of unigue

application packages.

- 4.0 COMPUTER LANGUAGE:
: Compute‘f programs are usually written in some specific languages, which
are known as computer language. It may be of two types:

4.1 Low level language :

“Low level language is a machine language. It is the énly language that
machine understands. In this language all instructions and data are
imparted in ter;ns of binary digits that are 0 and 1. An instruction in

- machine language has two principal parts. The first part is the

- command or operation part which informs the computer of the
functions to be performed. Each computer has an operation code or op
code for each of its function. The secand part of t.}ie instruction is the
operand part. It tells the computer the address or the storage locations
‘where the data or other instructions are fo be stored or found. A typical
example of such instruction is. ADD which directs the computer to
perform the arithmetic operation of addition. The second part "namely
0015, i1s the address part which tells the computer location of the

nufber in the storage which is to be added. It should be noted that
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0015 is not the data to be added but is the address number of storage

where the data can be found.

4.2High level language:

During the early stages the use of computers was confined to a class of
experts such as engineers and scientists. This was due to the fact that
knowledge of computer design and circuitry was essciitial to handle the

computer. With the advancement of technology computers with larger

‘memory capacity and higher degree of reliability and efficiency were

developed. These developments in computer technology opened a new
era with the potentiality of computer applications in a wider field of
human activity. These facts necessitated the search for ways and means
by which common non-expert persons can effectively use the computer

to solve problem and need not be concerned with internal logic circuits

.¢f the machine. Some programming language almost similar to natural

languages, such as English should be developed which will be
translated automatically to the machine language by the computer and
then executed. This necessity leads to the development to high level
languages. The programs in high level languages are writtén in simple,
concise'bui precise and unambiguous notations of natural languages

and are oriented towards a particular class of processing problems. |

5.0 DESKTOP

| The desktop is the overall work area while in WINDOWS. It's called the desktop because
WINDQOWS uses our whole screen in a way that’s analogous to that we would use the
surface of a desk. The desktop can contain several rectangular areas, in which an
application or a program displays information and these (different windows) can be

overlap dn the screen. Users can easily rearranging windows (opening. closing,
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expanding, moving etc.) and the working window calied as active window. Other
windows which are not acuve are treated as inactive onc We can move between different

apphcatmn wmdows by pressmg ALT+TAB.

In graphical computing. a desktop environment (DE) commonly refers to a style of
graphical user interface (GUI) that is based on the desktop metaphor which can be seen
on most modern personal comp(uers today. Desktop environments are the most popular
alternative to the older command line interface (CU) which today is generally limited in
use to computer professionals.’ A desktop enviromr;ent typically consists of icons,:

windows, to'olbars. folders, wallpapers, and desktop widgets.

Software which provides a desktop envirbn_ment_ might also provide -drag and drop
functionality and other features which make the desktop metaphor more complete. On the
whole, a desktop environment is to be an intuitive way for the user to interact with the
computer using concepts which are similar to those used when interacting with the

physical world, such as buttons and windows.

6.0 WINDOWS 98 _

Windows '98 is MS Corporatxon s product with a face lift and rchabnhty xmprovcmcnt lt
Wus launched in beginning of year 1998. It is a 32 bit single-user. mulmaskmg
mulmlneadcd opcrdtmg system which supports OLE. DDE and 32-bit nuwork drivers as
well as support for the increasingly popular TCP/IP protocols for accessing the UNIX-
based system such as the Internet. The upshot is that a WINDOWS 98 workstation will

interface easily with most existing Local and Wide Area Networks.

6.1 Main features of Windows ’98:

WINDOWS EXPLORER: Special interface _

Explorer is a special new feature: that replaces f’rogfam Manager and files manager
reamrw of the previous versions and make mulmaskmg feature more easier for new

llht?l"s
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Supports long file name:
Supports long file names rather than the severely hmltcd 8.3 character file names used by

DOS. WINDOWS 98 supports filec name up to 255 characters, which can be changcd

automatically, when called from other environment (such as DOS) in 8.3 character format

if required.

PuP Feature:

Suuports the new Plug-and-Play (PnP) standard being developed by PC makers that allow
you to simply plug a new board (or interfacing card. like Sound Card. Network
Interfacing Card etc.) into our computer without having to set switches or make other

settings like IRQ. WINDOWS’98 will figure out what we plugged in and make it work.

No more configuration headaches.

Backward Compatibility: ,
WINDOWS 98 supports all types of applications those are originally based on DOS or
previous versions of WINDOWS and exccute them properly.

Better Networking Supports:
WINDOWS 98 provides bunlt-m peer-to-peer networkmg and also mcludcs Remote-
Access Services, which allow users on the road to call into a WINDOWS "98 nctwork or

vice-versa.

6.2 WindowAContro‘l:

a) Minimize button: Click it to reduce the window to a button on taskbar when
working with document winc‘iows,~ click 1t to reduce the window to a button wi;hin
the application window. | o ;

b) Maximize Button: Click it to enlarge the window from rcStorc position to fill the
screen or application window.

¢) Close Button: Click it to close thc_: window.
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d)

g)

h)

System Menu Button: Click this to open a menu of commands that control the
window. E.g. Restore. Minimize and Close. Generally each and every application
displays their related icon on this position. '

Taskbar: Click bﬁtlons on it to select/activate a window that is currently inactive
or 1o open a window we have minimized.

Title bar: Drag it to move a window or double-click it to maximize/restore the ‘
window. Maximized windows cannot be moved or sized. Title bar always holds
application/file name.

Scroll Bar: Generally two typcs'of scroll bar - Honzontal and Vertical. Scroll
bars are always present with scroll buttons and scroll box. These are used to ‘pan
across’ the information in a window: up. down, left and right. This is necessary
when there is too much information (text or graphics) to fit into the window at
one time. Scroll bars have a little box in them called the scroll box, some times
called an elevator. Just as an elevator can take us from one floor of a building to
the next. the scroll bar takes us from one section of a window or document to the
next. The elevator moves within the scroll bar to indicate which portion of the
window we are viewing. By mo?ing also the scroll box with our mouse, we can
aiso scroll the window. By pressing scroll buttons that can also done.

Sizing Corner: The particular area from where we can start the resizing of the
window. But it can be done by dragging any border or corner of that window

when in restore position.

7.0 MY COMPUTER:
My computer is a system folder which holds all drives and special folders like

Printers. Control Panel etc. that means from this area we can get to any aspect of our

computer from opcning a document to adding a device drive or establishing a remote

access dial-in connection. Through this application window we can very easily access

the properties of a folder or a document. if we are in “view like web page” option.

lust like given figure, where we select hard drive (¢:) and in left hand window we

recetve detail information about that drive. like Total Capacity. Used Spaces and Free

Spaces remain in the drive. That's why My Computer is popular place for new user.
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A sfctmn of chrowﬁ Wmdows that was:. mtroduced with the release of Microsoft
Windows 95-and mcluded with all versxons of Windows after that. My Computer allows
' thc user to cxplore thc cdntents of theu' computcr drives as'well as manage their cOmputex
“files. To the right, the top- unage i$ an example of the My Computer .icon in Mlcnosott
Wmdows XP. Wxth the introduction of Wmdows Vista, Microsoft changed the traditional
My Cotirputer icon to Computer. the bottons i image to the right issan example of what this
icon looks like. Although the. name has changed-this icon still acts identical to the earlicr
My Computer. | B -
Openihg the My Compntcr:
" 1. Getto the Wmdows Desktop
2. Double-chck the My C omputer icon; this i xcon xs almost always located on the top-

left ponwn of the desktop and should look sumlar to thc icon above. Below are
L two. examples ot what should appear when My Computer is open

;vma-:) Dlsc(F) page:_

T c! ‘w-‘(SI |

Fig)}; Drive listing in My Computer
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" Fig s: Browsmg My Computer in Wmdows 2000

If you wssh to manage your computer md/or view other seumgs and mfonnatxon about
your ¢computer 1mtead of' doub!e-c.hcking the ‘My Computer lcon to open xt, mnke a. '
right-click on the *My Computer* and click propcmes. Performmg these steps wxu open
your System’ Pmperties (the same wmdow accessxble through the Control Panel)

° Addmonal mtormauon about: how to enable lhe My Computer icon to be
vd:splayed on the. desktop if mxssmg can be found on document CH000927

s See document CH000906 for additional information about gettmg the My
Computer icon above My Documems o

» Information about how to make My Computer dxsplay the ﬁles the same way cach B
time you open a new wmdow can be found on document CHOOO770 |

» Additional mformat!on about how to change how files are shown in My Computer‘
can be tound on document CHOOlOl 5
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8. O'Recycle Bin:

ln the chrosoﬁ Wmdows operating systems the Recyele Bin i isa holdmg area for files
and folders that are held before final deletxon from a.storage device. It temporarily holds
things that we delete. That's why items a.te.not actually erased from our computer thh

the delete command, we can get them_back in case we made a mistake.

Mtcrosoft mtroduced the Recycle Bm in the Wmdows 95 opcratmg system. The Recycle -
- Bin keeps ﬁles that have been deleted whether accndentally or intentionally. Users can
_ revxew the contents of the Recycle Bm before deleting the items perinanently. In previous
Wmdows operatmg systems and in MS-DOS, undeletxon was the only way to recover
accxdentally deleted files. The Recycle Bin holds data that not only lists deleted files, but
~also the date timeé and the path of those files. The Recycle Bin i is opened like an ordinary
Wmdows Explorer folder and the ﬁles are viewed sumlarly "Deleted files may be

removed from the Recycle Bm by restonng them thh a command or by deletmg them

-_ pcrman_ently

The Recycle Bin's icon. mdlcates whether therc are items in the Recycle Bin. If there are
no files or folders m the Recycle Bm thcn the icon resembles an empty wastepaner

- basket. Otherwxse 1f there are ﬁles and/or folders the icon resembles a full wastepaper

basket.

Prior to Windows Vnsta the default conﬁguratlon of the Recycle Bin was to hold 10% of
~ the total capacity: of the host hard disk drive. For. example on a hard drive thh a capacnty |
of 20 gigabytes, the Recycle Bm w1ll hold up to2 gxgabytes If the Recycle Bin fills up to |
maxxmum capacnty, the oldest files will be deleted in order to accommodate the “newly
deleted files. If a ﬁle 1s too large for the Recycle Bin, the user will be prompted to
permanently delete the ﬁle instead. The max1mum possible size of the Recycle Bin is
3.99 glgabytes in all veremns of Windows except Vista. In Vista, the maximum is 10%
'ior drives up to 40GB Above that, the maximum is 4GB plus 5% of the capacity above
40GB. Similar recycle bm features exist in other operatmg systems under various names.

For example in Apple's _Mac 'OS and various Linux distributions, it is named "Trash’. A
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“I'rash' folder was a feature of the Macintosh OS since the beginning. It is believed that
the recycle bin was first invented by Xerox PARC. '

Files arc moved to the Recycle Bin in a number of ways:

* By right-clicking on a file and selecting delete from the menu

*. Selecting the file and pressing the delete key

* Seclecting delete from the side menu in Windows XP

e Selecting the ﬁlc and choosmg delete from the File menu (in Windows XP
Pxplorer)

» From a context menu command or some othcf function in a software application
(usually configurable)

* By dragging and dropping a file into the Recycle Bin icon

It is also possnblc to bypass the Recycle Bin and directly delete a file by holding the
_ SHIFT key while performing one of the above mentioned delete techniques.

9.0 INTERNET

The internet is a huge network of computers conncctcd by cablcs throughout the world.
Information can be collected from any of the computer which is connccted to this
network. Two other tcrms related to this may also be defined. o ‘
INTRANET : It is local area nctwork (LAN) which connects several computers
’ within a busmess
" ’ "EXTRANBT It is a smaller network that looks and acts like larger global internet. It

is generally used to connect the computers of two or more business.
Requirements of the internet:

. » Personal computer
# Modem
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» Internet service provider (ISP)

» Telephone line

9.1 Modem
A device that connects computer to a telephone is termed as modem. [t converts the

digital data of the computer into the analog signal. Three models of modem are available

o External Modem: Resides outside the computer

¢ Internal Modem: A'modem that is installed inside the computer, leaving only a
telephone jack exposed out the back of the computer. '

» PC card modem: In case of laptop computer PC card modem is used. It fits into

the PCMCIA slot in laptop computer.

9.2 ISP »

Internet service provider is necessary to get connection of internet. It acts as an agent for
providing internet connection. To get ISP an accoupt is needed. If is nceded to sct up a
new Internet account, the windows Internet connection wizard can be used. A local ISP
might be better equipped than a national provider. One can learn about ISPs fro‘m his/her
area from news papér or personal connection. ' i

9.3 World Wide Web (Www) .

The World Wide Web (WWW) is a way of exchanging information over thc Internet
" using a program called a browser. A number of browsers are available for working on the
WWW, the most widely used of which are Internet Explorer and Netscape Navigator.
‘Most computers are sold nowadays ‘Internet ready’ with'the appropriate hardware and
one or both of these browser programs installed as standard. The WWW was developed
in 1992 and allows the display of information pagers containing multimedia objects (e.g.
text, images, audio and video) in a special format called hypertext. In a hypertext
* document, text is displayed normally and can be read and manipulated like any other text
document. but some words and objects are highlighted in a different color and these are

known as Rypertext links (or simply hyperlinks). Clicking on a hyperlink directs the
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browser 1o access another hypertext document, which might be gn the same computer or

might be on any other computer linked to the'lnterngt. The new document may have its
own hyperlinks and thus the process can be repeated allowing the user to movc“rapidiv
from computer to computer around the world downloading information as he or she goes

(this is commonly known as surfing the weh or surfing the net).

The WWW warks on the basis that each hypertext dociyment has a unique addrcss known
as 4 uniform resource locator (URL). URLs take the format http://restofaddress. wherc
“http:/”" identifies the protoco! for communication over the WWW (hypertext transfer
protocol) and ‘restofaddress’ provides a location for ‘the hypértext document on the ,
Internet. Every computer on the [nternet has an TP address. which. is in the form of four
integers conventionally scparated by dots. Assbciated wu(h this is a text version of the
address, for example http://www.bios.co.uk. which ‘is the pubhsher s address.” The
equivalent IP address for the publisher is:195.172.6.15.If a local user trics to contact
http:./!www.bios.c_o.uk. how does the browser find the correct site? The local computer
first-contacts Internet computers " called Domain Name Setvers (DNSs) that try to
understand parts of the address starting with the most significant (right hand) part. For
example. most text addresses have a country abbreviation. in this case “uk’ for United
Kingdom. but American addresses do not since the Internet was an American‘invention. -
If the computer one is trying to access is providing a service on the WWW., it is known as
a web server. This means there arc numerous files available for browsing. and each. can
be identified by a unique URL. Such files are specified by extra characters sépalfatcd
from the main Internet addrcs"s by a solidus (). For example, the URL.
http: “wwav.bios.co.uk/bioinformatics refers to a subdirectory on the publisher's web
" server that corresponds to the web site accompanying this book. Once the DNS has found

the dnternct name for the scrver, it is for the server itself 1o work out what do about any

extensions to the URL such as - /bioinformatics .

9.4 Browsing, Working and Downloading
Browsing tic Internet is simply a case of clicking on the desired hyperlinks and allowing

the associated pages to download. Some pages download faster than others, which may
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be due to content (pages with many images and other large files will take longer to
download than pages that contain text atone) or due to the speed of connection (there are
bottlenecks in many parts of the Internet, and it is advisable to find a local web server to
minimize the number of routers the information has to pass through). [t is also notable
that the Internet will be busier at certain times of the day, and during the weekends when
recreational use increases. Many bioinformatics sites are hosted by several web servers in
different locations arouhd the world to reduce such bottlenecks. Different web servers

3

providing the same service are called mirrors:

To access a particular web site, it may first be necessary to type in the URL in the address
bar of the browser. Once a page has been accessed, however. it should not be necessary
to type in the URL again. Browser programs maim.ain a list of URLs that have been
visited (the History file) and any URL can be added to a list of favorites (in Internct
Explorer) or Bookmarks (in Netscape Navigator) to allow easy access in the future.
Where does one start on the Internet? A number of public search engines are available
dllowmg the user to search for sites of .interest using pamcular keywords but it' may be.

better to start with some dedicated bioinformatics sites.

10.0 BIOINFORMATICS

onmtormatxcs is the combination of biology and mformanon technology. The

discipline encompasses any computanonal tools and methods used to manage, analyze
and manipulate large sets of biological data.
Bioinformatics incorporates the development of databases
s 1o store and search the data
e to use statistical tools and algor'ithm to analyze and deteymine relationship
between biological data sets , such as macromolecular sequence, structures,
cxpression profile and biochemical pathways. -
10.1 Fields of Application of Bioinformatics:
Bioinformatics covers various fields of biological sciences, some.of which are pointed
out below: |

Sequence analysis: Helps in sequencing DNA, RNA, protein etc.
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Genome Annotation: Annotation means the process of marking genes and -other
biological features in a DNA. Computer can be used to predict whgre the genes are in
genomic DNA . ‘

Gene Expression Analysis: Several techniques; viz., DNA micro array, Serial analysis
of gene expression (SAGE), Massive parallel signature sequcncing‘ (MPSS). etc are
applied. Clustering algorithms are used to determine gene co-ékpression. '
Protein Sequence Analysis: Protein micro arrays & HT mass spectrometry (MS)
provide information of protein in biological sample. ‘
Structure Prediction: Structure prediction of different macromolecule is performed.
Prediction of protein structure is made by comparative modeling and fold reco‘gniition. '
Computational Evolutionary Biology: Origin and descent of species and their changes
over time may be determined by suitable software. Phylogenetic analysis of protein and
nucleic acid is also done. Development of phy_togenétic tree. binary tree or cladogram,
has been developed. _ |
Modeling Biological Systems: Computer simulation of different system can bé made.
Differcm physiological processes, e.g.. signal transduction, enzymatic pathway..gc'nc
-regulatory network. have been simulated. '

Preserving Biodiversity: Information of biodiversity, viz., name of species, description,
distribution, population size. habitat etc. have been computerized. |
Ex: Species 2000 project (internet based global rescarch) _
Biomedical Informatics: There are various applications in this field- image analysis,
clinical imag;: analysis and visualization, quamif‘xcaiion of occlusion size. real time flow -
pattern. analysis of pictures of embryo & fate of cell clusters, analysis of mutation in
cancer eic.

~Dietary Analysis System: Appl'ications in this field include computerized data anéﬂysis

of dietary panerﬁ. nutrient database (Ex: USDA, INFOODS, PDS).

Biological information is stored on many different computers around the world. The
casiest way to access this informatiop is for the computers to be joined together in a
network. A computer network is a group of computers that can communicate, for

%
cxample over a telephone system, therefore allowing data to be exchanged between
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“remote users. Foi transfer, biological data are first broken into small packets (units of

mtormduon) which are sent mdependcmlv and reassembled when they arrive at their
dcstmalwn If information is sent from one computer (say. A) to another computer (say,
C). it}caﬁ travel via two ditferent routes. In one case computer B acts as a router, and in
the, other case computers D and L both act as routers. The availability of different routes
through the network means that communications can be maintained between computers

A and C even if part of the network is unav. ‘lable. for example if computer B ceases to

function.

Having got the feel of bioinformatics on the WWW. what are the mcfits and demerits of
installing software locally, rather than using a WWW site? Although locally installed
software will usually run faster than the same apphcanon used over the Internet. some
sofiware is difficult to install and might need expert help. There are advantages in having
local copies of simple sequence alignment and other software if you are working "at
home’ that is. limited by rates of data wransmission on telephone lines. However. the use

of locally mstalled databases can be disadvantageous because updates will be published
lcss frequently than the WWW-based versions. Many academic institutions have an

Intranct. that is. a local network that can be accessed only from computers within the

institution. Such local networks may provide a number of bioinformatics tools and

‘applications, which will usually run just as fast as Jocally installed software.

10.2 Scarching the Internct:

AItHough the nine web sites provide some of the best starting points for bioinformatics on
the WWW. there is a great deal of specialist biological data that cannot be accessed
direcﬂy from these sites. Finding relevant data on the Internet is made simpler by the
availability of gencral-purpose search engines, such as. Google. Yahoo. Lycos, Alta

Vista and Hotbot These tools search the entire Internet for pages that contain particular

keywords or phases. and they can also be used to search for files of a particular type. such

as image files or video files. For example, one might search the Internet using the phrasc
“alcohol dehydrogenase¢’ to {ind pages containing irformation about that enzyme.

Alternatively. cne might look for image tiles of a particular insect or flower. or video
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files of frog dé:velopmeht Relevant sites are &isplayed as a list of hits; with hyperlinks

allowmg dxrect access to "the page of mterest The problem with general purpose search

engmes is that they have not Been devcloped specrfica!ly with molecular blology inmind,
“and the mformauon they provrde can.be m-elevant or mxsleadmg. especrally if the search
term used has other cormotatlons
: As an altematrve to search engmes, “the home pages of academrc mstxtutxons or
brotechnology com‘pames ‘can. also be P good place to start Many unxVersrtxes, for,
example mamtam comprehensrve web sxtes with- pages for staff to descnbe research:
prpjects and dtsplay data, and such sztes often contam hyperlmks to0. srtes of related"

mterest
On a general-purpose search engme it is probably better to start thh a set of key words '

that is. very restrictive and then remove some of the words if no hits are generated. If a
search term is too broad (e.g. ‘bxochemlstry ) it will produce a ridiculous number of hits
and it will be impossible to check all the hsted pages Search terms with known
'_ _altematrve uses. are also best avoxded For exam;)le, searchmg the Internet with the word
*steroid” wrll hkely hrt more pages on body-buxldmg than molecular bxology A posmve ’
- .suggesucn 1s to use a htexature database on the WWW .such as Pub Med to-look for

useful and appropnate keywords and phrases to.use as search terms.

10.3 Software frame works for bxomformatrcs
Software is a collectrve term for the vanous drfferent programs -that can fun on :
| x:omputers Soﬁwarc is dlstmgurshed from hardware Wthh ‘refers to physrcal devxces |
" such as the processor, dtsk drwes and momtor Ona stand-alone computer ‘software is
divided into two categones system soﬁware and apphcatlon software System software
'essentmlly compnses the computer’s. operatmg sys tem and any other programs requrred
to run applrcatrons while apphcatron software is installed by the user for specxﬁc .
purposes (e. g word processmg, image analysrs etc) On networked computers, programs
can also be run remotely The same applxes to' comput‘ers attached to the Internet
104 Programs and programmmg languages‘ | |
Computer programs can he ‘wiittefi: m a varlety of programmmg languages whxch are

conventxmrally descrrbed in terms of three levels The first level i 1s machine cocle ‘which
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is the binary code used by tie computer’s own processor. The second level includes a
humber of languages known as assembly languages. The third and subsequent levels are
grouped as higher-level languages and include widely uséd programming languages such
~ as Pascal .and C programs written> in assembly and for higher-level progrmming
languagcs must be COnvcrted.into machine code before they will run. Foe assembly
- languages, this process is known as assembly. and for higher-level languages it is known
aé compilation: In WindowS. files in machine code are known as executable files and
héve the extcnsipxi .exe. There are no rules or conventions for naming such files in UNIX
| systéms. and they ‘are kijwn as executable images. These files can be created and stored
in the computer’s memory until the operating system is told to rtjn them. Alternatively,
assembly or compilation can be carried out ‘on the fly’ if programs are cxecuted

~ remotély, for example over the Internet.

.16.4;1 Seript§ and t;cripting languages:
' Exécu&able files (Windows) are executable images (IUNIX systems) are written in
maching code and are run by the computer’s processor. Other program files are désigned
1o .be'executcd by another program. and such files are known as scripts. Thérc are variety
of scripting languagt_és that can be used. including Microsoft Visual Bé;ic, JavaScript and
PERL. Script langtiageé are-casier work with than compiled languages, but take longer to

process, so they are ideal for short programs.

10.4.2 :Popular Alanguages in bioinformatics:
A number of 'progrémming, scripting and markup languages are popular with
bivinformatics because they are versatile and cén integrate a wide variety of types of data

cither in a stand-alone environment or over the Internet. Some of these languages are

discussed below.

o HTML and JavaScript |
- HTML is hypertext markup language. a language used to specify the appearance of a
‘hypertext document, including the positions of hyperlinks. Since HTML is not a

programiing language, basic hypertext documents are static. JavaScript is a popular
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scripting language that adds to the functionality of hypertext documents. allowing web

pages to include such features as pop-up windows, animations and objects that change in

appearance when the mouse cursor moves over them.

Java
Java is a versatile and portable programming language that is designed to generate

applications that can run on all hardware platfonﬁs, from large servers to individual PCs,
without modification. The Java source code i$ based on C¥* and can be run in a stand-
alone fashion or from within a hypertext document, in which case it is called an applet
(small application). When executed, a Java program is converted into an intermediate:
language called byte code. which is compiled into, machine code as the program runs.
Browsers must incorporate a Java plug-in interpreter called Java virtual machine for this
purpose. Java applets may take a jong time to download but the perfommance of the applet
is not dictated by activities of the server. Java is a full programming language and is not
the same as the JavaScript, which is a scripting language. The name s are similar because
both languages use a similar syhtax. As discussed above, JavaScript is used primarily to

cnhance World Wide Web (WWW)' pages. while Java has a much broader scope.

PERL _
PERL (Practical Extraction and Reporting Language) is a versatile‘scripting‘ language,
which is widely used ixl_bioihformatics for applications such-as the analysis of sequence
data. PERL is a free product, ‘provid'mg compatibility with Windows. UNIX or other
o;ﬁ_erating systems. [t has excellent facilities for file handling and uploading and

downloading files over the WWW.

XML

XML stands for Extensible Markup Language. This is a new standard markup lahguager
that allows files to be described in iermS' of the types of data they contain. As a
replacemen't for HTMI.. XML has the b‘advamage of controlling not only how data are
displaycqi\ ona WWW page, but also how the data.is processed by another program or by

a database management system.
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10.5 Running programs over the Internct:

Software does not have 1o be downloaded and installed on focal computers but can be run

over.the [nternet. This can be achieved in two ways. If the programs are client-side. they
are supplied for example as JavaScript or Java applets that are embedded in HTML
within a hypertext document. The utility of these programs might be limited by the
capacm of the local machine. Furthermore, although both Internet Explorer and Netscape
Navigator support JavaScript. the script is interpreted n shghdy different ways by the
two srowsers. [here is currently no clean solution to this problcm. The alternative is to
use common gatcway interface (CGI)® px‘()granms or Java servlets. in which case the
softwaré is run on the server itsell (the programs are sever side). Server side programs
can be written in machine code or in a scri pting language such as PERL or Java. ftis easy
to detect whether the software is runmng on a server because the URL will typically end
with the extension .cgi. The performance of CGI programs is dependent on the number of
current users (the server load). Some servers avoid bottlenecks by carrying out client

~insirjctions (e.g. homology searches) in their own time and then e-mailing the results to

the client.
.l0.6 DATABASE MANAGEMENT IN BIOINFORMATICS:

10.6.1 Flat files and markup languages:

Ona wmputer 'system, a file is a discrete collection of bytes that can be mampulated
(moved. copied. deleted etc.) as a single entity. A file may either constitute a program or
‘a data file that is processed by a program (e.g. a document that can be read by Microsoft
Word). In the context of bioinformatics. files are used to store structured biological data.
Most raw biological -data can be stored in the form of text, for example nucleotide and
protein sequences. protein structural coordinates and matrices of gene expression profiles.
Text files can be handled by various software applications such as text editors (c.g.
Simple Text), Internet browsers (e.g. Internet Explorer. Netscape Navigator) and word
processor  applications (e.g. Microsoﬁ Word. Corel WordPerfect). Other types of

hiological data are stored as images. for example gene expression patterns and pictures of
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two-dimensional-protcin gels. In some cases, the raw data in the i_magcs arc converted
into numbers that can be stored in text files. For example. this is the case for micro array
image data.

\lost software applications that handle text include a markup language that specifies how
the text should be displayed on screcn or in a printed documient. These instructions
comprise hidden character scts. known_as tags. In Microseft Word, for example, the
markup languagc controls the font. size. color. paragraph structure etc. of the text. Other
familiar markup languages include HIML (hypertext markup language). which controls -
‘the display of text on WWW pages and cnables hyperlinks to be inserted. and XML
(extensible markup language), which allows the integral description of data objects. Such
tags are often transparent. however. if the text is used by another software application,
such as a sequence analysis program. Therefore, it is best 10 save biological data files in a
simple format with no markup language. These text only files are known as flat files.
Text editor programs such as SimpleText and NotePad are suitable for handling flat files,

and flat files can be gencrated in word processor programs such as Microsoft Word by

saving as text only.

10.6.2 Databases:

A database is a collection of structured information, often stored in the form of tlat files
in the case o bioinformatics data. Individual database cntries are known as records and
cach record comprises the same sct of fields (categories of data). For example. in a
sequence database such as GenBank, cach record represents a deposited sequgnce and
ficlds include accession number. sequence name, taxonomy of source species, literature
refcrences, and the scquence itself. Computer databases are usually associated with
software that allows the information to be accessed; amended and scarched. This software
is known as a database management system (DBMS) and also controls the security and
integrity of the data. Searches are made possible by indexing the records. which in the
case of flat files is achieved by looking for text strings in particular fields. In the case of a
sequence database, the accession number could be used for index purposes. Several

different types of database are usced in bioinformatics,
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A relational databasc is organized as tables. each tablc comprising a group of records

(also known as tuples) with the same ficlds (known as attributes). This allows related data

to be linkcd (reasscmbled) as rcquired without reorganizing the original tables. For
examplc. a sequence table might contain records with the attributes accession number
and protein sequence. while a function table might contain records with the atuributes
accession number and protein function. Matching attributes in different tables can be
joined to bring together related records, in this case linking protein sequénce and protein
function. The industry standard language used to interrogate and process data in a
relational databases is SQL (symbolic query languagc) This is mcorporatcd into familiar
and widely used relational database management systems such as Microsoft Access and

Oracle.

An object-oriented database has a more flexible organization, that is, it does not depend
on the formal tablc, row and column’ format of relational databases. Data are defined as
objccts. which have a class hierarchy. that is, they can ‘be grouped into classes and
subclasses elc. in a hierarchical manner. Properties attributable to classes of objects are
inherited through the hierarchy; these may be general in the upper levels of the hierarchy
but may become more specialized in the lower levels. Properti layeres or procedures
attributable to data objects are known as methods. The flexibility of the data organization .
in object orientated databases allows more complex relationships between datasets to be
modeled than is possible with relational databases. Objcct-oriented database management
systems are also capable of handling multimedia objects (pictures. videos and audio files)
while relational DIBMSs are often restricted to numbers. alphanumeric text and dates.
Pure iject-oricntcd DBMSs include Object Store and ONTOS DB. ACeDB (A C
elegans database) is an example of a customized object-oriented database. It is more
common to scé bioinformatics databases incorporating relational DBMS- features i an
objcct-oriented programming environment. Such object-felational DBMSs are generally

accessed using a language based on SQL.

Developments in object-oriented programming have led to attempts to have object
definitions that are common across different corpputer systems. This is uscful for thse

intcgration of distributed databases, that is, databases that are physically stored on two or
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more separate computer systems. An interface definition called CORBA (Common

Object Request Brokering Architecture) has been* developed which can be used to
integrate large distributed bioinformatics databases. Software such as CORBA that

functjons as a conversion or translation layer in distributed systems is sometimes called

middie ware..

11.0 CONCLUSION: :
Computer is- essential for every field of biological sciences, including botany. The

students of biological science showd learn diffcrent aspects of computer and extract
beactit from it. The knowledge of hardware will help them to operate the computer in a
better way and enablc them to rectify minor hardware related problems. If they can learn
software they may be cable of writing application software for solving small
computations. The usage of internet will be a great help for acquiring subject related
information from diffcrent wcbsites. Bioinformatics is comparatively new ﬁeld; however.

it has isnmensce potential for guiding research and development.

12.0 SUMMARY:

Computer is an electronics device capable of computation with high dcgree of accuracy
within a very time The computer is composed two main components — hardware and
software. The hardware consists of CPU and peripheral devices. The CPU has three
subunits — control unit. arithmetic-logic unit, and primary memory. The primary memoty '
consists of Read Only Merﬁory (RAM) and Random Access Memory (RAM). Therp.are_

several types of software - monitor program, operating system. utility program, ianguagc |
processor and application program. There different kinds of operating system. e.g.. DOS,
Windows. UNIX ctc. Windows is the most popular operating system. The Windows
system works with dcsktoﬁ. which contains different elements like, 'iny computer’. files,
folders. title bar. scroll bar etc. Internet is global connection of computers through
telephone lines. It requires a'computer. modem. ISP. and telephone line. (e can enter
into the network through the WWW. the World Wide Web. Each website has an URL
(uniform resource locator). The information can we accessed by means of a web browser

like. Internet Explorcr. Search engine, such as, Google or Yahoo scarch etc. Different
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kinds of software help to down load desired information. Bioinformatics is the

combination of informatics and biological sciences. The computer and internet are

essential for bioinformatics. Different languages, Viz.. Java, PERL. XML. HTML etc are

popularly used in bioinformatics. Bioinformatics can be applied in various field

including. sequence analysis of protein. DNA. RNA etc. prediction of structure of

macromolecule. genome analysis. preservation of biodiversity. phylogenetic study and in

other fields. Different kinds of databases are formed in bioinformatics and various types

of software are used for the management of database.
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14.0 MODEL QUESTIONS:

14.1 Short questions:

1.
2.

-
J.

Slate the functions of ALU?

What is semiconductor memory?

Mention the function of optical character recognizer?
What is the advantage of using EPROM?

What are the components of bioinformatics?

What do you mean by hard disk?

What is search engine?.

*h
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8.
9.

What are the difference between source program and object program?

What is assembly language?

10. What are the requirements of internet?

11. What is modem? State the features of different types of modem.

12. How can you download data by I'TP server?

14.2 Long questions:

1.

2

Discuss the basic structure of the computer with a diagram.

What do you mean by RAM and Rom? Discuss different types of RAM and
ROM. |

‘What do mean by 1/O devices? Described different kinds of input devices of a

computer.
State the importance of printers. Discuss different types of computer printers
mentioning their advantages and disadvantages.

What is meant by computer software? Discuss, in brief, different types of
software with their importance.

Discuss in brief about different languages used for bioinformatics.

Discuss the database management in bioinformatics.

Discuss the importance of WWW for gewting information from internet.
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Introduction

Starting word 2000

Menus and toolbars

Add or remove buttons menu

Arranging buttons on the toolbar

Creating, cditing and saving a word document
Deleting text -

Automatic spelling and grammar checking

Disabling the automatic spelling and grammar checker

. Autocorrect feature

. Formatting marks

. Naming and saving document

Opening 4an existing document

. Choosing a view

Navigating the document

Scrolling through a document by using the mouse

. Scroll through a document using the keyboard

Go to a specific location or item using go to feature

1.19. Find text in a document

1.20. Cut, copy and paste text

1.21. Undoing and redoing changcs
1.22. Keyboard shortcuts

1.23. Applying formmating to text
1.24. Additional text effect

1.25. Format painter

1.26. Changing paragraph aligniment
1.27. Changing the paragraph spacing
1.28. Bulleting and numbering

1.29. Add borders and shading to a paragraph
1.30. Adding header and footer

1.31. Create special cffects with text




1.32. Printing in multiple columns
1.33. Link document

1.34. Creating a table

1.35. Working with graphics

1.36. Mail merge

1.37. Previewing and printing a document

Section 2: Excel 2000

2.1. Introduction

2.2. Excel 2000

2.3. Qsening of Excel 2000

2.4. Opening a file

2.5. Saving a Workbook

2.6. Workbook

2.7. Exccuting commands

2.8. Wizards

2.9. Creating and using templates
2.10. Working with Worksheets
2.11. Entering Date and Time
2.12. Entering data in a series
2.13. Manipulating cell contents
14. Formatting rows and-columns
.15. Password-Protecting a Workbook
.16. Ranges '

.17. Quit from Excel

2.18. Formula

2.19. Entering a formula

2.20. Naming cclls

2.21. Functions

2.22. Formatting

2.23. Printing 2 Worksheet
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Section 3: Programming in C

3.1. Introduction

3.2. The C character set

3.3. Constant data

3.4. Variables and arrays

3.5. Declarations

3.6, Expressions

3.7. Mathematical functions

3.8. Assignment statement

3.9. Input/Output statements

3.10. Complete programs

3.11. Control statements

3.12. Decision making and bfanching

3.13. Worked out examples .

3.14. User-dcfined function
Module summary
Self assessment questions
References '
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This module is divided into three sections to discuss three important topics - MS-Word,
MS-Excel and C language. In section 1. the MS-Word is introduced in very simple way
and discussed its most common topics. The Section 2 is devoted to MS-Excel. The basic
features of Excel 2000 are discussed hcre. In last section, an introduction of C
programming language is given. This section will help the learner to writc simple
programs. ' :

Objectives

Gone through this module you will learn threc 1nain topics MS-Word, MS-Excel and

programming in C.

¢ & & o ¢ o o

Opening and working with MS-Word
Formatting of a Word document
Printing of a. Word document
Opening and working with MS-Excel
Use of functions

Formatting of a Excel workbook
Printing of a Excel workbook

Basic concept of C programming
Input/output statements

Branching statements

Loop statements

Writing simplc programs

Key-words .
MS-Word. MS-Excel, C programming language.
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Section 1: Microsoft Word 2000

1.1, Introduction

Microsoft Word is one of the most popular amongst the word processing packages avarlab!c in

the market. Like any other word processor, the Word can create a new document such as letter,

memo, article, report or can modify a document that is already created earlier. Microsoft Word

may be used to type a text, edit existing text and format text to add craphasis, highlight ideas,

arrange text attractively on the page and to insert graphics, tables and charts as well as check your

Jocument for spelling and grammatical mistakes. Also Microsoft Word can use to create and

modify web pages that you can display on the Intemnct. ’

1.2. Starting word 2000 '

There are several ways to start Word 2000. A hst ‘of possible ways are glven below:

e Click on the Office 2000 shortcut bar.

» Click the Start button on the Windows taskbar. The Start menu appears. On the Start menu,
click Programs and then click on the Microsoft Word program to start Word 2000.

e Ifthe shortcut for Word 2000 is created earlier, then double-click on it to start Word.

e If the shortcut for Word 2000 is created in the Quick Launch bar then click on it to start
Word.,

Once you have started Word 2000, the application opens a new blank document as shown

in Figure 1.1,

.
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‘ l%éurc 1.3: Word Opening Window |

1.3, Memxs and toolbars
The Word opening screen contains a blank document, a menu bar and a toolbar in addition to the
usual W‘.xkows buttons. The menu bar organizes the commands in a logical manner, making it
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casy for yE)u to access the features which are needed. For example, the commands related to table
creation and formatting are grouped under thc Table menu. The menu bar as we have seen
contains a list of commands. The toolbar contains buttons in a horizontal or vertical row across
the top or on the sidc of the document window. Each button has a picture or icon on it
corresponding to a command. '

The Word 2000 dcfault setting for toolbars displays the most commonly used buttons for the
Standard and Formatting toolbars in a single row. By displaying only the frequently used
buttons in a single row, Word makes more space available for typing document. Word 2000 is a
very intelligent application. Once you use a command, its-button is added to the toolbar, replacing
another that is less often used.

For resetting the toolbars and menus do the following steps:

1. View > Toolbars > Customize. Click Customlze The Customize dialog box will appears.
2. Click the Options tab.

3. Click Reset My Usage Data button and click Yes when prompted.

4. Click close.

1.4. Add or remove buttons menu:

If the button that you necd is not available on the toolbar, you can find it by pressing the More
Buttons drop-down arrow. After locating the button, click on it to add it to the toolbar. Similarly,
you can remove a toolbar button from the toolbar. To do this follow the foHowmg steps:

1. Click on the More Buttons drop-down arrow.

2. Click Add or Remove Buttons button.

3. Uncheck the buttons you want to remove from the toolbar. These will be removed from the

toolbar. Check the buttons you want to add to the toolbar. Such buttons will be added.

4. If an arrow appears at the bottom of the list, click on the arrow. Additional toolbar buttons
will be displayed.

5. Click anywhere on the document to close the menu.

L.5. Arranging buttons on the toolbar

The order of the toolbar buttons can be changed. To arrange the toolbar buttons, do the following

steps:

. View > Toolbar -> Customize. The customize dialog box appcars

2. If the Customize dialog box appears over the toolbar that you want to arrange, drag the
dialog box away from the toolbar by clicking on the title bar at the top of the box and without
releasing the mouse button, move the dialog box to the desired position and then release the
mouse button.

3. On the toolbar drag the button you want to move and place it in the position you want. [f the
position is valid, then an l-beam will appear. If you drag the toolbar button to an area outside
the acceptable positions, then instead of the 1-beam an X mark will appear at the bottom of the

© mosse pointer.

4. After moving all the toolbar buttons to the desired positions, click the Close button.

1.6. Creating, editing and saving a Word document

The typing of any document is similar to typing on typewriter. The short vertical, blinking line at
the top of the new document is the insertion point. It indicates where the text will be entered as
you type. After typing a few lines or completing your typing you can move the insertion point
(using either the mouse or by arrow) to edit the text anywhere in the document. One point should
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be remember that when you typing a long sentences, do not press the Enter key at the end of each
line. The line break will be done automatically. This feature is called word wrapping.

Now we will type a document, say, an invitation lctter and it will be sent to all friends.

Suppose, a new blank document is open. If it is not open, press thc New button on the Standard
Toolbar. Alternatively, usc the menu. Press File & New -> Blank Document and press OK.

Remember that the use of toolbar button is more faster.

I'ype P.K.Sen and press Enter. The insertion point moves to the next line.

Type Department of Physics and press Enter.
Type Védyasagar University, Midnaporé — 721 102 and press Enter.

A red/green wavy line under a word means that the autematic Spelling and Grammar Checker
is active. It identifies the possible spelling mistakes and puts a red wavy line under the word.
Probable grammar mistake are indicated using a green wavy linc under the words or sentence. For
.now iznore the red/green lines.

Then type the body of the letter.

1.7. Defeting text
Using the Del key or the Backspace key you can delete the text. The Backspace key deletes the

text to the left of the insertion point and the Del key deletes the text to the right of the insertion
point. 8o, it is important to position the insertion point at the appropriatc position in the
document. The mouse pointer may be used to move the insestion point.

1.8. Automatic spelling and grammar checking

The red/green wavy fines may occur under some portion of the text. These lines indicate possible
spelling and grammatical errors. These lines occur when the automatic spelling and grammar
checking feature is active. After finishing the typing you can go dack to edit the document. To do
this, right-click the underlined word or words. A shortcut menu is displayed, giving you a list of
words that according to Word are possible alternatives. You may ignore the suggestions if you
need. The words like names, that you frequently usc are also underlined as spelling mistakes. In
such cases you can either ignore the suggestion or add the word to the custom dictionary. Once if
you added a word to the custom dictionary, Word will not underline it in the future. To add a
word to the custom dictionary, click Add on the shortcut menu.

:in th;e following, the automatic spelhnn ind grammar checking feature of Word is described in

etails.

1. Press ctrl + Home to move to the top of the document. Or use mouse to go to the top of the

document.

Right click on the incorrect word. Then Automatic Spelling and Grammar Checker

shorteut menu will displayed.

Click Spelling. The Spelling dialog box dmplayed

4. Click Ignore. The red wavy linc disappcars. The Spelling and Grammar Checker will
ignore this occurrence of the word. The second occurrence will still be underline.

5. 1f a word that is underlined occurs more than once then click Ignore Al in the shortcut meny,
The red wavy line disappears from all the occurrences. :

_f\)

L

62



1.9. Disabling the Automatic Spelling and Grammar Checker

The Automatic Spetling and Grammar Checker feature can bc turn off through the following
steps: .

Tools -> Options. The Options dialog bex will appear.

Click Spelling and Grammar tab.

In the Spelling area, uncheck Check spelling as you type check box.

In the Grammar area, uncheck Check grammar as you type check box.

Click OK.

WD W N -

1.10. AutoCorrect feature

Generally, when you type a document you might make many mistakes. But when you return for
correcting them, many of them would besn already corrected. This is due to the AutoCorrect
feature of Word. This Word feature corrects most of the common typographical errors. Some of
the common examples are ‘adn’ instead of ‘and’, “teh’ instead of ‘the’, etc. As soon as you type a
space or begin a new paragraph after the misspelt word, Word recognizes the error and corrects it.

You can see the entries in the AutoCorrect feature by going to Tools > AutoCorrect.

1.11. Formatting marks A

Whenever you create a document by typing, special characters called formatting marks are
inserted into the document. The two most common formatting marks are the paragraph mark (),
which is placed in the document every time you press the Enter key and the space mark (.),
which is inserted every time you press the space bar. The formatting marks can either be
displayed or hidden on the screen, but when the document is printed thesc are not printed.

The formatting mark helps you in troubleshooting the document while you edit it. You can use
these marks to identify extra lines between paragraphs, forced Enter keystrokes at the end of the
line spaces between words and so on. -

‘

To display the formatting marks, click the Show/Hide (§) button. The formatting marks are
displayed in your open document.

1.12. Naming and saving document

After finishing the work you have to save it for further use, such as, modification, printing etc.
You can save the document to hard disk or floppy disk or to another computer’s hard disk if the
computer is connected to a network. You can save documents in a different formats - Word 2000
document, web page. text document and so on.

If you save your document for first time then you have to give a name to the document. If you are
saving an existing document in another name, then also, you have to givc a name to the
document. . ’

In the following the saving of a document is illustrated stepwise.

1. Click the Save button on the Standard toolbar. Since this is the first time that you.are saving
the document, the Save As dialog box appears.
Alternatively, you can use the menu as
File - Save or File > Save As.

63



1n the Save in box, click on the drop-down arrow and select your hard drive.

In the list of folders, double-click on the folder that you want to save the document. The

folder opens.

4. In the File Name box, type the file name you want. The file name can be up to 255 characters
in length and can contain alphabets, numbers, spaces and other characters except the slash (/).

S. By default the document will be saved in Word 2000 - “*x doc’ file. This can be seen in the

Save as type box. If you want to change the format click on the drop-down arrow to sec the

different available formats.
6. Click Save to save the document.

w te

1.13. Opening an existing document

When you start Word, it opens a blank document. Now we will see how to open an existing
document. We have saved the invitation letter to the hard disk. Suppose you have saved it in C:
drive in a folder named examples. Let us assume that the name of the file is invitation.doc. We
will sce how to open that filc and save it under a new name so that the original file remain

unchanged.

To open and save the file, do the following steps: »

1. Click the Start button on the Windows taskbar. The Start menu appears. .

2. On the Start menu point to Programs and then click on Microsoft Word. Word opens with
a diank document.

3. Onthe Standard toolbar click the Open button. The Open dialog box appears.

4. Clink on the Look in drop-down arrow and then select (C:) drive. The folders in the C drive
are Listed.

5. Double-click on the folder named examples. The folder opens showing the word documents
in that foider. .

6. Double-click on the file named invitation.doc to open it. The document opens in the
document window. ' . :

7. File > Save As. The Save As dialog box appears. The examples folder will be in the Save
box. In the File name box, the name will be invitation.doc. .

8. Select the file name if it is not already selected by clicking on it.

9. Type say, invitationl.

10. Click Save.

1.14. Choosing 4 view

Word provides a variety of views or display formats that you can use to view the documert while
working. The choice of the view depends on the type of document and the way want to work with
it. The Normal view helps to focus on composition, text revisions and basic formatting such as
font effects (bold, italic, etc.) without worrying too much about the laout of the page. When you
are applying more sophisticated formatting or moving and copying text it will be better to work in
the Print Layout view. This is also the default view. Web Layout view shows you how your
web page will be displayed in a browser. Outline view lets you focus on document organization
by highlighting headings and subheadings. Full Screen view fills the window with your
document without displaying the toolbars or controls. All t=ese views can be selected form the
View menu.
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1.2: The View Menu

We consider the Print Layout view in this note.

1.15. Navigating the document

Once the document has been created, then may want to navigate to a particular page in
the document. Word has navigational and selection tools using which we can go to any
page within the document regardless of how big the document is and the document can
be edited. '

The methods that are available in word for navigational and editing purposes are given
below: '

* Scroll through a document

* Go to specific item or location

* Find Text

1.16. Scrolling through a document by using the mouse

The horizontal scrollbar and the vertical scrollbar are onc of the tools that are used for
navigating within the document. Table 1.1 shows how to scroll through a document using
the mouse.

Scroll up one line Click the up scroll arrow
Scroll down one line Click the down scroll arrow
Scroll to a specific page Drag the scroll box

Scroll left - . Click the left scroll arrow
Scroll right Click the right scroll arrow

Scroll left, beyond the Hold down SHIFT and click the left scroll arrow
margin, in Normal view :

~ Table 1.1
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1.17. Scroll through a document using the keyboard ; .

Apart from using the mouse for scrolling through the document, the keyboard can also be
used. Table 1.2 lists the keys that are used for moving from character to character, word
by Word, line by line, paragraph to paragraph, window to window, screen to screen, cte.

Press

To move

LEFT ARROW One character to the left
RIGHT ARROW One character to the right
'CTRDLEFT ARROW | One word to the left
CTRL+RIGHT Onc word to the right

ARROW : A

CTRL+UP ARROW One character up
CTRL+DOWN One paragraph down

ARROW ' .

SHIFT+TAB One cell to the left (in a table)
TAB One cell to the right (in a tablc)
UP ARROW Up one line )

DOWN ARROW Down one line

END To the end of a line

HOME To the beginning of a line
ALT+CTRL+PAGE UP | To the top of the window
ALT+CTRL+PAGE To the end of the window
DOWN :

PAGE UP Up one screen (scrolling)
PAGE DOWN Down one screen (scrolling)
CTRL+PAGE DOWN To the top of the next page
CTRL+PAGE UP | To the top of the previous page
CTRL+END T'o the end of a document
CTRIL+HOME To the beginning of a document

Table 1.2

1.18. Go to a specific location or item using GO TO featurc .
The GO TO feature is used to move in a document from one place to another placc. This

© is called navigation. Generally. we use keyboard or mouse to move the cursor from one
 place to another place within the page. llowever, whilé working in a big document. using

the keyboard or mouse will not be very cfficient and in such cases GO TO feature will be
very useful. This saves a lot of time and also makes the user's work easy and simple. This
tool is specifically used for moving from page to page or to move to a couple of pages
from the page, wherever in a document.

To display the Go To dialog box do the following steps:

1. On.the Edit menuy, click Go To. 5

2. A dialog box will appears on the screen and in the Go To what box, click the type of
item. :
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3. Type the name or number of the item in the Enter box and then click Go To.
4. To go to the next or previous item of the same type, lcave the Enter box empty and

«

then click Next or Previous.

1.19. Find text in a document ‘

Find and Replace featurc is another navigational tool in which the user can navigate or
search throygh pages based on some specific word or phrase. This tool is very useful
when we want to search for some text and further change or replace that text with some
other text. To find in a document, perform the following steps:

1. On the Edit menu, click Find. A menu appears.
2. Type the text to be searched in the Find what field.
3. Select any of the other options by clicking the More button.

1.20. Cut, Copy and Paste text

We want to make some changes to the letter. First, we want to list the names of the publishers in
the alphabetical order. The sentence we want to change is given below:

%2 are distributed many important books of the leading publishers
iike McGraw-Hill, Addison Wesley, Prentice-Hall, Artech House,
ernc.

This can be done by moving Addison Wesley and then Artech House before McGraw-Hall. To do
this follow the following steps: ~* -

1.~ Scroll down to the area where the words Addision Wesley appear.

2. Position the mouse pointer before the word Addison.

3. Dsag the mouse pointer holding the left mouse button till you have selected the word
Addison and Wesley and the comma. The selected words appear in a black background.

4. Click on the sclection and drag (while holding the mouse button down) and move the
pointer to the position. before the word McGrasv-Hill. 'When you click the selected
section, the mouse pointer changes to a left poinnng arrow instead of the I-beam. While
moving a dotted rectangle appears on the tail of the mousc pointer and a dotted vertical
line appears on the tip.of the mouse pointer.

5. Release the mouse button when the dotted vertical line is positioned before the word .
McGraw-Hill. The words Addison Wesley and the comma will be shifted to a position
before the word McGraw-Hill. i '

6. Repreat the above steps with the words Artech House and the comma. Now you will see
the sentence changed as follows: :

We are distributed many important books of the leading publishers
iike Addison Wesley, Artech House, McGraw~Hill, Prentice-Hall,
etrc.

Now we will use cut and paste for the same purpose. Do the following steps:

I. Scroll down to the area where the words Addision Wesley appear.
2. Position the mouse pointer before the word Addison.
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", Drag the mouse pcnter holding the left mouse button till you have selected the word
Addison and Wecsley and the comma. The selected words appear in a black background.

4. Click the Cut button on the Standard toolbar. The words ‘Addison Wesley', disappear. It

is also copied to the Clipboard. .

Move the insertion point to the porsition before the word McGraw-Hill.

6. Click the Paste button on the Standard toolbar. The words Addison Wesley and the
comma will now appear before the word McGraw-Hill.

7. Repeat the above steps with the words Artech House and the comma.

b

If you want to use the same text matter more than once in a document, you can copy the text and
then paste it whenever required. This will save a lot of time if you want to usc a word many times
in your document. To copy a word or sentence, select it and click on the Copy button on the
Standard toolbar. The text is copied to the Clipboard and will be available until a ncw text is
copied thereto. Whenever you want to type in the text that you have copied, place the insertion
point where you want text to appear and click on the Paste button. It will appear in the new

position.

To Keyboard shortcuts
Cut * CTRL+X
Copy  CTRL+C
Paste CTRL+V
Move  CTRL+X or CTRL*V
Delete BACKSPACE or DEL
Undo  CTRL#Z
Redo : CTRL+Y

Table 1.3

1.21. Undoing and redoing changes

You can undo and redo changes after you make them by using the Undo and Redo buttons on the
Standard toolbar. The Undo button reverses your last action. You use the Redo button to
reverse an Undo action. For example, if you delete a word and then click Undo, the word
reappears. If you then click Redo, it will be deleted again.

~ Word’s undo and redo features are very powerful. You can reverse more than one action. When
. you click the Undo drop-down arrow, you can see a list of actions that you reversed. The list will
have the most recent changes at the top and the previous changes below.

1.22. Keyboard shortcuts :

By using keyboard shortcuts we can save an enormous amount of time. Working with the
keyboard is faster than working with mouse. Keyboard shortcuts are keystrokes that
activate a command directly and they bypass the menu. Keystrokes that are used to open
a menu, such as ALT plus a key. are referred to as accelerator keys.

The shortéut key for each tool is displayed in the ScreenTips boxes that appears when
the user points at an icon on a toolbar. If the ScreenTips box does not appear, it can be
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activated by choosing Tools menu and by selecting Customize item. In the Custon...
dialog box, click the Options tab. In this tab, select the Show Shortcut Keys in
ScreenTips check box.

Task Key combination

"Create a new document CTRL+N
Open a document” .- CTRL+O

Save a document « CTRL+S

Help Fl

Make text bold , CTRL+B
Make text italics CTRL+1
Underline text CTRL+U

Left align text CTRL+L
Center align text CTRL+E

Right align text CTRL+R
Justified text CTRL+]

View normal CTRL+ALT+N
View outline CTRL+ALT+O
Print Preview CTRL+ALT+I]
Print CTRL+P

Undo CTRL+Z

Redo CTRL+Y

Closing a document CTRL+W

Table 1.4

1.23. Applying formmating to text

Using the formattting attributes you can change the appearance of text, which are available on the
Formatting toolbar. Commonly used attributes include bold, italic and underline. You can
change the font style and its size with the click of a button. A font is typeface applied to rext,
numbers and punctuation. There are many fonts that you can choose from font list.

In Word 2000 the font list is enhanced to display the name of the font in its own typeface so that
you can preview it before selection. Word provides more complex formatting like drop cap,
background, themes, etc. which are avi lable from the Format menu.
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In the following exescise we will apply some basic formatting to the invitation.doc.

following steps and show the changes in Figure | 3.

}l':“awl‘.)--

e

Opun the file invitation.doc.

Save it as samplel.doc.

In the first line select Mr. P.K.Sen.
On the Formatting toolbar, click the Bold (B) button.

Select the sentence We are the distributors of many o

Do the

f the leading publishers like

McGraw-Nill, Addison Wesley, Prentice Hall, Artech House, etc.
Click on the ifalic (I) button on the Formatting toolbar.
Click on the Underline (U) button.
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Figure 1.3: Basic Formatting

v Times New Roman
o Anal

T Monotyps (brava

T Courier New

& Ataramend

¢ Artal Blasck

v Anai Namow

7 Book Antiqua

r Bookman Oid Style
1 Century Gotnic
 Comic Sans M5

.

Figure 1.4: Font list

8 Select the second paragraph
9. Click the Bold button and then the italic button.
10. Sclect the last lines P.Biswas and Manager.

1 1. Click the Bold button.
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Figurc 1.5: More formatting

In the following exercise we will change the font style and size of the document invitation.doc.

1.
2.
3.

W D

~

8.
9.
10.

RS
12.

Open the document invitation.doc.

Save it as samplel.doc.

On the Formatting toolkar click the font drop-down arrow 1o see the list of fonts. The
font list appears as shown'in 4. :

Browse through the font {ist to see the different options available.

Click outside the font list. The list will disappears.

Select the entire text of the document. You do it using mousc or using Edit -> Select All
orctrl+ A.

Again click on the font drop-down arrow.

Click on Arial from the list. The entire text changes to Arial font. :

Click on the font size drop-down arrow and click 10. The size of entire text changes to 10
points. -

Now select the first 3 lines of the text.

Change the font to Arial Narrow.

Click on the font size drop-down arrow and click 14. The size of the first 3 lines changes
to 14 points. '

Now your document becomes to Figure 1.5,

1.24. Additional text effect

Not all the formatting options are available on the Formatting toolbar. You can find additional
effects on the Format menu. Effects used to animate text are also available in Word. These
effects are very useful when you are designing document for the web. These cffects are available
from Format -> Font -> Text Effects. In the Font dialog box, go to the Text Effects tab. There
you will find effects like ' :

(none)

Blinking Background '
[Jas Vegas Lights

Marching Black Ants

Marching Red Ants
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e Shimmer
e Sparkle Text.

If you click on each you can see how it looks like in the preview window.

In the Font dialog box, click the Font tab. Therc are a lot of special efﬁec}s available like
Shodow, Outline, Small Caps, etc. You can view these effects in the preview window.

1.25. Format painter

If you are using the same formatting scveral times in a document you cart use the Format
Painter instead of selecting the text and applyirg the formatting each and every time. To use the
Format Painter first select the text that has the formatting you want to apply to other text
selections. Once you activate the Format Painter, all the formatting attributes of the selected text
will be attached to your pointer. Double click the Format Painter button, if you are going 10
copy formatting to several locations or just click the button if you are going to copy the
formatting only once.

1.26. Changing paragraph alignment

Paragraph alignment is an important factor and its improves the look of a document. Paragraph
alignment refers to the arrangement of the paragraph between the left and right margins. There
are four ways to align a paragraph. Align left means that all lines on the lett side of the paragraph
are aligned with the left margin, while the lines on the right side end at different places. The
default alignment of Word is aligning left. Align right is just opposite to align left. Align center
means that the text is centered in the middle of the page. Text that is justified is aligned with both
the left and right margins by spreading the words evenly between the margins.

If you change the alignment of a single paragraph you do not need select the entire
paragraph. Word automatically recognizes that you want to apply an alignment style to that
paragraph only. Just position the insertion point anywhere in the paragraph you want to align and
click on the desired align button on the toolbar.

1.27. Changing the paragraph spacing
Changing the paragraph spacing the look of the document may be changed. You can choose from
single line spacing, 1.5 lines, double line spacing and so on.

To change the line spacing, follow the steps:

Open the document invitation.doc.

Save it under a new name, say, sample2.

Place the insertion point anywhere in the first paragraph.

Format -> Paragraph. The Paragraph dialog box appears.

In the Line spacing area, click on the drop-down arrow and click on Double.
Click OK. The first paragraph spacing changes to double line spacing.

Select the three paragraphs. )

Format -> Paragraph. The Paragraph dialog box appears.

0NN AW
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). In the Spacing section. in the Before box. change the 0 pt to 18 pt either by typing it or
clicking on the arrows.
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Figure 1.6: Paragraph Spacing

10. Click OK. The spacing between the paragraphs (spacing before cach paragraph to be
precise) increases to 18 points.

1.28. Bulleting and numbering .
Bulicts and numbers arc another way of improving the readability of the text in a document. In
Waord, adding bullets and numbers iy as clicking a button.

‘We will see how to use these features in the following:
I, Open invitation.doc and change it w another name.
2 Edit the text after first paragraph as follows:
We are the distributors of many of the leading publishers including:
McGraw-Hill
Addison Wesley
Prentice Hall

Artech House

We are official distributor of the standard of the following organizatic.ns
IEEFE, |

SO

ANSI

BSI
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We are the distributors of many of the leading publishers including
s  McGraw-Hill

Addison Wesley

Prentice Hall

Astech House

We are official distributor of the standard of the following organizations
1 IEEE
2 ISO -
3 ANSI
4 BSY
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. S ‘. ‘ ) »
SR O

Figure 1.7: Bullets and Numbering

Now select the text from McGraw-Hill to Artech House ( 4 lines). .

4. Click on the Bullets button on the Formatting toolbar. The selccted text becomes 2
bullet list. '

5. Select the text from IEEE to BSL. )

6. Click on the Numbers button. The selected text becomes a numbered list (sec Figure

1.7).°

(VS

1.29. Add borders and shading to a paragraph

Once you have given the paragraphs the alignment you want and the spacing that you
prefer, you can apply borders and shading. This formatting helps draw atterntion to the
text. Word has more than 20 different border style you can choose from. Almost all the
functions of adding borders and shading can be done from the Tables and Borders or
Format -> Borders and Shadings... toolbar. We will familiarize ourselves with the
toolbar buttons.

The following steps demonstrate how to apply border and shading to paragraphs.
1. Open and rename invitation.doc. «

Click at the beginning of the first paragr{ph.

Click the Outside Border button on the¥Tables and Borders toolbar. The paragraph is

surrounded by a border. .

4. Click at the beginning of the first paragaph.

On the Tables and Borders menu, clius the Line Style drop-down arrow to see more

options. Choose the last style in the drop-down box.

6. On the Tables and Borders menu, click on the Line Weight drop-down arrow 1o sec

‘more options. Choose 3 points. ‘

On the Tables and Borders menu, click on the Border Color drop-down arrow to see

the available colors. Choose Red. ‘

wgd
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Click the Outside Border button. The paragraph will be surrounded by a border that is
red in color as shown in 1.8.

Click at the beginning of the first paragraph.

On the Tables and Borders menu, click on the Shading Color drop-down arrow to sec
the available colors. o

- Click Gray — 10%. The paragraph is filled with gray 10% shading. Your screen will like

Figure 1.8.
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Figure 1.8° Border and Shading

1.30. Adding header and footer
To create header or footer following process is used.

1.
2.

6.

On the View menu, click Header and Footer.

The document appears in Print Layout view with the header area indicated by a
nonprinting dashed-linc box. Notice that the regular document text is changed 1o
gray and the header and footer toolbar is displayed.

To create a header, enter text or graphics in the header area or, ckick a button anf
the Header and Footer toolbar.

Use the toolbar buttons to add page numbers, date, time and so on.

To create a footer, click the Switch Between Header and Footer button to move
to the footer area.

Choose Close on the Header and Footer toolbar to return to the document.

1.31. Create special effects with text ,
You can create dazzling special effects and formatting on the text so that it looks attractive and
has a fancy look. ' ‘

Follow the following steps and see what is displayed on your screen.
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Create a new document and save it under the name testl.doc.

Type Vidyasagar University.

Select the text using the mouse pointer.

Click Format > Font.The Font dialog box appears (shown in Figure 1.9).

Choose Arial Black as the Font, Bold as the Font Style, 14 as the Size and Red as the
Font color.

In the effects scction, check Emboss and Small‘caps.

in the Text effects tab choose Sparkle text.

Click OK.

Click Save to save the changes.

0. Click Close to closc the document.
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Underline: Color:
l(none) :_J [i Auto :_J
Effects -
™ strikethrough r 553:&#:} ¥ small caps
™ Double striwethrough r [ allcaps
I~ Superscript ™ Emboss ™ Hidden
™ subscript [™ Engrave
Preview
_ VInYASAGAR UNIVERSITY
This foat style Is imitated for display. The dosest maching style will be printed.

. Q;faﬁtt... ] _ [ ] cancel R

Figure 1.9: Special Effect with Text

1.32. Printing in multiplc columns

Creating Columns: Columns can be crcated by clicking on Columns tool in the
Standard toolbar or by choosing Columns from the Format menu. On doing this, a
Columns dialog box appears, from which parameters such as the number of columns.
width of each column and spacing between columns, etc. can be chosen.
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Delcting Columns: To delete the columns created and convert text into a single column
format, choose Columns from the Format menu, choose an option {rom the Presets box
and click OK.

1.33. Link document

You have created a fancy looking text with some special effects. You want to place that at the top
of vour leter. [n other words. you want to created a letterhead. You can do this by copying
\ idyasagar University vou have created in the previous section and pasting it at the top of your
lettcr You can use Copy and Paste. But a better option will be Paste Special. Using Paste
Special you can paste the fancy text and simultaneously link the letter to the source document —
the document from where you copied the text. Once.you have linked the two documents, any’
changes you make - the text in the original document, will be reflected in your sinked document

as well,

1. Create a docusmnent named letter.doc

2. Open the document named head.doc.

3. Copy the text (say your name) from the head document.

4. On the taskbar click the button tor the letter.doc to display it.

5. Inthe letter.doc, place the pointer in the position you want to paste text.

6. Edit - Paste Special.. Pastce Special dialog box appears.

7. In the Paste Special dialog box, in the As list. select Formatted Text (RTF) to reflect
the type of the.text you are pasting from the source document.

8. Click the Paste Link radio button to create a link in your document 1o the source
document.

v, Click OK.

The link be test as follows:

On the Windows taskbar click on the button for the head.doc to open it.

Sclect the name using the mouse pointer.

Change the color Red to Blue and the Font from Arial Black to Arial Rounded MT
Bold.

I'he text in the head.doc changes.

Now click on the taskbar button to opcen the letter.doc.

You can see that the changes are rcflected in that document also since we pasted it as a
link. Whenever the source document is updated the document where the link pasted is
also updated automatically.

ed B
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1.34. Creating a table

A 1able_consisting rows and columns of cells that vou zan fill with text and graphics. Tables are
often used to organizc and present information, but they have other uses as well. You can use
tables to align numbers in columns and sort and perform calculations on them. You can also use
tables to create interesting page layouts and arrange text and graphics.

Supposc you have to make a list of the namc of book, author, publisher and price of some books
of a book sellers. It can be done very efficiently using tables. Table features of Word are very
pos ‘crful and gxtensive.

[n the following we will creatc a table with four columns and five rows.
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Create a new document as book.doc.
2. Click the Insert Table button on the Standard toolbar or click on Table on menu and

then click on Insert Table.
3. Drag to select the number of rows and columns you need. In this casc, select 4 columns

and 5 rows.
4. Release the mouse button. A table with 4 columns and 5 rows is created as shown in

Figure 1.10.

e

Book Author Publisher' Price (in Rs.)
Word 2000 K.P.Sinha Central 160.00
Operating System R.K.Rana Asian Books 250.00
Fortran 77 M.Pal Astan Books Pvt. Ltd. 185.00
| Mathematical Physics | T.Dash Universities Press 25000

1.10: A rable with 4 columpns and 5 Rows

Fill the first row with the titles like Name, Author, Publisher and Price.

6. When the tablc is created like this all the columns have equal width. If you want to
change the size of a column move the mouse over borderline. The mouse pointer changes
10 two horizontal lines pulled by two arrows. Click the mouse and drag in the direction
you want to increase or decrease thg width of the columns.

7. Now select the first row. To do this, move the mouse pointer by the left side of the table.
The mouse pointer changes tq a right pointing arrow. When it reaches the first row click.
The entire row is selected. :

8. Click on the Bold button on the toolbar. The text in the first row changes to bold.

9. Now select the last column. To do this, move the mouse from the top towards the 1op
oorder of the last column. The mouse pointer changes to a back downward pointing
arrow. Click the mouse button and the entire last column is selected.

10. Click the Align Right button on the toolbar. The contents of the last column are now
right aligned.

Il. To add a new row at the bottom of the table, position the mouse pointer at the bottom

: right corner of the table and press the Tab button. Another row is added.

12. To insert a new row, place the insertion point in the row above or below which you want
it. Table -> Insert and from the menu click on the appropriate button depending on
whether you want to insert the row above or below the current row.

W

Book | Author Publisher I Price (in Rs.)
Word 2000 i K.P.Sinha [ Central 160.00
Operating System R.K.Rana | Asian Books 250.00
Fortran 77 M.Pal Asian Books Pvt. Ltd. 185.00
Mathematical Physics T.Dash Universities Press 250.00 |
Figure 1.11: 4 table with 4 columns and 5 Rows

13. To insert a column, place the insertion point in the column right or feft of which you
want it. Table - Insert and from the menu click on the appropriate button depending on
whether you want to insert the column to the right or left of the current column.

14. To delete a row, place the mouse pointer on the one that is to be delcted. Tables
=>Delete and then click on the Rows.
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Creatc a table to tabulate the names and the marks of the students in a class. The table should

15. To delete a column, place the mouse pointer on the one th
Delete and then click on the Columns. The eatire column is deleted.

at is to be deleted. Tables =2

have columns for name, marks for English, Mathematics, Physics and Chemistry.
The table should be of the following form. :

| Tabulation Sheet of Marks of Students of Class XII
Name Subjects /
English Mathematics Physics Chemistry
Raman Rao 50 67 87 45
Aniket Pal 60 78 90 46
Bikash Hota 56 23 56 34
Palash Saha 34 56 76 23

Figure 1.12: Sample Tabulation Sheet

Creatc a table with 5 columns and 7 rows.

The first row of the table should be merged. To do this, select the first row by clicking the
mouse pointer and click on the Merge Cells button on the Tables and Borders toolbar
(or use nienu Table > Merge Cells).

Type the title Tabulation Sheet of Marks of Students of Class XII on the first row and
press Center button on toolbar. :

Select the second column to last column of second row by clicking the mouse pointer and
then click on the Merge Cells button on the Tables and Borders toolbar.

Type Subjects on the second row and click Center button on toolbar.

Select second and third rows by clicking mouse pointer and click Merge Cells button.
Then type Name on second row.

Then type English, Mathematics, Physics and Chemistry on the second to fifth columns.
To convert in italic font, select the respective rows and click Italic button on the toolbar.
If you need to arrange the tabulation according to the name of the students then, select the
column containing the names and then click on Sort Ascending button of the toolbar.
Then the table looks like as in Figure 1.12.

Tabulation Sheet of Marks of Students of Class XiI
Name Subjects

English | Mathematics | Physics Chemistry
Aniket Pal 60 78 90 46
Bikash Hota 56 23 56 - 34
Palash Saha 34 56 76 23
Raman Rao 50 67 ; 87 45

Figure 1.13: Sample Tabulation Sheet, afier sorting on name
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To draw the table of the following form do

9

To inscrt 2003. insert a columnn at left. Then type 2003 and click on Change Text
Direction bution on Tables and Borders toolbar. To put it on the center of the ventical
linc click on Center button on toolbar.

To make it colorful select table and click on Table AutoFormat button on Tables and
Borders toolbar (or usc menu as Table > Table AutoFormat - 3D cffects) and select

any option according your choice.

Tabulation Shee. of Marks of Students of Class XII

Name Subjects
English Mathematics  Physics Chemistry
Aniket Pal 60 . 78 . 90 46
Bikash Hota 56 23 - 56 34
S Palash Saha 34 56 76 N
~ Raman Rao 30 67 87 43

Figure 1.14: Sample Tabulation Sheet (with 3D effect)

"

1.35. Werking with graphics

You can enhance the impact of document by incorporating images and other graplms clements
into the text. Word 2000 provides thousands of i images that will be suitable for any purposc. You
can insert a graphics in five ways: from Clip Art, From File, AatoShapes. Word Art - ' Chart
To activate ClipArt do from menu Insert 2 Picture = ClipArt or from Draw tuolbu
Insert ClipArt button.

The steps are describe in the following to insert a graphics to your text.

R
2.

B

o v

Open a document test2.doc.

Click on the Insert ClipArt button on the Draw toolbar or Insert = Picture
ClipArt..

The Insert ClipArt dialog box appears.

Browse through the picturcs to sce if there is anything that interests you.

tt not, click on the Keep Looking button at the bottom.

When you have found the clip that vou want click on it. A callout appears with optrons to
insert the clip, preview the document and so on.

If you want to see an cnlarged view of the picture click on the Preview Clip button.

To insert the clip. click on the Insert clip button. The clip is inserted at the position
where the inscrtion point is in the docunient.

After insertion you can change the position and size of the picture. lo do this click on the
picture and drag it.
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1.36. Mail merge
Mail merging is a very useful and powerful feature of Word. You can creatc the same main
document and send then to different people customizing it individually as if the mail was written
for him’her Of course, you have the addresses of all the peaple you want to send the letier.

Details of mail merge feature is illustrated in the following.
1. Open the document invitation.doc and save it as temp.doc.

T de bl M2

Remove the address lines (the first three lines) for the document.

Remove the word after Dear.

Click Tools > Mail Merge.. The Mail Merge Helper dialog box appears,
Click the Create button under the section Main document. In the drop-down list box
choose Form Letters. The dialog box asking whether you want to make the active
window as the main document appears. Click on Active Window That is Tools -> Mail

Merge 2 Create 2 Form Letters = Active Window.

6. In the Data source section, click on the Get Data button. From the drop-down list
choose Create Data Source. The Create Data Source dialog box appears (sec Figure

1.14).

7. In the Create Data Source dialog box, Word provides a list of commonly used fields.
You can change the order in which they are listed, add ncw ficlds, or icmove existing

ones.

oo

Once you have customized the field names and their order, click OK.
9 You will be asked to save the data’source. The Save As dialog box appears and prompts
\ou to save the data source as a Word document. The data source is nothing but a Word
document consisting of a table with columns that vou have selected in the Create Data

Source dialog box.

10. Once vou have saved the blank data source, you will be asked to add records 1o the data

source.

A mail merge data source is composed of rows of data. The first row is called the
header row. Each of the columns in the header row begins with a field name.

Word pravides commonly used field names in the list below. You can add or remove
field names to customize the header row,

Field name:

' Ra
N S 4 2 ‘ LastName

JobTitle —! Move
Company M l
. Addressl
Remove Field Name f Add:CSSZ -:—}

Figure 1.14: Create Data Source Dialog Box
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11 You can press the Edit Data Source button to bring up the Data Form dialog box (see

Figure 1.15).

8".., 2 i

Ttle: .
stheme: a - addnew |

LastName: Pal

JobTitle: Student Qelete |

Company: Regtore l

Addressi: Aurobindanager {South) Find.. J

Address2:

Cry: l?’hdnapore view Souwrce J

State: FNes't Bengal __:J

Record: 4 { ¢ }! i M

Figure 1.1S: Data Form ‘Dialog Box

12. Fill the form by cntering addresses of all people. Use Tab to go to next field. After
completion of each address press the Add New button. The record will be added to the
data source. After completion data entry press OK to return to the main document.

13. Now the main document have an additional Mail Merge toolbar.

14. Position the insertion point at the beginning of the document. Click on the Insert Merge
Field button. The filed that you have created in the data source appcears.

15. Click the filed Title. The title field appears at the beginning of documents as <<Title>>.
The symbol << >> indicatés that it is a merger field.

16. Similarly, choose the fields that you want in the document. If you to put some
punctuation mark then insert those. For ex:mple, after State put a hyphen before the
Postal Code. Also put a comma after the First Name in the line Dear <<First Name>>.

17. Click on the Merge ... button and the Merge dialog box appears.

18. You can merge to a ncw document, printer of e-mail. You can also select the record to be
merged. .

19. Click on the Don’t print blank lines when data fields are empty in the When merging
records section. This will instruct not to leave a blank space if some fields are empty. For
example, all the people will not have a Job Title and Company.

20. If you are merging to a new document, the letters will be creatcd as a new document,
where each individual letter will start in a new page. You can print this document later.”
Also you can see the merged letters before you actually print and correct mistakes. it’
there are any. :

21. The mer~ed document will look similar to Figure 1.16.
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Figure 1.16: Merge document

You can merge envelopes, mailing labels, etc. using the same method. If the data source is
available then vou can use that data instead of creating a new onc. Create a set of envelopes for
sending the letters that we have jus: created.

1.37. Previewing and printing a document

The method by which you print a document is the same in all the Office 2000 applications. Here
we see how to preview a document before printing, print whole or part of a document and control
the options of the printer.

Print Preview
You may see how a document will look when printed by using the Print Preview feature. To
preview a document before printing do the following:
1. Click the Print Preview button on the Standard toolbar. The Print Preview window wil'
appear. The window in the different applications will be slightly different.

2. The Print Preview window toolbar contains buttons for printing, magnifying. see o
page at a time, zoom (zoom to 10% to 500%, two pages, fit width, etc.) and a Clos:
button 1.17 shows a preview of this document.

3. Click on the zoom and choose the magnification that you want. You can choose 25%
27% etc.

4. To see more than one page at a time click on Multiple Pages button.

5. Atend of previewed click the Close button.

83



S . DAL A

File Edit View [nsent Fomuat Tools Table Window Help
' 27%, -F"‘o B O Close X?

Cr x4 s 0 ATEDR :J
g ek LD o IR L ST

=

Page 20 Sec ) © 2020 ALY in2 Todsz G

Figure 1.17: Print Preview

Printing a document

The print of a document can be taken in the following three ways:
1. Click on Print button on the Print Preview window toolbar.
2. From the main document, click on the Print button on the Standard toolbar.
3. From menu, click File - Print. ) ‘

When you print a document using the toolbar buttons it will be printed on the default
printer. ) '

If vou want to choose a different printer or if you want to exercise more control over the

printing (like printing selected pages or a specific range of pages) then you have to print
using the Print dialog box. The print dialog box is shown in Figure 1.18.
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Print ' :

Printer
Neme: [ __5HP Laserlet 6L PCL , ~]  Properties
Status: idle
Type: HP LaserJet 6L PCL
where: LPT1: [T Print to file
Comment:

Page range Copies

(O] Number of copies: i[l 3 =
v Collate

" Current page c
© € Pages: | . v
Enter page numbers andfor page ranges '

separated by commas. For example, 1,3,5-12

Print what: ]Document E] Print: . [AII pages in range .j

- Options. .. I OK I Cancel l

Figure 1.18: The Print Dialog box

In the Print dialog box you can choose the printer to print the document. the number of
copies to be printed, to print the entire document or specific pages. to collate pages in the
case of multiple copies and so on.

The Properties button in the Print dialog box allows you to control the unique features
of your printer, such as font resolution, paper type, etc. :

The LaserJet 6L Properties box has four tabs of information related to the unique
features of this particular laser printer. The Paper tab lets you identify the kind of paper
that is currently installed in the printer and select the orientation or dircction you want
text to appear on the page. The Graphics tab lets you select the font resolution and toner
intensity, while the Fonts tab lets you choose the type of fonts you want to use. The
Device Options tab allows you to control unique characteristics of vour printer, including
print qualify and usage of printer's memory.

‘Once you have selected the required options and set the required parameters and

propertics then click the OK button in the Print dialog box 1o initiate printing. If vou
want to cancel the print job then click the Cancel button.

The contents of the tabs in the Properties dialog box will vary depending on the type of
the printer. :
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Section 2: Excel 2000

2.1, Introduction

A spreadsheet is a highly interactive computer program that consists of a collection of rows and
columns that are displayed on the screen in a scrollable window. It is a_grid of rows and columns
and is also called as a worksheet. Spreadsheet programs are developed to automate tasks such as
technical calculations, inferential statistics, analyzing data, ctc. It also has a powerful program for
graphical preparation of numerical data. It is commonly used in production, planning, personnel
management, marketing, payroll and accounting.

2.2. Excel 2000

Excel 2000 is a powerful spreadsheet application used for managing, analyzing and presenting
data in a graphical manner. Microsoft Excel 2000 is developed on the GUI concept.

Excel performs three different classes of tasks mentioned below:

o It analyses and displays the text and numbers in the cells.
e [t manipulates lists of information.

o {tcreates charts that help to present data in a graphical manner.

Excel 2000 is the most comprehensive spreadsheet application available in the market. [t is not
just a tool for calculating, manipulating and analyzing data, but also a versatile organizational tool
for presenting information. The features of Excel 2000 are listed below.

Worksheet and Graphics: Th e worksheet and graphics feature includes extremely powerful
calculating features. Apart from working with numbers and texts, it is also possible to present
graphical data using Excel 2000. '

Data Lists and Databases: Database functions is an important featurc of Excel. Several useful
{unctions are available for working with data that are listed in a tabular form. Functions are also
available for evaluating values, combining data and so on.

Data Exchange with other Applications: Excel takes advantage of the Windows environment.
he Windows cnvironment especially applies to the DDE (Dynamic Data Exchange) and OLE
(Object Linking and Embedding) concepts within Excel and between Excel and other Windows
applications.

Workbooks: Excel works with a consistent file concept. All data is gathered in workbooks. These
workbooks store current status of the workspace, along with all currently opened files and the
settings selected for them ‘

1.3. Opening of Excel 2000

I'v start Excel 2000, click the Start button and select Microsoft Excel from the Program option,
On starting Excel, a blank workbook is opened. This workbook has several worksheets and by
default. Shect 1 is selected. Extel provides optjons in the menu and the user can select the
appropriate option to perform an operation. Excel provides a toolbar with buttons, which
graphicaily represent the frequently used commands. A typical Excel workbook is shown in Fig.
2.1
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Figure 2.1. Excel 2000 Window

When' Excel 2000 is opened, two windows appear that are nested one within the other. The
larger window is called the Application Window, which covers the entire screen. The
application window is used to communicate with the Excel program. The smaller window s
called the Document Window and is used to creatc and edit Excel worksheets and charts.

2.4. Opening a File
To open a new workbook, click File menu and choose the New option. In the New dialog box

that appears, click OK. It will open a blank worksheet.

-~

To open an existing workbook, click the iced icon ‘n the Standard toolbar or sefect Open from
the File menu. : '

2.5. Saving a Workbook

To save a workbook after entering data, click Save from the File menu. When the file has to be
saved for the first time then sMoose Save As option from the File menu. Type the file name and
Excel will automatically give the " xls" extension whilg saving the file.

A non-Excel file can also be opened in Excel.
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2.6. Workbook

A workbook is an Excel file where the data is stored. A workbook consists of many worksheets.
A worksheet is a page in the workbook where data can be cntered. The current sheet is always
highlighted in the sheet tab. Sheets belonging 1o a particular application can be stored in the same
workbook. When the workbook is opened, all the worksheets contained in that workbook are
automatically opened. Since each workbook contains many sheets, we can organize various types

of related information in a single file.
By default a workbook contains three worksheets. To move from one sheet to another shcu

click the sheet tabs.

A workshecet consists of rows and columns. Rows run horizontally in a sheet and are identified
by numbers. Columns run vertically in a sheet and are identified by letters. The intersection of a
row and a column is called a cell. Cells arc named by their position in the columns and rows, The

column letter followed by the row number is called a cell reference. \
2.7. Executing Commands
Excel commands can be given in one of the following ways.
¢ Choosing an option from the Menu bar.
e Choosing an option from the Shortcut menu.
* Selecting a tool from the Toolbar.
¢ Using Shortcut key combinations.
Menu Bars

Menus are the primary means of performing tasks such as opening a file, copying a group of cells
printing a worksheet or creating a chart. Menus can be invoked by using either the keyboard or
the mouse. To invoke a command from the menu bar use the specific combination of keys.
Shortcut Menus

A shortcut menu is invoked by pressing the right mouse button. The shortcut menu gives direct
access to the most commonly used commands. For example, clicking the right mouse button on
the active ccll display a short-cut menu of editing and formatting options.

Clicking the right mouse button on the toolbar will display the toolbar shortcut menu as
shown in Fig. 2.2
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Figure 2.2.

Shoitcut menus are also available for manipulating toolbars, rows, columns and sheets as well as
for editing and formatting charts and databascs.

2.8. Wizards

It provides guidelines and a series of step-by-step procedures to complete a process. Following
are the different wizards available in Excel 2000.

Text Import Wizard- it impons text files.

ChartWizard-It creates and edits charts.

Convert Text to Columns Wizard - It separates contents in a cell into two diffcrent
cells.

Function Wizard-It inserts a function.

Tip Wizard-It suggest casier ways of doing tasks.

PivotTable Wizard - Builds an interactive table from data existing on sheets.

2.9. Creating and Using Templates

A template is like a pad of preprinted paper. Every time a template is opened a copy of the
template is created. Templates can be extremely helpful when working with workbooks with
identical formatting, labels, formulas and so on.

To save a workbook as template follow the steps given below.

Sctup the workbook to the desired format.

Choose Save As from the File menu. The Save As dialog box appears.

Click Template in the Save As Type box. Excel automatically opens the lemplatc
location. .
Specify a filename to the template and click Save. Excel gives a .xIt extension to the file.

To open a copy of the template. choose New from the File menu. In the New dialog box double
click the icon to open the template.
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2.10. Working with Worksheets '

To add a new worksheet click Insert —» Worksheet from the menu bar. To add multiple
worksheets. click the number of worksheet tab to add in the open workbopk by holding the
SHIFT key. Then click Worksheet on the Insert menu.

Text, numbers and dates can be entered into any cell of a worksheet. Data can be entered in the
active cell by clicking the enter box in the formula bar or by pressing F2. An entry can be
cancelled by clicking the Cancel button X on the formula bar or by pressing the ESC key. Each
cell can hold up to 255 characters. Text is left aligned and numbers are right aligned in Excel and
this default alignment is called General alignment.

The column headings may not appear properly, if the column width is not large enough to
contain them. To increase the column width, place the mouse on the right border of the column
whose width has 1o be increased and click drag the mouse button. '

2.11. Entering Date and Time
To enter today's date, move to a cell and type = today(). '

In Excel the time is added to the date serial number as a decimal fraction of a 24 hour day.
Therefore, midnight is 0.000000, noou is 0.500000 and | 1:59:59 PM is 0.999988. Whenever the
date or time is to be changed, the cell format is automatically changed from the normal format to
the appropriate date or time format.

2.12. Entering Data in a Series

Whenever the user wants to fill a cell range with data forms as a series (e.g. 1,2,3,4 or Jan, Feb or
Mon, Tue) the data input can be automated. This can be achieved by using the fill handle. The fill
handle is a black square located on the lower right corner of the selected cell. This is called
Autofill feature. '

For example, to generate month names in a range of cells, enter Jan into cell Al and point to
the fill handle with the mouse, the mouse pointer changes to a black cross. Click and drag through
the cells Al to A12 and then release the mouse button. The series of months from January to
December will be filled into cells Al through A12.

2.13. Manipulating Cell Contents

The cell contents can also be rearranged. Rearranging involves copying, moving, clearing cells or
inserting and deleting rows. These are discussed below:

Copy Data: While copying or moving data, a copy of that data is placed in the clipboard. The
clipboard provided by Office 2000 can store multiple bits or data (up to 12). To copy a range of
data, select the range and press the key CTRL and the key~C or click the Copy button in the
Standard toolbar. The icons are the same as in Word 2000. Select the destination cell and click
the Paste button from the toolbar menu. The Copy and Paste commands can be easily accessed
from the shortcut menu, '

Move Data: Moving data is similar to copying, except that the data is removed from its original
place. To move data choose the Cut button from the Standard toolbar.

Drag and Drop: The fastest way to copy is to drag and drop the data. To do this, select the cells
to be copied, hold down the CTRL key and drag the border of the selected range. On releasing
the mouse button the data is copied to the new locatiod. The data gets moved to the new location
if the boraer is dragged without holding down the CTRL key.
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To copy data to a div. zrent sheet, press the keys CTRL and ALT 'whilc dragging the selgction
to the sheet's tab. Excel switches to that sheet, where the sclection can be dropped in the
appropriate 1ocation.

Delete Data: To delete data in a cell or range of cells, select the cell or the range and press the

DEL key. The Edit —» Clear command can be used to delete only the formatting of the cell(s).
The Clear command can be used to clear the format, contents, comments or all of them.

The Edit —» Delcte command removes the cells and then shifts the surrounding cells to take
over their place

Example 1. Prepare a worksheet showing employee code, employee name and designation of the
software engineers working 'in a company ATLANTA The employee code starts with 1000
increments by one for each engineer and ends with 1004. Insert today’s date on top of the

worksheet.

* From the Start menu, click on the progiam option and select Microsoft Excel. A
worksheet will open. ’ .

* Place the insertion point in a cell in the top of the worksheet. Type “=today()" in the cell
‘and press ENTER.

* Type Employee code, Employec name, Designation in the cells BS, CS, D5 respectively.
* Inthe first cell of the employee code column: type 2000. In order to fill all the cells of the

employee code column, select Edit — Fill —» Series. _, .

* Enter the step value as | and stop value as 2004, select columns option. Press OK. This
will fill the column. Enter the employee names for each employee code.

* Type Software Engineer in the first cell of the Designation column. To have the same
designation in al] the following cells, select the cell, click and drag through the cells
using the fill handle. This will have a copy of the first cell.

The resultant worksheet is shown in F ig. 2.3.
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2.14. Formatting Rows and Columns
Rows and Columns Insertion

To insert a row or column in the worksheet follow the following steps:
e Select the cell below which the row has to be inserted or the cell to the right of which the

column has to be inserted.
e To insert multiple rows or columns, sclect the number of rows or columns cqual to the

number to be inscrted by clicking and dragging the mouse over the worksheet.
e Sclect Rows or Columns from the Insert menu. Excel inserts row below the selection or

columns to the left of the selection.

A row or column can also be inserted by right clicking the row number or column header and by
clicking the Insert... from the pop-up menu.

Alternately. to insert a row or column, right-click a cell and from the pop-up menu, choosc
Insert option. An Insert dialog box will be displayed. Select the Entire row or Entire column

option to insert a row or column in the worksheet.
Deleting Rows and Columns

When rows are-deleted in the worksheet, the rows below the deleted row move up to fill the
space. When columns are deleted, the columns to the right are shifted to the left.

To delcte 2 row or column, click the row number or column letter on the row or column to be
deleted and then select the Delete option from the Edit menu. To delete more than one row or
column drag over the row numbers or column letters for selecting them. Alternately, right-click
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the selection and choose Delete from the pop-up menu. The rows and columns are renumbered
automatically.

Merging Cells
Exccl allows merging data in one cell with adjacent cells (that are blank) to form a big cell.
Merging cells is useful especially while creating a.decorative title for the worksheet,

To create a title with merged cells, follow the steps given below.

° Enter the title in the upper-left cell of the range. To enter multi-line title. press
ALT+ENTER todnsert each new line.

o Select the range in which the title has to be placed.

* Click Cells from the Format menu. The Format Cells dialog box appears.

* Click the Alignment tab. )

* Click the Merge Cells check box and click OK.

Inserting and Deleting Cells

Inserting cells will cause the data in the existing cells to shift down a row or over a column for

creating space for the new cells. Follow the steps given below to insert a single cell or group of

cells. :

* Select the area where the new cell(s) are to be inserted. Excel will insert the same number
of cells as selected.

¢ Choose Cells from Insert menu. The Insert dialog box appears.

* Select Shift Cells Right or Shift Cells Down and click OK.

To delete the cells completely, follow the steps given below.
» Select the cell or range of cells to be deleted.
¢ Choose Delete from the Edit menu. The Delete dialog box appears.
* Select Shift Cells Left or Shift Cells Up and click OK.

Note. When cells are deleted, they are removed from the worksheet and the surrounding cells are
shifted to fill in the space. But when a cell is cleared, the.cell remains in the worksheet while the
contents, format or notes of the cells are cleared. To clear a cell, select the range of cells to be
cleared and choose Clear from the Edit menu. '

2.15. Password-Protecting 2 Workbook

If the workbook contains confidential information, a password can be applied to it. This will only
allow the users with password to open and view the workbook. To protect a workbook. follow the
steps given below.

e Open the workbook and sclect Save As from the File menu.

* In the Save As dialog box, click the Tools bution to display the drop-down menu and
choose General Options. The Save Options dialog box shown in Fig. 2.4 appears.

* Enter the password in the Password to Open box.

* To have a separate password for editing the file, enter the password in the Password to
Modify box.

o  (lick OK.

4n the Confirm Password dialog bex, re-enter the password for verification.

Click OK to return to the Save As dialog box.
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o Specify a filename and path for the file and click Save. )
o If prompted, click Yes to replace the old version of the file with the new password-

protected version.

If the Read-only recommended option is selected in the Save Options dialog box, the user is
prompted whether he or she wants to open the file as read-only. On selecting Yes, the changes

o

made to the file must be saved under a different ﬁlenamg.
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Figure 2.4: Password-Protecting a workbook

2.16. Ranges

A range is a rectangular group of cells. The smallest range is a single cell and the largest range
includes all the cells in the worksheet. A range can include cells from same sheet or cells from
adjacent sheets: Ranges arc defined by the addresses of two opposite or diagonally paired corner

cells separated by a colon or two dots.
Ranges can be set when only a part of the worksheet has to be printed. To print the selected

range, follow the steps given below. !

» Select the range of cells to be printed.

o In the File menu, point to the Print Area option and click Set Print Area.
The print area set is indicated by a dotted line around it in the worksheet.

e To check click the Print Preview button.

To print non-adjacent columns or rows in a table, hide the columns or rows not needed to print.
To do this select the rows or columns and right-click the selection and select Hide.

2.17. Quit from Excel

The user can quit the Excel appfication by selecting Exit from the File menu. It is always
recommended to save and close the file before quitting Excel. If a workbook has riot been saved,
Excel displays a confirmation box to confirm whether to save or quit without saving changes.

2.18, Formula

Excel formulae can be used to perform simple calculations on the data like addition. subtraction,

wmultiplication and division. One of the significant.features of a spreadsheet program is its ability

to manipulatc text and perform simple and complex calculations cfficiently. Formulae usually

consist of one or more cell addresses or values and a mathematical operator such as +, - * and /.
Formulae are of the following three types.
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Text Formulae: Uses text and maﬁf' contain the text operator ampersand (&) which concatenates
two numbers. For example, if we type the expression =123 & 456 in a cell, then the result
123456 will display in that cell.

Numeric Formulae: Contains arithmetic operators like +, -, *, /, A and %. For example,
(A1+A2+A3+Ad) or Al:A4.

Logical Formulae: Contains comparison operators like >, <, <=, >=and <.

A formula can be up to 255 characters long. A formula must always begin withan '=", '+ ora -’
sign. Formulas do not accept spaces, except between sets of letters, numbers or symbols enclosed
in quotation marks.

Order of Evaluation of Operators

Excel evaluates a formula in a particular order determined by the precedence number of the
operators being used and the parentheses placed in the formula. This is listed in the following
table.

Operator | Description recedence Number
: Range of cells
Space |Intersection of cells

, Union of cells

- Negation

% Percentage .
A Exponentiation
&

/

+

ultipiication
ivision
ddition
- . {Subtraction
& gncatenation
= ual to
< sser than
> reater than
<= esser than or equal to
>= reater than or equal to
< ot equal to

[ oI NN N e N S SN PO I S By

COO0OC O

2.19. Entering a Formula

A Formula can be entered in two ways, i.e. by typing the formula or by selecting cell references.
To enter a formula, the following steps are performed.

e Sclect the cell in which the formula calculation has to appear.
o Type the equal sign "=" or click the Edit Formula button in the Formula bar. Type the
formula and press ENTER.

Example 2. Open a new sheet and type the numbers 10, 45, 15 and 90 starting from cell Al ©©

A4. Now select the cell AS and type =Al +A2 +A3 +A4 and press ENTER. The sum 150 is
displayed in the cell AS. To edit the formula select the cell AS and press F2.
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To enter a formula by selecting cell references, follow the steps given below.

e Select the cell in which the formula's result has to be displayed.

e Type the equal sign "=" or click the Edit Formula button in the Formula bar. Ciick. the
cell whose address has to appear first in the formula, We can also click a cell in a
different worksheet or workbook. The cell address appears in the formula bar

e Typc the mathematical operator after the value to indicate the next operation to be
performed. The operator appears in the Formula bar. ,

e Continue to click the cells and type the operators till the formula is complete and press

ENTER.

An error appears in a eell, if anyone of the following operations is performed. Division by zcro,
use of a blank cell as a divisor. referencing to a blank cell, deleting a cell used in a formula or
including a reference to the cell in which the result appears.

Referencing Methods . . )
A formula can be moved from one worksheet location to another. When a formula is moved, the

cell addresses are automatically changed relative to the location to which they are moved. This is
known as Relative referencing. By default, Excel does not treat cells included in the formula as a
set location but considers them as a relative location. This type of referencing saves time for the
user, since the same formula need not be created repeatedly. For example, AutoSum formulas are

written with relative referencing.

In certain situations. it might be cssential to refer to the same specific cell on'the worksheet in

every copy of the formula. The Absolute referencing method is used in such cases. Absolute
references are denoted by dollar signs before the column and'tow addresses, for example SAS2.
. In case some part of the' address needs to be fixed, Mixed referencing is used. Mixed
refercnces contain both absolute and relative cell addresses, like $A2 or (°$4. To quickly cycle
through the reference types, click the formula bar and press F4. This will change the reference to
$AS1, AS1, $AL, and A with cach press.

AutoSum
SUM is one of the most commonls used functions and Excel provides a fast way to enter it The

AutoSum button on the Standard toolbar = automatically sums the rows or columns The
AutoSum tool automatically builds a SUM formula in the active cell based on a contiguous range
of numbers, either above or to the left of the active cell.

AutoSum can be used in the following three ways.

e To locate and total rows or columns in the range nearest to the current cell.

¢ Tototal any sclected range.
o To add grand totals to a range containing other totals.

To sum rows or columns for the nearest range click the AutoSum button and press LNTER or
double click the AutoSum button. To find the sum of a specific range, select the range and click
the AutoSum button. To add grand total to a range of cell values select the entire range. including
sub-totals and click the AutoSum button.

2.20. Naming Cells
We can use different methods to name cells. The Name box, the Create Names dialog box and the

96



Define Name dialog box.

Using the Name Box

The Name box is the fastest way of naming a cell or range of cells if we are creating a single
name. The Name box can alSo be used if the name is not already a label or table heading on the
worksheet. _ . '
Follow the steps given below to name a cells or range of cells using a Name box.

* Select the cell or range of cells to be named.

e Click the Name box (Fig. 2.5).

e Type the name and press ENTER.
Hereafter, whenever the range is sclected, the name appears in the Name box.
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Figure 2.5. Naming cells

Writing Formulas with Named Cells

To use cell and range names in a formula follow the steps given below.
» Click the cell in which the result of the formula has to be displayed.
* Type the formula by pressing an "=" in the beginning.

* Toinsert the formula in a particular cell, type the name or select Insert — Name —»
Paste from the menu bar and click the name in the list.
» Complete the formula by pressing ENTER.

Example 4.
Payroll sheet of the employees is given in the following table:

Wanre Pay rate | Hours .
Pal . BS 13




Karmakar 20 15
Nandi 22 20
Verma 40 23
Mondal D3 B

The gross pay for each employec, and the total number of hours worked are calculated using
the following steps.

Select the cell to the right of hours.

Typ: the equal sign "=". :
Click the Payrate cell whose address has to appear first in the formula. The cell address
appears in the formula bar. )

Type the “*" sign after the value. Click the hours cell whose address has to appear next in
the formula. Press ENTER.

Drag the fill handle to the rest of the cells in the column. The gross pay for other
empioyees are displayed in the corresponding fows.

Name the hours column by selecting the entire column. The name box is clicked and the
column is named as “hours™. )

Place the inscrtion point in the cell where the total number of days worked should be
displayed. Click AutoSum button and select the entire hours column, press ENTER and
the sum is displayed in the cell. The resultant sheet will be as shown in Fig. 2.6.
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Figure 2.6.

2.21. Functions .
"Functions are special pre-written formulac that take values and perform operations and then
return a value 10 the cell in which they arc entered. Functions simplify and shorten formulae in
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the worksheet. For example, instead of using the formula =Al+A2+A3+A4+A5 we can use the
function =sum(AL:AS). In certain instances, functions arc the only way in which certain tasks can
be carried out. '

Specifying Arguments

In order to perform certain tasks. functions rcquire specific information called Arguments.
Arguments are values that are passed to the functions to perform operations. The number of
arguments in a function varies between 0 and 14 and the length is restricted to 255 characters
including quotation marks, if any. Arguments can be Constants, Cclls or ranges, Range names or
Functions.

Function Wizard

The Function Wizard can be uscd to select the Function and assemble the arguments correctly.

Although functions can be typed dircctly into a cell, the Function Wizard can bc used to
simplify the process. The Function Wizard helps in the process of inserting a function. The steps
in the Function Wizard arc the following.

* Select the cell in which the function has to be inserted.

* Type "=" or click the Edit Formula button on the Formula bar. The Formula Palectte
appears. .

e Select the function that has to be inserted from the Functions list by clicking the arrow
on the Functions drop down list. If a particular function is not listed in the Functions list,
click the More Functions option at the bottom of the list.

e Enter the argument for the formula. To sclect a range of cells as an argument, click the
Collapse Dialog button. '

e Afier sclecting the range, click the Collapse Dialog button again to return to the
Formula Palette.

e Click OK to return to the worksheet.

Common Functions

Some of the commonly used functions and their purposes are shown in the following table.

Functions Purpose .

SUM Add the values in the selected range.

MIN Find the minimum value in the selected range.
MAX Find the maximum value in the selected range.
AVERAGE Average the values in a selected range.
COUNTIF Count all values that meet specific criteria.
SUMIF Add togethcer all values that meet specific criteria.
VLOOKUP and Find a value in a table.

HLOOKUP

IF Display a value that depends on a set criferia.
PMT Calculate the payment for specific loan terms.
NOW Return current date and time.

TODAY Return the current date.

CONCATENATE Join cell values together in a singlc cell.

LEFT and Recturn a specific number of characters from the left (or right) end of a cell's
RIGHT value. :

2.22. Formatting
Formatting makes a worksheet look pleasant and makes the data morc meaningful by visually
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segregating data into groups. We can format cells, columns, number, text, border and alignment.
Formattingcan be done in the following three ways:

» Selecting tools from the Formatting toolbar

e Using the Format menu

e Using Automatic

Using the Formatting Toolbar

In order to display the Formatting toolbar, right-click any toolbar or menu bar and then select

Formatting option from the shortcut menu. The most frequently used formats are available on

formatting toolbar. Using the formatting toolbar makes the formatting work easier and quicker.
To find the hidden buttons in the toolbar, click the small arrow at the right end of the

toolbar and click the Add or Remove Buttons. Click the buitons that have to be displayed in the

toolbar.

Formatting Cells: After entering data, ExXcel's formatting features help us to make the worksheet
and its contents fit together.

Aligning Entries: When data is entered, the text is automatically aligned to the left side of the
cell and numbers to the right side. The Align Left, Center and Align nght buttons in the
Formatting toolbar can be used to change the default alignment.

Rotate Cell Entries: Follow the steps given below to rotate the text entered in the cells.
e Select the cells that have to be rotated.
e Click Cells in the Format menu.
e On the Alignment tab, under Orientation, click in the half-circle to set a rotation angle
as shown in Fig. 2.7.
e Click OK.
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Figure 2.7.
Changing Column Width -and Row Height: In most of the worksheets the column has to be

/
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resized and row height adjusted. There are several ways to resize rows and columns.

Resize a Column Visually: Position the mouse pointer over the right border of the column
selector for the column that has to be resized. When the mouse pointer becomes a t'wo-headed
arrow, drag the border 1o resize the column. Follow the same procedure to resize the rows as well,
but in this case drag the bottom border of the row selector for the row that has to be resized.

Best-Fitting: When the worksheet is too large, we can save the trouble of guessing the
appropriate width by “best-fitting” the column width. Tg best-fit columns, follow the steps given

below.

* Position the mouse pointer over the right border of the column selector for the column
that has to be best-fit. . :

*  When the mouse pointer becomes a two-headed arrow, double-click the border to best-fit
the column. '

To best-fit a row, follow the same steps as above, but in this case double-click the bottom
border of the row selector for the row to be resized.

Marching Precise Width or Height: We can match the measurements of rows and columns that
are far apart in a worksheet or in a different worksheet. To achieve this, set the precise
measurements for the columns and rows to be matched and they will match exactly. To set a
precise column width or row height, follow the steps given below.

* Right-click a column or row selector.
* Click Column Width or Row Height.
* Enter a new measurement and click OK.

Hide or Unhide Rows and Columns :
We can hide important but cluttered cells. by hiding those particular columns and/or rows. The
worksheet will still continue to function properly. In order to hide rows or columns, right-click
the selector (row number or column letter) for the row or column that has to be hidden and click
Hide. To hide multiple rows or columns, select the rows or columns and then select Hide.

To unhide rows or columns, select the rows or columns on both sides of the hidden column(s).
Right-click the selection and select Unhide from the shortcut menu.

Shrinking Entries to Fit a Cell: In case there is a cell entry that does not fit and we also do not
want to widen the column for that particular cell, we can shrink the entry so that it fits within the
column width. To shrink an entry to fit the column width, follow the given steps.

* Select the cells whose entries have to be shrunk.
¢ Click Cells from the Format menu.
* Click Shrink to fit check box on the Alignment tab and click OK.

Wrap Text to Multiple Lines: A different method to fit long entries in a narrow column is to wrap
the text into multiple lines. Wrapping increases the row height. To wrap an entry to multiple lines
follow the given steps. :

* Select the cells whose entries have to be wrapped.

* Click Cells from the Format menu.

o Click Wrap text check box on the Alignment tab and ctick OK.

Applying Number Formats: To format a number value, follow the steps given below.

-
*  Stlect the cell or range of cells to format.
® Click Cells in the Format menu.
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e Select a format category on the Number tab.
e Select and set the options available for the format category and click OK.

To format dates and times, select the Date or Time from the Category list box.

Formatting Borders: Border segregates information so that it is quickly understood. Since Excel
does not print the worksheet gridlines, the borders have to be specified explicitly. To apply
borders quickly. we use the Borders palette. To display the Borders palette, click the Borders

button — : :
The Format Cells dialog box can also be used to apply borders. Selcct the Borders 1ab to sct

the appropriate border.

AutoFormat: To apply a format automatically, select a range and choose the AuteFormat
command from the Format menu. Select one of the different table formats, including formats for

financial and accounting data.

Adding Graphic Images to a Worksheet: 1 is possible to add a logo or graphic image to a
worksheet. To paste a graphic image into a worksheet follow the steps given below.
e Make enough room for the image in the worksheet. .
e Click the cell where thc picturc has to be pasted.
e  On the Insert menu, point 10 Picture and then click From File.
 In the Tmsert Picture dialog box, double-click the image file. The picture will be inserted
at the selected cell.

2.23. Printing a Worksheet

Once the data is entered, the calculations and formatting is completed the next step is to take a
printout of the worksheet. Excel provides scveral options for customizing the printing job. To
print a worksheet, click Print from the File menu. The Print dialog box will appear on the

screen. The Print dialog box will give an overview of the available options.

To select various options such as Print quality, Paper orientation, Media and Media sizes click
the Properties button. The Preview button gives a view of the document that is to be printed.
To make adjustments (margins, page size, etc.) before printing the document, sclect the Page
Setup option from the File menu. This is used 10 specify major facets of the page like page
layout, margins, etc.

Setting and Removing a Print Area: If only a part of the worksheet has to be printed repeatedly.
the print arca can be set which allows printing the range quickly without selecting it first. To sct a
print area in the worksheet, follow the steps given below.

e Select the range of cclls that has to be included in the print area
e On the File menu, point to Print Area and click Set Print Area. ‘The print area will be
set and a dashed line is displayed around it in the worksheet.
To remove a print arca, point to Print Area in the File menu and select Clear Print Arca.

Printing a Selected Range: To print a range of cell in a worksheet only once without setting print
area follow the steps given below:

o Sclect the range of cells to be printed.

e Click Print from the File menu.

e inthe Print dialog box, click Sclection under Print what and click OK.
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Programming in C

3.1. Introduction

C is a high level programming language was developed by Dennis Ritchie and was implemented
at Bell Laboratories in 1972. This language running under different operating systems. At present
it is the most useful programming language and it is used as gencral purpose programming

language.

3.2. The C character set .
A computer key board contains many symbols (characters), some of them are used to writc a
program in C. The valid C characters are listed below. ‘

The C character set consists of alphabets A - Z (upper case), a - z (lower casc), digits 0 - 9
and some special symbols listed below: .

1 » + \ “ <
RO =1 { >
% ) ~ 5 }y
A e s, 2
& _ '} ¢ . blank

C uses certain combination of these characters such as \b, \n and \t, to represent spccial
conditions such as backspace, newline and horizontal tab, respectively. These characters
combination are known as escape sequence. ‘

3.3. Constant data

Any entry which remains unchanged during the exccution of a C program is defined as a
constant. [t

may be of integer constants, floating point constants, character constants and String constant.

Integer constant

An integer constant is a whole number that is written as a string of decimal digits withouta
~decimal point or an exponent symbol. It can be either positive or negative. It is also called a fixed
" point constant.

Some valid integer constants:
25 0 -7 +12367

Long integer constant ‘

Long integer constants may excced the magnitude of ordinary integer constants, but require more
memory within the computer. ‘
Floating point constant X ;

A signed or an unsigned whole number containing a decimal point or an exponent or both, is
called a real or floating point constant. '
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Some valid real constants :
2613 0.12 -0.563 0.000017 23 L.

Character constant )
A character conistant is a single character, enclosed in apostrophes (single quotation marks).

b

Some character constants are_‘x’, ‘a’, ‘B’, ‘6’, '+’

.. String constant : ' '
A string constant cowsists of any number of consccutive characters enclosed in double quotation
marks.

Following are the valid string constants: o
“raman” “Botany” “Rs. 2345” “Vidyasagar University’

X3 “w

3.4. Variables and arrays .

A quantity that varies during program execution is called a variable. Each variable has a specific
storage location in memory where its numerical value is stored. The following rules must be
satisfied by every C variable.

(i) The first character must be an alphabet.

(ii) The variable name can have at most 32 characters.

(iii) The variable name should not contain any special character other than underscore.

(iv) Upper case and lower case letters are different, i.c., C is case sensitive.

The array is another kind of variable that is used extensively in C. An array-is an identifier
that refers to a collection of data items which all have the same name. The data items must all be
of the same type (for example, all integers, all characters, etc.). The individual data items are
represented by their corresponding array element, i.c., the first data item is represented by the
first array element, and so on. The individual array elements are distinguished from one another
by the value that is assigned to a subscript.

Suppose that x is an array having 10 elements. The first element is referred to as x[0], the
second as x| 1], and so on. The last element will be x[9].

The subscript associated with each element is shown in square brackets. Thus, the value
of the subscript for the first element is 0, the value of the subscript for the second element is 1.
and so on. For an n-element array, the subscripts always range from 0 to n-1.

There are several differcnt ways to categorize arrays (e.g., integer arrays, character
arrays, one~dimensional arrays, muitidimensional arrays).

3.5. Declarations
A declaration associates a group of variables with a specific data type. All variables must
be declared before they can appear in executable statements.

A declaration consists of a data type, followed by one or more variablc names,
ending with a semicolon. Each array variable must be followed by a pair of squarc
brackets, containing a positive integer which specifies the size (i.e., the number of
elements) of the array. '

A C program may contain the following type declarations:

int a, b, c[20];
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float X, ¥, 2 u
char flag, name[25];

thus a, b are declared to be integer variables and c¢ is an 20-element integer array
variables x, y, z and u are floating point variables. flag is a char-type variable and name i
a 25-element char-type array. '

3.6. Expressions . 4
In C. an expression is a combination of variables, constants, operators and functions. Ap
algebraic expression can not be entered to the computer directly. Before entering an algebraic
expression in the computer it should be converted to a C expression. Three major types of

~expression namely (i) arithmetic expression, (ii) logical expression and (iii) character expression .

are used in C. . _
Expressions can also represent logical.conditions that arc either true or false. However. in

C the conditions true and false are represented by the integer values 1 and 0, respectively. Hence,

logical-type expressions really represent numerical quantities.

Arithmetic Operators : :

The following are the symbols for C operators corresponding to different arithmetic operators.

Operator  Purpose

+ Addition

- _ Subtraction

* Multiplication

/ Division

% Remainder after integer division

The operator % is sometimes referred to as the modulus operator. There is no exponentiation
operator in C. However, there is a library function (pow()) to carry out exponentiation.

Integer expression L
The mathematical expression obtained by combining integer variables and integer constants with
the help of arithmetic operators, is known as integer expression.

Note on integer division
When an integer is divided by an another integer then the result may contain a fractional part. But
in C, the fractional part is discarded during calculation. Let a=S5, b=2.Then :
atb=7
a-b=3
a/b=2(not2.5)
a%b=]

The value of the expression 32/5*5+8/9 is calculated as follows:
32/5*5+8/9=6*5+0=30+0=30

Real expression

The mathematical expression obtained by combining real constants and real variables with the
help of arithmetic operators, is known as a real expression.
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Nate: : .
All the exponents arc evaluated (irst. After completion of exponents the expression is scanncd
from left to right, to complete execution of all divisions and multiplications in the order of their
appearance. Finally, all additions and subtractions are performed again from the left of the
expression. If there is any parentheses within the expression then the expression within the
parentheses is cvaluated first using the above rules.

Hierarchy of arithmetic operators :
The hierarchy of operators is the order in which the arithmetic operatsons are executed. The

hierarchy of arithmetic operators is shown in the following table.

Operator Hicrérch_v
multiplication (*), division (/) and modulo (%) First
addition (+) and subtraction (-) + | Second

Relational operators

We often compare two quantities and depending on their relation, take certain decisions. For
example, we may compare the age of two persons, or the price of two items and so on. These
comparisons can be done with the help of relational operators. The value of a relational
expression is either one or zero. It is one 1f the specified relation is true and zcro if the relation is
false. For example, 20<30 is true while 40<30 is false. The six relational operators and their
meanings are shown below:

Operator Mcaning

< Is less than v

<= Is less than or equal t

> Is greater than

>= Is greater than or equal to

== Is equal to ' .
1= Is not equal 10

Logical operators
In addition to the relational operators, C has the following three logical operaltors.
Operator | Meaning
&& Logical AND
I | Logical OR
! "| Logical NOT

The logical operations && and || are used when we want to test more than one condition and
make decisions. An example is : x<y && x<z

An expression of this kind which combines two or more relational expressions is termed as a
logical expression or a compound relational expression.

Increment and decrement operators ;
The language C has two very useful operators not generally found in other languages. These are
the increment and decrement operators: ++ and -~ .
The operator ++ adds | to the operand while - subtracts 1. Both are unary no.
take the following form: ++a or a++, ~ b or b——.
++a or a++ is equivalent to a=at]
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-~aora--isequivalent to a=a-|

3.7. Mathematical Functions ‘
There are cerain mathematical functions such as trigonometric, exponential. l_ogarithmlc.‘elc.‘
- which are frequently used in_programs, especially to solve scientific problems. These functions
are gemerally referred as Library functions, built--in functions or intrinsic functions. The general

form of these functions is
Function name (argument)

The argument of a function can be a valid variable name or an expression. It can also be a real
number, an integer, a charac'er or a string. The argument should be written within parentheses. If
a function has more than onc argument then they are separated by comma. Some commonly used
library functions arc listed in the following table.

Function Meaning
sqr(x) Square root of x, x>=0
w(X.y) x to the power y (x%)
log(x) Natural log of x, x>0
log10(x) Pase 10 log of x, x>0
exp(x) the power x (e”)
fabs(x) solute value of x
| fmod(x,y) remainder of x/y
ceil(x) X rounded up to the nearest integer |
floor(x) x rounded down to the nearest integer -
cos(x) cosine of x
sin(x) sine of x

All these functions are not available in C program unless we use the following statement at the
beginning of the program. '
#include<math.h>

3.8. Assignment Statement
An assignment statement is an exccutable statement in which a new value is assigned tu a
variable. Its general form is

v=¢ . '
where v is a variable and e may be a constant, another variable or an expression to which a value
has been assigned previously or a formula which can be evaluated by the computer.

Some arithmetic assignment statements are
x=5.9
=a
z=atb*c.

3.9. Input/Output Statentents .

To enter the value of variables to the computer the input and output statements arc used. C does
not have any built-in input-output statcments as part of its syntax. All input/output operations are
carried out through function calls such as scanf() (input statement) and printf() (output
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statement). These functions are collectively known as the standard 1/0 library. Each program that

uses a standard input/output function must contain the statement
: #include <stdio.h>

at the beginning. The fine name stdio.h is an abbreviation for srandard input-outpul header file.
I'he instruction #include <stdio.h> tells the computer ‘to search for a file named sidio.h and
place its contents at this point in the program.’ The contents of the header file become part of the
source code when it is compiled.

Reading a character

I'he simplest of all input/output operations is reading a character from the standard input unit

(usually the keyboard) and writing it to the standard output unit (usually the screen). Reading a

single character can be done by using the function getchar(). The syntax of this function is
variablename=getchar()

variablename is a valid C variable that has been declared as char type. When this statement is
executed, the computer waits until a key is pressed and then assigns this character as a value 10
getchar() function. For example, -
char sex;
sex=getchar(),

If we press the key ‘m’ then the value of the variable becomes 'm’

Writing a character
Like getchar(), there is an similar function putchar() for writing character one at a time to the
terminal, Its general form is By
. putchar(varibaiename);
where varibalname is a type char variable containing a character. This statement displays the
character gontained in the variablename at the screen. For example,
sex='m’,
putchar(sex).
will display the character ‘m’ on the screen. The statcment
. putchar('\n’),
would cause the cursor on the screen to move to the beginning of the next line.
The scanf() fun. tion :
Input data can be entered into the computer from a standard input device by means of the C
library function scanf(). This function can be used 10 enter any combination of numerical valyes,
single character and string. The function returns the number of data items that have been entered
successfully. '
The general form is

scanf(control string, arg1, arg2, . . .. argn), .
where control string refers to a string containing certain required formatting information, and
arg1, arg2, . . ., argn are arguments that represent the individual input data items. ‘

The control string comprises individual groups of characters, with one character group for
each input data item. Each character group must with a percent sign (%). In its simplest form, a
single character group will consist of the percent sign, followed by a conversion character which
indicates the type of the corresponding data item. Some commonly used conversion characters for
data type is shown below: . ’
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Conversion character Meaning

C : Data item is a single character
d Data item is a decimal integer
f Data item is a decimal floating-point value

i Data item is a decimal integer, octal integer or
hexadecimal integer

0 Data item is an octal integer
Data item is a hexadecimal integer
{ s Data item is a string

char name[25];

int rolino; . .

float age;

scanf(*%d %s %f" &rolino,name, &age),

Within the scnaf() function, the control string is “%d%s%f™. It contains three character groups.
The first character group, %d, indicates that the first argument (&rollno) represents a decimal
integer value. The second character group, %s, indicates that the, second argument (name)
represents a string, and the third character group, %f, indicates that the third arguments (&age)
represents a floating point value.

The printf() function
Output data can be written from the computer onto a standard output device using the library
function printf(). This function can be used to output any combination « i numerical values, single
characters and strings. It is similar to the input function scanf(), except that its purpose is to
display data rather than to enter data into computer. That is, the prinft() function moves data from
the computer’s memory to the standard output device. The general form of printf() function is
printf(control string, arg1, arg2, . . ., argn),
where control string refers to a string that contains formatting information, and arg1, arg2, . . .,
argn are arguments that represent the individual output data items. The arguments can be
constants, single variable or array or more complex expressions. Function references may also be
included. The control string is composed of individual groups of characters, with one character
group for each output data item. Each character group must begin with a percent sign (%). In its
simplest form, an individual character group will consist of the percent sign followed by a
conversion character indicating the type of the corresponding dati item.
The following C statements illustrate the use of the printf() function.

inti=10;
float x=23.923;
printf("The value of i=%3d and the value of x=%f",i,x);

These statements will print the following output
The value of i= 10 and the value of x=23.923000

The gets() and puts() functions

These functions accept a single argument. The argument must be a data jtem that represents a
string (c.g., a character array). The string may include whitespace characters. In the case of
gets(), the string will be entered from the key board and will terminate with a newline character
(i-c., the swing will end when thie user presses the return key).
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3.10. Compléte programs i ,
Now, trom the ongoing discussions we have sufficient resources to write a complete program in

C.

Example 1. Write a program to find Fahrenheit temperature from the corresponding Centigrade
temperature,

Solution: We have the relation between Fahrenheit (F) and Centigrade (C) temperature as

Y . 9C+160
or F =220

<

* Conversion from Centigrade to Fahrenhei */
#include<stdio.h>

main{)
{
- float ¢, f;
scanf(*%f",c);
f=(9*c+160)/5.0; .
printf(*The Centigrade temperature is %f when Fahrenheit temperature is
%f\n” ¢
}

Example 2. Write a program to find the suin and average of five real numbers.

Solution: We denote the variable as a, b, ¢, d, e. The sum of them is sum=a+b+c+d+e and
average is average=(a+b+c+d+e)/S=sum/S.

/" Program to find sum and average of five numbers */
#include<stdio h>
main()
{

float a,b,c.d.e;
scanf(“%f%f%f%f%f" a,b.c.d,e):
sum=a+b+c+d+e;
average=sum/5;
printf("The sum=%f and average=%f\n",sum,average);

3.11. Control Statements

In most of C programs we have encounter so far, the instructions were executed in the same order
in which they appeared in the program. Lach instru tion was executed once and only once.
Programs of this type are very simple, since they do not include any logical control structures.
Many programs rcquire that a group of .astructions be executed repeatedly, until some logical
condition has been satisficd. This is known as looping. Sometimes the requircd number of
repetitions will not be known in advance; the computation simply continues until. the logical
condition becomes true. In C the most useful looping statements are while, do-while and for.

*
The while'statement ‘
The while statement is used 1o carry out looping operativns. The general form of the statement is
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while (expression) statement

Or
) while (expression)

{

statements

The included sratement will be executed repeatedly, as long as the value of expression is not
zcro. This statement can be simple or compound, though it is typically a compound statement. It
must include some feature which cventually alters the value of expression, thus providing a
stopping condition for the loop. Usually, the expression is a logical expression that is either true
or false. Thus, the statement will continue to execute as long as the logical expression is true.

The following program will find the sum of first 20 natural numbers using while loop.

#include<stdio.h>
main()
{
int x=1, sum=0;
while (x<=20)
{
suM=sum+x;
+4+X

printf(“The sum of first 20 natural numbers is %d",&sum);

The do-while statement
When a loop is constructed using the while siatement, the test for continuation of the loop is
carried out at the beginaing of cach pass. Sometimes, it is dcsirable to have a loop with the test
for continuation at the end of each pass. This can be done with do-while loop.

The general form of the do-while statement 1s

do {
.statement;

}

while(logical expression)

The included starement will be executed repeatedly, as long as the value of expression is not
zero. Notice that statement will always be executed at least once, since the test for repetition does
not occur until the end of the first pass through the loop. The statement can be either simple or
compound, though most applications will require it to be a compound statement. Usually logical
expression is a logical expression which is either true or false. The included statement will be
repeated if the logical expression is true. '

The for statement
The for statement is the third and perhaps the most commonly used looping statement in C. This
statement includes an expression that specifics an initial value for an index, another expression
that determines whether or not the loop is continued and a third expression that allows the index
to be modified at the end of cach pass.

The general form of the do statement is
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for(exprssiont; expression2; expression3)

{

statement;

}

where expressionl is used to initialize some parameter (called an index) that contrc?ls the !oop?ng
action, expression2 represents a condition that must be satisfied for the loop to continue execution
and  expression3 is used .to alter the value of the parameter mmglly 2.1551gned ' by
expressionl.Generally, expressionl is an assignment expression, exp.resszonz is a logical
expression and expression3 is a unary expression or an assignment expression.

When the for statement is executed, expression2 is evaluated and tested before each pass
through the loop, and expression3 is evaluated at the end of each pass.

Example 3. Write a pr(')Jgram to find the sum and average of n real numbers.
Solution. Let x[0], x[1], x[2], . . ., Xx[n-1] be the set of n real numbers. Their sum and average are
computed by the following formula '

n=}
sum = Zx[i] and average = sum/n.
1=0

.

[

/* Program to find the sum and average of n real numbers */
#include<stdio.h>
main()
{ .
intn,i;
float x[50];
fioat sum=0; average,
printf(“Enter the value of n *);
scanf("%d” &n);
printf(*Enter data\n”),
for(i=0;i<n;i++) scanf(“%f" x[i]);
for(i=0i<n;i++)
sum+=x[i].
average=sum/n;
printf(“The sum=%f and average=%f",sum,average),

3.12. Decision making and branching
The C language possesses decision making capabilities and supports the following statements
known as control or decision making statements.
¢ if statement
e switch statement
e Conditional operator statement
e goto statement
Here w shall discuss if and goto statements.
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if statement R
The if statement is a powerful decision making statement and is used to control the flow of
cxecution of statements. It is basically a two-way decision statement and is used in connection
with an expression. Its general form is '
; if (logical expression)
It allows the computer to evaluate the expression first and then, depending on whether the value
of the expression is true or false, it transfer the control to a particular statement.
The if statement may be implemented in different forms depending on the nature of the

condition to be tested. .
e Simple if statement

» if.. else statement

¢ Nested if...else statemer--

The simple if statewsent .
The general form of a simple if statement is

if(logical expression)

statement;

}

The statement may be a single statement or a group of statements. If the logical expression is
true, the siatement will be executed; otherwise the statement will be skipped and the execution
will jump to the outside if block. It may be noted that if the logical expression is true then both
the statement and the outside statement are executed in sequence.

Example 4. Write a progrém to find the maximum among n real numbers.

- Solution. | et x[0], x[1], x[2], . . ., x[n-1] be the set of n real numbers. To find the maximum,

initially we set max=x[0]; for remaining data we check the condition x[i}<max. If it is true then
max will be updated as max=x[i] otherwise no action is required. The following program finds
the maximum among n numbers.

I* Program to find the maximum among n real numbers */
#include<stdio.h>
mairy)
‘-

int n,i;

float x[50},max;

printf(“Enter the value of n *);

scanf(*%d",&n);

printf(“Enter data\n”);

for(i=0;i<n;i++) scanf(“%f" x[i});

max=x[0];

for(i=0;i<n;i++)

if(x{i}<max) max=x(i; :
printf(*The maximum among the given numbers is %f*,max);
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The if...else statement
Fhe if  else statement is an extension of the simple i stafement. I'he gencral torm is
if(logical expression)

true-block statement;
étse

false-block statement;

o
I the Ingicai oxpression is true, than the true-block stcement, immediately following the if
stncment are executed; otherwise. th. fulse block starement are executed. In either case; cither
tiue Mock or fulse block will be executed. not both.
Fet us consider an example of counting the number of male and {emale students in « class.
We use code | for male and 2 for female students. To find number of nrale and female students
we may usc the tollowing program scgment.

if{code==1)

{
male++;
}
else
female++;
}

The got statement

Like other languages, C also support the goto statément to branch umondmonally from one point
to another in the program. The goto statement requires a label in order to identify the place where
the branch is to bc made. A label ‘is any valid variablc name, and must be followed by a colon.
The general form is shown below:

goto stop;

" statement(s);
stop:
statement;

3.13. Worked out examples
Example 5. Write a program to find the maximum among three numbers.

Solution: The following program finds maximum among three numbers using simple if
statement.

/* Program to find maximum among 3 numbers, using if statement */
#include<stdio.h>
main()
float a,b,c,max;
printf(“Enter three numbers\n");
scanf("%f%f%f".a,b,c);
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max=a,
if(max<b) max=b;
f(max<c) max=c,
printf("The maximuam number is %f" . max),

}

Example 6. Write a program to find the standard deviation of a sample ot size ».
Solution: et x{O1. x| 1] . . .. x[n-11 be a samplc of size n. The standard deviation of this sarple
is

e e e e e ——— . aan

—
l nei A ,] 6~ N 3

§ = ;~-}_‘(x,, -Xx) = ,-~-Zx, - X
’n =0 Vn 1=0

where ¥ denotes the mean of the sample.

i* Program to find the standard deviation of a sample */
#include<stdio.h>
#include<math.h>
main()

{ . .
nti,n;
float x[50),s,sum=0.sum2=0;
printf("Enter sample size "),
scanf("%d",&n);
for(i=0,i<n,i++)
scanf("%f", &x{i});
for(i=0;i<n;i++)
{
sum+=x{i].
sum2+=x[ij*x{i];

xbar=sum/n;
s=sqgrt{sum2/n-xbar*xbar).
printf(“The standard deviation of the given sample is %f".s),

3.14. User-defined function

Like other programming languages, C also’provide the facility of functions. Such facility is the
most powerful and convenient way to solve a large problem. The programmer can divide a large
problem into several smaller subprograms (blocks), which when reassembled constitutes the
complete C program. C functions can be classified into two categories, namely, library functions
and user-deiined funcrions. The main() is an example of user-defined function. The functions
printf() agd scanf() are library functions. Also sin(), cos(), IOQ'().- cte are library functions. The
main différence between these two categories is that library functions are not required to be
written by user wherenas a user-defined function has to be developed by the user at the time of
writing a program. The function main() is a specially recognized function in G, Every program
must have the main() function to indicate where the program has to begin its exccution. ;
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Example 7. Write a program to find the correlation cocfficient of a bivariate sample of size n.

Solution. The correlation coefficient is denoted by r and dcfined by

- l nel . - . ! n-1 S
. sovix.y) where cov(x,y)= = )_(X, = X)(¥, = ¥) = nzxy -
. nio =0
1 n-1 ) —2
and Sy= *Z)’, =y
n 1=0

Let sumi(x[iD= x[0]+x[1]+.. . ex[n-1]; sum2(x[i])= ’x(O}zwLx[l 2+, .. +x[?- 1]%; and simi!arly'
sum 1(y[iD=y[OF+y[1}+. . . +y[n-1]; sum2(y{i})= y[0) ry(1]7+. .. +y[n-1]" and sumxy(x[i].y(i]}*
x[0]y[O}+x[1]y{1]+. . . +x[n-1]y[n-1].

Therefore, Sx=sqrt{sum2(x)/n-(sum 1(x)/n)’ } and similarly Sy=sqn{sum2(y)/n-(suml(y)/n)z}
and cov(x,y)=sumxy(x,y)n- (suml(x)/n) (sr'mI(y)/n).

The C program is given below.
/* Program to find the correlation coefficient of a sahwple of size n */

#include<stdio.h>
#include<math.h>

main()
‘ .
inti,n;
float x[50}, y[50].r,sx,sYy;
float sum1(float x[]),sum2(float x[}), sumxy(float x[],float y[]);
printf(“Enter sample size "),
scanf(“%d" &n);
printf(“Enter the sample x[i], y[i\n").
for(i=0;i<n;i++)

) scanf(*%f%f", &x[i],y[!]): .
sx=sqrt(sum2(x)/n-(sum1(x)/n)* (sum1(x)/n)),
sy=sqrt(sum2(y)/n-(sum1(y)/n)* (sum1(y)/n)).
cov=sumxy(x.y)- (sum1(x)/n) *(sumi(y)/n). .
r=cov/(sx"sy),
printf(“The correlation coefficient of the given sample is %f".r),

} - _
float sum1(float af})
float s:
inti;
for(i=0;i<n;i++) s+=a[i};
return(s);
}
float sum2(fioat a[]){ |
float s2:
int i,
for(i=0;i<n;i++) s2+=afi}*a[l],
return(s2),
}
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float sumxy(flioat af}, ﬂoét b[})

{
float ss;
int i
for(i=0:i<n;i++) ss+=ali]*b[l];
return(ss);
}
Module summary

In this module we discussed three topics MS-Word, MS-Excel and C programming language. All
the three topics are introduced in very simple way. The frequently used features of MS-'Vord and-
MS-Excel are discussed. Open, create. delete, modify, save, load, formatting, printing of MS-
Word and MS-Excel documents are discussed in this module. Most of the topics are explained
with the help of simple examples. A self assessment exercise is supplied at the end of the module.

Self Assessment Questions
Section 1: Microsoft Word 2000

Al i ol s e

6
7.
8.
9.
l

What are the different ways to create a Word document? Explain each.

What is Print Layout View?

What is the difference between Page Layout view and Print Layout view?

How would you find a word dr phrase in 2 document? Explain the method brieﬂ y.

What are headers and footers? How would you go about creatmg a header or a
footer?

What are the deferent types of pictures that can be inserted into Word documents?
Describe a method to create a table.

Is it possible to convert a table into text? If yes, how?

What is a cell in a table?

0. What is mail merge feature? Is it possible to create envelopes usmg mail merge?

Section 2: Excel 2000

B NN AW —

What is a spreadsheet?

What are the advantages of using spreadsheet?

What do you mean by a cell in a spreadsheet?

What are the three components of Excel and what do they do?

What are the steps involved in building a workbook?

What is the use of fill handle? Discuss all of its uses.

What is a workbook and what is its use? '

Explain insertion and deletion of rows and columns method in a spreadsheet.

How is a workbook protected? What is the advantage of protecting a file?
. How do we create a formula in a sprcadsheet?
. Explain the types of formula in brief.
. Why and how do we format a workbook?
13.
14,

What is the purpose of Function Wizard?
How is the AutoSum feature used and what are its advantages?

Section 3: Programming in C

1.

Explain with example do-while loop in C.
| nr



. *What do you mean by branching and looping in a programming language?
Explain for loop of C programming language.

What are the uses of scanf() and priftf() functions in C.

Explain if statement with example.

What are the purpose of gets() and puts() functions in C.

Write a .program to find Fahrenheit temperature from the corresponding
Centigrade temperature. '

8. Write a program 10 find the largest among four given numbers.

9. Write a program to find the minimum among n given numbers. ~

10. Write a programn to find the maximum and minimum among n given numbers.

11. Write 4 program to find the sum of n numbers.

12. Write a program to find the average among of n numbers.

13.Writc a program to find the standard deviation of a sample of size n.

14. Write a program to find the correlation coefTicient vf a sample of size n.
15. Write a program to find the median of a simple ordered sample of'size n.
16.Write a program te find the mode of a simple sample of size n. -

N s A
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PROGRAMMING IN BASIC

1.0 INTRODUCTION

C t‘)lﬁpu!cr program is very much helpful tor solving problems. Those can be used for
computation of small. medium and large sized data, In biological sciences. including
Botany. computation of data. which are gathered from the laboratory as well as from
the field. is frequently required. A simplc program may reduce the time and labour of
the users. BASIC programs may a useful solution for this purpose. Basic is a very
powerful fanguage as'"a.. tool for the novice programmer.

BASIC is a high level Janguage. BASIC Stands for Beginner’s All-purpose Symbolic
Instruction Code. The original BASIC language was designed in 1963 by John
Kemeny and Thomas  Kurtz and implemented by a team of Dartmouth students
under their direction. BASIC was designed to allow students to write programs for the
Dartmouth Time-Sharing System. It was intended to address the complexity issucs of
‘older languages with a new language design specifically for the new class of users

that time-sharing svstems allowed—that is. a less technical user who did not have the

mathemati=zl background of the more traditional users and was not interested in
acquiring it. Being able 10 use 4 computer 10 support teaching and research was quite
novel at the time. In the following years, as other dialects of BASIC appeared,

Kemeny and Kurtz's original BASIC dialect became known as Dartmouth BASIC

The BASIC language was designed to be conversational right from the start. This can
put the pmgrammer or user into direct communication with computer. usually
through 2 teletype terminal. In this interactivg mode. the user, can enter his program
statements directly into the computer memory and any errors in the statements will be

layed. Thus. the user can correct his mistakes immediately. While

2

immediatei
running the program. the programmer can ask for results at intermediate points and

check for the correciness of his program logic without having 1o wait for the

computer 1 ool the end of the program.
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These languages introduced many cxtensions to the original home computer BASIC,

such as improved string manipulation and graphics support, access to the file system
and additional data types. More important  were the facilities for structured

programming. including additional control structures and proper subroutines

supporting local variables.

However, by the latter half of the 19805 newer computers werc far more capable with
more resources. At the same time. computers had progressed from a hobbyist interest
t0 tools used primarily for applications written by others. and programming became
less impor.tam i‘or most users. BASIC started to recede in importance. thbugh
numerous versions remained available. Compiled BASIC or CBASIC is still used in

many IBM 4690 OS point of salc systcms.

2.0. AIM OF THE MODULE

"You should learn a computer program. This will enable you to get confidence about
the application of the computer. This will help vou to learn other programming
language easily. Not only that you can analyze your data very quickly and correctly.
The main aim of this module is that you will be taught about the basics of the BASIC
programming. From this module you will be aware of -

~ elements of BASIC
~ different statements used in the BASIC
# framing of the statements in the programming
# usc of branching in the BASIC programming
~ use of looping in the programming
# the way of writing application programs in Botany

» significance of different commands for running BASIC in the computer.
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3.0 FEATURES OF BASIC LANGUAGE

The BASIC was developed on the following design principles:

4
5
6.
7
8

Be casy for beginners to use.

Be a general-purpose programming language.

Allow advanced features to be added for experts (while keeping the languagc
simple for beginners).

Be interactive.

Provide clear and friendly error messages.

Respond quickly for small programs.

Not to require an understanding of computer hardware.

Shield the user from the operating system

The designers of the language decided to make the compiler available free of charge s0
that the language would become widespread. They also Me it available to high schools
in the Dartmouth arca ar.J put a considerable amount of effort into promoting the
language. As a result, knowledge of BASIC became relatively widespread (for a
computer language) and BASIC was implemented by a number of manufacturers.
‘becoming fairly popular on newer minicomputers like the DEC PDP series and the Data
General Nova. The BASIC language was also central to the HP Time-Shared BASIC
system in the late 1960s and carly 1970s. In these instances the language tended to be

implemented as an interpreter, instead of (or in addition t0) a compiler.

The main features of the BASIC are as follow5'
1. BASIC is a user oriented language and can be learnt easily. Any person with a little

sense of logic can learn programming in BASIC. It can also be used as a stepping

stone for learning other languages.

2. The flexibility of BASIC allows the programmer 1o write, run, modify and debug

the program easily and quickly.
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3. The BASIC programs. entering data is casy and programmers need not be confused

about output formats because of facility for allowing more sop'hivsticatcd formats for

output.

4. The use of BASIC is not only restricted to elementary application but it is also

useful for advanced applications.

5. It is relatively machine-independent language. Though there are minor differences-
between various versions of BASIC. programmers can run programs in different

computers only with minor changes i in the programs.

3.1 ELEMENTS OF BAsic:

Before entering the BASIC programming some elements of BASIC should be
learnt. Important elements are discussed in the following subsection.

3.1.1 THE CHARACTER SET:

A letter, digit. punctuation mark, or specific Symbeols used is programs are called
characters. Like every language BASIC has its own character set. The following

are the recognized character set of BASIC.

i) Alphabets : AB.C..........Z
ii) Digits : 0.1,2,....... 9.
i)  Special characters :
Addition
Substraction
Multiplication
Division
Exponentiation
Left parenthesis
Right parenthesis
Equal 1o
Not equal to
Less than
Less than equalto <= .
Greater than >
Greater than equal to >=
Comma

+

— T @ 8
=]
L}
>

/\o I} S~
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Colon
Semicolon
Quotation mark
Dollar Sign )
Exclamauon point !
Percent sign %
Nurnber sign #
Blank

Sy

3.1.2 CONSTANTS AND VARIABLES:

In BASIC, expression are used which may be constanis or variables.

Constants: A quantity in a computer program which does not change its value
during the execution of the program is called a Constant. BASIC allows two

types of constants.

i) Numeric Constant 1) String Constant

Numeric Constant: A numeric constant is one that is formed by a sequence of
digits, 0. 1, 2......... 9. A numeric constant is also known as numbers. A numeric
constant may or may not include a decimal point. i.c.. it may be an integer or a
real number. The numeric constant may be positive or negative. The sign + or -
must precede the number. If no sign is indicated. the number is assumed to be

positive. The followings are the valid numeric constants:
495 +781 0 -16.48

The numbers can be expressed in exponential notation. The exponential notation
i5 used for representing very large and very small numbers. E represents base 10,
and the signed integer following [ is called exponent. The signed number
(integer or real) preceding the letter E is called mantissa. The exponent can be
positive or negative but cannot contain decimal point, the length of exponent
cannot be more than two digits. There is no restriction on mantissa.

In the exponential format a given number is represented as a value between 1 and

10 multiplied by the power of 10. For example, if the given number is 12340000
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thcn. 1t is displayed as 1.234 (which is a number between 1 and 10) multiplied by

10 to the power of 7 (1.224 x 107) as 1.234E7 in GW-BASIC.

Example:
Number
693215
-4423
-0.0021
RULES:

a)

Equivalent form Exponential form
6.93215 x 10° 6.93215E05
-4.423 x 10° -4.423E+03
-2.1x10° 2.1 E-03

BASIC does not distinguish between an integer and a real.

b) Commas are not allowed in a numetic constant.

¢) The limit on the number of digits that can be used in a numeric

constant varies from computer to computer. Normally, a numeric

constant can have up to a maximum of eight digits.

Invalid numeric constants
5522+  — plus sign is included in the right side of the number

2457, 86 — comma is not allowed within a number.

83596 — berween the digits 3 and S there is a blank

899E-0.5 — the exponent should not have decimal point. -

String Constant: BASIC can handle non-numeric data called string constants.

String constants are composed of valid basic characters (alphabets. digits. special

characters. even blank) enclosed within quotation marks. The quotation marks

help the coMtputer to detect the beginning and the end of the string constant,

String constant are used (o represent non-numeric expression, such as, names,

addresses, date, nature of the problem etc.
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Rule: Mixture of numeric and string constants is not permissible.

In case of mixture of numeric and string GW-BASIC will display error

message “Type mismatch”.

Some examples of valid and invalid string constants are given below-

Valid String Constants

“Vidyasagar University”
“Mean Value ="

“08765™ (it is string constant but 98765 is a numeric constant]
NPT

Invalid String Constant

Botany [quotation mark absent]

“696 [right quotation absent]

“Rupees” 500 [Mixture of numeric and String constants]
Variables:

The quantity which may-change its values during the execution of the
program is called a variable. We use variables for the purpose of storing
information (number of string) in the memory of the computer. It is actually a
temporary storage area for a piece of information. When computer encounters a
variables name in the program it immediately assigns a memory location by the
variable name. The value of a variable can be changed by the program. BASIC
accepts two types of variables:

i) Numeric variable i1) String Variable

Numeric Variables:

Numeric variables are names that are used for assigning locations in computer
memory for gtoring numeric constants. The value of a variable is either supplied
by the programmer or by a result of computations made by the computer during
the execution of the program.

Cach of the numeric variables should have a name. The followings are the rules

tor prescnting a variable name.

128



Rules:

a) A numeric variable is represented by an alphabet ( A, B. ... 7). numbers
(0.1 ,2'. ..9) and the decimal point.

b) The fi;'si character in a variable name must be a letter. [t may be
represented by a letter followed by a digit (e.g., PS. /.6 etc.), letter (e.g.
abc, xy etc.) or decimal point (e.g. , Specis. I ,p2.k, etc.).

c) No space or punctuation mark is allowed.

d) Reserved keywords, which are used in the BASIC programming, like
READ. LET, and PRINT etc. cannot be used as variable names.

The variable names may be of any length, but only 40 characters are

significant.

Valid numeric variables: A. T2, FLOWERI, FUNGI.500

Invalid numeric variables:  8k. D$. A:B. **. 100SEEDS

String Variables:

A string variablc is used to represent the value of character string. To store a
string constant we need a ‘string variable’. A string variable is the same as a
numeric variable with one difference, string variables must end with a dollar (8)
symbol. If you put a dollar sign at the end of any numeric variable name it will
become a string variable and can be used to store any string constant. As you
cannot store a string constant into a numeric variable into a string variable. trying
to store a number or numeric constant into a string variable will also give vou

“Type mismatch™ erior message. ' '

Valid String variables: AS. Y23. GENUSS. NAMES$

Invalid String Variables: b, 7C$, $D2
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3.1.3 BASIC EXPRESSIONS:

In BASIC two types of variables are used - arithmetic expression and logical

expression.

Arithmetic Expression:
An arithmetic exprcssion may be a numeric constant. a numeric variable, a

function or a combination of numeric constants, variables and funciions;

connected by arithmetic operators to form a singlc value.

The following arithmetic operators are recognized by-BASIC.

Operators bperations
+ Ad.dition
- - Substraction
o * Mulitiplication
/ Division
for” Exponentiation

In a particular arithmetic expression, there is a hierarchy for the order of
exccution.  All exponentiation  operations are performed  first, then
multiplication/division and the addition/substraction operations are last to be
carried out. Within a particular hierarchical group, the operations arc executed
from left to right. Normal hicrarchy of operations can be altered by use of
parenthcses. The operations within the innermost parentheses are performed first

and then the second innermost and so on.

Rules of Writing Arithmétic Expression:
i) Two operations must not appear together. For example, A + - B, X -/C etc.
are not permitted.

i) Zero should not be raised to a negative point.
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iii)  String constants and string variables should not be used in arithmetic

expression. IFor cxample Al + BS, N+"RAM?” are wrong.
v) When brackets arc used they must be used in pairs. i.e., every left bracket
must be matched with a right bracket.

The following table shows somr : examples of arithmetic expressions.

Table -1: BASIC equivalents of algebric expressions

Algebric Expression BASIC Equivalent
a+b-ed A+B-C*D
P+rq)k~) (p+q)*K+J
(xly)z (XY)*z
B’ 4 AC B r2-4*A*C
({(x+y) 2%)/s (X+Y)*Z 2y S
-p4 -Prqor-(P"q)

Logical Expression:

Logical expressions are used when it is necessary to compare two numerical or
string quantities. A relational expression will have either the value TRUE or the
value FALSE. For example. X>Y will be true if X is greater than Y and false if X
is Yess than or equal to Y. The result of the comparison TRUE or FALSE will
determine the program flow. ' | |
Rules:

i) When arithmetic and logical operators are both used in one expression, the

arithmetic operations are performed first.
i) String comparison is alphabetical order and all string constanis mvst be

enclosed in a quotation mark.
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The following are the examples of a few logical expressions:

A=B
- x=+y>100
P<=Q-R
A<>B

N§ = “Genetics”

4.0 CONSTRUCTION OF BASIC PROGRAM

A BASIC program consists of several statements called BASIC Statements. The
statements are made up of Keywords and line numbers or statement numbers. The

BASIC statement is either executable or non-executable. The format of BASIC

statement is-

Line number # Statement

Keywords: Keywords are the words which have special significance for the
interpreter. These words cannot be used as a variable name. For example. LET,

INPUT. READ, DATA etc. are some keywords.

Line Numbers: A BASIC program consists of a set of statements put together in a
logical manner. The statements are identified by line numbers. Line numbers wcli the
computer the order in which the statements are to be executed ndrmally. The line
" number must be an integer between 1 and 99999. The upper limit varies from system
to system. Line numbers must be taken in ascending order. It is customary to use the
line numbers as 10, 20, 30, 40. 50...... etc, in order to leave room for the insertion of '

additional line, if required, at a later stage.

4.1 BASIC STATEMENTS:

The elementary BASIC statements used in a program are described below.
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4.1.1. LET STATEMENT: The use of LET statement in BASIC is to assign a numeric

or string value to a variable. It is also known as assignment statement. The general

tormat of LET statement is

Ln LET variable = constant/ variable/ expression

Where. Ln is the line number. The following are a few illustrations of let statements.

10 LET B=S
In the above statement, 10 is the line number and LET is the keyword. Here the

variable B is assigned to the numeric constant value §.

30 N$ = “Taxonomy"”
On line number 30, the string variable N$ is assigned to a string constant Taxonomy. It

should be noted that the string constant is within a quotation.

40 LET X=Y

A numeric variable X is assigned to the value of another numeric variable Y.
The statement

50 LET K$=D%

Assigns the value of a string variable D$ to another strmg variable K$
The Statement

20 LET P=2*A+3*B
Assigns the value of expression 2A + 3b to the variable P.

Remarks:

i) In the l:ET statement the variable on the left of equality sign must assign a value
of the same type on the right side. If the variable on the left be a numeric
variable then the value on the right of the equality sign must be a numeric value,
In other words string value should not be assigned for numeric variable. If a

numeric value is assigned for string variable or a string value is assigned for
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i)

numeric variable. the condition is called type mismatch. An error message

“type mismatch” will appear on the screen during exccution of the’program.

The following statements arc valid

200 LET K=15.2 .
150 LET GS$=“Germcell

But the following statements are invalid because of type mismatch.

20 hET H=“Heredity”
30 LET P$=150 | :

‘Two or more Vvariables cannot be used for assignment purpose in the same LET

statement separating each by a comma.

50 LET A =10,B =20, ES$ = “Ecology” is an invalid statement.

in certain situation one can use multiple LET statements. I{ the same value is
required to be assigned to different variables, then multiple equality signs can be
used in a statcment.
For Example
100 LETS1=82=S3=54=0
Remark: ’ _ )

Optional use of the keyword LET

The use of keywerd LET for the gurpose of assigning value to a variable is
optional. The equal sign is sufficient to do the same.

Examples:
10 B =10
150 N$  =“MENDEL™"
160 X =
130 K =K+2

The above statements, in which the word LET has been omitted. arc also valid.
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4.1.2. INPUT Statement

The INPUT statement permits the entry of data during running-of a program. The

general format of INPUT statement is

Ln INPUT Laist of vanables
where, Ln is the line number.

Examples:

30 INPUT A
40 INPUT T$

Rules:
1) The INPUT statement may be associated with only one variable or more than

one variable. If more than one variable are used, they must be separated by

commas.

Example:
10 INPUT S
20 INPUT P,Q
40 INPUT P.Q.CS$

When INPUT statement is encountéred, the program execution stops and ? (Question
mark) appears on VDU screen and the computer waits for users/ programmers to enter
the value (data) corresponding to the variables listed in the INPUT statement. In case of

more than one input variables the user should supply the. same number of data as the

number of input variables.

i) Different types of variables (both numeric and string) can be used in the same
INPUT statement. The data to be entered in response to INPUT statement

must match the type of variables used in the INPUT statement, that is, there

should be no type mismatch.

’Examplcz
30 INPUT X,BS.C
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For above statement one may enter 60.5. “Phloem ™. 100: but, ~"Phloem™. 60.5. 100

are not valia.

i) Entry of formula or expressions for the INPUT variables is not allowed. '
iv) In INPUT statement message with in the quotation may be used, following by

a semicolon or comma and then the name of the variables are given.

Fxample:
80 INPUT “ENTER NAME™; N§
120 INPUT “PUT THE VALUE OF RADIUS™ R
Puring execution of program the message in the quotation will appear in the screen

indicating the nature of data to be given.

v) . If the number of data supplied be less than the number of variables in the
INPUT statement or data are supplied in wrong manner (Say, numeric for

string), an error message “? Redo from start” will appear on the screen.
Disadvantage of INPUT Statement :

i) The INPUT statement is unsuitable for large number of data.
i) The data entered throixgh INPUT statement cannot be stored for subsequent use
and there is any mistake in entering data for a list of variables it cannot be

corrected and data are to be supplied anew.

4.1.3. READ, DATA Statement:

The purpose of the READ Statement is to read data from the DATA Statement present in

the program. The general format of READ statement is as follows:

{.n READ List of Variables
' Where, Ln is the line number.

136



EXamplcs:

80 READ X
50 READ Y$
The DATA statement is used in BASIC programs to assign appropriate values (numeric

and string) to the variable listed in the READ statement. The general format is -

Ln DATA List of constants
Where. Ln is the line number.

Examples:
100 DATA 23.15
200 DATA “Endodermis™

Rules:

1) A READ statement may contain one or more than one variables and the
variables may be numeric or string. Incase the number of variables in a READ
statement be more than one, each variable must be separated by comma.

Example:
50 READP
70 READ P, QS$, R

i) The list of constants in a DATA statement must be separated by commas. No
expression is allowed in DATA. statement

Example:

20 DATA5.2.9,2.71
110 DATA 20, “Petals"

iii) A READ statement must accompany at least one DATA statement, i.e.. a
READ statement without a DATA statement is invalid and vice-versa.
Because. the DATA statement assigns appropriate values to the variables of
the READ statement. During execution of BASIC program when control
encounters a READ statement it immediately searches for the DATA
statement. There must be exact cdrres;pondence between the types of variables
in READ statements and the types of values in DATA statements; otherwise

DATA type mismatch will occur.
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Example:
10 READA, B.RPS
30 DATA 10, 20. “Root pressure™

Assigns 10 to A. 20 to B. and "Root pressure” to RPS.

For the following statements
10. "~ READ A.B,RP$
30 DATA *“Root pressure”. 20, 10

Data type mismatch will occur because “Root pressure” will be assigned to the numeric

variable A ‘ v

v) Any number of data statements can be used in a program. A single READ
statement may access one or more DATA statements in order. Several READ

statements may access the same DATA statement.

Example:
50 READ A.B.C.D$

100 DATA 10, 30.,
110 DATA 50, *CHLOROPHYLL"

Here a single READ statement access several DATA statements.

Example: .
10 READ M$
20 READ Y
50 READIL. D

s

150 DATA “MARCH”, 1999, 1000. 50

Here several READ statements access a single DATA statement.
v) It is not essential that DATA statement must {ollow READ statement. DATA
statement can be given in the program before END statement.
vi) If the number of variables in a READ statement become greater than the

number of values in DATA list then “Out of data” will appear in the VDU.
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4.1.4. PRINT Statement:

The Print statement is used o print output data on the printer/terminal. The general

tormat of the print statement is

[.n PRINT List of items
Where, Ln is the line number.

The list contains constants. variables, formula whose values are to be printed.

Example:
10 PRINT A
20 PRINT B$

Rules:
1) Each PRINT statement initiates output on a new line.

Example:
10 LETA=5.2
20 LET B$ =“PLANTS”
30 PRINT A
40 PRINT B%

The print out of the results will be as follows:
5.2
PLANTS

i) The téxt can be taken as printout by the PRINT statement. All strings used as
message must appear in a PRINT statement within quc;tation mark. When no
item is mentioned in front of PRINT then a blank line will appear, i.e., nothing
will be printed on the corresponding output line.

- Example:
10 READP, S
20 PRINT “Name of species™
30 PRINT ,
40 PRINT “Number of Petals="; P
50 PRINT “Number of Sepals="; S
60 DATA 5.4

The output of the above statements will be as follows:
Name of species
« blank line
Number of Petals = §
Number of Sepals =4
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iv)

v)

Comma Control: The output medium in BASIC (either paper page or visual

display screen) is usually divided into cqual zones. The width of each zone

varies from 12 to 15 spaces with a space of one to four spaces between the

zones. If the items in the PRINT statement be separated by comma, the output

of the item following comma will be printed in the next zone. In case the output

items do not fit in one line then two or more lines of output will be gencrated by
the same PRINT statement. A pair of commas after an item causes a print zone

1o be skipped. '

Example:

30 READ A.B.C,D,E, F

40 PRINT “NUM”. “TEMP”. “PRESSURE", ,*Humidity™
50 PRINT A,B.C.D.E.F

60 DATA 5,26.5.76.75.5.10,1.2

The output})f the PRINT statement (Zone wise) will be follows:

Zone 1 Zone 2 Zone 3 Zone 4 Zone 5

NUM  TEMP PRESSURE REMARK

5 26:5 76 5.5 10

1.2
Semicolon Control: The major limitation of the use of Comma is that we
cannot print more than 5 items in a line. In many occasions it is advantageous to
print more items in each line. And also, one may like to print information where
the item name and its value are printed close to each other. These objectives can
be met by using the semicolon in place of comma. The items which are

separated by semicolons will be printed close together. The computer

automatically provides one or two spaces between two items.

Example:

10 READ NS, R.M

20 PRINT “NAME”; “ROLL”; “MARKS"
30 PRINT N§; R; M

40 DATA "PUSPA™, 25. 82
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The output will be as follows:

L MIA |R |K IS
2

s o e e

b o o

R!OIL
2.]5

S
o

S —

P lA

L e d

If a semicolon is given at the end of a PRINT statement, this will suppress the carriage

return and the output of the next PRINT statement will continue on the same line.

Example: ,
5 PRINT “DELHI"; “MUMBATI"; “PATNA"
10 READA,B,C,D.E .

20 DATA 111,212,313,414, 515
30 PRINT A; B; C;
40 PRINTD; E

TAB Function: The TAB function provide additional flexibility for printing output of
the items in the PRINT statement. TAB stands for the abbreviation of “Tabulate”. It
permits the programmer to specify the exact position of each output item in a PRINT
statement. The general format of TAB function used in PRINT statement.

TAB (X): List
Where the argument X may be numeric constant, numeric variable or an arithmetic

cxpression. If the value of X be a fraction, then it will be rounded off to the imeger value.
Example:

60  PRINT TAB (10); X

It will cause the printing of the value of X from 10" column onward.
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Example:
40 A=10
50 PRINT TAB (5): . TAB (15); J; TAB (20); K
60 PRINT TAB (A+2); X; TAB(A+3); Y; TAB(A+B). Z
70 PRINT “RUPEES™. TAB (7); R

The TAB function can position the cursor/ print head anywhere on the output line

but it moves only from left to right. In the following statcment
20 PRINT “NUMBER OF PLANTS™. TAB (5): N

Here, TAB (5) will not have any effect because for printing NUMBER OF
PLANTS has alrcady moved through 16 columns and since the argument 5 in

TAB is less than 16, therefore. TAB will be igriored.

4.1.5. REM Statement:

The purpose of REM statement in BASIC program is to introduce remarks within the
program which provides the information for programmer or any one else to understand
the program, to define different variables used in the program. to highlight different
segments of the program, to add comment, to make a heading of the program. This
statement is not executed by the computer while running the program. The general format
is

L.Ln REM Comments

Where. Ln is the line number

Example:
10 REM Program No. |
20 REM Calculation of Arca
30 REM Roll No. VU/PG/BOT-11/05

4.1.6. END Statement:

The purpose of the END statement in a BASIC program is to terminate the program
execution. So. END statement must be the last statement of the program. The general
format is
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Example:

[.n END
Wherc. L is the highest statement number of the program.

200 END

4.1.7. RESTORE Statement:

This statement is used to allow the same data to be read more than once. A situation may

arisc when the same has to be stored for other variables. The general format of

RESTORE statement is

Example:
10
20

Ln RESTORE

Where. Ln is the line number.

READA,B,C
DATA 10, 20, 30

..........................

RESTORE
READX., Y, Z

In the above example the vaiucs 10, 20 and 30 are assigned to the variables A, B
and C respectively. After RESTORF statement the same values are assigned to

the variables X, Y and Z. That is, X=10, Y=ZQ and Z=30.

5.0 SOME SIMPLE PROGRAMS

Program 1:

Solving a simplc equation. Suppose, you arc given the values of A and B,

you have to find out the value of x with the cquation x= B -~ 2AB

10
20
30
40
30

REM Solving Simple cquation B? - 4AC

INPUT A.B.C

LETX~-B*2-4*A*C .
PRINT X "
END
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Program 2: Program for finding square, cube and square root of a given number

10
20
30
40
50
60
© 70
80

REM computing square, cube and square root
READ X

SQ=X"2

CUB=X"3

SR=X"0.5

PRINT SQ, CUB, SR

DATA 10

END

Program 3: Program for converting temperature given in degree Fahrenheit to degrec

Celsius.

10
20
30
40

50°

50

REM CONVERSION OF TEMP FROM FAHRENHEIT
REM TO CELSIUS

INPUT “Give Temperature”; F

C =(F-32)*5/9

PRINT “TEMP IN CELSIUS=": C

END

Program 4: Program for student result {Suppose a student obtained different marks in

three subjects, e.g., Taxonomy, Forestry. Physiology.] You have to find out total marks

obtained in 3 subjects.

{0
20
30
40
50
60
70
80
90

100

REM computing total marks for a student
READNS. T,F. P

TM = T+F+Pp

PRINT “Name:"; N§

PRINT “Taxonomy:”; T

PRINT “Forestry:™; F

PRINT “Physiology:™; P

PRINT “Total:”; TM

DATA *“MADHUMITA ROY™, 68, 51. 60
END

Output of the program

Name

Taxonomy

Forestry

Physiology

Total

: MADHUMITA RQY
: 68

51

1 60

2179
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6.0. BASIC STATEMENTS FOR BRANCHING OPERATIONS

Fhe exceution of instructions in a BASIC program generally takes place according to the
ascending order of Tine numbers. But sometimes it becomes necessary o change the
sequence of exceution or to by-pass a few statements. The objective can be achieved by

branching operations. Branching operation may be unconditional or conditional.,

6.1. GOTO Statement:
GOTO statement causes unconditional transfer of control to a specificd statement of the
program. The general format of the C()TO statement is

Ln1 GOTOI.n2

Where, L.n denotes line numbers.

For example:
SOGOTO 20

Iranster the control from line number 50 to line number 20

GOTO statement can be referred to a line number which may pe either executable or non-

exceutable

Ixample

10 - INPUTX.Y
20 LETC=X*Y

30 PRINTC
80 GOTO10
10  END

6.2. IF......THEN Statement:

The lF.... ... THEN statcment is used for conditiuqal transfer of control in a BASIC

program. It is a decision making statement and depending upon the decision it can change
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the order of execution of statements. It is always used in a conjugation with a relational

expression. It allows the computer to check whether a specified relation is TRUE or
FALSE and to perform the transfer of control to a particular statement it it is TRUE.
This point of program has two branches to follow, one for FALSE condiiion and other

for TRUE condition.
The general format of the statement is
Ln IF [Relational Expression) THEN Ln
Wher?. Ln indicates statement number.

For Example:
90 IF A>200 THEN 160

Will transfer the control to line number 160 if A>200, otherwise to next line number.
Example:

40 IF N$ = “Sourav” THEN 250
Some other formats of IFF............. THEN statements are also allowed.

a) Ln IF [Relational Expression] GOTO Ln
(Ln is the line number]

Example:
25 IF X > =Y THEN GOTO 1§

'b) Ln IF [Relational Expression] THEN Statement

Example:
60 [FP<QTHENS=P-Q

c) L.n IF [Relational Expression| THEN Ln/Statement ELSE Ln/Statement

’

Examples:

20 IF A > 100 THEN P=A-S ELSEP=A+S
90 IFA>=10THEN S0 ELSE B=A
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Program S: A program to find out greater chromosome number between two plants

10 REM Greater chromosome number between two plants
20 READ crl.cr2

30 IF cri>e¢r2 THEN 60

40 PRINT cr2

50 GOTO 70

60 PRINT crl

70 DATA 42, 56
H END

Output

36 ...................

Program 6: Suppose you have measured the length of some leaves in inches. Now

you have to write a program to convert the length in inch to length in centimeter.

10 REM Conversion of leaf length from inch to cm
20 PRINT "Type the length in inch”

30 INPUT L.1

40 LC=L1*254

50 PRINT “Leaf length of leaf in cm.=", LC

60 PRINT “Do you want to continue?”

70 PRINT *If yes. type y. if no., type n”

80 INPUT AS

90 IF A$ = “y" THEN 20

100 END

* Note: In the above statements from line number 60 to 90 provide an option for the

user whether he/ she wishes to convert more data or not.

Program 7: A program for finding largest number of petals among three flowers

10 REM largest number of petals among three flowers
20 READ F1,F2, F3

30 IF FI >F2THEN 90

40 IF F2 > F3 THEN 70

50 PRINT “Largest no. of petals="; F3

60 GOTO 130

70 PRINT “Largest no. of petals=": F2

80 GOTO 130

90 IF F1 >F3 THEN 120
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100 PRINT ~Largest no. of petals="; '3
110 GOTO 130 - :

120 PRINT “Largest no. of petals="; I']
1350 DATA4.10.6 '

140 END

Output
[.argest no. of petals= 10

Program 8: A program to calculate the sum of spikes in 5 plants

.10 REM Sum of spikes in 5 plants
20 Cc=0

30 SUM =0

40 READ SP

50 SUM = SUM + SP

60 C=C+1

70 IF C <5 THEN 30

80 PRINT “SUM="; SUM

90 DATA 20. 28, 30. 31, 12

100 END

Output o '
SUM = 12]

7.0 LOOPING OPERATICN:

In many BASIC programs a statement or a number of statements are required to
be repeated a number of times. This type of operations can be effectively handled
with the help of loops. A GOTO statement can be used to set up a loop because it

can cause a jump to a stalcment that was executed earlier. Loops can also be

formed by using FOR............... NEXT Statement.

7.1 FOR............ vereeee NEXT Statement:

FOR............NEXT statements are used when a loop consisting of several
statements is to be executed repcatedly in a program. FOR and NEXT statements

arc used in conjugation. The general formatof FOR............. NEXT statement is:
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Ln2 NEXT ]

In this gase, all the statements between line number 1 to line number ? are
executed while varying the variable I from J to K at the increment of L each time.
Ihe variable T is known as control variable or index variable whose initial valuc
s ] and the final value is K. The STEP in this format is optional and in case it is
absent. L. is assumed to be 1. i.c., increment is taken as 1. All thclstatemcnts

bciween Line number | and Line number 2 are said to form the body of the |

FOR........... .NEXT loop.

Example: _
10 FORI=1t0 10

Statements

.............................

.............................

3

Statements

..................................

.................................

80 NEXTJ

REMARKS:

Iie loop execution is terminated when the value of control variable exceeds the

end vajue. A
If the loop control variable's initial value' under some condition has exceeded

{2

the end value then loop is not executed.
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7.1.1 Nested Loop:

One or more FOR..........NEXT loop can be inserted within another loop. Such
loops are called nested loops. There can be several levels of nested loops in a

specific program.

Rules:
I~ Each loop within the nest mustdave its own FOR and NEXT statements. The

loops must not overlap. The inner loops must lie within outer loops as shown

in Fig.1.
. 703 23 CRp—
FORI= ~coommen
FOR Js= e
| 4] + 30—
NEXT J
- NEXT1
I NEXTJ
“Fig. 1 a) Valid Nesting : b) Invalid Nesting

2. The outer loop and the inner loop must have different variables.
3. One can enter FOR.......... NEXT loop only through . FOR statement;

however. branchmg out is possible as shown in Fzg 2.

—> R

A
1
i

Fig. 2. a) Invalid Branching in - b) Valid Branching out
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Program 9: A program for Using FOR ....NEXT loop ,
10 REM printing natural numbers from 1 to 10
20 FORI=1TO 10

30  PRINTI
40 NEXT I
50 END
Output
t
2
3
4
5
6
7
8
9
10

Program 10: Program for finding sum of cube of even-numbers between 1-50.

10
20
30
40
50
60

70 -

. REM sum of cubes of even numbers between | -50

S=0 .
FORI1=2TO 50 STEP 2
S=S+I13

NEXT I

PRINT “RESULT="; §
END

Progrsm 11: A program for listing the characteristics of 5 flowers.

10
20
30
40

50.

60
70
80

90

REM Listing the floral characteristics
REM ** No. of Sepals: S , .No. of Petals: P
REM ** No. of Carpels: C , Ovary type: OT$
REM ** Superior ovary: SUP ., Inferior ovary: INF ’
- PRINT TAR(S); “Flower No.”; TAB(20); “Sepals™; TAB(31); “Petals™
TAB(42); “Carpel”; TAB(55); “Ovary Type”
PRINT '
FORI=1TOS5
READ S, P, C,OTS$ : '
PRINT TAB(8); I; TAB(23); S; TAB(34); P; TAB(45); C; TAB(60); OTS
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100 NEXTI | ,
110 DATA 5.5.5. "SUP™. 4.3.3.“INF™. 6,8.6, “INF™, 3.4.5. “SUP". 4.4.4.

“SLPT
120 END
Output
Flowu' Ne. Scpals Petals Carpels - Ovary Type
! 5 5 5 sup
2 4 3 3 INF
3 6 8 6 INF
4 3 <4 5 sUPp
5 4 . 4 4 sup

8.0. ARRAYS:

An orderly arrangement of data may be called an array. Arrays arc used when many
different data- nems are rcqum,d 10 share the same type of variable name. T he\ are also

useful in program su_mcnts when one rcqunres to store some valucs or intermediate

results for further use. ' .

8.1. Subscripted Variables:

An ordered set of variables is called subscripted variables. For example. A(1). A(2).
B(S). C(10) etc are subscripted variables. The numbers 1, 2, 5. 10 arc arguments. The
argument ot a subscripted variable may be a variable expression but. when referred, the
vatue of argument will be evaluated first and it should be an integer value. Sct off
subscripted variables. say. A(1). A(2). A(3)......... is said to be form an array. In fact this
is a one dimensional array as there is a single argument. There are also two-dimensional
or multi-dimensional arrays. Two-dimensional arrays are knewn as .matr;ices‘. One-
dimensional arfays are called vectors. For example. S1. $2. S3. $4. S5 may represent
total sales of 5 salesman. In BASIC we shall write these variables as S(1). S(2). $03).
S(4). S(5). The usc of arrays and SubSci'ipted' variables helps us in processing large

quantities of data.



REMARKS:

I. In case of subscripted variables. the subscripts may be a constant, variable or an

expression.

2. A subscripted variable may consists of several letters and numbers.

Exainples of subscripted variables

P(5)
K(T)
X(A+B)
A(P*Q)

8.2. DIM Statement:

In using ‘subscripted variables in programs we have to declare the size of array to the
computers. in other words, some memory locations should be reserved for the value of
subscripted variable. This is attained by usihg DIM statement which is a short form of

dimension. The gencral format of DIM statement is

Ln DIM variable (argument)
Where L is the line number
For example,
20 DIM A(100)

Set asid. 100 storage locations for the variable A. That means that array A can contain up

to 100 elements.

Rules:
. The maximum value of the subscript should not exceed the value declared in

DIM statement.

2. DIM statement can be placed any thre in a program. However, it is good

practice to place the DIM statement at the beginning of the progtam.
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3.A smgle DIM statement is not necessary when the numbcr of subscripted

vanables are less than equal to 11 for lists. However. it is good pracnce to use
DIM statement in program which uses subscripted variables, whether it is

necessary or not.

4. A single DIM statement may be used to declare the dimensions of several
arrays. '

Example:

10 DIM X(100), Y(200). Z(150)

9.0 LIBRARY FUNCTIONS

BASIC has a facility of some in-built functions. They are called library functions.
These functions help the users to evaluate many complicated mathematical functions and

carryout logxcal operauons The general format of library function is

Name (argument)

The followings are some of the important library fungtions used in BASIC:

ABS: This function retains the absolute value of a number. Absolute value is the actual

valuc of a number without sign part.

ABS(X)
Where . X must be a numeric constant or a numeric variable or & numeric expression.

Exaﬁxple:
A=ABS(-9)

The value of A will be assigned as 9.

EXP: The function gives the exponential value of a given number X, i.c., e to the power
X.'where =2.718282 ~ the base of the natural logarithm.

Thegeneral format is -
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EXP(X) .
Where. X must be a numeric constant or a numeric variable or a numeric expression and

must be less than 88.02969.
Example: |
100 PRINT EXP(5).
148.4132
OK
FIX: the function i is used to set up the integer part of a given number. It does not care
about decimal part of a give number, be it positive or negative. The FIX function Just
removes the decimal part and returns the integer portion of the number.
The general format ié—
FIX(X)
Where, X has the significances as mentioned before.
Fxample:
20 PRINT FIX(3.8) J
3
OK

40 PRINT FIX(-3.8) J

3

OK
INT: This function gives the whole number part of a given number. In other words it
gives the lafgest integer, not greater than the given number. The difference betwcen INT
and FIX comes when the given number, INT( 5. 9) will give -6 whereas FIX(-5. 9) will
gwe -5.
The general formaf is -
INT(X)
Example:
5 PRINT INT(15.6) J

15
0K

10 PRINT INT(-5.8) J
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-6
OK

130 PRINT INT(10/30) J

3
OK

LOG: This function returns the natural logarithm of any number X, where the X should
 be greater than 0.

The general format is-

LOG(X)
Examplc;

K= LOG(i0)
"The value of K will be 2.302585

SQR: This function is used for making square root of a given number. The general
format is - ' '
SQR(X)
Where X is a numeric value and must be gtcatér than or equal to zero.

__Example: .
60 PRINT SQR(64)

64

0K

Trigonometric Functions: ‘
The following functions are used to get the results of trigonometric functions.

SIN. COS, TAN
The general formats are ~
SIN(X). COS(X). TAN(X)
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[:xample:

10 PRINT COS(45%(3.141593/180)) J

0.7071067
OK

10.0 SOME APPLICATION PROGRAMS IN BOTANY

Program 12: Suppose. you have measured the grow.h rate of different plants by an
auxanometer. Write a program in BASIC to find the mean value of growth rate of a

number of plants.

10 REM Finding mean growth rate of n number of plants
20 DIM GR (50)

30 $=0
40 PRINT “Growth rate of plants:™
50 READ N~

60 FORI=1TON

70  READGR (D)

80 S=S-~GR()

90  PRINT GR(l)

100  NEXTI

110 MGR =S/N | |
120  PRINT “Mean Growth Rate="; MGR

130 DATA ............
140 DATA .....cccoo...
150 END

Program 13: You are given some data of length and diamecter of some cylindrical logs.
You have to write a program in BASIC for determining girths and volumes of n number

of logs and listing them in tabular form.

10 REM Determination of girths and volumes of n logs

20 REM D: diameter, L: Length, G: Girth, V: volume

30 DIM D(100), L(100), G(100), V(100)

40- - READN . |
50 PRINT “No."; TAB(7). “DIAMETER™; TAB(20); “LENGTH™ TAB(31):

v “GIRTH”; TAB(41): “VOLUME™
66 PRINT TAB(9): “(cm)”; TAB(21): “(em); TAB(32): “(cm)": TAB(41).
“(sq.m.)”
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70

‘80
90
100
110
120

130
140
150

FORI=1TON
READ D), L(I)
G(I) = 3.1416 * D(I)
V() =3.1416 * L(I) * (D(I) 1 2)/4)
PRINT [; TAB(7): D(I); TAB(ZO), L(1); TAB(3]) G(I); TAB(42) V)
NEXT I
DATA .............

Program 14: In an experiment root pressures of some plants have been measured. Write

a pregram in BASIC to ﬁnd out highest value of root pressure among n number of plants.

10
20
30
40
50
60
70
75
&0
90
100
110
120
130
140
150
160
170

REM Finding hnghest value of root pressure

" 'REM Root Pressure: RP; nghcst root pressure: HPR-
~ DIM RP(50)

READN

- READRP(1)

HPR = RP(1)
PRINT “The values of Root Pressure are:”

“PRINT RP(1)

FORJ=2TON

READ RP(J)

PRINT RP(J)

IF HPR > RP(I) THEN 130

HPR = RP(J)

NEXTJ

PRINT* Htghest Root Pressure="", HPR ‘mm Hg”
DATA ...........

Note: The lowest value of root pressure (or any other data) can be computed by the same

program with a élight alteration. The line number 110 should be altered like this-

110

IF HPR <RP(J) THEN 130

The variable names can be altered (say LPR in place of HPR) , if desired.
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- Program 15:

In an experimental study the length of a number of seedlings were

measured and they were divided into 3 groups: 2-5 cm, 6-9 cm and 10-15 cm. Now, write

a program to determinc the total count and percentage of seedling length in each group.

10
20
30
40
50
60
70
80
90
100
110
120
130
140
150
160
170
180
190
200
210
220
230
240
250
260
270
280
290
300
310

REM Finding Total count and percentage of seedling lengths of 3 groups
REM * * * seedling length: SL

DIM SL(200)

READN

LI=L2=L3=0

PRINT “Measured Seedling Lengths o
FORK=1TON

READ SL(K)

PRINT SL(K)

IF SL(K)> 15 THEN 190

IF SL(K) <2 THEN 190

IF SL(K) >= 10 THEN 180

IF SL(K) <=6 THEN 160

Li=L1+]1

GOTO 190

L2=L2+1

GOTO 190

L3=L3+1

NEXT K |
PL1 = (LI/N) * 100

PL2 = (L2/N) * 100

PL3 = (I.3/N) * 100

PRINT TAB(30); “SEEDLING LENGTH”

PRINT TAB(IS), ™ eoeeeee e, "

PRINT TAB(15); “2-5 cm™; TAB(26); “6- 9 cm™;  TABG7); “10-15 em”
PRINT: PRINT

PRINT “COUNT™; TAB(17); L1; TAB(28); L2; TAB(39); L3

PRINT “PERCENTAGE"™; TAB(17); PL1; Tab(28); PL2; TAB(39); PL3
DATA ..........

Output: The print out will be found in the following format:

seeees senses

.......................

Measured seedling lengths:

ceven o
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- COUNT

....................................................

.................................

PERCENTAGE

Program 16:

L0
.20
30
40
S0
60
A
80
90
100
110
120
130
140
150
160
170
180
190
200
210

Program 17:

A program for computing Standard Deviation of mean ‘of leaf Iengths

REM computing standard deviation of mean uf n naumber of lcaf lengths

DIM L.(100)

SL=0 _ . _
PRINT “Measured Leaf lengths are:-*
READN

FOR{=1TON

READ L(I)

PRINT L(I)

SL =SL + I(D)

NEXT1

ML = SL/N

V=0

FORI=1TON
V=V+M-LUI)1T2

NEXT I

SD = SQR(V/N)

PRINT “Mean leaf length ="; ML; “cm”
PRINT “Standard Deviation ="; SD; “cm™
DATA ......... .

DATA .........

END

Suppose. in a forest the heights of a particular group of trees have been

measurcd. Write a program in BASIC to find out the mean height of the trees and to

~ arrange the heights of the trees in ascending order.

10
20
30
40
50
60
70
80
%

REM finding mean height of trees and arranging them in ascending order
DIM HT{(500)

READN

PRINT “*Height of the trees in Meter:-"

SHT =0

FORP=1TON

READ HT(P)

PRINT HT(P)

SHT = SHT + HT(P)
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100 NEXTP

110 MHT =SHT/N

120 PRINT “MEAN HEIGHT OF THE TREES="; MHT “Meter”
130 REM Arrangement of heights in ascending order

140 FORK=1TON-]

150 FORM =1TON-K

160 IF HI (M+1)>=HTM) THEN 200

170 X =HT(M)

180 HT(M)=HT(M+1)

190 HT(M+1)=X

200 NEXTM
210 NEXTK
220 PRINT

230  PRINT "Heights of the Trees in Ascending ordet (in meter):”
240 FORP=1TON
250 PRINT HT(P),

260 NEXTP

270 DATA ............ -
280 DATA ..........
290 END

Program 18: In a biochemical analysis percentage of sucrose has been determined in two
- types of fruits. In type A fruit n number of samples and in type B fruit m number of
samples were taken. Write a program in BASIC to compute t-value for finding

significance of difference in sucrose percentage bétween two groups of fruits.

10 REM * * computing t-value for two groups of sucrose percentagc.
20 DIM PSA(100). PSB(100)

30 READN,M

40 PRINT “Percentage of Sucrgse in Type A fruit=""
50 SA=0 .

60 FORI=1TON

70 READ PSA(I)

80  PRINT PSA(I)

90 . SA =SA +PSA(D)

100 NEXT!

110 MA =SA/N

120 PRINT “Percentage of Sucrose in Type B fnm—
130 SB=0 .

140 FORJI=1TOM

150 READPSB())

160  PRINT PSB(J)

Y0 SB=SB+PSB(J)

180 NEXT)J
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190
200
210
220
230
240
250
260
270
280
290
300
310
320
330
- 340

350
2360

" 370

380 -

390
400

MB = SBM

VA =0

FORI=1TON

VA = VA +(MA - PSA(D)) 12
NEXT 1

vB=0

FORJ=1TOM
VB=VB+(MB-PSB(J)) 12
NEXTJ '

SDA = SQR(VAMN)

SDB = SQR(VB/MN)

X = MA-MB

P =(SDAI2N) + (SDB12/M) -

T = X/SQR(P)

PRINT “Mean of Group A ="; MA
PRINT “S.D. of Group A ="; SDA
PRINT “Mean of Group B ="; MB

* PRINT “S.D. of Group B ="; SDB

PRlNT“t-valuc=" T
DATA .......

DATA .......

END

Program 19: In a ficld survey, distribution of plants of different {amilia was studied in
an area. On the basxs of field survey data, write a program in BASIC to find out
frequency and pemcntagc of dnstnbuuon of plants belonged to the followmg families -
(1) Solanaceae (2) Leguminosae (3) Gramineae (4) Labiatae

10
20
30
40
50
60
70

. 80
90
100
110
120
130
140
150
160

REM Finding percentage of distribution of 4 families

REM Solanaceae: SL; Leguminosae: LG; Gramineae: GR; Labiatae: LB
DIM SLS$(500), LG$(500), GR$(500), LB$(500) : ,
READN

SL=LG=GR=LB=0

FORI=1TON

READ F$(I)

IF F$(I) = “SL” THEN 130

IF F$(I) =“LG” THEN 150

IF F$(1) =*GR” THEN 170

IF. F$(I) = “LB” THEN 190

GOTO 200 .

SL=SL +1

GOTO 200

LG=LG+1

“GOTO 200
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170
180
190
200
210
220
230
240

250

260

270

280 .

290

300

310
320

330.
340

350

GR=GR +1

GOTO 200

LB=LB+1

NEXT I

REM Calculation of percentage

PSL = (SL/N) * 100

PLG = (LG/N) * 100

PGR =(GR/N) * 100

PLB = (LLB/N) * 100

PRINT TAB(15); “SOLANACEAE"; TAB(30); “LEGUM!NOSAL"
TAB(45); “GRAMINEAE™; TAB(58) “LABIATAE”

PRINT : PRINT ‘

PRINT “FREQUENCY™: TAB( 18); SL; TAB(33); LG: TAB(48) GR;.
TAB(60); LB '
PRINT .

PRINT: “PERCENTAGE" ‘TAB( 18), PSL TAB(33), PLG TAB(48);
PGR; TAB(60); PLB

PRINT “...cooeeeeeeetoeeneeeeeeneanes SSTOURORURO ?’
PRINT “TOTAL NUMBER OF PLANTS STUD!ED =" N
DATA .......

DATA ..........

END

11.0. RUNNING BASIC PROGRAM IN COMPUTER:

The process of starting the computer is known as booting. To boot the computer the
following step may be taken. The switch of the computer should be turned on and after
some time DOS prompt will appear in VDU screen. In case of Windows system onc can

.enter into DOS through the sub menus of ‘All Program’ options of the ‘Start” menu.

These steps may be varied from ‘computer to computer. After ehtering into DOS the

following will appear in the screen:

C:v>

Here C denotes the hard disk drive. The symbol is used to mean the blinking cursor. The

presence of DOS prompt indicates that DOS invites you for using commands.
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To get into BASIC environment a version of BASIC is required. There are many versions
of BASIC, e.g.. GWBASIC. QBASIC, BASICA etc. We shall discuss the operation of
the version GWBASIC.

11.1. Entering into GWBASIC:

Type GWBASIC after DOS prompt as
CA>GWBASIC J
And press enter key. The VDU will display
OK
Prompt on the screen instead of DOS prompt. Now you are in GWBASIC environment

and can start typing your program. _
From the program sheet the steps of the program may be typed and after each step enter

key (. ) should be pressed. Care must be taken to include punctuation marks, spaces etc.

during typing the program.

To save the time the line numbers can be generated by using AUTO command.
AUTOLn J

Where Ln is the starting line number.

Example: '
~AUTO 10 J

Generates line number 10. 20. 30........ and so on.

The arrow symbol .  denotes the enter key.

11.2. Edifing the program:

A program may have a number of mistakes. In order to correct them EDIT command is
used

EDITLn J
Where Ln is a line number to be edited.
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Example:
EDIT 50. J

I'be statement having the line number 50 will appeartunder the command. The statement
can be altered or corrections can be made by shifting the cursor in the desired position.

The enter key should be pressed after this.

11.3. Listing the program:

. LIST command is used to list all or part of the program on the screen. The LIST

commgnd can be typed from the key board or the function Key (F1) may be pressed to

get the LIST command on the screen.

"LISTLn-Lm

Where Lm and Ln are line numbers.

Exa;nplc:

Command - Functions

LIST | - _ Lists the entire program on the screen

LIST 60 | ' . Lists the lines starting from 60 and onwards

LIST 10-200 Lists lines from 10 to 200

S

'11.4. Renumbering Lines:

‘Thc,lines of the program can be renumbered by using RENUM command.

Example:

RENUM , _ . ' .
Renumbers the program staning with line number 10 and increment 10 L

RENUM 100, 90, 5 : o
Replaces the linc number 90 by 100 and subsequent line mimbers are increased by
5. o
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11.5. Running the program:

To run the _progx‘ain RUN command is used. The command can be typed from the
keyboard or the function key 2 (F2) may be pressed to get the word RUN on the screen
and the result of the program (olitput) will be displayed.

. 11.6. Saving the program:

The SAVE command saves the program in the memory (for further usc) under the
 specific name. The SAVE command can be typed from the key board or the function Key
- (F4) may be pressed to get the command displayed on the screen. The file name should

be within the quotation marks. However, closing quotation mark is optional.

SAVE “File Name
Example: ‘ :

SAVE“PS2
The program will be saved under the file name “PS2".

11.7. Starting a new program: ‘ , .
After saving the program, if another new program is to be started the command NEW
should be used. . |
NEW o
The OK prompt will appear on the screen., _

11.8. Loading a program:
The LOAD command allows us to load a previously saved program in computer memory.
The LLOAD command can be typed from the key board or the function Key (F3) may be

pressed to get the LIST command dispiayed on the épreem

LOAD “File Name
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In the first step, function key no.3 (F3) is pressed and in sccond step, file name is typed

after the command [.LOAD.

Example:

| LOAD “PS2 J
This will load the program which is stored under the file name PS2. The OK prompt will
appear on the ‘screen. After this, if F1 key is pressed the list of the program will be
displayed. |

11.9. Priating s program and eutput:

The LIST and PRINT commands are used to list the program and print the output on the
screen. On the other hand the hard copy of the-output may also be taken from the printer.
The following commands are used to get the same in a printer.

- LLIST J |
The printer will print the whole program and printed copy of the program will ‘be
obtained. '

To get a printed copy of the output (fesults) all the PRINT statements should be replaced
by LPRINT. After ‘prepar'ing the program with LPRINT statement instead of PRINT
when thé program is run (by pressing F2 key) a printed outﬁut will be obtained from the
printer. ' ’
11.10. Deleting the statement

Sometimes one or more statements of a program are required to be deleted. The
DELETE command is used for this purpose. To delete the statement number should be

given after the command.

 DELETE70 J
The statement number 70 will be deleted from the program
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DELETE 70 - 100 J

All the statements from 70 to 100 will be deleted from the program.

11.11 Quitting the BASIC:

After completing your work with BASIC, ydu should quit the ‘GWBASIC environment

and return to MS-DOS. To do this following command is used-

SYSTEM J
_ The display will show
C:/>

Which conﬁrms DOS command mode.
12.0 DIAGNOSIS OF PROGRAMMING ERRORS

Programming errors often remain undetected until an attempt is made to execute the
program. Once the RUN command ( pressing F2 key) has been given. the presence of
certain errors will become readily apparent. since such errors will prevent the program
from being interpreted, i.e.. transformed into a machine language program. Some
particularly common errors of this type arc'a reference to an undefined variable or an
undcﬁned statement number. right- and left-hand parenthcses that do not balance failure
10 termmatc the program wnh an END statement, etc. Such errors are called grammatical
or symacncal errors. The BASIC will generate a diagnostic message when grammatical
The BASIC will generate a diagnostic message, when grammatical error has been

detected. They are helpful in identifying the nature and location of the error.

Grammatical and typing errors are usually very obvious when they occur. Much more
insidious are logical crrors. Herc thc program correctly conveys the programmer’s
instructions, free of grammatical and typing errors, but the programmer has supplied the

compuder with a logically incorrect set of instructions.
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Somectimes a logical error wijl result in a condition that can be recognized by the

computcr. Such a situation might result from the generation of excessively large quantity
or for an attempt to compute the square root of a ncgative number, etc. Diagnostic
messages will be generate in situations of this type. making it easy to identify and correct

the errors. These diagnostic messages are called execution diagnostics to dxstmgulsh them

from the interpretation diagnosties.

Logical Debugging: The first step in attacking logical errors to find out if they are
present. It can sometimcs be accomplished by testing anew program with data that will
yield a new answer. If the correct results are not obtained, then the progrant obvibusly
contains errors. Even if the correct results are obtained, one cannot absolutely certain that
the progran* is error free. since some errors cause incdrrect results only under certain

circumstances (as, for example, with certain values of the input data or with certainw

~ program options). Therefore a new program should receive thorough testmg before it is

considered to be debugged. This is cspecrally true for complicated programs of programs

that wil] be used extensively by others.

As arule, u calculation will have to be carried out by hand, with the aid of a calculator, in
order to obtain a known answer. For some problems, however, the amount of work in
carrying out a hand calculation is prohibitive. (A problem requiring a few seconds of ti. .c
on a large ccrmputer may require several weeks to solve by hand.). Therefore a sample
prob_le’m cannot always be developed to test anew program. Though logical debugging of
such programs can be particularly difficult, the programmer. can often detect logical

errors by studying the computed results carefully to see if they are rcasonable

Correcting Errors: Error detection should always begin with the programmer carefully
reviewing each logical group of statements in the program., Armed with the knowledge
that an error exists somewhere, the programmer can often spot the error by such careful
sludv If the error cannot oe found. it sometimes helps to set the program aside for a

whnle It is not unusual for an overly intend programmer to miss an obvious error for the

first nmew.around
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If an error has not been found after repeated inspection of the program, then the

programmer should proceed to rerun the program, printing out a large quantity of
intermediate output. This is referred to as tracing. Often the source of error will become

evident once the intermediate calculations have been carefully examined.

13.0. SUMMARY
BASIC (Beginners All Purpose Symbolic Instruction €ode) is high level language.
This is a simple to use computer language to write a program. It recognizes three
categories of character sets- i) alphabets -A,B....Zand ‘a, b, ...z ii) digits - 0.!,2.:...9 .
and iii) spccial characters like, @ # $% & * ( ).> <etc. For writing- program in
BASIC variables and constants are used. The BASIC,Zconstants arc of two types —
numcric.and string cbnstams. The numeric constant deals the numbers. e.g., 2345, -203,
0.098_etc. It can also be represented in exponent form. viz., 123E-04. The string constant
represents non-numeric characters like, name, address, etc. It is usually kept under the
quotation -ma:jk's. The examples of the string constantans are- “algae”, “University™
“234", etc. The BASIC variables are also divided into numeric and string variables. The
numeric variables are used to store numeric constants in the memory. The numeric
variable name is given by using alphabets and'digits; the first character of the variable
. name should be an alphabet. For example — A, XY, B3, Flowerl, M15K, etc. The string
variable represents the string constants. The nomenclature of the string variable is done in
the same way as done in numeric variable but a dollar sign is followed by the .numeric
variable name. Example- A$, d258, Génuss, etc. In BASIC programming both arithmetic
expression (e.g., A+B”2) and logical expression (e.g., X>Y) are used.
The format of the BASIC program is a line number followed by BASIC statement. The
line number ‘is given in ascending order. The BASIC statements are consisted of key
word(s) having special significance. The common keywords are LET, INPUT. PRINT,
READ. DATA_, END. REM etc. The LET statement is used for assigning values (e.g.,S()
LET A=4). The INPUT statement is used for providing data to the computer during
execution of the program. The READ and DATA‘ statement are also used for the same

purpose. However. data are given in the DATA statement before the execution of the

170



program. The PRINT statement is used for getting output of the program in the monitor.
The END statement declares the physical end o_f the program. The REM is a non-

exccutable statement. which is used for putting the comments of the users. With the help

of those statements simple programs can be framed. Some of the examples are — solving
small equations, conversion of temperature from Fahrenheit to Celsius, preparation of ‘
student’s results, etc. In those programs the flow of control moves in ascending direction.
However, b’ranching of the flow may be caused where the flow is moved in both
ascending and descending directions with skipping some steps. The branching may of o
two types- unconditional and conditional. For unconditional branching GOTO statement E
(e.g., 70 GOTO 30) is used. For conditiorial branching IF ... THEN statement (60 IF
GR> 15 THEN 110) can be used. By those statements some programs like, finding larger
between two numbers or largest among three numbers, conversion of length from inch'to
centimeter of a number of leafs, computing sum of numbers etc. may be written. When
some steps of the program are executed repeatedly for more than one times, the process is
called looping. FOR ... NEXT statements are used for this purpose. The FOR statement
(e.2.. 80 FORI=110 10) is the beginning statement and the NEXT statement (e.g.. 150
NEXT I) is the closing statement of the loop. Sometimes, one FOR ... NEXT loop may
~contain another loop. This is known as nested FOR ..... NEXT loop. Using this loop
printing of natural numbers floral characteristics of a number of flowers can be listed. An
orderly arrangement of data may be called an array. Arrays are used when many different
data-items are required to share the same type of variable name. An ordered set of
variables is called subscripted variables. For example, A(l), A(2), B(S) C(10) etc are
subscripted variables. When the subscripted vanable is used in thc program a DIM
statement should be used. This statement (e.g., DIM A (100), X5(50), FS(ZOO)) 1S
employed for assigning space in the memory location. Using ail the above statements a
number of application programs can be written. For example, programs for computing the
mean value of leaf length, determining the girth ahd volume of a number of cylindrical
logs and their listing, finding highest value of root pressure, arranging the tree length in
ascending order, standard deviation of mean of leaf lengths, t-test for f inding the
sxgmf icance of difference between the sucrose% of two groups fruits, listing the

percentage distribution of plants in different families etc. may be written.
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For running the BASIC program in the computer several commands. viz., LIST, RUN,
[.OAD. SAVE. EDIT. DELETE etc. are used. To run the program perfcctly. correction of

. errors in the program is needed. This is called debugging. The syntactical errors can be

corrected from the error list given during execution of program. However. the correction

of logical should be made by careful examination of each of the steps in the program.
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15,0. MODEL QUESTIONS:

15.1 Leng Questions:

1. What do you mean by READ, DATA. Statements of BASIC? How do they diffec

- from INPUT statement. Explain with example.

2. What is FOR ~ NEXT ioop? What do you understand by nested FOR NEXT loop.
Hustrate with examples. '

3. What is the function of PRINT statement? Discuss thc rules of PRINT statement. What
is TAB function?

4. What is subscripted variable? Write a brogram for finding the highest value of

transpiration rate of different leaves. |

5. Write‘ia ﬁrqgram in BASIC to compute stomatal index of ‘n’ number of leaves of a

plant. . ' o )
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BIOMETRY AND STATISTICS

What is Statistics ?
Statistics is a field of study concerned with
1)  thecollection, organisation and summarisation of data, and, ,
2)  thedrawing ofinferences about a body of data when only a part of the data are observed.

The concepts and methods necessary for achieving the first objective are presented under the heading of
- Descripuive Statistics and the second objective is reached by the study of Inferential Statistics. :

The word statistics has multiple meanings :
1) Statistics is synonymous with numerical facts ordata, -

2)  Statisticsis the science dealing with the designing of experiments leading to the collection of numerical
facts and method of analyzing, interpreting and presenting these numerical facts:

Characteristics and limitations of statistics :
Characteristics : |

1. Instatistics, all available informations are to be expressed in quantitative terms. Even in the study of a qual ity
like intelligence of a group of students we require scores or marks secured inatest. '

2. Statistics deals with a collection of_ facts, not an individual happening,
3. Statistical data are collected with a definite object in view i.e. there must be a definite ficld of enquiry.

4. Statistics are affected by a multiplicity of causes. In all fields or enquiry, thé observed data arc the result of a
large number of factors,eact of which contributes to the final figure.

5. Statistics is not an exact science. Conclusions are usally derived from samples and hence exactness cannot be
guaranted. :
6. Statistics should bc capable of being related to each other, so that some cause and effect rclanonshnp canbe
established. . '

7. Astatistical enqmry passes through the following four stages :
Collection of data

{
Classification and tabulation of the data
) .
Analysis of the data
i
Interpretation of the data

"
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LIMITATIONS : |
1. Statistics is applicable only to quantitative data and it is not suited to the study of qualitative phenomenon.
2. Statistics can be used only to analyze an aggregate of objects, and not individual objects.

3. Statistical decisions are true only on an average and also the average is to be taken for alarge number of
observations. They may not be true fora few cascs.

4. Statistical decisions are to be made carefully by the experts. The use of statistical tools by untrained persons
may lead to false conclusions. Misuse of statistics has, infact, created some distrust on the subject.

S.  Statistical datamust be uniform, in the sense that they should be subject to a stable casual system. There should
not be change in the group of factors responsible for variation in the data. ,

BIOSTATISTICS OR BIOMETRY :

It may be defined as the application of statistics as a seience to Biology. The use of sta§isticai.mcth<‘)d.s is
constantly increasing in biological sciences. The development of biological theories is closely associated with statistical
methods. Therefore, a good understanding of biostatistics is essential for the students of biologi.cal sciences, as the
methods of Bicstatistics are indespensable tools for the design and analysis of data in the interpretation of experimental -
results for dependable conclusions.

DEFINITION OF FEW TERMS COMMONLY USED IN STATISTICS :
Population :

If refers to the complete set of observations or measurements about which inferences are to be mfnde ata
particular time. It is simply means the total ity of the set of objects under consideration. For examp!e, all Pabngc bom
in a particular yezr, all plants in a wheat field may constitute a population. Population may be finite orinfinite. Ifa
population consists of a fixed number of observations, the population is said to be finite. For example, the number of
patients in a hospital, the number of wheat plants in a quadrant etc. On the other hand, a population which is
unlimited in size is said to be an infinite population. Thus for an infinite population it is impossible to observe all the
. values. For examp!e the number of RBCs in the human body, the numbcr of’ phyto,:lanktons inapondetc.

Sample :

Itis simply defined as apart ofa populationi.e. a sample is a selected number of individua}ls eachof whichisa
member of the population. Thus, a sample represents the small collection of the population which has actually been
- observed. For example, all plants in a wheat field rcprment apopulation whereas individual observations on 10 high
yielding plants from this population is asample. ‘ T

Data :

Numbers or measurements that are collected as a result of observatxons know as data. For example, scores Of
apsychological or educational test.

Varzables :

~ Any quality or quantity liable to show.variation from one individual to the other in the same population is known
as variable. An individual observation of any variable is known as variate. For example, plant helght, the wei ghts of
. pre school children etc.

Constant :

The value of which never changes is known as constant. For example, 7t (pi).
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Quantitative variables :

Variables that can be measured in usual sense i. e.canbewcpmedmtmofnmnbasamsaxdtobequanutaﬂvc
variables, For example, yield of crops, number of spikelets/ spike, measurement on the hexght of adult male's etc.

Qualitative variables :

Variables that can not be measured in usual sense i.e. cannot be expressed in tcrms of numbers, but :lelo?;
classified under different heads or categones are said to be qualxtatxve variables. For examples' rehgmm sex,
etc. _

Continuous variable :

‘A variable s said to be continuous when it can assume any value within a specified interval of values assumed
by the variable, For example, height, weight etc.

Discrete or discontinuous variables :

A discrete variable is a variable, which can take only some isolated values. For example, the number Ofpléms
inagiven quadrant, the number ofbxrths ina hospxta! etc.

Random variable :

A variable whose values depends on chance and can not be predicted is called a random variable. Statistical
theories deals with random variables only

Primary and Secondary data :

The most important task of a stat:sucxan is to collect and assemble his data. Hc may prepare the data himself
(primary data) or borrow them form other sources (secondary data).

Prlmary data :

- These are collected for a specific purpose directly fmm the field of enquiry. Thus, these data are ongm;l ﬂ:
nature. Generally, trade associations collect data from their member concerns, govemment organisations co alt'ac
data from its subordinate offices. They are considered as primary data, But individuals or any organisation can also
collect primary data from the actual field of enquiry by appointing trained investigators.

Sources for collecting prima:y data :
An mvmt:gator may collect primary data by the followmg methods:
Direct personal observation :

In thiis method, the i mvcstxgator may collect data by direct observation or measurement. Al:i mV;?tlgbag"' ::lz‘;
himselfmeet persons who can supply the requisite information. The method is time consummﬁ and costly, but y |
very accurate results. It is therefore suitable for such studies when the field of enquiry 1s sma

Indirect oral investigation :

In this method data are collected through indirect sources. Persons, who are likely to have information about
the problem, arc interrogated and on the basis of their answers, the data have to be compiled. Most of the oomxmss:jons
ofenquiry or committees appointed by Govemment collect primary data by this method. The reliability ofthis data
very much depends on the i integrity of the persons selected.
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Sending questionnaires by mail :

In this method the most important instrument is the questionnaire. This contains a set of questions relevant to the
subject of enquiry and these questions are sent by mail to the selected persons with request to retum them duly filled
in. Though this method can cover large areas and is also comparatively cheaper, but the principal disadvantages of
the method are — the low degree of reliability of the collected data, and a large number of non-responses.

Sending schedules through investigators :

This method is most widely used for the collection of primary data. In this method paid investigators are
employed for the data collection. The investigators carry with them the printed schedules and mect the person
concemed. The investigators fill up the schedules on the spot based.on the answer received from the informants. The
data are thus collected. This method is very popularand yields satisfactory results.

TWO PROCEDURES FOR COLLECTION OF DATA::
-Complete enumeration or Census :

When information is collected in respect of every individual person or item of a given population, we say that
the enquiry has been donc on complete enumeration or census. This process is called census survey.

Sample survey :

In most cases of statistical cnquiry, because of limitations of time and money, only a portion of the pOpulanon is
examined and the data collected therefrom. This process of partial enumeration is known as Sample survey. The
results and findings are, howevcr, made applicable to the whole field of enquiry. This is known as Sampling.

Secondary data :

These are numerical information, which have been previously collected as primary data by some agency fora
. specific purpose but now arc compiled from that source for use in a different connection. In fact, data collected by
some agency when used by another or collected for one purpose when used for another may be termed as secondary
data. The same data is primary for its collecting authority but secondary to another agency who used them.

The chief sources of secondary data are :

¢ ° Official publications of State and Central Governments, Foreign Governments and Interational bodies
like ILO, UNO, UNESCO, WHO etc.

¢  Publications and reports of various Chambers of commerce, Trade associations, Co-operative societies
elc.

¢ Reports of commissions and committees of enquiry appointed from time to time for specific purposes of
qnquiry.
¢, Joumnals and Magazines published by private agencies.
Unpublished reports prepared by researchers, labours and trade unions.
Presentation of data :
There are three different ways in which statistical data may be presenteu
Textual presentation :

In this method numerical data are presented in descriptive from. Example : N umencal data with regard to
industrial diseases and geaths therefrom in Great Britain during 1935-39 and 1940-44 are as follows :
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During 1935-39, there were in Great Britain 1775 cases of industrial diseases made up of 677 caseséoof ol/czc;
poisoning, 111 of other poisoning, 144 of anthrax and 843 of gassing. The number of deattfs re?oned was x tof
the cases for all the four disease taken together, that for lead poisoning was 135, for other poisoning 25, and that for
anthrax was 30. '

During 1940-44, the total number of cases reported was 2807, But lead poisonirfg case reportcd fell by 3; !
and anthrax cases by 35. Other poisoning cases increased by 784 between the two periods. T!w number of deaths
reported decreased only by 2 for anthrax from the prewar to the postwar. In the lal:er period, '52 dea}hs \;/crc
reported for poisoning other than lead poisoning. The total number of deaths reported in 1940-44 including those
from gassing was 64 greater than in 1935-39. '

Disadvantages are :
I: ltisalengthy text.
2 There has been much repetition in words.
3. Comparison between the corresponding figures in the two periods is difficult.
4

Itisdifficultto grasp, from a lengthy text the important points if there be a number of them, making it all
- the more difficult to arrive any conclusion,

Tabular presentation :

Tabulation may be defined as the logical and systematic organisation of statistical data in rows and columns., _
designed to simplify the presentation and facilitate comparisons.

Tabular representation is also a form of presentation of quantitative data in a condenscd form so that numerical
figures and easy to understand.

The numerical descriptions of the previous example have been condensed in the form of table given below :

Example: Tabel 1 : Deaths from industrial diseases in Great Britain ‘

SL Types of ' 1935 - 39  1940-44
No. Diseases No.of | No. of % of No. of No. of % of
cases Deaths Deaths cases Deaths Deaths
e 2 3 4 5 6 7 8
l. | Leadpoisoning 677 135 | 199 326 | 90 8
Ii’. ‘Other poisoning 111 25 22.5 859 ’ 52 6.1
3. Anm}ax 144 30 20.8 109 28 | 57
4. Gassing 843 165 | 196 | 1513 - 249 16.5
| Tou 1775 355 200 | 2807 419 14.9
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Advantages of tabulation are:

1. Itenables the significance of data rcadxly u-xderstood and leaves a lastmg impression than textual
presentation.

. Itfacilitates quick comparison of statistical data shown between rows and columns
3. Errors and omissions can be readily detected when data are tabulated.

Repetitions of explanatory terms can be avoided, and the concise tabular form clearly revcals the
characteristics of data.

RAWDATA:

Statistical Data may originally appear in a form where the collected data are not organised numerically. We call
them Raw data.

_ Suppose that the number of grains per spike of a wheat variefy ‘Bansi' are as shown below :
Tabel 2 : Number '.6f grains per spike in wheat

37 38 40 _ 3 38 37 36 40 50 47
41 4 38 31 33 48 37 52 32 S0
40 SO 47 4 50 43 26 45 52 45
41 44 39 16 21 30 38 32 48 47
41 45 41 S1 37 26 40 38 46 3R

Tabel 3 : Array of data éf table 2 (arranged in order ascending mngnltudes)

16 21 26 26 30 31 32 32 32 33
36 36 37 37 37 37 38 38 38 38
38 39 40 . 40 40 40 41 41 41 41-
41 43 44 45 45 45 46 46 47 47
47 48 48 50 50 50 50 51 52 52

The variable observed here are the number of grains per spike in wheat and the data obtained are known as
observations. Ifn observations on a variable x are available, they are usually denoted by :

where x| denotes the first observation onx,
x, denotes the second observationon x,

" x,denotes the third observation on x,

i
!
X, denotes the n-th observation on x.
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In genérdl x, denotes the ith observationonx (i=1,2, .cccesuneeee. ,n). InTable2
X, =37, %, =38, %, =40, coocorerunerennny Xgp = 32, All the observation are not different, some of them are repeated.

 Frequency: =

Frequency of a value of the variable is the number of times it occurs in a given series of obscn{ation. Intable3,
16 occurs once, 21 occurs once, 26 occurs 2 times, 30 occurs once, 31 occurs once, 32 occurs 3 times etc. Hence,
the frequencies of the values 16, 21, 26, 30, 31,32are 1, 1,2, 1, 1, 3 respectively. -

Tally sheet : ,

A telly sheet may be used to calculaté the frequencies from the raw data. A tally mark (/) is put against the value
when it occurs in the raw data. Having occurred 4 times, the fifth occurrence is represented by putting a cross tally
mark (\) on the first four tally marks. This technique facilitates the counting of tally marks at the end.

Ny
s

Tabel 4 : Tally marks

No. of grains per spike (x). ~_Tally marks F,requencies.(l)

16 R , ‘ 1
21 1 o 1

26 — N 2
30 / 1
31 | W 1
T -~ s 3
1 — ; |
36 ) /" 2
37 » - i 4
38 - ‘ MWL 5
39 ) !/ 1
40 m 4
41 _ ' M 5
43 / -1
44 . _ / 1
P A4S : B il 3
46 ' ol 2
4T . ] 3
8 . _ A 2
50 1. - 4
S1 : S 1
52 : i 2

i Total frequency 50 .
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Such a representation of the data is known as the ﬁ'equeﬁcy distribution.

Frequency distribution is a statistical table which shows the values of the variable arranged in order of magnitude,
either individually or in groups, and also corresponding frequencies side by side. There are two types of frequency
distributions :

(1) Simple frequency distribution ;
It shows the values of the variable individually (see Table 4).
(2) Grouped frequency distribution :
It shows the values of the variable in groups or intervals (see Table 5).

Tabel § : Grouped frequency distribution

~ No. of grains per spike Frequencies (f)
16 - 20 B 1
21-25 - 1 - 1
2630 o 3
31-35 » ' : 5
36 - 40 | : - | 16
41-45 - 10
46 - S0 _ v 11
51-55 | 3
Total | ‘ 50

In constructing a frequency distribution, it is desirable to consider the following basic rules :
I. Range:

Range of a given data is the difference between the highest and lowest value cf the variable, In Table 3, the
highest value is 52 and the lowest is 16, hence the range=52-16=36.

2. Number of classes :

Asa gencral rule, the number of classes should lie between 10 — 15, never more than 30 and not less than 0.
However, the number of classes in a frequency distribution are not fixed.

3. Class intervals :

The class intervals depend on the range of the data and the numbers of classes. The class interval would be
equal to the difference between the highest and the lowest value of the variable divided by the number ofclasses.
The following formula may be used to estimate the class interval ;

180



where i=class interval
L =largest value
S =smallest value
_ C = No. of classes. -

-~ Thenumber of classes C can be decided with the help of the sturge rule. According to sturge, the class interval

C=1+3.322 logN
Where N = total number ofob,scrvations
| Log = logarithm.
Class limits : - |
The class limits are the lowest and the highest values which are included in the calss, For example, inthe class

41 -45, the lowest valueis 41 and the highest value is 45. It indicates that there can be no values in the class below
the lower limit 41°and above the upper limit4Softhe class. - :

Class boundaries or true class limits :

The most extreme values which would ever be included in a class interval are called class boundaries or true
class limits. If age is considered, the class interval 15 - 19 actually includes all ages between 14.5 and .'1 9.5. Thus,
class boundaries are, infact, the real limits of a class interval, In this case the lower extreme point 14.5 is the lower
class boundary and the upper extreme point is the upper class boundary. Class boundaries may be calculated from
class limits by applying the following rule ; ’ '

Lower class bourdary = lower class limit— % d
Upper class boundary = upper class limit - % d

Where d is the common differénce between the upper class limit of any class interval and the lower class limit of the
nextclassinterval, - '

Mid ~ value ; _ .
The value exactly at the middle of a class intervalis called the Mid— value.
Mid - value = (lower class limit + upper class limit) /2 |
; = (lower class boundary + upper class boundary) /2.
There are two ways of classifying the data on the basis of class intervals :
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Exclusive method :
In this method, the upper limit of a cldss is the lower limit of succeeding class. The followmg data are classified

on this basis :
No. of grains per spike Number of plsnts
16 butless than 21 - 1
-~ 21 butless than 26 1
26 hyt Jess than 31 3
31 but less than 36 5
36 but less than 41 16
41 but less than 46 10
46 but less than51 11
§] but less than 56. 3
Total 50
Inclusive method :

} lndusmethoddaeuppcrhnntofone classis mcludedmthatclass The followmgdataareclassxﬁedonﬂnsbasxs

No. of grains per spike " Number of plaﬁti
16 -20 1
21-25 1
26~ 30 3
31-35 5
36-40 16
41 - 45 10
46 - 50 n
51-55 3
Total 50
Width of a class :

Itis the difference between the lower and the upper class boundaries (not class limits). Width of a class = upper

class boundary - lower class boundary.
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Cumulative Sfrequency and cumulative frequency distribution :

Instatistical investigations, sometimes we are interested in the number of observations less than (ér more than)
a given value. In such cases our main objective is concerned with the accumulated frequency upto (or above) some

~ valueofthe variable. This accumulated frequency is kniown as the cumulative frequency. Thus, cumulative frequency

corresponding to a specified value of the variable may be defined as the number of observations less than (or more
than) that specified value. The number of observations upto a given value is known as the cumulative frequency less
than type, and the number of observations more than a given value is called the cumulative frequency more than type.
When a frequency distribution is given, the cumulative totals of frequencies give the cumulative frequencies. Whena
grouped frequency distribution is given, the cumulative frequencies calculated there from must be shwon against the
class boundary points. A table showing the cumulative frequencies against values of the variable arranged in order
inagnitude either in ascending (or in descending) order is known as the cumulative frequency distribution.

Example 1 : Construct (a) the cumulative frequency distribution, and (b) the grouped frequency distribution, from
the following data ;.

Number ofgrains | Number of plapts

less than 10 : 37
lessthan 20 118
less than 30 - 161
less than 40 185
lessthan 50 . 194
less than 60 200

Solution ;

(8)  Thecumulative frequency distribution shows the values of the variable and the corresponding cumulative
frequencies (less than), : o

" Table 6: Cumulative frequency distribution

Number of grajng L Number of plants

(less than)
10 , 37
20 | 118
30 | 161
40 | | 185
50 194
60 | 200

(b)  The grouped frequency distribution shows the values of the variable in class intervals and the c esponding
class frequencies: L :
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Table 7: Grouped frequency distribution

(less than) ‘
0-10 _ | 37
10-20 81
20 - 30 . 43
30 - 40 24
40 - 50 9
50 - 60 6

Total number of plants =200

Exmple 2 ;
Construct the cumulative frequency distribution less than and more than type of the number of grains per spike
from the Table 7. B
. Solution : ‘ :
Cumulative frequency distribution.
Number of grains | Number of grains | , { plant
(less than) Number of plants (more than) Number of plants
10 37 0 200
20 " 37+481=118 10 200 - 37 = 163
30 118 +43 =161 20 200-118=82
40 | 161+24=185 30 | 200-161=39
50 185 +9 =194 40 200 - 185=15
60 ' 194 + 6 =200 50 200 -194=6
-Histogram :

Itis the common form of diagrammatic representation of a group frequency distribution. It consists of & set of
adjoiningrectangles drawnon a horizontal line, with areas proportional to the class frequencies. The widthof
rectengles, extends over the class boundaries (not class limits) shown on the horizontal line. The histogram can be
constructed in two ways depending upon the class-intervals :

(1)  Fordistribution that have equal class-intervals

(2)  Fordistributions that have unequal class-intervals

When the class-intervals are equal, the height of the rectangles will be proportional to the class frequency.
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 Exmple 3 ; -
Draw a histogram for the following frequency distri}:utx’on :

Solution:

Here the class intervals are defined by clasé limits and so we have to find the class b.oundan'es for drawing the
histogram. All the classes have the same width and therefore when histogram is drawn, heights of the rectangles may

Number of pods
50-59
60 - 69
70:79
80 - 89
90 - 99
100 -109
110-119

be represented by the class frequencies.

10

16

14
10

g

Number of pods ;. .... | Number of plants

(class limi!:s) Class boundaries (frequency)

50 - 59 49,5 -59.5 -8

60 — 69 59.5=69.5 | 10

70-179 69.5-79.5 . 16

80 - 89 79.5-89.5 14

90 —~ 99 89.5=99.5 10
100~ 109 99,5 -109.5 5
110-119 109.5-119.5 2
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16
14
12

3 10

&

(-9

s B

| ™

-§ 6

=]

L

- 10

16

14

10

49.5 59.5 69.5 79.5 89.5 99.5 1095 1195

Number of pods

Histogram representing the distribution of the number of pods per plants as given in Example 3.

Example 4 : Draw ahistc;gram forthe followihg frequency distribution :

Solution :

Since the class intervals are unequal, frequency densit.y hastobec
10-20,20 - 30, 30 - 40, 40 - 50 etc. as 1 unit, the class interval 50 - 70 becomes 2 units,

becomes 4 units etc.

Number of grains

(less than)
10-20
20-30
30-40

40- 50 -

50-70
70-110
110-150
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Thus, histogram can be drawn on the basis of the following data :

Number of gLaixis ' Units Number of .plants Frequency Density
10-20 1 ' 16 16+1=16
20-30 1 : 24 24+1=24
30 —-40 1 39 - 39+1=39
40 - S0 1 ‘ 25 25+1=25
5070 2 . 20 20+ 2= 10
70— 110 4 . 20 20+4=$5
110~ 150 4 12 12+4=3

40 39 
3%
k?)

g

ta 24

£

3 20
16 ¢ 16
2 ¢ 10

T8 ¢
. 5
4 T 3
0 1020 3040 0 @ N 80 9 K0 B0 KD
Number of grains

Histogram representing the distribution of the number of grains per spike as gven in Example 4,
Frequency polygon :
o Itisto graphxca} representation altemative the histogram and may be looked upon as derived from histogram by
Joining the mid-points of the tops of consecutive rectangles, To construct a frequency polygon, we mark the frequencies
along the vertical and the values of the variables along the horizontal as in the case of histogram. A dot s placed

above the mid-pointypf each class and the height of a given dot corresponds to the frequency of the relevant class
interval. Connecting these dots by a straight line, the frequency polygon is prepared. :
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Example 5 : _ '
Construct a frequency polygon and histogram for the followingdata: -

Soiutién :

Number of graips

17-19
20-22
23 - 25
26 - 28
29 - 31
32.34
35.37
38 - 40
41-43

Number of grains

16.5-19.5
19.5-22.5
22.5-255
25.5 - 28.5
28.5-31.5
31.5-34.5
34.5-37.5
37.5-40.5
40.5 - 43.5
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18
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26
19
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Frequency polygon and histogram representing the distribution of number of grains per spike as given in Example 5.

Number of Plants

_-/ l/

dmcam——

0 165 195 225
18 21 24

255 285

27

30

315 345
33

Number of grains per spike

Sample Questions :

1.

(a)

Define variable and attribute. What is difference between a discrete variable and a continous variable?
() Defineclass limit and class boundary

(c) Whatdoyou understand by primary and seoondary data?
Write short notes on the following :

(a)
(b)
(c)

Different methods of data collection.

Histogram
Frequency polygon.
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4.  Measures of Central Tendancy
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4.2 Types of Measures of Central Tendancy

4.3  Arithmatic Mean

4.4  Short-cut method for Calculating Mean

4.5  Step Deviation Method
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4.13 Computation of Mode

4.14 Merits and Demerits of Mode

4.15 Other Measures of Central Tendency
4.16 Excercises

5. Measures of Dispersion

5.1 Range

5.2 Quartile Deviation

5.3  Mean Deviation

5.4  Standard Deviation

5.5  Merits and Demerits of Standard Deviation
5.6  Computation of Standard Deviation

5.7  Relative Measures of Dispersion

5.8 Exercises |

6.  Moments, Skewness and Kurtosis

6.1 Moments

6.2  Skewness

6.3 Kurtosis

6.4 Exercises

7. Unit Summary

8. References/Suggested Further Readings

1. Introduction

- This module contains three sections, in which first section deals with measures of central
tendency. In measures of Central Tendency, we have discussed the definitions, merits and demerits,
various exaniples and the exercises about mean, median and mode. The second section deals with

measure of dispersion. In measure of dispersion, we have discussed the various absolute and relative
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Module [9(a). Riostatistics

----------

measures including the definitions, merits, demerits and examples. The last section describes the
various moments, skewness and kurtosis with their definitions, properties and examples.
2.  Objectives : To study this module, the reader will learn the following topics

1) Measures of Central Tendancy

2) Measures of dispersion

3) Moments, skewness and kurtosis.

3. Keywords : Mean, Median, Mode, Range, Quartile Deviation, Mean Deviation, Standard
Deviation, Moments, Skewness and Kurtosis.
I.  Measures of Central Tendency :

The word ‘average’ or ‘measures of Central Tendancy’ denotes a ‘representative’ or ‘typical value’
of a whole set of observations. It is a single figure which describes the entire series of observations
with their varying sizes. Since a typical value usually occupies a Central position, so that some
observations are larger and some otliers are smaller than it, averages are also known as measures of
Central Tendency. ‘

1.1 Definition : An average is a method of condensing a mass of data to a single figure, WhtCh is
typlcal%d fully representative of the entire data It represents the whole group.

The functions of an average are :

(i) To present the salient feaures of a mass of complex data.

(ii) To facilitate comparison.

(iii) To know about the population from a sample.

(iv) To help in decision making.

However, some desirable properties of a good measure of Central Tendency are as follows:

(i) Itshould be rigidly definied.

(ii) Itshould be easily comprehensible and easy to calculate.

(iii) Itshould be capable of further mathematical treatment.

(iv) Itshould be based on all the observations.

(v) Itshould not be affected by fluctuations of random sampling.
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(vi) Itshould not be unduly affected by extreme observations.

(vi1) Itshould be césy to understand.

(viii) It should have sampling stability.
1.2 Types of Measures of Central Tendency :

There are three measures of Central Tendency — Mean, Median and Mode. Again, Mean is of
three types — Arithmatic Mean (A.M.). Geometric Mean (GM.) and Harmonic Mean (H.M.). The

words ‘mean’and ‘average’ only refer to Arithmatic Mean.

Measures of Central Tendency

Mea_n Median Mode

' |
| ] 1

Arithmatic Geometric Harmonic
Mean (A.M.) Mean (GM.) Mean (H.M.)

4.3 Arithmatic Méan : ,

We have the following techniques to calculate the arithmatic mean of a given data.

Mean of Raw Data : We know that in an ungrouped raw data, we are given individual items. We
' also know that the average of n numbers is obtained by finding their sum (by adding and th¢n dividing
itby n), letx,, x,, ..., x, be n numbers, then their average js given by '

_ Nttt

X

n
Example 1. Find the arithmatic mean of the marks obtained by 10 students of a class in

Mathematics in a cartain examination. The marks obtained are :
- 25,30, 21, 55,47, 10, 15, 17, 45, 35
Solution : Let ¥ be the average matk.
", Sum of all the observations = 25 + 30 +21 + 55 + 47+ 10+ 15 + 17 + 45 +35 =300

Number of students =10
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300

Anthmatlc mean =~ o= = 30.

Mean of Groupe,d.Data :Let x,x,
frequencies, then their mean ¥ is given by
| | L Jx, ). fx
i_zf,x,+j;x2r+....+f£§_,,_=_4§~’ '2%: i
+ ot N x

i=1

«eyX, be the vériates-andv-let fisJos e, be their corresponding

_whereN Zf h+fot. +f totalﬁequency

i=]

. Example 2 : Find theAmhmatxc mean from the ﬁ'equency table

Marks

52

58

60

65

68

70

75

7

5

..4

6

3

No. of Students

Solution : Let x be the marks and fbe the frequency so that we have the following table :

x J xf
52 7 " 364
58 5 290
60 4 240
65 5 1390
68 3 204
70 3 210 -
75 2 150

HereN Zf 30, andZﬁc 1848

Mean ¥ =¥§6—==6L6.
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Example 3 : Calculate the Arithmatic Mean for the following data :

...........................................

Class interval. Frequency Class interval Frequency
10-20 | 2 | 60-70 10
20-30 7 70 — 80 3
30-40 17 . 80-90 2
40 - 50 29 90 — 100 1
50 - 60 ' 29

Solution : While calculating the arithematic mean for such a tabular data, it is assumed that the
all the observations in any particular class interval have the same value. This value is the middle value

or mid point of the class interval, i.e., we replace the classes by the mid values and proceed as follows:

Class interval - Mid values Frequency fx
| ' | at |
10 - 20 5 -2 | 30
20 - 30 | 25 B 7 175
30 - 40 35 17 | 595
40-50 45 29 1305
' 50-60 55 29 1595
60-70 65 10 650
70 — 80 75 3 225
80 — 90 85 2 170
90 — 100 95 1 95
: | TOTAL 100 4840
Here N=Y £ =100, /=4840 o -
Arithmatic Mean ¥ = %—? = %%469 =48.4

4.4 Short-cut Method for Calculating Mean :
For Mean of ungrouped data, short-cut method is applied when the frequencies and the values of
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2ccase

the variables are quite large and it becomes very difficult to compute the arithmatic mean. In a frequency
table of such a type the "broy,isional mean is taken as that values of x (mid value of the class interval)
which comes near the middle value of the frequency distribution. This number is called the Provisional

Mean or Assumed Mean. Also find the deviations of the variates from this provisional mean. Then the

arithmatic mean is given by the formula :
(i) Inthe case of ungrouped data

d
X=a+ ~Z~——— where a = assumed mean,
n

n = number of items,
d = x — a = deviations of any variate from a.

Working Rule for Short Cut method for ungrouped data :
Step I : Denote the variable for the discrete series by x or X.
Step II : Take any item of series, preferably the middle one, and denote it by a. This number a is

called the assumed mean or provisional mean.
Step I : Take the difference x — @ and denote it bydordxor d’'=x-a, where d' is the deviation

of any variate from ‘a’.
Step IV. Find the sum of Z d.
Step V. Use the following formula to calculate the arithmetic mean :

>d

X =gl

(i) Inthecase of grouped data

X=a+ , where

Jd=product of the frequency and the corresponding deviation.

N = Zf = the sum of all the frequencies.
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Wbrking Rule for Short Cut Method for Grouped data

Step L In the cae of discrete series, denote the variable by x of X and the corresponding frequency
by 1. (But in the case of continuous series x is the mid value of the interval and /] the frequency
corresponding to that interval).

Step 11 Take any item x series, preferably the middle one and denote it by “a’ This number ‘a’ s
called the assumed mean or provisional mean.

Step IT1. Take the difference x —a and denote it by d or dx or d =x —a = deviation of any variate
x from a, the assumed mean. | . J

Step I'V. Multiply the respective fand d and denote the product under the column /d.

Step V. Find ¥ fd. |

Step V1. Use the following formula to calculate the arithemetic mean.

X=a+ Z‘-‘E—i—
2.
Example 4.'Find, by short-cut-method, the mean height of the following 8 students whose
height in centimetre are
59, 65, 71, 67, 61, 63, 69, 73 -
Solution. Let us take 65 as assumed mean, ie,a= 65. Let us prepare the following table. (i)

X ~ d=x-65
59 -6
65 0
71 +6
67 +2
61 | -4
63 -2
69 B +4
73 ' B +8

Total dgviation = Z fd =8

8 - Directorate of Distance Education



Module 19(a): Biostatistics

Herea=65,n=38, Zfd-:S |

cxear2t 65 8 csom
. on. : 8

Example 5. Ten coins were tossed tOgethér and the pumber of tails resuiting’ from them were
observed. The operation was performed 1050 times and the frgquencies thus obtained for different
number of tails (x) are shown in the foliowing table. Calculate the arithmetic mean by the shortcut
method. _ | | ’ ‘

Cox 0 41 2 3 4 5 6 7 8 9 10
f2 8 43 133 207 260 213 120 sS4 9 |

Solution : Let 5 be the assumed mean, i.e.,a=>5. Let us prepare the followmg table in order to

calculate the arithmetic mean :
x f d=x-5 - fd
0 2 -5 - ~10
1 8 —4 ~32
2 43 | -3 ~129-
3 133 =2 ~ 266
4 207 -1 -7
5 260 0 0
6 213 1 +213
7 120 o 2 +240
3 54 3 4162
9 9 4 +36
10 5 +5
Xr=1050 . Y g

. d
Al‘lthmetchean“’C a+2}%‘[f— 5+-1-bl-§—6~5+00114 5.0114.

Directorate of Distance Education : g



s -

Advanced Optzmzzalzonand OperatzonsResearchJ .......................................................... v raessssasnesarsbnss

4.5 Step Deviation Method. When the class mtervals in agrouped data are equal, thenthe calculahons '
~canbe sxmphﬁed further by taking out the common factor from the deviations. This common factor is
equal to the width of the class-interval. In such cases, the dev1at10n of vanates x from the assumed
~ mean‘a’(ie.d=x-—a) are divided by the common factor. The arithmetic mean 0 i is then obtained by
;he following method : '
¥=a+ Zﬁf‘lx i |
where @ =assumed mean or ProVisionéi Méan,

b

d..

= the deviation of any vanate from a,

= the width of the class interval,
' N=the number of obse'rvations , |
Example 6. Calculate, by step deviation method, the arithmetic mean of the following marks

obtained by students in Englxsh
Solution. Leta=20and i=5.
X - f dx=x-a dx' =dxli fa'
5 20 ~25 -5 - 100
10 43 ~20 _4 ~172
s | 15 ~15 -3 _ns
20 61 | -1 -2 _134
25 7 -5 -1 -T2
. 30 45 0 0 0,
35 39 | 1 39
40 9 10 2 18
45 8 15 3 24
%0 6 20 4 24
| Y f=384 Y fdx' =-598
" 10 Directorate of Distance Eduéation
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Now i"=a+ZZ—[}€—x-xi=30~§9%x5‘~—4_30—1-.56_><5

=30-7.80=22.2

- Example 7. (On weighted average)‘.ﬂ The following table gives the number of students in different
classes in a Government Senior Secondary School and their tuition fees. Find the average tuition fee

per student.
| .Class ‘ No. of students Tuition fee (Rs.)
v 65 050
Vi | 80 075
VI 95 1.00
© VI o 90 | 1.50
X 70 2.00

Solution. Here the values of x are 65, 80, 95, 90, 70 and their corresponding weights w’s are |
0.50, 0.75, 1.00, 1.50, 2.00 respectively. |

Weithted Arithemetic Mean = ZZ—;

_ 65%0.50+80x0.75+95x1.00+90x1.50+ 70x 2:00
65+80+95+90+70 .

_32.5+60.0+95.0+135+140 _ 462.5
400 T 400

.Example 8. Calculate the average marks, by the step deviation method, from the following data

=1.156.

Marks T0-10 1020 20-30 3040 40-50  50-60
No.ofstudénts ~ 42 = 44 'S8 -~ 35 26 15

- Directorate of Distance Education : 11
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Solution :

.........................................................................................

X =35 +(
., 220
Example ’9._ In a study on patients, the following data were thained. Find the arithmetic mean.
Age (inyears) 10-19 20-29  30-39 4049  50-59 . 6069 70-79 80-89

Number of cases 1 0

Solutien : The data is presented in the form of an inclusive series. We have to transform the

.‘.f~a+~zﬁgxi.

-216

)x10=35—9.8#25.2

1

1_0'

17

38

inclusive series in an exclusive series. It can be transformed as follows: -

~ We measure the distance between the lower limit of the second class interval and the upper limit

1 ' .
of the first class-interval. This is equal to 20-19=1. We subtract 5 of this distance (i.e, 0.5) from the

Marks Mid value d= ’.5-1_035 . " No. of students fd |
0

0-10 5 -3 -~ 42 ~126

10 - 20 15 -2 44 88

20 - 30 25 ~1 58 _ 58

30 - 40 35 0 35 0

40 - 50 45 . 26" . 26
C50-60 . 55 2 15 30

- S N=220 3 fd=-216

Here a = 35, N = 220, > fd=-216 i=10

9

lower limit and'add it to the upper limit. th.e"nc,w classes will be formed as follows:
| 10-0.5=95;19+0.5=19.5 |

12
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The new data will be as follows:

bg) . f M value #x—134.5 . fd
() o £ -
95-195 1 14.5 -3 53
195-295 0 . 245 -2 0
295-39.5 .1 - 345 -1 -1
39.5-49.5 10 - 445 0 0
495-595 17 545 1 17
595-69.5 38 645 2 76
69.5-795 9 74.5 3 27
795-89.5 3 - 845 4 12
- N=79 > fd=128
S fd_
Now_x=q+ZN X1,
128

¥ =44 5+7§-x10 44.5+16.2=60.7.

4.6 Corrected Mean.

. Module 1 9(a). Biostatistics

Example 10. Mean of 25 observatxons was found to be 78.4. But latcr on it was found that 96

was mlsread as 69. Find the correct mean.
‘Solution. We know that the mean is given by

x——-Z—J—c-oer nx

Here f =T78.4,n=25.
) x=25x78.4=1960.

But this Eqr is incorrect as 96 was misread as 69.

s, correct ) x =1960—69 +96 =1987. .

Directorate of Distance Education
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1987
correct mean = s =79.48.

4.7 Combined mean. If we are given the mean of two series and their size, then the combined mean

for the resultant series can be obtained by the formula.

Y= nx, + ”;fz
m+n,
where ¢ = Combined mean of the two series.
X, = Mean of the first series.
%, = Mean of the second series.
n, = Size of the first series.

n, = Size of the second series.
Example 11. A firm of ready-made garments make both men’s and women’s shirts. Its profit

average is 6% of sales. Its profits in men’s shirts average 8% of sales; and women’s shirts comprise
\

60% of outpiut. What is the average profit per sales rupee in women’s shirts.
Solution. Here X =6,X, =8,n, =40,n, =60. Assuming that the total output is 100, we are

required to find out X,. We know that

nx +n%, 40.8+60-%,

e

X =

n+n, 40+ 60
6::3204»60552
100
_ :600—320 : 280 _ 10 — 4.66.

=X, —
) 60 60- 3
Thus, the average profits in women’s shirt is Rs. 4.66 per cent of sales, and Rs. 0.0466 per sale

rupee.
4;8 Merits, Demerits and uses of Arithmetic Mean

Merits :
1. Itcan be easily calculated.
2. Its calculation is based on all the observations.
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Itis easy to understand.
. Itisrightly defined by the mathematical formula.
Itis least affected by samplihg fluctuations. '
It 1s the best measure to compare two or more series (datas).
7. Itistheaverage obtained by calculations and it does not depend upon and position.
Demerits : R |
1. Itmay notbe represente&in actual data so it is theoretical.
2. Theextreme values have greater affect on mean.
3. " Itcannotbe calculated ifall the values are not known. -
4.  Ttcannot be determined for the qualitative data such as love, beauty, honesty, etc. -
5. . Mean may lead to fallacious conditions in the absence of ongmal observatxons :
Uses of Arithmetic Mean : ‘ '
1. A common man uses for calculating average marks obtamed bya student
2. Itis extremely used in practical statistics.
3. Estimates ate always obtained by mean. .
4. Busmessman uses it'to find out the operation cost, profit per unit of article, output per man
and per machine, average monthly income and expenditure, etc. etc.
45.9 Median - | o _
Median is defined as the middle-most or the central value of the variable in a set of observations,
when the observafior;s are arranged either in ascending or in' descending order of their magnitudes. It

SRV I )

divides the arranged series in two equal parts. Median is a position average, whereas, the arithmetic = -

mean is the calculated average. When a seriés consists of an even number of terms, median is the
arithmetic mean of the two central items. It is generally denoted by M.
4. l(f Calculation of Median. ‘

 (a) When the data is ungrouped Arrange the n values of the variable in ascending (or

descending) order of magmtudes

- n+l .
“Case I. When nis odd. Inthe case %’“ th value is the median

: n+ 1
ie. M —-*—27* term.

Directorate of Distance Education ‘ : S =
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Case IL. When nis even. In this case there are two middle terms -g-th- and (-2'-2- + lJth. The median

~ is the average of these two terms, i.e.,

- 24(24)
M=2\2 )
Ex_ample 12. The number of runs scored by 11 pléyers of a cricket team of a school are
- 5,19, 42, 11, 50, 30, 21, 0, 52, 36, 27 I o ‘
'._'Find themedian.
Solution. Let us arrange the values in ascending order :
10,5,11,19,21, 27, 30, 36, 42, 50, 52.
.. Median =M = (nz 1)th al e= (1 12+ l)thvalue o
- =6"value. |
Now the 6"’ value in the date (i) is 27.
Mednan 27 runs.
, ‘Example 13. Find the median of the followmg items :
'~ 6,10,4,3,9,11,22,18 - -
 Solution. Let us arrange the items ‘in ascending order.
3,4,6,9,10,11,18,22.
In this data the number of items is =8, which is even.

.. Median = M = average of (%)th and(—;- + l)th terms.

" = Average of(z)th and@ +1)th terms.

- =average of 4th and 5¢h terms.

=’9+10=1g__95
2 2
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(b) - When the datais grouped :
Case (1). When the series is dlscrete In this case the values of the variable are arranged in
ascending or descending order of magmtudes. A table is prepared showing the _comespondmg ,

frequencies and cumulative frequencies. Then the median Is calculated by the following formula:

e (”“)ﬂ;
2 .
where. - = Z f = total frequencies.
Example 14. Calculate median for the following data: o
No.ofstudents 6 4 16 7 . 8 2
Marks © 20 9 .25 50 - 40 80 .-
Solution. Arranging the marks in ascending order and preparing the following table : i
‘ Marks . Fréqiién'cy ‘. Cumulative Frequency - -
9 4. T4 T
20 6 ' 10 .
25 16 26
40 | 8 | 34
50 | 7 4
80 2 43
”=Z f=43
Here n=43. .
' Median= =( ngljth value

= ( f32+ 1 Jth. value = 22nd value.
The above table shows that all items from.11 to 26 have their values 25. Since 22nd item lies in
this interval, therefore, its value is 25.
Hence Median =25 marks. |
(c¢) When the series is continuous. In this case the data is given in the form of a frequency table

with class-interval, etc. and the following formula is used to calculate the Median.

 Directorate of Distance Education o o 17
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L lower lnmt of the class in whxch the medlan hes |
n = total number of frequemces, ie n= Z f

" f=frequency of'the class in which the median hes.

C = Cumulative frequency of the class preceding the median class. -
i = Width of the class interval of the class in which the median lies.

Example 15. The followmg table nges the marks obtamed by 80 students in Economics. F ind-

. the medxan

~'Marks | No.ofstudents Marks ~ No. of students
1014 4 3034 | 7
15-19 | 6 .~ 35-39 o 3
- 20-24 | 10 40 - 44 - 9
25-29 -5 45 - 49 | ' 6
Solutlon Letus prepare the following table - showing the frequencies and cmnulatlve frequencies:
Marks Frequency Cumulative Frequency
1014 - -4 - 4 '
15-19 . | 6 10
20 - 24 o100 | 20
25-29 5 | 25
30-34 - 7 32
35-39 3 | - 35
40 — 44 9 '~ 44
45 - 49 6 .50

. L Lowcr limit of the median class = 24.5.
C Cumulative frequency of the class (20-24) precedmg the median class = 20.
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[= Freqtiency of the median class =5..
i- = Class-interval of the median class = 5.
25-20

- Median = 24 5+ x5
=245+ 5 =29.5.
Example 16. The follwomg table gives the weeldy expenditure of 100 famlhes Find the medxan '
weekly expendlture : .
- ‘Weekly Expenditure (inRs. ) _ Number of Families
—-10 ) - VIS
io-zo - - 23
20-30 27
30-40 - . | 21 -
: : 40-50 o 15
Solntion Let us prepare atable which gives the ﬁ'equency and cumulative frequency:
‘Weekly Expenditure Number of families Cumulative frequency
(in Rs.) (frequency) | -~
0-10 14 14
10-20 23 3T
20-3 - | 217 | - .64
©30-40 S22 .85
 40-50 N S T | 100
Heren= Zf =100 o

.. Median = (—;—)th value = (-l-gg)th value = 50th vah_ie. :
Median closs = 20-30. |

Here-5=50L 20f 27 C= 37i 10

n
"‘C 50-37

- Median =L +2 =20+ 10 -24.81.
» f 27 ‘
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4.11 Merits and Demerits
Merits .
Itis easily understood. .
It isnot affected by extreme values.
It can be located graphically.
Itis the best measure for quahtatxve datasuch as beauty, intelligence, etc.
It can be easily located even if the class-intervals in the series are unequal.
It can be determined even by mspectlon in many cases.

S R

- Demerits.
1. Itis not subject to algebralc treatments.
2. . Itcannot represent the megular dlstnbuuon series.
_ Example 17 In a survey of 950 families i ina v1llage, the fo]lowmg distribution of numbers of

children was obtamed

20

No. of children .

02

T 24

46

6-8

.. 8-10

1_0~12- |

No. of families

272

328

205 |

120

15

10

~ Findthe mean and median of the above dlstnbutlon
Solution. Let us prepare the followmg table by taking 7 as assumed mean, i.e.a=7.

. T x =T

Class- - X, £ of. d; = 5= 2 | ﬁd,.'.
0-2 1 272 272 -3 - 819
2-4 3 328 600 -2 ~ 656
4-6 5 205 805 -1 - 205

6-8 7 120 . 925 0 0
g~ 10 9 15 940 15
10-12 11 . 10 950 2 20
950 — 1642

. ) Zf;dl" .
Now AM =g+t — xi=7+242 5

- =l

950
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=728, 3.46=3.54
. 950
N 950 -,
For Median. _-—2——T=475
Medxanclass 2-4;L= ZC 600; i=2.
. N .
Medlan L+-2-———xz 2,,__4_7_5_2]2 2
7 328
224285, 2+59-§-2+124 |
e 328 328 -
'-“-3.24.

4.12 Mode _

Mode is deﬁned as that value in a series whieh occurs most frequently. In a frequency
dlstnbution mode is that variate which has the maxim,um Mqueney. In other words, mode | 4
represents that value which is most ﬁequent ortypxcal or. predommant For example in the series 6, 5, -

3,4,3,7,8,9,5, 5, 4 we notice thatS occurs most frequently, therefore,S isthe mode Modeisalso =~

~ known as the Norm. : |
* Example 18. A Bata shop in Delhi had sold 100 paus of shoes of Bata exclus:ve ona certam day

with the following dlstnbutxon o ' | . :
SizeofShoe | 4 | 5 6 1 7 ] 8 | 9 10
No. of Pairs 10 15 | 20 | 35 | ‘16 31
Fmd the mode of the distribution. R - -
Solutlon Letus prepare the table showing the ﬁ'equency o
Size of Shoe 4 | 5 6 | 7 ] 8 ] 9] 10
Frequency . 10 | 15 ] 20| 35| 16 [ 3| 1

. Inthe above table we notice that the size 7 has the maxxmum frequency, viz. 35 Therefore 7 is
the mode of the df’stnbutxon ' ' | | |

Dimctoi‘ate of Distance Education =~ : B ' : - 21
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4.13 Computation of Mode. (a) Simple series. In the case of Simple series the value which is -
" repeated maximum number of times is the mode of the series. | | ‘
Example 19.In Rajdham Rubber Industry, Tilak Nagar, New Delhi, seven labourers are receiving
the daxly wages ofRs. 5,6, 6, 8, 8, 8 and 10. Find the modal wage ‘
Solution. In the series 5, 6, 6, 8, 8, 8, 10; 8 occurs thrice and no other item occurs three times
 or more than three times and hence the modal wage isRs. 8.
(b) Discrete frequency distribution senes In the case of discrete frequency dxstnbutlon mode
is the value of the variable correspondmg to the maximum frequency
: Enample ZQ.Aset of numbers consists of f_our 4’s, five 5° s, six 6’s and nine 9’s. What is the mode?
Size of item 4 | s 6 9
| { Frequency - 4 5 ’ 6 9

. Since9 has the maxlmum frequency viz. 9, therefore 9 is the mode

Thus, we notice that in discrete senes, mode is determined by inspection and therefore, an error
of Judgement ispossible in these cases where the difference between the maximum frequency and the
frequency precedmg or succeeding it is very small and the items are heavily. concentrated on either -
side. Under such circumstances the value of mode is determined by preparing a groupmg table and
o analysis table. A grouping table has the following six columns: R
" ColumnLIt has original frequencnes and the maximum frequency is marked by bold type.

Column ILIn thns column the frequencles of column I are combmed two by two. Here also the
ma:}gmum frequency is marked by bold type. ‘

- Column IIL Here, we leave the first frequency of the column I and combine the others intwo by
two. Agam the maximum ﬁequency is marked by bold type. -

Column IV. In this column the frequencies of the column I are cornbmed (grouped) in three by
three and again the maximum frequency is marked by bold type .

Column V. Here we leave the first frequency of the column I and group the others three by

three. Again mark the maximum frequency by bold typ_e.
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Column V1. Now leave the first two frequencies of column I and combine the others in three by

three. Mark the maximum frequency by bold type.
After preparing the grouping table, we prepare the analysis table. While preparing this table we

put the column numbers on the left hand side and the various probable values of the mode on the right-

handside, i.e., values against which frequencies are maximum marked in the grouping table, The value

which occurs maximum number of times is the mode.
The procedure of preparing a grouping table and analysis table shall be clear from the following

table:

Example 21. Calculate the mode of the following frequency distribution :
Size (x) 4 5 6 7 8 9 10 11 12 13
Frequency () 2 5 8 9 12 14 14 15 11 13

Solution. This problem is solved by the method of gfouping as it an irrgular distribution in the

sense that the difference between maximum frequency 15 and frequency preceding it, is very small.

Let us prepare the grouping and analysis table.

Grouping Table
' Grouping
Size Frequency of two of two of three of three of three
X f leaving the leaving the {leaving the
first first first
(I (1D (1 (Iv) V) (V1)
4 2 }
7 _ .
5 S } 13 } 15 A
6 8 } 17 } 22
7 9 } 21 29
8 12 | | 3 | | }
L ,
9 14 } 28 ~ 40
10 14 } 29 R
1 15 }26 . 40
12 ' 9
11 } 24 } 3
12k 13
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Letus ngﬁ\ii' prepare the analysis table. |
Analysis Table
Size of items having
maximum frequency
11
.10, 11
9,10
10, 11, 12
8,9, 10
\% O 9,10, 11

| Columns

< 2 B = -

Since the item 10 occurs maximum number of times, viz. 5 times, Hence mode is 10.

Continuous Frequency Distribution.
(i) Modal class. Itis that class in grouped frequency distribution in which the mode lies. The
modal class can be determined either by inspection or with the help of grouping table. After finding

the modal class, we calculate the mode by the following formula:
T
where [ = the lower limit of the modal class.
i = the width of the modal class.
/, = the frequency of the class preceding modal class.

Mode =1+

/. = the frequency of the modal class.
f, = the frequency of the class succeeding modal class.
Sometimes it so happened that the above formula fails to give the mode. In this case, the modal

value lies in a class other than the one containing maximum frequency. In such cases we take the help

of the following formula;

/s
fi+ 1

where [,f,, f,, ihave usual meanings.

X1

Mode ={+
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Asymmetrical Distribution. A distribution in which mean, median and mode coincide is called
asymmetrical distribution. If the distribution is moderately asymmetrical then, mean, median and
mode are connected by the formula.

Mode =3 Median — 2 Mean
The procedure of finding the mode by the above methods shall be clear by the following examples v

This method is generally used when we have to locate mean, median, mode simulataneously.

Example 22. Find the mode for the follovying’ data :

Marks .. No. of Students -
1-5 7

6-10 10

1-1s 16

16 — 20 | 32

21 -25 24

~Solution. From the above table it is clear that,the maximum frequency is 32 and it lies in the
class 16 ~ 20. Thus the modal class is 16 — 20.
Here 1=16, 1, =32, j; =16, £, = 24, 1-5

-‘-M0d3=1+-——-['ﬂ—:—f'——-—~xi:16+ 32-16
2fu— 11 64 -16-24
16 10

—16+———x5~16+——l6+3 33=19.33.
24 3

4;14 Merits and Demerits of Mode.
Merits
() It Qaﬁ'be easily understood.
(2) It canbe located in some cases, by inspection.
(3) Itis capable of being ascertained graphically.
(4) Ttisnot affected by extreme values.

{5) Itrepresents the most frequent value and hence it is very often in practice.
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(6) - The arrangement of data is not necesssary if the items are a few.

Demerits

(1) There are different formulae for its calculations which ordinarily given different answers.

(2) Mode is determinate. Some series have two or more than two modes. .
4.15 Other Measures of Central Tendency - |

Midrange. The midrange is the value midway between the smallest and largest values in the
sample, that is, the arithemetic mean of the largest and the smallest values. for example, in the sct of
radiologic counts 4, 5, 9, 1, 2, the midrémge is (9 + 1)/2 or 5_it is clear that the midrange will be
influenced by extréme values. | .

Geometric Mean. The geometric mean of a set of observations is the nth root of their product.
the computation of the geometric mean requires that all observations be positive, that is, greater than
zero. For example, the géometric mean of the radiologic counts 4 and 9 is J34.9 =36 or 6. A
general formula for computing the geometric mean of the set of observations x,. X;, .-.X, is
m . The geometric mean is sometimes denoted by %. An interesting property is that the
logarithm of the geometric mean is the arithmetic mean of the logarithms of the individual observations.
This result is expressed by the formula |

Zn; log x,

i=]
n:

In addition to other applications, the geometric mean is used in microbiology for computing

logXx, =

average dilution titers.
} 'Harmonic Mean. The harmonic mean of a set of observations is the reciprocal of the arithmetic
mean of the reciprocals of the observations. That is, if the observations are x,, x'z, WX then the harmonic
mean is

n

= 1

i=l x[
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The harmonic mean is often denoted by X, . It is an interesting example of the usefulness of the
harmonic mean. The problem of determining the average velocity of a car that has travelled the first
.10 miles of a trip at 30 miles per hour and the second 10 miles at 60 miles per hour. At first glance the
average velocity would seem to be the simple average of 30 and 60, that is, 45 miles per hour. However,

this kind of average is usually defined to be total distance divided by total time. Here the total distance

1 1
is 20 miles, whereas the total time 3 hour plus P hour of 5 hour, producing an average velocity of

40 miles per hour rather than 45 miles per hour. .

4.16 EXERCISES
What are the measures of central tendency and give their relative merits and demerits.
.Give a critical review of the different measures of Central tendency, with examples.
How do you calculate the mean of a grouped frequency distribution?
Define mean. What are its merits and demerits? Also give its uses.
Define median. What are its merits and demerits? Also give its uses.

" Define mode. What are its merits and demerits? Also give its uses.

R S S

Compute the mean from the frequency table :

Marks

70

50

60

52

65

75

68

No. of Students

3

5

4

7

6

8. Findthe mean height from the following frequency distribution

‘Heights in ¢cms

150

160

158

155

164

168

No. of Students

10

14

8

15

16

9. Find the median of the following items :
58,16, 12,11, 15, 10, 13, 6, 18, 20.
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10. Find the median forthe following data

Class Interval Frequency
0-10 28
10 -20 35
20-30 24
30 - 40 41
40 - 50 : 18
50 - 60 | i1
60 — 70 o 8
70 - 80 7
80 — 90- 3
90 — 100 . 1
Ex. 11 Calculate the mode for the following distribution :
X 10 20 30 40 50 60 70
y 17 22 31 39 27 15 13
Ex. 12 Find mean median and mode for the following frequency distribution : _
Marks No. of Students Marks No. of Students
0-10 2 0-60 79
0-20 6 - 0-70 - 94
0-30 21 0-80 98
0-40 39 0-90 100
0-30 61 B
Ex. 13 Find the mean and the median for the follbwing data, and comment on the shape of the
distribution :
Weightinkg. : | 3640 | 41-45 46-50 | 51-55 | . 56-60 61-65 | 66-70
| No. of Persons 14 26 - 40 53 50 37 25
£x. 14 Find the mean and mode for the following :
Year under : 10 20 30 40 50 60
No. of Persons : | 15 32 51 78 97 109
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Ex. 15 Find the median and the median class of the data given below :
| Class boundaries | 15-25 | 25-35| 35-45] 45-55 55-65 65-75
Frequency 4 11 19 14 0 2

Answers :
(7)60.27 (8) 159.5 (9) 12 (10) 30.24 (11) 40 (12) Mean = Median = Mode = 45 (13) Mean = 54.3 Kg. Median
=54.5 kg. (14) Méan = 29.95, Median = 35.00 (15) Median = 40.26, Median Class = 35-65.

S. Measurs of 'Dispersion _

The word dispersion or variability is used to denote the “degree of heterogeneity” in the data. [t
is an important characteristic indicating the entent to which observations vary among themselves. The
dispersion of a given set of observations will be zero, only when all of them are equal. The wider-
discrepancy from one observation to another, the larger will be the dispersion.

- A measure of dispersion is designed to state numerically the entent to which individual

observations vary on the average. There are several measures to dispersion. -

Measures of Dispersion
Y | T
| I
Absolute measures ( Relative measures
r R N B
Range Quartile Mean Standard Coefﬁ;xent Coefficn?nt Coefficient
Deviation Deviation  Deviation © of Quratile  of Mean

Variation Deviation Deviation

Now we discuss the different absolute measures one by one.

51 Range of a set of observations is the difference between the maximum and minimum values.

Range = Maximum value — Minimum value.
As for example, for the observations, (in Rs.) 6,4, 1,6, 5, 10, 3, the maximum and the minimum.

Values are 10and 1. Therefore,
Range=10-1=9Rs.
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Advantages :

(i) Itiseasyto understood.

(i) Range is also simple to calculate.

(iii) Its units are the same as the units of the variable being measured.

Limitations :

(i) It does not depend on all obsevations, and is based on only the largest and the smallest

among them. The values of intermediate observations, are not of all necessary for its

calculation.
(ii) Itis highly affected by extreme values.
(iii) It does not take into account the form of the distribution.
“(iv) The greatest disadvantage of Range is that it cannot be calculated from frequency

distributions with open— end classes.

5.2 Quartile Deviation or Semi-interquartile Range :

~ Quartile Daviation is defined as half the difference between the upper and lower quartiles.

Q3 — Q|
' 2
The difference Q, — (O, being the distance between the two quartiles, may be called interquatile

Quartile Deviation =

range, and half of this is semi-interquartile Range.
Example 1. Calculate the quartile deviation from the following :
Classinterval:  10-15 15-20  20-25 25-30 3040  40-50 S0-60  60-70

Frequency : 4 12 16 22 10 8 6 4

Solution. In order to compute Quartile deviation, we have to find O, (1st quartile) and Q, (2nd

quartile) i.e., values of the variable corresponding to cummulative frequencies N/ and 3/ Here
, & “q 4 4

- - N/ 2905 and 3V/ = 61
total frequency NV = 82. Therefore /4 20.5, and /,f 61.5.
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Class boundary Cumulative frequency (less than)-
10 0
15 4
20 16
0 Ni=205
25 32
30 54
0, | 3N/ =61.5
40 64
50 72
60 | 78
70 82=N

Applying simple interpolation -
0,-20 20.5-16

25-20 32-16
4.5%5
=0 -20= =1.4
0} i
= =214
Simmilarl 0,-30  61.5-54
AY. 40°30 64— 54
=0, =375
- 37.5-21.4
-. Quartile deviation &, 5 Q_ 5 =8.0

5.3 Mean Deviation :
Mean Deviation (also called Mean Asbolute Deviation) of a set of observations is the arithematic

mean of absolute deviations from mean or any other specified value. Given the observations x,, X,

...x_ inorder to find ‘Mean Deviation about A’, we first obtain the deviations (x,~A), (x,~A), ... (x ~A).
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Some of these deviatiion may be positive and some negative. If we write [x,. - AI to denote the positive

value of (x ~-A), whatever the actual sign, the sum of these ‘absolute deviations’ is
Ix, - A[+|x2 - Al + .. -I_-lx,, - A| = Z|x,. - AI.
and A M. of the absolute deviations is
1
Mean Deviation about 4 = ;ZIX, -4

Mean Deviation is usually calculated about arithmatic mean (X)), and hence for simple series,

Mean Deviation =+ Zl(x, -X )‘
n
For frequency distribution,

Mean Deviation = 7:/—2 /i )x,. - fl, where N = fo

Example 2. Calculate the Mean Deviation of the following values about the median : , 15, 53,

49,19, 62,7, 15,95, 77.
- Solution. Since there are an even number of observations, so, 10, the median is the average of

the two middle most observations, when arranged in order of magnitude 7, 8, 15, 15, (19,49), 53, 62,
77. 95.
19+49

Median = 34.
Table for calculations of Mean Deviation
x }x - medianl
i.e., difference from median

8 26

15 ' 19

53 19

49 15

19 15

62 , 28
7 . 27
15 19

95 61
77 43

Total . 272
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Mean Deviation about median

= %le — median|.
| ‘
= ) x272=127.2
Example 3. Find the mean deviation of the follwoing series : ‘ A
x 10 | 1 | 12 13 14 EE
Frequency 3 | 12 18 12 3 48
Solution. Table for calculations for Mean Deviation N
x 7 fx [x—x| fle-x i
10 3 30 2 6
11 112 132 | . r 12
12 18 216 - | 0 0
13 12 156 1 12
14 3 . 42 2 6
Total - 48 . 576 - - 36

Mem..szy Lol e

So Mean Deviation about mean = Zflx x[ 36 =0.75.
; Y 48

5.4 Standard Deviation (S.D.)
Standard Deviation of a set of observations is the square root of the arithmetic mean of squares

of deviations from arithmatic mean. In short S.D. may be defined as “Root- Mean-Square~Dev1atlon
from mean”. It is usually denoted by the Greek small letter o(sigma).

If X3 Xp R X, be a set of observations and x their A.M. then

Deviations from : (x, —x),(x2 =X )y (x, =X
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Square-Deviations from mean : (x, ~%)°,(x, ~ ¥ ), = %)

Mean-Square-Deviation from mean :

1

L B

Root-Mean-Square-Deviation from mean, i.e..

Standard Deviation (o)-= \/ -rl; Z(‘x,. -X )2

The square of standard deviation, i.e., o2, is known as variance.

Variance = (S.D.)?
R ]
For simple series, o* =~ Y (% -%)

For frequency distrib_ution,

) 1 —\2
| o‘=~ﬁ2ﬁ(x,—x)
S.D. is always considered as positive. Thus, S.D. is the positive square root of variance.

Important properties of S.D. :

(a) S.D.is i,ndepend‘ent of the change of origin; i.e. if y = x — ¢ where ¢ is a constant, then
S.D.ofx=S8S.D.ofy

In symbols, o, =0, _
This implies that the same S.D. will be obtained if each of the observations is increased or

decreased by a constant.
(b) Iftwo variables x and z are so related thatz=ax + b for each x = x,, where a and b are constants,

then
| 0. =,
where |a| denotes the positve value of a.
In particular, if y = (x—c)/d, where cand d are constants (dpositive), then o, =d o,
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This implies that S.D. does not depend on origin, but depends on scale of measurement. Lf each
observation is multiplied or divided by a constant, S.D. will also be similarly affected.
(c) Ifagroupofn, observations has mean ¥, and S.D. o,, and another group of n, observations has
mean X, and S.D. o, then S.D. (o) of the composite group of n, +n, (= N say) observations can be
obtained by the formula _
Ng? =(n,cf +n20'§)+(n,d,2+n2d22) .............. (1)
whére d =X -X,d, =%, -X, and NX = nX, +n,x,
Relation (1) may be extended to any mimber of groups :
No? = Z no? + Z:n,d,2 | ‘
where d, =¥, ~%,N =) "n,, and ¥ is the mean of composite group given by Nz = > nx,

(d) S.D.is the minimum root-mean-square-deviation, i.e. t

o7« [

whatever be the value of 4.

Merits and Demerits of Standard Deviation :
Merits :

:J'
Wi

I.  Itis based on all the observations.

2

[tisrigidly defined.

3. Itlends itself to further algebric treatment.

4. Itisless affected by fluctuations of sampling as compared to other measures of dispersion.
5. ltis extremely useful in correlation.

& Like mean deviation, there is no artificiality in it.

Demerits

i, [Ttisdifficult to compute unlike other measures of dispersion.
Z.  Itisnot simple to understand. |

3 ltgives more weightage to extreme values.
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Uses : The standard deviation is most useful in the case of the normal frequency distribution.
- The majority of measurements arising in biologicat and medical data form a distinct pattern.
5.6 Computétion of Standard Deviation
| The methods of calculating the standard deviation depend upon the nature of data and also on the
number of observations for grouped data.
(a) Standard Deviations for grouped data

Direct method. In case of simple series, the standard deviation can be obtained by the fermula.

—\2 2
, - / d _ .
o= (x x) = Z ,whered =x—X
n n .

and x=value of the varidble or observation.

X =arithmetic mean.
n = total number of observations.
Example 4. Find the standard deviation of 16, 13, 17, 22.
| 16+13+17+22 68

Solution. Here AM.=% = y =—-=17.
Let us prepare the following table in order to calculate the standard deviation.
(x) d=x—f=x—l7 (JC—"55)2
16 -1 1
13 -4 16
17 0 0
22 | 5 25
>di=4

—\2 ’
Nowcﬂ’Z—(—{:—{)— :ﬁ:&z.
n 4

Short-cut Method. This method is applied to calculate the standard deviation, when the mean of

the data comes out to be a fraction. In that cas, it is very difficult and tedious to find the deviations of
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all observations from the mean by the earlier method. The formula used is

|

n n

whered=x- 4, A = assumed mean,

n = total number of observations.

Example 5. Find the standard deviation of the following data :
48, 43, 65, 57, 31, 60, 37, 48, 59, 78.

Solution. Let us prepare the following table in order to calculate the value of S.D.:

Value(x) 7 d=x-A,(A=50) &’
48 | -2 | 4
43 -7 49
65 | 15 225
57 7 49
31 -19 361
60 10 100
37 -13 169
48 -2 4
59 9 81
78 28 784

n=10 D>.d=26 D.d*=1826

' d
nge f=A+—Z.——=SO+Izg-=52.6.

n

- which is a fraction. Let us apply the short-cut formula in order to calculate S.D.

2 2 2
-SD=o< Zi-(zz) _ 1826 zé)
n n 10 - \10)

- =/182.60-6.76 = 175.84 =13 26
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(b) . Standard deviation for grouped data or discrete series.

Direct Method. The standard deviation for the discrete sereis is given by formula
J > f(x-%)
g=
n

where ¥ is A.M., x is the size of the item, and f'is the corresponding frequency in the case of

discrete series. But when the mean has a fractional value, then the following formula is applied to

“calculate S.D.

-

-

where d = x — A, A = assumed mean, n = Y f = total frequency.
(c) Standard deviation in continuous series
Direct Method. The standard deviation in the case of continuous series is obtained by the

following formula :
: —\2
.- JZf(x—x) |
n

where x = mid-value, ¥ =A.M., /= frequency, n = total frequency.

Short Method. The formula for short method to find the standard deviation of continuos series

1s

0=J2fdt(_z_;_dyx,.,

n
x-A - :
where d = T A =Assumed mean,
n = total frequency. i = class width.
Example 6. Find the standard deviation from the following data :
Size of the item : 10 11 512 13 14 15 | 16
Frequency : 217 11 15 10 4 1
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Also find the coefficient of variation. _
Solution. Let us prepare the following table :

Sizeofthe- | Frequency | d=x-4 fd S

items (x) f - 4=13 |
0 | 2 |- =3 6 18
11 7 | -2 —14 28
12 S0 N ~11 o1
13 15 0 0 0
14 10 ro. | 10 10
15 4 2 8 16
16 1|3 | 3 | 9
Total |'n=3 f=50 | XA=-10 | Y fd* =92

Now AM.=% = A+ and =13+ (;.100) =12.8

Here ¥ =12.8 ,is a fraction,

©SDege |20 _(2AY _ 22_(;!_0_)’
n n | 50 50

 =VI84-004=1180=1342.
. Now the coefficient of variation

;

Example 7. Find the standard deviation for the following diStribution D
Marks : 1020 20-30 3040  40-50 5060  60-70  70-80
No.ofStudeht: 5 12 15 - 20 10 - 4 2
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Solution. Let us prepare the foHoWing table in order to calculate the standard deviation :

- Marks No.of | Mid-value | d= x;: > fa R
(ClassInterval) | Students | = (x) |l

10-20 5 15 Z3 | 15 45

20-30 | 12 25 2 | -2 48

30-40 15 35 -1 C-15 15

40 - 50 20 45 o | 0 0

s50-60 | 10 | 55 | 1 10 10

60-70 | 4 65 "2 8 | 16
qo-80 | 2 | 15 | -3 | 18

Toal |3 f=n=68] - T | a0 | T =152

o v 2 [ ‘ 2 / a 3 ) .
LO=ix J—‘d—‘@—-w(z—é{} "=10x \/242;‘—-(-—63894) =14.3 Approx.
n y

n. 68
Example 8 : Calculate the mean, mediah and variance of the fol_lowing data: |
Heightincm.  95-105 - 105-115 115-125  125-135 135-145
No.ofChildren 19 - 23 36 170 25
! Solution. Let us prepare the follwoing data : ) |

Class Mid-value ~ No.of - d= ; fd &
| o x-120 -
~ Inteerval - (x) Children = To
95 =105 . 100 .19 =2 - 38 76
105-115 110 23 -1 -2 23"
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115 - 125 2 36 0 0 0
125135 130 70 ] 1 70 70
135~ 145 140 52 2 104 208

N =200 | 113 377

o .
Now Mean =a+~Z‘X{-xi=120+—%—3x10=.§20+5.65=125.65

Median. The median class is 125 — 135 as N/2 = 100 lies in it.

N/I2-C 100-78

Medz’an=L+-—-—f——~xi=125+ x10

=125+3.14=128.14.

Variance : = ¢° =[Zfd2 —[Zfd) }xiz.
N N

. 2 . .
o’ = 371,(11_3) x100 = (3.77~1.2759)x 100 = 249.31.
100 \100 )

Example 9. In a study to test the effectiveness of a new variety of seeds, an experiment was

peformed with 50 experimental field and the following results of yield per hectare (in quintals) were

obtained.
Yielding No. of fields Yield No. of fields
31-35 2 51-55 16
36 - 40 3 56 ~ 60 5
41 - 45 8 61 - 65 2
46 - 50 12 66170 2
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Find the Mean Devi‘ation from the Mean and Standard Deviation.

Solution. (2) Let us prepare the following table to calculate mean deviation :

Yield Per | No.of | Mid-value fx |d| = fld!
Hectare | fields x |x - 50| |
31 -35 2 33 66 17 34
36 — 40 3 38 (14 12 36
41 - 45 8 43 344 7 56
46 - 50 12 48 576 2 24
51 55 16 53 848 3 48
56 - 60 5 58 290 8 40
61 - 65 63 126 13 26
66-70 | -2 68 136 18 36
n=>50 " fx = 2500 Y fld| =300
Now A.M.:Z—f?‘—=—2-§99=so
S 50
Mean Devigtion = *‘ZI‘J'ﬂ = %%Q: 6.
(b) Calculation of Standard Deviation
Yield Per | No. of | Midvalue | d= X ;53 , fd f&
Hectare fields X
31-35 2 33 -4 -8 32
36 — 40 3 38 -3 -9 | 27
4145 8 43 =2 ~ 16 32
46 - 50 12 48 = ~12 12
51-55 | . 16 53 0 0 0
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56 - 60 5 8. | 1 | 5 5
61-65 | 2 63 2 | - 4 8
66 — 70 2 68 3 6 18 -
n=50 L X fA=30 Y =13 |
. 2 ' 2 : " -
NowSD-zx\/Z‘f—z—i- (Z-f—J =5x‘F34 (5360)

=5x [22 20 s, ,/“ =5x1.5=75..
50 2500
Example 10. Ina study on patxents the followmg data was obtamed Find the standard deviation

ofthedata - ,
Age(gnyrs.) _10—-19 20%29 30-39 ‘40~49 "50-59 60-69 70-79 80-89

Numberofceses 1 . 0 1 1717 38 9 3
Solution. | | |
Age No.of | Midvalue| d= ?—1‘;4.5 - Jfd Ja&
| (in years) cases - x | |
1019 1 145 -3 -3 9
1 20-20 |© 0 |, 245 2 | 0 0
loso=s | | sas | -1 | oy [
CLo40-49 | 10 445 o | o 0
so-59 1 17 | sas | 1| 1 | ar
60-69 | 38 | 645 2 76 152
0-79 | 9 745 3 27 81
80-8 | 3 845 | 4 12 48
vy Y18 R
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SR
Standard Devxatlon

- 10x 308 128)
W79 79 )
| - 10

_10 4332215384 = -2 % 89.15 =11.28.
79 " | 79

: Relative measures of dxspersxon
. The four measures — Range, Quartile Deviation, Mean Deviation and Standard Deviation, are
expressed in the same uiits as the original observations, and are called Absolute measures of variability.
_ So, they can not be used for comparing the variability of two or more distributions ngen in different
units. In order to meet such SItuatlons the Relative measures of vanabllxty have been mtroduccd
| which are mde,pa;ndem of the units of measurement. There are 3 such measures —
. S.D. ‘
Mean

i) Coefficient of Variation =100 x
Quar’tile Deviation

Median

Mean Deviation
Mean or Median

ii) - Coefficient of Quartile Deviation =100x

iii) Coeffient of Mean Deviation =100x

/ Among these, coefficient of variation is the most important and is used in almost all cases.
" The relative measures of variability may also be used to measure the precision of observations,

although given in the same unit.
5.8 - Exercises

1. Findthe gean deviation about median from the following data
46, 79, 26, 85, 39, 65, 99, 29, 56, 72.
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2. Find the mean deviation for .thc following frequency distribution :
Variable : 3 5 7 9 11 13
Frquency : 2 7 10 9 5 1
3. Findthe standard deviation for the distribution given below :
X: 1 2 3 4 5 6 7
| Frequency: 10 20 30 35 14 10 2
4, Cofnputc the arithematic mean, standard deviation and mean deviation about the mean for the

following data :

Sources : 4-5 6-7 8-9 ° 10-11 12--13 14-15 Total
I 4 10 20 15 8 3 60
Answers
1. 204
2. 2.02
3. 14
4. 9.23,2.48,2.03
6. Moments, Skewness & Kurtosis

6.1 Moments : Given n observations X,s X,, ..., X, and an arbitrary constant 4,

¢ .

n Z(l - A) is called the 1st moment about A.

1 2, ' ‘

" Z(Y - A) is called the 2nd moment about 4.

Ry 3.
- Z(x — A) s called the 2nd moment about 4.

and so on. Let us denote these moments successively by m!,m},m}, etc,

Then m) = Z(x—'A)/n=(Zx~ZA)/n=——;1~E~ A=X-A
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i.e. the first moment about a equals (X = 4).

Basically moments are two kinds : One is moments about zero (Raw moments) and another

moments about mean (central moments).

Moments about zero (Raw moments) :

! -
st moment about zero = — X = X

n

1 2
2nd moment about zero= - Z x

1
3rd moment about zero= ” Z x’ and so on.

Note that the 1st moment about zero is the mean ¥.

Moments about mean (Central moments) :

I'st moment about mean = —’;Z(x ~X)=0

] —\2
2nd moment about zero = —(x-X) = o’
n

1 =3
3rd moment about zero = ;(X ~X)" and so on.

These arc usually denoted by m,,m,,m;,, etc.

Note that the 1st central moment about mean is zero and the 2nd central moment is the variance
o®,m, =0and m, = ¢’. The 3rd central moment m; is used to measure skewness and the 4th central
moment m, is used to measure Kurtosis. |

6.2 Skewness:
A frequency distribution is said to be ‘symmetrical’, if the frequencies are symmetrically

distiibuted about mean, i.c., when values of the variable equi distant from mean have equal frequencies.

As for example for symmetrical distribution
x: 10 15 20 25 30
I 3 7 16 7 3
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[n general, however, frequericy disttibutions are not symmetrical, some are slightly agvmmgm’cal
and some othérs may be highly ssyriftiettical. '
As for example for asymmiétrical distribution
x: 5-8 S 9-12 13-16 17-20 21-24
£ 718 23 16 7
The word ‘Skewness™ is used to denote the ‘exterit of of asymmetry’ in the data. When the
frequency distribution is not symiietrical. it is said tobe ‘Skew’. The word ‘skewness’ literally denotes
asymmetry, or ‘lack of symmetry’ and ‘skey’ denotes ‘asymmettical’. A symmetrical distribution has
therefore zero skewness. Skewness may also bé positive ot negative.
Skewness is measured by the following formulae :
(1) Pearson’s first measure —
Mean-Mode
Standarddeviation

-Skewness =

(2) Pearson’s second measure —

3 ( Mean-Median)
Standard deviation

Skewness =

(3) Bowleys’ measure —

(Qs‘Qz)"(Q3“Ql)
(©-2,)+(2-2)

— Q} - 2Qz + Q:
Q} - QI
- where Q,0,,0, denote the first, second and third quartiles.of the distribution

Skewness =

(4) Moment measure : Skewness(y,) = \[BT =
O,

Example. Calculate the coefficient of skewness based on quartiles from the following :
Class interval : 10-15 15-20 20-25 25-30 3046 40-50 50-60 - 697.70 Total

Frequency : 4 12 16 2 10 8 6 4 82
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Solution. In ordef to computer skewness, we have to find first o, Q2 and Q, i.e. values of the

N N 3N
variable correspondmgtocumulatxve ﬁ'equencxes 2’22 rwpecuvely, where N= total frequenCy

' \
N N 3N
Here total ﬁ'equencyN 82 Therefore 7—20 5, -2-_ 41, and 7_61 5.
. Class boundary R " CumulatiVe frequency
L . (less than)
10 R 0
. | N
O | ‘Z—=2_0.5
25 -] 32
QZ | ‘-5':41
30 : ' ‘.'54 |
| : 3N
O : ‘ | 4 61 5
0 | 64
- 50 | . ’ A N _72 o
60 T8
70 o » 82=N

Cuniulaﬁve Frequency Distribution.
~ Applying simple interpolation

9-20_205-16 -
25220 32-16
H=214
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Q,-25 41-32

30-25 54-32

=, =27.045

0,-30 61.5-54

40-30 64-54

=0, =375

Similarly

and similarly

0,-20,+0,

Qs“Qu
_37.5-2x27.045+214
- 37.5-214

_4309 =0.2987

16.1
. Skewness = 0.2987.
6.3 Kaurtosis : Kurtosis refers to the degree of “peakedness” of the frequency curve. Two distributions

may have the same average, dispersion and skewness; yet, in one there may be high concentration of

Now skewness =

values near the mode; showing a sharper peak in the frequency curve than in the other. this characteristic

of the frequency distribution is known as “kurtosis”. The only measure of kurtosis is based on moments, |

viz. Kurtosis (¥,) = % -3=p,~-3.

. - : . N m4
where m, and o denote the fourth central moment and S.D. respectively, and B,= ‘(;T

The following ﬁgﬁres are shown different types of kurtosis.

AN

(a.) Platy kurtic (b) Mesokurtic

(c) Leptokurtic

%
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B, <3, for platykurtic distribution
B, =3, for mesokurtic distribution
B, >3, for lepokurtic distribution
A distribution is said to be “platykuﬁic”, when v, is negative; it is said to be “mesokurtic”, when
v, =0, and “lepokurtic” when 7y, is positive, }
The frequency curve for é platykurtic distribution is relatively flat-topped, and for a leptokurtic |
~ distribution it has a relatively high peak. A mesokurtic distribution is of moderate peakedness. |

6.4 EXERCISE

Ex. 1 Find the first four moments and the valeus of B, and B, from the following frequency distribution:
X 21-24 25-28 29-32  33-36  37-40 41-44
I - 40 90 190 110 50 20

Also, find the measures of skewness and Kurtosis.

Ex. 1 Calculate the measure of skewness based on quartiles and median from the following data:
Variable : 10-20  20-30 3040 40-50 50-60 60-70 70-80
Frequency : 358 2417 976 129 02 18 10

Ex. 3 Calculate the coefficient of skewness based on quartiles :

Class limitsb: 10-19 2029 30-39 40—49 50-59 60-69 70-79 80-89
Frequency : 5 9 14 20 25 15 8 4

- Answers
1. Mean =313, m =23.04, m,=26.11, m, = 1496.68
B, =.056,B, = 2.82, Skewness(y, ) = 0.24, Kurtosis(y,) = —.18, —0.18
2. 0.13 (quartiles, 22.63, 26.73, 32.07)
3. - -0.103 (quartiles 37.36, 50.30, 60.83) ,
| 7. Unit Summary : In this module, we have discussed the various types of measures of Central

Tendency, the various types of measures of dispersion and various moments, skewness and kurtosis. -
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We have also discussed the merits and demerits of various types of measures of Central Tendency.
and the various types of measures of dispersion. We have solved lot of problems on the discussion
topic in this module also. 4 |

8. Reference/ Suggested Further Readings :

I.. N.G Das, Statistical Methods, Vol. I & II, Das & Das Publishers, Calcutta.

2. PN.Arora&PK. Malhan, Bio Statxstxcs. Himalaya Publishing House, Delhi, 1996.

3. LA.Khan & A. Khanim, Fundamentals of Bio Statistics, Ukaaz Pubhcatzons, Andhra Pradesh,

1994, .
4. S.C.Gupta & Kappor, Fundamentals of Mathematical Statistics, Meerut, 2002.
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1. Introduction

2..  Objectives

3. .Keywords

4.  Probability

4.1  Some Important terms and concepts
4.2  Definition of Probability

“4.3  Theorems of Probability |

44 Theorem on Compound Probability
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6.6

6.7

6.8

1.

In probablhty, we have discussed some unportant dxstnbutxons, such as Binomial distribution, Poisson

Properties of Correlation Coefficient
Regression |

Properties of Regressxon Coefficxent
Exercises '

Chi-Square Test

Degrees of Freedom

Chi-Square Distribution

Properties of y2-distribution
. Uses of y? Test _
Conditions for using the chi-square test -

y2-Test

y2-test for goodness of fit

Exercises ‘ .

Unit Summary

References/Suggested Further Readmgs

Module 19(b): Biostatistics

Introduction : This module contains three sections, in which first section deals with probability.

distribution and Normal distribution. In second section deals with correlation and regression analysis.
We have also discussed the properties of correlation and regression coefficient. The last section -

describes the chi-square test and its application on biostatistics.
' Objectxves To study this module, the reader will' leam the followmg topxcs

2.
| (@) Probabxllty and some important dxstnbutxons
. (b) Correlation and regression analys1s A
(¢) Chi-square test and y2-test for goodness of fit. -
3.
Chi-square Test.

Keywords Probabnhty, Binomial, Poisson and Noxmal distribution, Correlation, Regressxon,
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4, Pmbablhty
Probabxhty theory was originated from gambhng theory. A large number of problems exist

even today which are based on the game of chance, such as coin tossing, die throwing and playing
cards. The utility of probability in business and economics is most emphatically revealéd in the field
of predictions for future. We have to axiticipat,e, consequences of the each of these plans and finally
we compare the results. Uncertainly plays an important role in business and probability is a concept
which measures the degrée of uncertainly and that of certainly also as a corollary. The probability
| when defined in the simplest way is chance of occurrence of a certain’ event when expressed
| guantitatively. The probability is defined in two different wéys : | |
(i) Mathematical (or a priori) definition
(ii) Statlstzcal (or empmcal) definition
Before we study the probability theory in detaﬂ it is appropnate to give the deﬁnmons of
certain terms, which are éssential for the study of Probabzlzty theory. '
41 SomeImportant Terms and Concepts
1. Random Expenment or Trial. An experiment is characterlzcd by the property that its
observations under a given set of circumstances do not always lead to the same ol_)scrved outcome but
rather to different outcomes which follb'w a sort of statistical regularity. It is also called a Trial. For
example tossing a coin, or throwing a die. - " '
2. Sample Spacé. Asetof all p‘ossible outcomes from an'experiment is called a Sampl‘e Space.
Let us toss a coin. The result is eitherhead or tail, Let 1 denote head and 0 denote tail, Mark the
pomt 0, 1 onastraight line. Thus we get two different} pomts Oand1ona strmght line. These points are
called sample pomts or event points. For a given experiment there are different possible outcomes
and hence different sample points. The collection of all such sample points is called a Sample Space.
" . Toss two coins simultaneously, then the possible resul;s are four pairs (0, 0), (1, 0), (0, 1), (1,1), and
they can be reprgsented as points in coordinate plane. These points constitute a sample space of four
~ sample points. Sﬁiiii‘larly, by tossiﬁg‘th'ree coins simultaneously we get eight points which can be
denoted by the triplets (0, 0, 0), (0, 1, 0), (0,0, 1), (1,0,0), (1, 1,0), (0, 1, 1), (1,0, 1), (1, 1, 1). These
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8 points form a sample space of 3 dimension. In general, in tossing 7 coins simultaneously we can
have an n-dimensional sample space consisting 6f 2" sample points.

3. Discrete Sample Space. A sample space whose elements are finite or infinite but countable s
called a discrete sample space. For example, if we toss a coin as many times as we require for -
turning up one head then the sequence ofpomtsS (l), S, = (O 1), S (1 0,1),S, (O 0,0, 1) etc.,

is a discrete sample space. ‘ :
4. Contmuous Sample Space. A sample space whose elements are mﬁmte and uncountable or -

assume all the values onareal lineR oronan interval of R is called continuous sample space. In this
case the sample points build upa ‘continuum, and the sample space is said to the continuous. For
examplc all the points on a line or all points on a plane is a sample space. '
5. Event. Asub-collection ofa number of sample points under the definite rule or law is called an
event. For example, let us take a die. Let its faces 1,2, 3,4, 5, 6 be represented byE,E,E,E,E,E,
respectxvely Then all the E’s are sample points. Let E be the event of getting an even number on the
die. Obvxously E= (E E,, E)) which is a subset of the set {E,, E,E,E,E,E}. -
~6. NullEvent. An event havmg no sample point is called a null event and is denoted by ¢.
7. Simple Event. An event conmstmg of only one sample point ofa sample space is called a
sample event. o , , o |
Forexample, let a die be rolled once, and 4 be the event that face number 5 is turned up, then 4
is a simple event. A _ : R S
8. - Compound Events. When an event is decomposable into a number of simple event then 1t is
‘called a compound event, .

- For example, the sum of the two numbers shown by the upper faces of the two dlce isseven in
the simultaneous throw of the two unbiased dice, is a compound event asit can be decomposable
9, Exhaustive Cases or Event, It is the total number of all the possible outcomes of an‘experiment.
For example when we throw a die then any one of the six faces (1, 2, 3, 4, 5, 6) may turn up and,
therefore, there are six possible outcomes Hence, there are six exhaustive cases or events in throwing

adie.
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10. Moutually Exclusive Events. If in an experiment the occurrence of an event precludes or
prevents or rules out the happening of all other events in the same experiment then these events are
said to be mutually exclusive events. For example, in tossing a coin, the events head and tail are
mutually exclusive, because if the outcome is-head, then thé possibility of getting a tail in the same
trial is ruled out. |

11.  Equally likely. Events are said to be equally likely if there is no reason to expect any one in
preference to other. For example, in throwing a die, all the six faces (l 2,3, 4. 3, 6) are equally likely
to occur.

12. _,Collectively Exhaustive Events. The total number of events in a population exhausts the
population. So they are known as collectively exhaustive events.

13.  Equally Probable Events. Itin an experiment all possible outcomes have an equal chances of .
occurrence, then such events are said to be equally probable. For example, i in throwing a coin, the
events head and tail have equal chances of occurrence, therefore they are equally probable events.
14.  Favourable Cases. The cases which ensure the oceurrences of an event are said to be favourable |
to the events.

15. Independentand Dependent Event. When the experiments are conducted in such a way that
the occurrences of an events in one trial does not have any effect on the occurrence of this or other
events at a subsequent experiment, then the events are said to be independent. In other words, two or
more events are said to be independent if the happening of any one does not depend on the happening
of the other. Events which are not independent are called dependent events.

THustration. If we draw a card in a pack of well shuffled cards and again draw a card from the
rest of pack of cards (containing 51 cards), then the second draw is dependent on the first. But lf on
the other hand, we draw a second card from the pack by replacmg the first card drawn, the second draw
is known as independent of the first.

4.2 Definition of Probability
Classical definition of Probability. If an experiment has mumally exclusive, cqually likely

and exhaustive cases, out of which m are favourable to the happening of the event 4, then the probability
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of the happening of 4 is denoted by P (4) and is defined as

No.of cases favourable to A
Total ( Exhaustive)ynumber of cases

Example 1. What is the probability of getting an even number in a single throw with a die?
Solution. The possible cases in the throw of a die are six, viz., 1, 2, 3, 4. 5, 6.

Favourable cases are those which are marked with 2, 4, 6 and these are three in number.
- ) 3
. Probability of getting an even number = = =

Notés 1. Probability of an event which is certain to occur is 1 and the probability of an impossible
event is zero. : -~

2. The possibility of occurrence of any event lies between 0 and 1, both igclusive. E

Example 2. What is the probability of getting tail in a throu:' of a coin?

Solution. When we toss a coin, there are two possible outcomes viz., Head or Tail. In this case

the number of possible cases n =2.

No. of favourable cases = m = 1.

(" The outcome of'tail is a favourable event)

om 1
. Probability of getting a tail = -; = 5

Example 3. 4 bag contains 6 white balls, 9 black balls. What is the probability of drawing
a black ball?

Solution. The total number of equally likely and exhaustive cases
=n=6+9=15. |
Number of favourable cases = m =9.
(" Number of black balls = 9)

- 9 3
Probability of drawing a black ball = s = 5

Example 4. What is the probability that if a card is drawn at random from an ordinary pack

of cards, it is (i) ared card, (if) a club, (iii) one of the court cards (Jack of Queen or King).
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~ Solution. No. of exhaustive cases = 52.
(i) There are 26 red cards and 26 black cards in an ordinary pack.

Favourable cases = n = 26 (number of red cards).

Probability of getting a red card = —z—g— = —;—
(#f) Number of clubs in a pack = 13.
Favourable cases = 13
- Probability of getting a club = B_1.
: 52 4

(iif) There are 4x3=12 court cards in a pack of cards.
Number of favourable cases =m = 12.
Number of exhaustive cases =n = 52.

13 1
Probability of getting a court card = 5 = rh

" Example 5. What is the probability that a leap year, seIécted at random, will have 53
Sundays?
Solution, There are 366 days in a leap year and it has 52 complcte weeks and 2 days over.
These two extra days can occur in fbllowing bossible ways. |
(1) Sundéy and Monday;
(ii) Monday and Tuesday,
(iii) Tuesday and Wednesday;
(iv) Wednesday and Thursday;
(v) Thursday and Friday;
(vi)Friday and Saturday;
(vii) Saturday and Sunday.
.. No. of exhaustive cases = 7.
No. of favourable cases = 2.

{*. There are two cases which have Sunday [(i} and (vi1)}}
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2
.. Probability = :7-
Exam ple 6. 4 card is drawn from an ordihary pack of playing cards and a person bets that

it is a spade or an ace. What are the odds against his winning this bet?

Solution: In a pack of 52 cards, [ card can be drawn in 52 ways. Since there are 13 spades and
3 aces (one ace is also present in spade), therefore, the favourable cases = m = 13 +3 = 16.
. No. of exhaustive cases =n =152, |
16 4 4

Probability of getting a spade or an ace = 213 = FYWE

-~ Odds against winning the bet are 9 to 4. A
Statistical or Empirical definition. Von Mises has given the following statistical or empirical
definition of probability. |
-If the experiment be repeated a large number of times, under essentially identical couditions,
the limiting value of the ratio of the numBer of times the event 4 happens to the total number of trials
of the experiment as the number of trials increases indefinitely is called the probability of heppen i’ng‘

ofthe event 4.” . _
Symbolically. Let P(4) denote the probability of the occurrence of A. Let m be the number of

times in which an event 4 occurs in a series on n trials, then

P(4)=1limZ,

n-»x n

Provided the limit is finite and unique.
4.3 Theorems of Probability
- There are two important theorems probability, namely
l. The Addition theorem, or the theorem on Total Prbbability.
2. The Mpltiplication theorem or theorem on Compound Probability.
Additional theorem of the theorem on Total Probability
Statement. If the events are mutually exclush;e, then the Probability of happening of ariy

one of them is egual to the sum of the probabilities of the happening of the separate events, i, in
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other words if E . E, E,, ... E, be n events and P(E,), P(E). ... P(E,). be their respective
probabilities. then . ' |
P(E,+E, + E, +..+E,) = P(E,)+ P(E,) + P(E,).
Example 7. A die is rolled. What is the probability that a number 1 or 6 may appear on the

upper face?

1
Solution. The probability of appearing the number 1 on the upper face = 5

Q| e
| e

_ 1
~. The probability 1 or 6 may appear on the face = 6 +
1
Example 8. If the probability of the horse A winning the race is 3 and the probability of the

A { :
horse B winning the same race is i what is the probability that one of the horses will win the

race?
1 .
Solution. Probability of the winning of the horse A= 5 Probability of the winning of the

1
B=-—.
horseﬂ p

1 11
- P(A+B)= P(A)+P(B)-§ =3

Multiplicative theorem or Theorem on Compund Probability

Before we proceed further in stating and proving this theorem, we require the following ‘
definitons;

Simple and compound events. A single event is called a simple event, whcreas when two or
more then two simple events occur in connections with each other, then their simultaneous occurrences
is called a compound event. If 4 and B are two simple events, the sxmultaneous occurrence 4 and B is
called a compound event and is denoted by AB. '

Conditional Probability. The probability of the happending of an event 4, when itis known
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that B has already happened, is called the condmonal probability of 4 and is denoted by P(A/B),
| ie., P( A/B) = conditional probabxhty of 4 given that B has already occurred.
- Similarly, P (B/ A ) = conditional probability of B given that 4 has already happened.
Mutually indepelldent Events. An event A4 is said to be independent of the event B if
P(4/B)=P(4), ie.,the probabxhty ofthe happemng ofAis mdependent of the happemng of B.
4. 4 Theorem on Compound Probabxhty o :
| Theorem on Compound Px‘obabllity The probability of the simultaneous occurrence of .
the two events A and B is equaI to the probability of one of the events multtplted by the conditional
probability of other, given the occurrence ‘of the first, i.e.,
P(AB)= P(A)-P(B/4)=P(B)-P(4/B) |
Example9. 4 card is drawn ﬁom a pack of 52 cards and then a second is drawn. What is the
probability that both the cards drawn are queen? o
Solution. First draw. Probability ef getting aqueen = ?5% = ilg
Second draw. After drawing the first queen, we are left with 51 cards having 3 queens.

-3 1
Probabxllty of gettmg a queen in second draw = -5—1~ = 7

’ . 1 1 1
Probability that both the cards are queen = B *17 =51
Example 10. 4 bag contams b} whzte and 3 black balls. Two balls are drawn at random one
’ aﬁer the other without replacemem Find the probability that both the balls drawn are black. |
~ Solution. Let P(4), P(B/A) denote the probability of drawmg a black ballin the first and second

-

attempt respectlvely
. Probability of drawmg a black ball in the first attempt is P(A)

Favourable cases . 3. 3 .'
T otal exhaistive cases, * 5+3 8

where P(4)=
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Probability of drawing the second black ball given the first ball drawn is black is

Favourable cases =~ _ 2 _2_
Total exhaustive cases 5+2 1

P(B/ A)=

Probability that both the balls drawn are black is
32 3

P(AB)=P(A4)P(B/d)=3x% =50

Additional theorem for compatible events
Theorem. The probability of the occurrence of at least one of the events 4 and B is given by
P(4+B)=P(A)+P(B)-P(4B).
Happening of at least one Event
Let A and Btwo mdependent events and p, and p, be the probabllltxes of their happening, then
~ the chance that both 4 and B happenis p, x p,. Also the probabilities of not happening of 4 and Bare
1 -p,, | -p, respectively. The probability that both do not happen is (1~ p,)x(1- p,)-
Now the chance that at least one of them habpens :
pp,+ (1= p)+ p(1-p) =1-(1-p)(1- )
Thus the above result can be genemlised forneventsE,E,, ... E| w1th Py Py - p respective
probabilities. Then the probability that at least one of them happens is
1-(1-p) (1= p2)--(1- P.)
Example 11. 4 coins are tossed Find the probability that at least one head turns up.
Solution. Probability of getting a head in a toss of a coin = 1/2.
Probability of gétting a tail in each case = 1/2.

1

T s

1 1 1 1
= X X — X =
Probability of getting a tail in all the four cases 2 57272716

- o115
- Probability of getting at least one head =1- -l-g = 16‘

Example 12. In a throw of 3 dice, find the probability that at least one die shows up l.
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1
Solution. p = Probablhty of gettmg 1 in a throw of a die = =5

15
:1—- :1——-:'—.‘
TP

Probability of getting at ‘least one die shows up
=1-¢’=1- -5-) 2L
6) 216 A
Ex_ample 13. Aproblem in Mathematics is given to three students Dayanand, Ramesh, Naresh

whose chances of solving it are — -respectively. What is the probability that the problem will

11
2’3’4
be solved?

111
Solution. The probablhtles of Dayanand, Ramesh and Naresh solvmg the problem are :2- 3%

respectively.

The probabilities of Dayanahd, Ramesh, Naresh not solving the problem are

1~~!—= 1_...];——_2_1_1 3 t l
2 T3y 4respecxvey
' o . | 102 3 1
-. The probability that the problem is not solved by any of them is = —2- X -3- X Z = Z ‘
- : o : 1 .3
~ The probability that the problem will be solved by at least one of them'1— Y

Example 14. A card is drawn at random from a well shuﬁled pack of 52 cards. Find the
probability of getting a two of heart of diamond.

Solution. Since there is only one two of hearts and only.one two of diamonds, therefore, the

‘ e o 1 1
probability of getting a two.of hearts = — and the probability of gettmg atwo of dlamonds =

52 5
Since these are mutually exclusive cases, therefore, the probability of getting a two of heart or
atwo ofd nonds = s Lo 2o L
O amons = o T2 52 " 26
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Example 15. A man and his wife appear for an interview for two posts. The probability of

1 1
the husband 5 selectzon is 7 and that of the w;fe 5 selection is 3 What is the probability that only

one of them wzll be selected ?

.~ Solution. The probability that husband is not selected = 1 — -;— = —:—
g 1_4
- The probabxllty,that 'wxfe is not“sclccted =1- 573
1 4 4
Probabllxty that only husband is selected = :/' 5735
Probabili th l' if -' 1 td“lxg“i
robability atonyW1 eis selected =77 35
-4 6 10 2

o Probabxhty that only one of them is selected 3-5— 3—5 = —3-5- =

.Example 16. 4 speaks truth in75% and B in 80% of the cases. In what percentage of cases

are they likely to contradzct each other narratmg the same incident?

Solution. Let P(4), P(B) be the probablhty of 4 and B speaking the truths, then

~v
—
N}
\_/
"o
~~
'
8,
o
Q
-
Q'
v
"u
o~
m
\_/
p—a
|
[
i

P( ) P(Btellsalze) 1- P(B) -2 =

Now P(4 and B will contradict) = P(A)P(B) + P(B)P( )

Example 17. Kamal and Monica appeared for an interview for two vacancies. The_

1 4
provability of Kamal's selection is 3 and that of Monica’s selection is 3 Find the probability
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that only one of them will be selected. _
A. Solution. Let p, and p, be the probabilities of Ka’mal and Monica selection.

mheap=tad g =
| en Py | 3§n q 3’
...l' d —-i :
b, 5an_ q, 5
Now the required probability is gi\}_czn by p4g,+qp,
| 1.4 21
=X =X
3535
_4.2_6_2
= 3

4. 5 Some Important Theoretical Distributions
The distributions which are based on actual data of expemnent are called observed frequency

distribuiton, Ttis sometlmes poss1ble, by assummg acertain hypothesis to derive under mathematically
- the frequency distribution of a cettain population. Such dxstrlbutlons are known as theorétical
distributions. In other words, a theoretical distribution is the frequenqy distributio_n of certair_x events
in which frequencies are obtained by mathematical cofnputa_tions.' Some of the ini_portant theoretical
distributions are : , |

1. Binomial distribution. i

2. Poisson distribution.’

3. Normal dlstrxbutlon

There are two types of theoretlcal dlstrlbutlon

(i) Discrete distribition.

(i1) Continuous distribution. - ‘_

~ Bionomial and Poisson distributions are known as discrete distribution. Normal distributions

is an example of a continuous distribution. | |

4. 6 Binomial distribution : S
' Bmom1a1 distribution is a probability which is obtained whcn the probability p of the happenm g
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of an event in same in all the trials, and there are only two events in each trial.

For example, the probability of getting a head, when a coin in tossed a number of times, must

remain same in each trial, i.e., 5

Let an experiment consisting of  trials be performed and let the occurrence of an event inany
trial be called a success and its non occurrence of failure. Lefp be the probability of success and g be
the probability of the failure in a single trial, whereyg = 1-p, so thatp + g = 1.

Let us assume that the trials are independent and the probability of success is same in each
trial. Let us claim that we have n trials, then the probability of happening of an event  times and failing
(n —r) times inAany specified order is p'¢""". But the total number of ways in which the event can

happen r times exactly in # trials in 72, . These n. ways are equally likely, mutually exclusive and

- exhaustive.
Therefore, the probability 7 successes and (n - r) failures in n trials in any order, whatsoever is

n p’q"”. Itcan also be expressed in the form
p(r)=n_p'q"",r=0,12,.,n
where p (r) is the probability distribution of the number of successes. Giving differerit values
to r, i.e., putting'r = 0, 1, 2, ... n. We get the corresponding probabilities
n.q", n.pq -, n, Pq" n. p", which are the different terms in the Binomial expansion of (g+p)’.
Asa résult of it, the distribution p(r) =n_p'q"" is called Binomial Probability distribution.

The two independent constants, viz., 7 and p in the distribution are called the parameters of distribution.
Again if the experiment (each consisting 7 trials) be repeated N times, the frequent function of

the Bionomial distribution is givenby -
f(r)=Np(r)=Nn_p'q"",r=0,2,..n
where p ~2"q = |, which is also called the Binomial frequency distribution.

Mean and Variance of Binomial distribution :
The probability distribution of Binomial distribution for r success in » trials is given by
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p(r)=n_p'q""

Its mean = np and variance o? = npq.

Ex. 1 A dic is thrown three times. Getting a “3’ or a ‘6" is considered a success. Find the
probability of at least two successes.

Solution. Let p(x) be the probability of getting the number x in a toss of a dice. Then

Now p(r) = n;’ P'q" .Heren=3,

2Y? (1Y 2
.‘-P2=3 — — = —,
@=(5) (5) -3

2Y7 (1Y _ 1

PB3)=3 2] [2] =—.
©0=(5) (5] -5

2 1 7
P (at least 2 successes) = P(2)+P(3) =

Ex. 2 There are 64 beds in a garden and 3 seeds of a particular type of flower are down in cach

. -1 ' .
bed. The probability of a flower being white is 1 Find the number of beds with 3, 2, 1 and 0 white
flowers. _

' 1
Solution. The probability p of a white flower =

—

a

Here n=3, N =64,
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o ()

- Number of beds with zero white flower NAQ)

"

| . by o3
Beds with 1 white flower =64 /(1) =64 3, (%) (%} =27

| ‘ 2 3~2
1Y(3

Beds with 2 white flowers = 64/ (2) = 64 3 N (Z) (2) =9

Beds with 3 white flowers = 64 f(3) =64 3, (

-
N
e
)

Ex. 3 If the probability of a defective bolt is 0.1, find the mean and standard deviation for the
distribution of defective bolt in a total of 500.

Solution. Let (g+p)".q+ p =1, be the Binomial distribution.

Here we are given that p = 0.1, n = 500,

| Mean = np =500 x 0.1 = 50

Nowp=0.1,g=1-p=1-0.1=0.9

Variance = npg =500 % 0.9 x 0.1 =45

Standard devxatxon =45 =6.7
4.7 The Poisson Distribution :

Poisson distribution is the distribution of a random variable taking values 0, 1, 2, ... and 1s
useful in a wide variety of applications dealing with counts. However, not all variables arising from

counting applicatoins follow this distribution.

The probability distriution of a random variable x is said to have a Poisson distribution if it

takes only non-negative values and if its distribution is given by

68 . Directorate of Distance Education



Module 19(b): Biostatisﬁcs

~H, X

€E o x=012.
x! :

P(X?x)¥

where x is the parameter. 7 _
Te quantity e in the formula above is a constant with value approximately equal to 2.71828.
The mean and variance of Poisson distribution are equal and is equal to .

. Ex.4. Suppose a bogk of 585 pages contains 43 fy;iographical errors. If these errors are randomly
distributed throughout the book. What is the probability that 10 pages, selected atrandom, will be free
from errros ? -

[Use_ e = O.4795]

Solution. Here =10, p =" = 0.0735, mean = np = 0735
Thus Poxsson dxstnbutlon is glven by |
- -o 735
P(x) _€ ‘.1 (O 735)
x!
-0735 0 735
Probabxhty of zero enspr = P(0) = (0' )

=0. 4795 , . . .
Ex. 5. The mortalnty rate for a certain disease is 7 in 1000. What is the probablhty for Just 2

deaths on account of this disease in a group of 400? (Cnven e ”. =0. 06)

7
Solutlon. Here p = m and n= 400

. ) 7 N . R
S H=np =400 =2.8
HE =t Y000 =%
Now the required probability is given by

2
s (2.8

- 2 ) ’
P()=ber cen Sl Sz,
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4.8  Normal Distribution : Normal distribution is a continuous distribution. Normal distribution
is also a limiting form of the Binomial distribution under the following conditions :
(i) n, the number of trials is indefinitely large, i.e., in other words, 7 — oo.
(i) neither p nor g is very small.
The probability function of the normal distribution with mean at the origin is given by

. xz

Yy
e ¥ —w<x<m,

P =y=
(x)y o227

where ¢ is the standard deviation.

The probability function of a normal distribution with mean m is given by

(x-m)’
e ¥ —o<x<m,

P(x)=

oV2n
Properties of Normal Curve :

The normal probability curve with mean m and standard deviation o has the following properties:

_tz=m)

¢ * ,—o<x <o, anditis bell shaped. |

1. The equation of the curve is y =
. ovVn

The curve is symmetrical about the line x = m and x ranges from —oc 0 oo,

2

3. Mean, Median and Mode are coincide at x = m. |

4. Itcan be shown that it has Arithmatic mean = m and variance — 2.

5. The total area under the normal curve is equal to unity and the if is shown in the following

figures.

i1 14% 34% | 34% | 14% S

-0  m2c mc x=m mo m-2G
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4.9 EXERCISES

123

L. The probability of 4, B, C solving a problem are 3. 3 respectwcly If all the three try to

solve the problem simultaneously, find the probability that exactly one of them will solvc it.

2. A bag contains 4 white balls and 2 black balls. Another contains 3 white balls and 5 black balls. |
Ifone ball is drawn from from each bag, find the probability that (i) both are white (fi) both are black
(iii) One is white and one is black.

3. Fournumbers are selected at random. Show that the probability that the last digit in the product

of these four numbers will be 1,3,70r9is -6—156—5-

11 1
4. The probability of hitting a target by three men are 3’3 and 7 respectively: Find the probability

that one and only one of them will hit the target when they fire simultaneously.

Answer
LB
' 56
13
2 24
. b
) 24

S. Correlation
Before we study the correlation analysis we introduce the concept of “covariance” between
two quantitative variables x and y. Let the corresponding values of the two variablés x and y on the
ngen set of n units of observations be given by the ordered pairs (x, y,), (x,, y,), (xl, V3) e (X p)-
Thus the covanance between x and y is denoted by cov (x, y). It is defined as

Con(sy) = TRV A+ 5)(0s 5]t (5= %))
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=*Z(x —x)(y, y)

1=l

where X and y are the means of x andy respectively.

Lo ¥ =l X+t X, 5= N+ Yy toty,
o n _ n
5.1 Correlation and Coefficient of Correlation :

* Correlation : Correlation may be defined as a iendehcy towards interrelation vatiatjon and
the coefficient of correlation is a measure of such a tendency, i.e., the degree to which the two
variables are interrelated is measured by a coefficient which is called the coefficient of correlation.
If gives the degree of correlation. | |

Definition : The relationship between two variables such thata change in one variable results
i a positive or negatlve change in the other and also a greater change in one variable results in
corresponding greater or smaller change i in the other variable in known as “correlation”. The coeﬂ”xuent
of correlation between the two variables x, y is generally denoted by rorr ore (x,y)ore and is

defined as

os Cov(x,y) _ ;I;Z(xi -%)(»,-7)
c,0, 0.0,
5.2 Properties of Correlation Coefficient :
1. Itis ameasure of the closeness of a fitin a relative sense. -
/ 2. Correlation coefficient lies between —1 and +1,i.e. 1<r < 2.

3. The cOrrélation is perfect and positive if 7= 1 and it is perfect and negative ifr=—1

4, Ifr= O then there isno correlatlon between the two variables and thus the variables are
said to be mdependent

Ex. 1. Calculate the correlation coefficient from the following data

Zx, 280, Zy, 60, Zx, 2384, Zy, =117, Zx y, =438

i=l i=l i=] . i=l i=l
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Solution. Correlation coefficient 7 =

Here

Cov(x, y)
0,0,

2 2_(_2_{J2=23§§_(280J oy

' n 100 100

. y
H =%¥~-(Z—y.‘ _i".-( 60) =081

100 100

-

Cov(x, ),_Z_{J’__(Zﬂ(zy] 438_280 60 .

_n JUn ) 100 100 100

Subsituting these values,

2.7

r = —m———= (.75,
, \/16x0.81

Ex. 2. Find the coefficient of correlation from the following data.

x:

65 = 63 . 67 64 - 68 62 70 - 66

y.

68. 66 68 - 65 - 69 66 68 65

Solution. Since the correlation coefﬁment is unaffected by change of origin (and also scale)
letus change the origins of x and ¥1t0 65 and 67 respectlvely ie:, writtx=X-65,y=Y-67.

Table for Calculatxons for Correlatlon Coefficient

x

y X=x-65| y=y-67 S ox B xy. -
65 68 | 0 1 0 1 0
63 66 | -2 -1 4 1 2
67 68 +2 1 4 1 2
64 | 65 -1 - -2 L 4 2
68 69 3 | 2 9 4 6
62 66 -3 -1 9 1 3
70 68 5 1 25 1 5
66 6s | 1 | -2 I 4 2
525 535 5 -1 53 17 18
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N 2(2)322
oW | . 3 8 Y

, 17 1)’ 135
g =] - e —
vy g 8 64

8 (5 1 149
s =5 (3 2) o

Cov(x,y)
O'XO');

.. Correlation coefficient 7 =

149
64 0.64.

N
.64 64

5.3 Regression : We know that the cofrelation studies the relationship between two variables x
and y. In this section we shall consider the related p}‘oblem of prediction “estimation” of the value of
variable from a known value of variable from a known value of variable to which it is rela;ed. This
would be discussed by means of regression lines.

Regression shows a relationship between the average values of two variables. Thus regression
is very helpful in estimating and predicating the average value of one variable for a given value of the
other variable. The estimate or prediction may be made with the help of regression line which shows
the average value of one variable x for a given value of the other variable y. The best average value of
one variable associated with the given value of the other variable may also be estimated or predicated
by means of an equation and the equatibn is known as a Regression equation.

The two lines of regression are

1. Regression equation of x ony is

. O, 5
x-% =r~(—;—-(y-y)‘

y

[If estimates x for a given value of y].
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2. Regression equation of y on x is.

[It estimates y for a given value of x].
where x = value of'x, y = value of y
| ' ¥ =Mean of x series
.5?‘ = Meeifx of ¥y senes
‘o, =Standard deviation of x
o, = Standard deviation of y
r = Correlation coefficient between x & y.

Itis unportant to note that the regression equation of x on y should be used for predictings or
timing the value of x for a given value of y and the regwssxon equation of y on x should be used for
predicting or estimating the value of y for a given value of x.

Regression Coefficients : . | | -

e . .o, . O
The regression coefficient of y on x is byx =r—* and that of x on y is b, =r—*

Q

5.4 Properties oi" Regression Coefﬁciexifs :
1) The coefficients of correlation is the geometric mean of the coefficients of regression.
e, r= b, xb,. | R |
i ‘2) It one of the regression coefficients is greater than unity, theh the other is less than unity.
3) Arithmatic mean of the regression coefficient is greater than the correlation cdéﬂiciem..
4) Regression coefficient are independent of change of origin but not of Scale
Ex. 3. From the data given below estimate the mosthkely height of a father son’s height is 65"
Father’s : Mean height is 67'anda.$.D.0f3.5"
Son’s ; Megn hexght is 65" anda S.D. of 2.5"

" The coefficient of correlation between the heights of fathers and sons is + 0.8,
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Estimate the height of father when height of son is 70".

Solution. Let x and y be the variables corfesponding to the heights of sons and fathers.

. Then X =65,y =67,0,=25,06,=35r, =08

S, _(08)3.5) _ |5

. The equation of line of regression of y on x is
y=y=b,(x-%)
= y~67-1.12(x-65)
=t =1.12x-5.8.....(1)

Height of a father whosé son’s height is 70 is = estimate of y for x=70. |

Putting x = 70 in (1), we get

y=112x70~5.8=72.6".
Ex. 4. Given the following results of the height and weight of 1,000 students :
5 =68 inchs, ¥ =150 Ibs, »=0.60, 6, =2.50 inchs,

o, =10 1bs. Amit weights 100 Ibs. Sumit is 5 feet tall. Estimate the height of Amit from his

weight and the weight of Sumit from his height.

76

Solution. Here Height = y, weight =x, 7 = 68 inchs
"% =1501bs, o, =2.50 inchs, 6, = 10 1bs, r=0.60

(1) the regression equation of y on x is

y-y=r—2(x-x)

Gx
::>y~68=0.60x21'30(x—~150)
= y=0.15x+63.

When Amit’s weight x = 100 Ibs, his height
y=0.15x100+53=15+53 =68 inchs.

Directorate of Distance Education
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.. Required height of Amit = 68 inchs
(2) The regression equation of x on y is

= _ O =
x-—x—ro (y y)

y

= x-150=0. 60x—-———(y 68)

> x=24y-132.

When Sumit’s height y = 5 feet = 60 inches.
Then His weight x =2.4 X 60 — 13.2 =130.8 Ibs.

- Required weight of Sumit = 130.8 Ibs.
- Ex. 5. Find the regression of x on y from the following data :

Sx=24,Y =44, xy =306, x* =164, )* = 574,n = 4.

Find the value of x, when y =6.

T

Solution. Here X=HH—=—=6.

n 4
y=sd 2

c,
‘Regression coefficient (bx}) =r- ;‘

ROXEDRIN,
Xy -(Ty)
" 4x306-24x44
" exsTa- ()
= (0.47
The r'egressidn equation of x on y is

. M.
x-—x-—r(r (y-7)

y
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= x-6=047(y-11)

= x-6=047y-5.17

= x=0.47y +0.83.

when y =6, x=0.47 X 6 + 0.83 = 3.65

.. Requried value of x=3.65.

| 5.5 Exercises

Ex.1. Find the linesiof regression x on y and y on x for the following data :
X: 3 5 6 6 9
y: 2 3 4 _ 6 5 ,
Ex. 2. For 10 observations on price (x) and supply (y), the following data were obtained.

Y x=130,Y y =220, x = 2288, y* = 5506, Y xy = 3467

Obtain the iine of regression of y on x and estimate the supply when the price is 16 units

. Ex. 3. The following data give the correlation coefficients, means and standard deviation of rainfall

and yield of paddy in a certain tract :

Yield per acre * Annual rainfall

- (in Ibs)
Mean ' 973.5 18.3
SD. : 38.4 . 20

Coefﬁcient of correlation = 0.58
_ Estimate the most likely yield of paddy when the annual rainfall is 22”, other factors being

assumed to remain the same.

Ex. 4. Obtain the correlation coefficient from the follbwing results.

X 6 2 10 4 8
yi 9 115 8 7

Answers
. y=06x+04,x=12y+120 "
2. y=88+1.05x,25.04.
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3. 10147

-0.92
6.  Chi-square test '

The chi-square test, written as \yz' ~test, is a useful measure of comparing experhﬁentally obtained
results with those expected theoretically and based on the hypothesis. It is used as a test statistic in
testing a hypothesis that provides a set of theoretical frequencies with which observed
frequencies are cdmpared. In general‘ Chi-square te_ét is applied to those problems in which we
study whether the ﬁetluency with which a given event has occurred, is sigﬁiﬁcantly different from the
one as expected theoretically, The measure of Chl-square enables us to find out the degree of
discrepancy between observed frequencies and theoretical frequencxes and thus to determine whether
the discrepancy so obtained between observed frequencxes and theoretxcal ﬁ'equencxes is due to error
of sampling or due to chance ‘ , ,

The chi-square is computed on the basis of frequencies in a sample and thus the value of chi-
square so obtained is a statistic. Chi-square is not a patameter as its value is not derived fronfthe
observatxons ina populatlon Hence Chx-square test is a Non-Parametric test. Ch1~test Is not .
noncerned with any popuiation distribution and its observations. '

The y*-test was first used in testing statistical hypothesis by Karl Pearson+n the year 1900. It

is defined as

where O, = observed frequency of ith event
E,=Expected frequency of ith event.

We require the following steps to calculate 2.
Step 1. Calculate all the expected frequencies i.e., £, for all values ofi= L,2,.
Step 2. Take the dlﬁ‘erenee between each observed frequency 0, and the corresponding expected
frequency E for each value of i, i.e., and (O~E). _ ‘ ' ,
Step 3. Square the difference for eachvalue of i, i.e., calculate (O-E) for all values of i=1, 2, 3,..,1.

‘Step 4. Divide each square difference by the corresponding expected -
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frequeny i.e., Calculate for all valuesof i=1,2,3, ..., n.

(Q "E:‘)z
E

i

Step 5. Add all these quotients obtained in Step 4, then

e

i=l

 isthe required value of Chi-square.
It should be noted that

(a) The value of W’ is always positive as each pair is squared up.

(b) y? will be zero if each pair is zero and it may assume any value extending to infinity, when
the difference between the observed trequency and expected frequency in each pair are
unequal. Thus y lies between 0 and co.

(c) The significance test on y? is always based on One Tailed Test of the right hand side of
standara uurmal curve as y? is always non-negative. |

(d) As y? is a statistic and not a parameter, so it does not involve any assumption about the
form of original distribution from which the observation come.

6.1 Degrees of Freedoni

The number of data that are given in the form of a series of variables in a row or column or the
number of frequencies that are put in cells in a contingency table, which can be calculated independently
is called the degrees of freedom and is denoted by v.

Case L. If the data is given in the form of a series of variables in a row or column, then the
Jegree of freedom = (number of items in the series) -1 i.c. = n—1, where n is the number of
variabies in the series in a row or column.

Case I1. When the number of frequencies are put in cells in a contingency table, the degrees of

freedom will be the product of (number of rows less one) and the (number of columsn less one)

e.,v=(R-1)(C-1), where R is the number of rov‘;s and C is the number of columns.
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6.2  Chi-square distribution

w* - distribution is a continuous distribution whose probability density function is given by

3

P(y?)=y, (wz)%(v-z) e?

where y, = constant depending on the degrees of freedom.

v = degrees of freedom =n - 1.

6.3 Properties of y’-distribution

L.

S v oA W N

Chi-square curve is always positively skewed.

The mean of distribution is the numbér of degrees of freedom.

The standard deviation of 2 distribution = /2y, where v is the degrees of frecdom.
Chi-square values increase with the increase with the increase in degrees of freedom.
The value of y? lies between zero and infinity ie.,0 < q)z <w, -

The sum of two y? distribution is again a y? distribution ie. if ] and y] are two
independent and they have a y’ -distribution with n, and n, degrees of freedom respectively,
then (w,z + \u,z) is also a y’ -distribution with (n,+n,) degrees of freedom.

For different degrees of freedom, the shape of the curve will be different. See figure 1.
Like t-distribution its shape depends on the degree of freedom but it is not a symmetrical

distribution.
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6.4 Usesof ¥’ test .
The W’ testis a very powerful test for testing the hypothesis of a number of statistical problems.

The important uses of Wy ° test are :

1.

Test of Gooduess of Fit. If the two curves, viz.(/) Observed frequency curve and (ii) the
expected frequency curve, are drawn. then the Chi-square statistic may be used to determine
whether the two curves so drawn are fitted good or not. Thus the term goodness of fit is

used to test the concordance of the fitness of these two curves. Under this test there is

Aonly one variable, i.e., the degrees of freedomisv=n-1.

Test of Independence of Attrlbutes. The Chi-square test is used to see that the principles
of classnﬁcatlgn of attributes are mdcpendcnt. In this test the attributes are classified into
a two way table or a contingency table as the case may be. The observed frequency in each
cell (square) is known as Cell frequency. The total frequency in each row or column of the
two way contingency table is known as Marginal frequency. The degrees of freedom is
v=(R-1)(C-1), '

where R = number of rows, C=number of columns in the two way contingency table. This
test discloses whether there is any association or rélationship between two or more
attributes.

Test of Homogeneity or a Test for a Specified Standard deviation.

The Chi-square test may be used to test the homogeneity of the attributes in respect of a
particular characteristic or it may also be used to test the population variance. In the case

of a specified standard deviation, the test statistic is given by y* = (n - 1)3'2 /o}, where s?

=sample variance and o is the hypothesized value of population variance.

6.5 Conditions for using the Chi-square test

1.

Each of the observations making up the sample for this test should be independent of each

other.

2. The expected frequency of any items or cell should not be less than 5. If it is less than 3,

82
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then frequencies taking from the adjaeent items or cells be pooled together in order to
make it 5 or more than 5. | |

3. Thetotal number of observations used in this test must be large i.e. n > 50,

4. This test is used only for drawing mferences by testing hypothesis. It cannot be used for
estimation of parameter or any other value.. ‘

5. Itis wholly dependent on the degrees of freedom. -

6. The frequencles used in y ? -test should be absolute and not relative in terms.

7. The observation collected for y? -test should be on random basis of sampling.
6.6 W% Test _

The Chi-square test is widely used to test the 'independence of attributes It is applied to
test the association between the attnbutes when the sample data is presented m the form of a
contmgency table with any number of rows or columns.

WORKING RULE

Step 1. Set up the Null Hypothesxs H, : No Association exists between the attributes.
Alternative Hypothesis /| : An association exists between the attributes.
Step 2. Calculate the expected frequency E corresponding to each cell by the formula |

E, = L
¢ n

where R, = Sum total of the roaw in which E, is lying
C, = Sum total of the colum in which E,is lying

- n="Total sample size.

Step 3 Calculate  * -statistic by the formula -
h 0-E)
oz lo-s

The charaggeristics of this distribution are completely defined by the number of degrees of
freedom v which is given by v=(R~1) (C-1), _ |
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where R = number of rows and
C = number of columns in the contingency table

Step 4 Find from the table the value of ¥ ? for a given value of the level of significance o and
for the degrees of freedom v, Ca'lculated in Step 2.
If no value for « is mentioned, then take a = 0.05.
Step 5. Compare the computed value of ¥ ? with the tabled value of y? found in step4.
(a) If calculated vélue of W * <tabulated value of then then accept null hypothesis £,
(b) If calculated value of W ? >tabulated value of \yi , then rejected null hypothesis A, and
accept the alternative hypothesis /..

6.7 W7 -Test for goodness of fit

| v 2 .test is a measure of probabilities of association between the attributes. It gives us an idea
about the divergence between the observed and expected frequencies. Thus the test is also described
as the test of “Goodness of Fit”. If the curves of these two distributions, when superimposed do nto

coincide or appear to diverge much we say that the fit is poor. On the other hand if they don’t diverge
much, then the fit is less poor.

This concept is illustrated by the following examples.

Example 1. In a sample survey of public opinion, answers to the questions

(f) Do you drink?

(ii) Are you in favour of local option on sale of liquor?

are tabulated below:

Question (1)

Yes No Total
Yes 56 31 87
No 18 6 | 24
Total 74 37 . 111

Can you infer whether or not the local option on the sale of liquor is dependent on individual

drink.
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~ Solution. Null hypothesis H, : The option on the sale of liquoris mdependent ornot assocxatcd

Modlule 1 9(b).' Bio.s'taﬁstics

with individual drinking,
The theoretical frequencies are tabulated as below
| : Questio‘n*_(l) '
Yes | No
87x74 : 37x87
=58 =29
Yes 1 111
T4x24 24x37
No 111 111
Total 74 37
Computation of test statistic
Applying the formula
(0 E) we: gét
E- .7 | _-
- 2 L N2 \2 2
2 (56-—58) . (1-8—-16) N (31—29) N (6-—8)
58 . 16 29 8
:i-{.i.{.i.}.izlﬂ-—o 957

58 16 29 8 116

3. Degree offreedom y= (R -DEC-DH=2-1)2-1D=L1.

4. Decision. The tabulated value of ¥ * at a=0.05 and one degree of freedom s y, =3.441.
Since caleulated W * =0.957<Tabulated value v, , =3.441=> the Null hypothesis H, is

accepted = Sale of liquor is independent or not associated with the individual drinking.

Example 2. From the table gzven below whether the colour. of son's eyes is assocaited with

~ that of father s eyes.

Eye colour in Sons

Directorate of Distance Education

Not light Light
“Eye Colour Not light 230 148
-in fathers Light - 151 471
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Solution. The observed frequencies are given by following Table.

. Eye colour in Sons

T Not light Tight Total

Eye colourin | Notlight | 230 b 148 378
fathers Light | 151 A 622
Total 381 - 619 - 1000

The theoretxcal frequencies of Expected frequencies are given by the table

Colour in sons

- Not light ~ Light
381378 _ 4 619x378 ..
in Not light = = 144 O7X21C 234
 Eye colourin T 71000
381x622 619% 622
' Light 2o-X05% = 937 “ 385
fathers gh 500 1000

1. Null hypothesis H,: The colour of the son’s eyes is not associated with the colour of
father’s eyes. | |
2. Calculation of test Statistic.

. _(230- ~144)" (151 -237)’ (148 234)° (471 385)
144 237 234 385

7396+7396 7396+7396 :
144 237 234 385

=51 36+3121+3161+ 19.21=133.39
3. Degree offreedom y=R-DEC-N=2-H2-D=1
‘ 4 ' Declsmn The tabulated value of ¥ * for a.=0.05 and 1 degree of freedom is woos,
“Now calculated y?=133.39> wm, =3.84 = the Null hypothesis is rejected = there isan

=3.84.
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association between the colours of eyes of son’s and colours of eyes of father’s.
Example 3. 4 survey of 320 families with 5 children each revealed the following distribution.

No. of bays : J 4 b) 2 1 0
No. of girls : 0 / 2 3 4 h]
No. of families : 14 56 110 88 40 12

Is this result consistent with the hypothesis that the male and SJemale births are ‘equally

probable;?

Solution. Null hypothesis Ho ‘: Male and female births are equally probable.

Alternative hypothesis 11,' : Male and female births are not equally probable.
2. Calculation of test statistic. On the basis of null hypothesis the expected frequencies are

b
32()(.l +—l-)
2 2
= 10, 50, 100, 100, 50, 10.
Table for v 2

20 _L.ilﬂ.l.o_ij_)
3273232732732’ 32

, - (0-E)
0 E O-E (O-Ep —
14 10 4 16 1.60
56 50 6 36 1.72
110 100 10 100 1.00
88 100 12 144 1.44
40 50 10 100 2.00
12 10 2 4 0.40

’ 2

2 (0'—E)
= =7.16
yi=) -

3. Level of significance. Take o = 0.05.

” 4. Critical value. The table value of v? at o = 0.05 for (6-1)=5 degrees of freedom is

Weos =11.07.

S." Decision. Since the calculated value of v’ =7.16<table value y2 . for5d.f=11.07,so

the null hypothesis is accepted => the male and female births are equally probable.

- Directorate of Distance Education
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Example 4. In 60 throws of a dice, face one tirned up 6 times, face two or three 18 times,

fabe fur or five 24 times and face six, | 2 times. Test at 10% significance level, if the dice is honest,
it being given that P(\v2 > 6.25) =0.1 for 3 degrees of freedom.

Solution.

1. Null hypothesis H,=The dice is honest.

Alternative Hypothesis H : The dice is not honest.

2. Computation of test statistics. Under the assumptlon of null hypothe31s that the dice is

Sl
honest, the expected frequency for each face is 60x ris 10

[ Probability of turning up any ohe of the numbers
| ~ o
1,2,3,4,5,6,is <.

We prepare the following table.

Computation Table for .
. : . - » (O-EY
Face of the Observed *| Expected O-E -
die frequency | frequency " |
o___ E
6 10 -4 1.6
2 : 1 -2 : 0.2
18 - N
} He |
4 } 24 ._ 10} 49 4 .08
5 , - 10J . -
12 10 10 2 - 04
- 0-E)
i Total 60 - 60 gl = ZLE-«)—- =3.0

syt =3.0.
3. Critical value. The table value of ¥ 2ata= 0.1 for 4~ 1 =3 degrees of freedom is 6.25.
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4. Decision. The tabulated value of y* =3.0 <y} for 3 d.f. = 6.25, therefore, the Null
hypothesis that the die is honest is accepted.
Example 5. Calculate the expected frequencies for the following data presuming the two

attributes viz., conditions of home and condition of child as independent

Conditoin of home
"Clean Dirty
Condition of Clean 70 ‘ 50
child Fairly clean 80 20
Dirty 35 45

Use chi-square test at 5% level of significance to state whether the two attributes are

independent.

(Table value of w* at 5% for d.of is 5.991 and for 3 d.o.f is 7.815 and 4 d.of is 9.488).
Solution. The expected frequency E, corresponding to each cell in the table is given by |

_.RxC
n

E

where R = arow total, C = a column total and n = the sample size.
We form the table of expected frquencies, with the help of the above rule and write the observed

frequencies in each cell within brackets.

Condition of home Total
Clean ' Dirty
Clean (70) (50) 120
l85x120=,}4 115x120=46
300 300 :
Fairly clean (80) (20) 100
185x100=“61.67 ”5)(]00:38.33
300 300
Dirty (35) (45) 80
1,85><80:49.33 115)(80::30.67
300 300 v
Total 185 115 300

Directorate of Distance Education
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1. Null Hypothesis H : There does not exist any association between the attributes.
2. Alternative _Hypothesis H : An association exists between the attributes.
3. Calculation of test statistics
Z(o E)} (10-74) , (50— 64)’ , (80 -61.67)"
74 64 61.67
(20-3833)° (35 -49.33)" (45 ~30.67)’

38.33 49.33 30.67
=(.2162 + 0.3478 + 5.4482 + 8.7657 + 4.1627 + 6.6954

=25.636
Degree of freedom = (R— 1) (C-1)=2x1=2.
Decision. The table value of ¥’ at o = 0.05 for 2 degrees of freedom is Waose =35.991.

Also the calculated y? = 25.636 > y?  for 2d.f.=5.991

= the Null hypothesis is rejected = Alternative Hypothesis H, is accepted from which we
conclude that there exists an association between the attributes.

Example 6. The following figures show the distribution of digits in number chosen at random
from a telephone directory :
Digits : 0 1 2 3 4 S5 6 7 8 9
Frequency : 1026 1107 997 966 1075 933 . 1107 972 964 853

Test at 5% level whether the digits may be taken to occur equallyfrequently in the directory.

(The table value of ¥ 2 for 9 degrees of freedom = 16.919).

Solution.
1. Null Hypothesis H, : The digits occur eqully frequently in the directory.

Alternative Hypothesis H, : The digits do not occur equally frequently.
2. Calculation of Test Statistic. Here the total number of frequencies
n=1026 + 1107 + 997 + 966 + 1075 + 933 + 1107 + 972 + 964 + 853 = 10,000.
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=1000. Thus the

. 10,000
Expected frequency for each of the digits 0, 1,2,3 ..., 91is £ = 0

value of ¥ ? is
Vi (1026 -1000Y’ . (1107 -1000)’ . (997 -1000)°
1000 1000 1000
+(966-1000)2 , (1075~1000)’ . (933 -1000)’
1000 1000 1000

, (1107-1000)" (972-1000)’
1000 1000

, (964-1000)° L (853~ 1000)’
: 1000 1000
- =0.676 + 11.449 + 0.009 + 1.156 + 5.625 + 4.489 + 11.449

+0.784 + 1.296 + 1.296 + 21.609 = 58.542
3. Critical value. The tabulated value or critical value of W 2 at o=0.05 for 10~1'9 degrees
of freedom is g0 =16. 919.

Since calculated valuc of y? = 58.542 is > Tabulated ¥ 2 = 16.919 the null hypothesis His
rejected and the alternative hypothesis H, is accepted = the digits do not occur equally frequently.
Example 7. 4 dice is tossed 120 times with the following results : |
Number turned up : 1 2 3 4 5 6 Total
Frequency : 30 25 18 10 . 22 15 120
- Test the hypothesis that the dice is unbiased.

Solution. 1. Null Hypothesis H : The dice is unbiased one.
Alternative Hypothesis H| : the dice is a biased one.
2. Calculation of test statistic. On the hypothesis that the dice is unbiased, the expected

| .
frequency is 120 x i 20. We calculate v from the following table.
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0-EY

0 E O-E (O - Ey L—E—-)-
30 20 | 10 100 | 5.00
25 20 | s 25 1.25
5 20 -2 4 0.20
10 20 | =10 100 . 5.00
22 20 2 4 | 0.20
5 20 | -s | 25 1.25

. 2

=Z.(_0__':£)_.=12,9o

E

| 3. Critical value. The control value of ¥ * at a=0.05 a.nd for 6 —1 =5 degrees f freedom
IS W55 =11.070.
4. Decision. Since the calculated value ¥ ? = 12.90 iS W3 6s.s= 11.07, so null the hypothesis -
H, is rejected and the alternative Hypothesis H, is accepted = the diceis a biased one.
Example 8. From the adult male population of seven large cities random sample given 2X7
contingency table of 'married and unmarried men, as given below were taken. Can it be said that

there is a significant variation among the cities in the tendency of men to marry?

City A B C D E F G Total
Married 133 164 155 106 153 123 146 980
Unmarried 36 57 40 37 55 33 36 294
Total 169 221 195 143 208 156 182 1274

[41(2-1)(7-1)d.f Take y}os =12.6]
Solution 1. Null Hypothesis H, : There is no significant variation among the cities in the
tendnecy of men to-marry.

Alternative Hypothesis H, : There is a significant vanatnon among the cities in the tendency

of men to marry.
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are.

2. Calculation of test statistic. On the basis of Null Hypothesis the expected frquencies

980

Expected number of married people in City A = 1274 ¢ 169 =130

980
Expected number of married people in City B = 1274 x221=170

980
1274

’ ' 980
Expected number of married people in City D = Tk 143=110

x195 =150

Expected number of married people in City C =

980
Expected number of married people in City E = Tk 208 =160

' : . 980
Expected number of married people in City F = 1578 % 156 =120

. 980
Expected number of married people in City G = 1278 182 =140

Similarly, the expected frequencies for unmarried are 39, 51, 45, 33, 48, 36 and 42.

Table for expeéted frequencies |
Married 130 170 150 110 160 120 140
Unmaried 39 51 45 33 48 36 42
Total 169 221 195 143 208 156 182

Table for calculation of ¥ !

: O-EY
0 E O-E (O-Ey ( E)
133 130 | "3 .9 ,. - 0.069
164 170 -6 36 0.212
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155 150 5 25 0.167
106 110 -4 16 0.145
153 160 -7 49 0.306
123 120 3 9 0.075
146 140 6 36 0.257
36 39 -3 9 0.231
57 51 6 36 0.706
40 - 45 -5 25 0.556
37 33 . 4 16 0.485
55 48 7 49 1.021
33 36 -3 9 0.250
36 42 -6 36 0.857
0-E)
:.qﬂ:Z( - ) _ 5337

3. Level of significance. Take a = 0.05.
4. Critical value. The critical value or table valeu of ¥ >ata=005for21)(71)=6

degrees of freedom is y; o = 12.6.
5. Decision. Since the calculated value of ¥* = 5.337 < critical value v for 6 d.f. =

12.6, so the Null hypothesis is accepted => that there is no significant variation among the

cities in the tendency of men to marry.

6.8 EXERCISES
1. A sample of 300 students of Under-Graduate and 300 students of Post-Graduate classes of a
University were asked to give their opinion toward the autonomous colleges. 190 of the Under-
Graduate and 210 of the Post-Graduate students favoured the autonomous status. |
Present the above data in the form of frequency table and test of 5% levels, the opinion of

Under-Graduate and Post-Gradaute students on autonomous status of colleges are indendent (Table
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association between the colours of eyes of son’s and colours of eyes of father’s.
Example 3. 4 sMey of 320 families with 5 children each revealed the following distribution.

No. of boys : | 5 4 b 2 1 0
No. of girls : - 0 / 2 3 4 b)
No. of families : 14 56 110 88 40 12

Is this result con.s;istent with the hypothesis that the male and female births are equally
probable? /

Solution. Null hypothesis Ho ‘: Male and female births are equally probable.

Alternative hypothesis H,‘ : Male and female births are not equally probable.

2. Calculation of test statistic. On the basis of null hypothesis the expected frequencies are

S
320( L+ 1) ~ 390 .L,i,l‘_)_‘lf’.’i,_l_)
2 2 32732°32°32°32°32
=10, 50, 100, 100, 50, 10.
Table for v’

2

- , (0——E)

o E O-E ©-BF

14 10 4 16 1.60

56 50 6 : 36 ' 1.72

110 100 10 100 1.00

88 100 ~12 144 1.44

40 50 10 100 2.00

12 10 2 4 0.40

. _ - ,
2 (O_E) 7

=) 2L =716

yi=) 5

3. Level of significance. Take o = 0.05, :
” 4. Critical value. The table value of v* at o =0.05 for (6-1)=5 degrees of freedom is

Weos =11.07.
3. Decision. Since the calculated value of y? =7.16 < table value y? , for5d.£=11.07,so

the null hypothesis is accepted = the male and female births are equally probable.
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Example 4. In 60 throws of a dice, face one turned up 6 times, face two or three | 8 times,

face fur or five 24 times and face six, 12 times. Test at 10% significance level, if the dice is honest,
it being given that P(\u >6.25 ) =0.1 for3 degrees of freedom.

Solution.
1. Null hypothesis H=The dice is honest.
Alternative Hypothesis H, : The dice is not honest |

2. Computation of test statistics. Under the assumption of null hypothesis that the dice is

Cq
honest, the expected frequency for each face is 60x i 10

[ - Probability of turning up any one of the numbers

1
1234561S‘f6']

We prepare the following table.

Computation Table for .
| | o (0-E)
Face of the Observed | Expected O-E E
die frequency | frequency " -

0] . E _
1 6 10 —4 1.6
2 . 1 -2 . 0.2

18 : .
i} o} |
4 } 24 .‘ 10} 20 4 . 0.8
5 : 10 :
6 12 10 10 2 0.4

, <« (0-E
i Total 60 60 = ZM)— =30

Syt =3.0.
3. Critical value. The table value of ¥ 2 at o=0.1 for 4~ 1 =3 degrees of freedom is 6.25.
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4. Decision. The tabulated value of y® =3.0 <y}, for 3 d.f. = 6.25, therefore, the Null
hypothesis that the die is honest is accepted.

Example 5. Calculate the expected frequencies for the following data presuming the two

attributes viz., conditions of home and condition of child as independent

Conditoin of home
"Clean Dirty
Condition of Clean 70 | 50
child Fairly clean 80 , 20
Dirty 35 45

Use chi-square test at 5% level of significance to state whether the two attributes are
independent. ,

(Table value of W* at 5% for d.o.f is 5.991 and for 3 d.of is 7.815 and 4 d.of. is 9.488)

Solution. The expected frequency E, corresponding to each cell in the table is given by

_RxC
n

E

where R = a row total, C = a column total and n = the sample size.
We form the table of expected frquencies, with the help of the above rule and write the observed

frequencies in each cell within brackets.

Directorate of Distance Education

Condition of home Total
Clean ' Dirty
Clean (70) (50) 120
l85x120=74 115x120=46
300 300 :
Fairly clean (80) (20) 100
185)(100:61.67 HSX100=38.33
300 300
Dirty (35) (45) 80
185><80=49.33 115x80=30.67
300 300 _
Total 185 115 300
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1. Null Hypothesis A : There does not exist any association between the attributes.

2. Alternative Hypothesis H : An association exists between the attributes.
3. Calculation of test statistics

,_S(0-E) _(10-74)" (50-64) (80-6167)
v E 74 64 61.67

. (20-38.33)’ ER -49.33)" L (45 ~30.67)°
| 38.33 49.33 30.67
=0.2162 + 0.3478 + 5.4482 + 8.7657 + 4.1627 + 6.6954

=25.636
Degree of freedom =(R-1)(C-1)=2x1=2.

Decision. The table value of W > at a = 0.05 for 2 degrees of freedom is g, =5.991.

Also the calculated y? = 25.636 > y2,, for 2d.f. =5.991
= the Null hypothesis is rejected —> Alternative Hypothesis H, is accepted from which we
conclude that there exists an association between the attributes.

Example 6. The following figures show the distribution of digits in number chosen at random

from a telephone directory :
0 1 2 3 4 5 -6 7 8 9

Digits :
Frequency : 1026 1107 997 966 1075 933 . 1107 972 964 853
Test at 5% level whether the digits may be taken to occur equallyﬁequently in the directory.

(The table value of ¥ 2 for 9 degrees of freedom = 16.919).

Solution.
1. Null Hypothesis H, : The digits occur eqully frequently in the directory.

Alternative Hypothesis H, : The digits do not occur equally frequently.
2. Calculation of Test Statistic. Here the total number of frequencies
n=1026 + 1107 + 997 + 966 + 1075 + 933 + 1107 + 972 + 964 + 853 = 10,000.
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10,000

Expected frequency for each of the digits 0, 1, 2,3 ..., 9is £ = =1000. Thusthe

value of ¥ 2 is

, _ (1026-1000)° (1107-1000)" (997-1000)
v 1000 1000 1000

, (9661000 , (1075-1000)° L (933~ 1000)°
1000 1000 1000

, (1107-1000)* (972~1000)"
1000 1000

, (964-1000)"  (853~1000)"
1000 1000
=0.676 + 11.449 + 0.009 + 1.156 + 5.625 + 4.489 + 11.449

+0.784 + 1.296 + 1.296 + 21.609 = 58.542
3. Critical value, The tabulated value or critical value of W ata=0.05 for 10—1“9 degrees
of freedom is g4 =16. 919.

Since calculated value of W’ = 58.542 ‘.is > Tabulated ? =16.919 the null hypothc_sis His
rejected and the alternative hypothesis H, is accepted = the digits do not occur equally frequently. |
Example 7. 4 dice is tossed 120 times with the following results : |
Number turned up : 1 2 3 4 5 6 Total
Frequency : 30 25 18 0. 22 15 120
~ Test the hypothesis that the dice is unbiased.

Solution. 1. Null Hypothesis H, : The dice is unbiased one.
Alternative Hypothesis H, : the dice is a biased one.
2. Calculation of test statistic. On the hypothesis that the dice is unbiased, the expected

| .
frequency is 120 x i 20. We calculate v * from the following table.
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) E O-E (O - Ey (""Z:"l'
30 20 | 10 100 | 5.00
25 20 | s 25 1.25
15 20 -2 4 0.20
10 20 ~10 100 5.00
22 20 2 4 0.20
15 20 -5 25 1.25

2

- ZQ.ZE).. =12.90
E

3. Critical value. The control value of ¥ * at a=0.05 and for 6 ~1=5 degrees f freedom
is Wieso =11.070.
4. Decision. Since the calculated value ¥ * = 12..90 iS Waos.s= 11.07, so null the hypothesis
H, is rejected and the alternative Hypothesis H, is accepted = the dice is a biased one.
Example 8. From the adult male population of seven large cities randoh sample given 2X7
contmgency table of married and unmarried men, as given below were taken. Can it be said that

there is a szgmf icant vammon among the cities in the tendency of men to marry?

City A B € D E F —G__ Iotal
Married 133 164 155 106 153 123 146 980
Unmarried 36 57 40 37 55 33 36 294
Total 169 221 195 143 208 156 182 1274

[46(2-1)(7~1)d.f Take }oss =12.6] |
Solution 1. Null Hypothesis H, : There is no significant variation among the cities in the

tendnecy of men to-marry.
Alternative Hypothesis H, : Thereisa significant vanatnon among the cities in the tendency

of men to marry.

92 Directorate of Distance Edgication



Module 19(b): Biostatistics

arc:

2. Calculation of test statistic. On the basis of Null Hypothesis the expected frquencies

980

Expected number of married people in City A = 1272 169 =130

980

Expected number of married people in City B = 1272 > 221=170

' 980
Expected number of married people in City C = 572> 195=150

’ ' 980
Expected number of married people in City D = 1273 143=110

980
Expected number of married people in City E = 1272~ 208 =160

Expected number of married people in City F = 1272 > 156 =120

980

Expected number of married people in City G = 1272 > 182 =140

Similarly, the expected frequencies for unmarried are 39, 51, 45, 33, 48, 36 ahd 42.

Table for expeéted frequencies -
Marmried 130 170 150 110 160 120 140
Unmarried 39 51 45 33 48 36 42
Total 169 221 195 143 208 156 182

Table for calculation of V¥ !

0-E)
0 E O-E (O-Ey (0-£)
A , K
133 130 | "3 9 | - 0.069
164 170 -6 36 0.212
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155 150 5 25 0.167
106 110 -4 16 0.145
153 160 -7 49 0.306
123 120 3 9 0.075
146 140 6 36 0.257
36 39 -3 9 0.231
57 51 6 36 0.706
40 - 45 -5 25 0.556
37 33 . 4 16 0.485
55 48 7 49 1.021
33 36 -3 9 0.250
36 42 -6 36 0.857
0-EY
syl = ZL—E—L=5.337

3. Level of significance. Take a = 0.05.
4. Critical value. The critical value or table valeu of W Zata=005for21)(71)=6

degrees of freedom is o = 12.6.
5. Decision. Since the calculated value of ¥* = 5.337 < critical value w2 for 6 d.f. =

12.6, so the Null hypothesis is accepted = that there is no significant variation among the

cities in the tendency of men to marry.

6.8 EXERCISES
1. A sample of 300 students of Under-Graduate and 300 students of Post-Graduate classes of a
University were asked to give their opinion toward the autonomous colleges. 190 of the Under-
(,}raduate and 210 of the Post-Graduate students favoured the autonomous status.
Present the above data in the form of frequency table and test of 5% levels, the opinion of

Under-Graduate and Post-Gradaute students on autonomous status of colleges are indendent (Table
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«» Module 19(b): Biostatistics

value of W ? at 5% level for 1 d.f. is 3.;'84) [Hint. The contingency table of observed frequencies in

which expected frequencies are shown in braces is

Favour ~ |  Notin | Total

_ | favour ;
Under Graduate; | 190 (200) - | 110 (100) 300
Post Graduate : | 210 (200) - | 90 (100) 300
400 - .200 600

Null Hypothesis H, : Opinion on autonomous status and level of Graduation are independent.

—=—3_100 100. 100 100
+ + +
200 200 100 100

df=2-1)(2-1)=1. |
Table value of ¥ at o= 0.05 and for 1 df is yg,s=3.84.
Now calculated y? =3 < q/?m, =3.84. Null hypothesis is accepted

Opinion on aﬁtonomous status and level of Graduation are independent.

2. A certain drug is clalmcd to be effective i is curing colds Inan expemment of 164 people ‘
~ with cold halfof them were ngen the drug and half of them given sugar pills. The patxent’s reactions
to the treatment are recorded in the following table. Test the hypothesis that the drug is not better than

sugar Pills for sugar colds

Helped Harmed ~~  No effect
Drug : 52 10 20
SugarPills: . 44 12 26

3. In a survey of 200 boys, of which 75 were 'infelligent, 40 had skilled fathers, while 85 of
the unintelligent boys had unskilled fathers. Do these support the hypothesis that skilled fathers have
intelligent boys. Use w? test. Values of ¥ for 1-degree of freedom at 5% level is 3.84.
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" 4, Four dibe were thrown 112 t_imes and the number of times 1.3 or 5 were as under :

Number of dice - 0 1 2 3 4
" showing 1,3 or § |
Frequency - 10 S 25 40 30 7
'Ansv&ers

~ Opinion on autonomous status and level of graduations are indepdent.

Computed y?=1.622, \yo 05 = '5.991. Drug is not better than sugar points.

=0.88, 2, 1d.f.=3.84; skilled fathers have intelligent boys
All the four dice are fair. '
Umt Summary : In this module, we have discussed probablhty, some important dxstnbuuons,
correlation and regresswn analysxs, and chi-square test. Also we have discussed the properties
of correlation and regressxon coefﬁcwnt Fmally a lot of problems have solved of our discussion

on Biostatistics.
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